Copyright © 1997-2006 PLP Digital Systems, Inc.
All rights reserved.

This documentation is subject to the PLP Digital Systems, Inc. End-User License Agreement ("EULA"), revised November 30, 2004. A copy of this agreement is available in this User Guide. By using any of the instructions given here, you indicate your acceptance of those terms and conditions.

The software described in this document is furnished under a license agreement. The software may be used or copied only in accordance with the terms of the agreement. It is against the law to copy the software except as specifically allowed in the license agreement.

This guide may not be reproduced or transmitted in any form or by any means, electronic or mechanical, including photocopying and recording, in whole or in part, without written consent of PLP Digital Systems, except for normal internal use by employees of a business licensed by PLP Digital Systems. External distribution to customers or other outside parties is expressly prohibited. The proprietary and copyright notices that appear on this page must be affixed to any permitted copies.

The information in this guide is subject to change without notice. PLP Digital Systems, Inc. makes no warranty of any kind with regard to this guide, and shall not be liable for any errors or for incidental or consequential damages in connection with the use of the instructions or examples herein.

PlotWorks is a registered trademark of PLP Digital Systems, Inc. Arlington VA, USA. Windows and Windows NT are trademarks of Microsoft Corp.

Other brands and products mentioned in this guide are the trademarks of their respective manufacturers and should be noted as such.

⚠️ Depending on the PlotWorks version you are using, one or more software components or some of their features may not be available. Please see your PlotWorks retailer for more information.
Table of Contents

Chapter 1

Introduction ...................................................................................................................... 1-1
  What’s New in PlotWorks Version 5.7.0 ................................................................. 1-1
Supported PlotWorks Devices .................................................................................. 1-3
  Printers .................................................................................................................... 1-3
  Legacy Printers ...................................................................................................... 1-3
  Scanners .................................................................................................................. 1-3
  Folders ..................................................................................................................... 1-4
Supported File Formats ............................................................................................... 1-5
  Job Ticket Compatibility ........................................................................................ 1-5
PlotWorks Hardware Configurations ......................................................................... 1-6
  Interface Cards ....................................................................................................... 1-7
  Scorpion Interface Card ......................................................................................... 1-7
  Gecko Interface Card ............................................................................................. 1-7
  Security Key/External Dongle ................................................................................ 1-10
  PlotWorks Smart Switch I ..................................................................................... 1-11
System Requirements ............................................................................................... 1-15
PlotWorks Software Components ........................................................................... 1-16
  The Job Queue ....................................................................................................... 1-16
  The Job Editor ....................................................................................................... 1-16
  The Printer Interface ............................................................................................. 1-16
  The Job Processor ................................................................................................. 1-16
  Network Polling ..................................................................................................... 1-16
Optional PlotWorks Components: ................................................................. 1-17
  The Scanner Interface ........................................................................................... 1-17
  Print-to-Queue ......................................................................................................... 1-17
  PlotWorks Client .................................................................................................. 1-17
Software Flowchart ................................................................................................. 1-18
Using this Manual ........................................................................................................ 1-19
  Before You Start .................................................................................................. 1-20
  Documentation Conventions ................................................................................ 1-20
Help and Technical Support ..................................................................................... 1-21
  Online Help .......................................................................................................... 1-21
  Technical Support ................................................................................................. 1-21
  PLP Internet Support ............................................................................................ 1-22
  Printing Electronic Documentation ...................................................................... 1-22

Chapter 2

Getting Started ........................................................................................................... 2-1
<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Saving Jobs from the Queue to a different location</td>
<td>3-20</td>
</tr>
<tr>
<td>Output to File</td>
<td>3-21</td>
</tr>
<tr>
<td>Logs and Reports</td>
<td>3-22</td>
</tr>
<tr>
<td>Processing Log</td>
<td>3-22</td>
</tr>
<tr>
<td>Printing and Print to File Logs</td>
<td>3-22</td>
</tr>
<tr>
<td>Media/Capabilities Log</td>
<td>3-22</td>
</tr>
<tr>
<td>Job Information</td>
<td>3-23</td>
</tr>
<tr>
<td>Job Order</td>
<td>3-23</td>
</tr>
<tr>
<td>Troubleshooting</td>
<td>3-24</td>
</tr>
<tr>
<td>Rebuild the Queue</td>
<td>3-24</td>
</tr>
<tr>
<td>Reset the Activity Field for a Job</td>
<td>3-25</td>
</tr>
</tbody>
</table>

**Chapter 4**

The Job Editor ................................................................................................. 4-1

Creating a simple job ticket ................................................................. 4-3
To start a new job ticket: ................................................................. 4-3
To add images to a job ticket: ......................................................... 4-3

The Job Editor Window ............................................................................. 4-5
The Toolbar ............................................................................................... 4-5
The Menus ................................................................................................. 4-7
The Job Grid ............................................................................................ 4-12
Changing Print Parameters ...................................................................... 4-15
To change prototype parameters: ......................................................... 4-15
Editing Functions ..................................................................................... 4-15
Change Image Filenames ......................................................................... 4-16
Saving a Job Ticket .................................................................................. 4-16

The Detail Property Sheet ....................................................................... 4-18
Main Tabbed Dialog Box ........................................................................... 4-19
Specified Size Tabbed Dialog Box .......................................................... 4-21
Output Setup Tabbed Dialog Box .............................................................. 4-25
Data Format Tabbed Dialog Box ............................................................... 4-27
Pens tabbed dialog box ............................................................................ 4-32
Pen/Print Options Tabbed Dialog Box ..................................................... 4-39
Overlays Tabbed Dialog Box .................................................................... 4-46
Watermarks Tabbed Dialog Box ................................................................ 4-49
Margins Tabbed Dialog Box ...................................................................... 4-52
Labels Tabbed Dialog Box ....................................................................... 4-58

Saving and applying options selected from the Detail Property Sheet ........ 4-61
Saving and applying a Pen Set .................................................................. 4-61
Saving and applying watermark, margin and label settings .................... 4-61
The Scale View .......................................................................................... 4-64
Setting Preferences ................................................................................... 4-65
General Preferences tabbed dialog box .................................................. 4-65
Chapter 5

The Image Viewer .................................................................5-1
## Viewing Image Files
- Open the Image Viewer
- The Viewer Window
- Zoom In or Out
- Adjust the Size of a Print
- Adjust the Origin of a Print
- Black Paper
- Show or Hide Pens
- Identify Pens
- Refresh the Viewer Window
- Configure a Third Party Viewer

## Chapter 6
### The Network Polling Program
- Advantages of Network Polling
- The Network Polling Window
- The Network Polling Toolbar
- Network Polling Menus
- Columns
- Setting Up Network Polling
  - Set Polling Options
  - Add a Target Directory
  - Modify a Polling Directory
  - Delete a Target Directory
  - Edit the Directory PFS File
  - Edit the Master PFS File
- Polling for Jobs
  - Receiving Jobs from a Remote Source
  - Poll Target Directories
  - Polling Status
  - The Polling Log

## Chapter 7
### The Job Processor
- The Job Processor Window
- The File Menu
- The View Menu
- The Setup Menu
- The Help Menu
- Setting Up the Job Processor
  - Connect to a Queue
- Running the Job Processor
  - Start and Stop Processing
Run Processing in the Background ............................................................ 7-7
View Processing Log ................................................................................. 7-7

Chapter 8

The Printer Interface ....................................................................................... 8-1

The Printer Interface Window ........................................................................ 8-3
The Toolbar Buttons ....................................................................................... 8-3
The Menu Options ......................................................................................... 8-4
The Printer Diagram ..................................................................................... 8-7
The Printer Information Box ........................................................................... 8-8
The Print Status Box ...................................................................................... 8-8
Setting Up the Printer Interface ................................................................. 8-10
Set General Printing Options ...................................................................... 8-10
Configure Device Specific Options ............................................................. 8-15
Generic Embedded Controller Options ....................................................... 8-18
Selecting Notification Sounds ...................................................................... 8-20
Setting Up Media Inventory .......................................................................... 8-21
About the Media Inventory .......................................................................... 8-21
Adding Media to Inventory ......................................................................... 8-21
Edit the Media Inventory List ...................................................................... 8-24
Deleting Media from Inventory .................................................................... 8-24
Media Override ............................................................................................ 8-24
Change Media Type ..................................................................................... 8-25
Manual Feed ............................................................................................... 8-26
Printing Basics ........................................................................................... 8-28
Set Printing Modes ....................................................................................... 8-28
Printing Rush Jobs ....................................................................................... 8-28
Display Images When Printing ..................................................................... 8-30
Printing Separator Pages ............................................................................. 8-30
Advanced Options ....................................................................................... 8-33
Opening the Advanced Options dialog box ................................................. 8-33
The Vector Imaging and Raster Imaging Tabbed Dialog Boxes ................. 8-34
The RK Color Model Specific Tab Window ................................................ 8-37
Connect to a Different Queue ....................................................................... 8-39
Job Recovery ............................................................................................... 8-40
Printer Errors ............................................................................................. 8-41
Out of Toner ............................................................................................... 8-41
Media Type Unknown Error ....................................................................... 8-41
Paper Jam ................................................................................................... 8-42
Simulate Printing ........................................................................................ 8-44
Printer-Specific Options .............................................................................. 8-46
XES MAX 200 and 8180 Printer Interfaces .................................................. 8-46
XEROX WIDE FORMAT 8825, 8830, & 8850 ............................................. 8-51
# Table of Contents

- Xerox 8840D/Fuji Xerox 4024 Printer Interface Options ........................................ 8-53
- Xerox 8845/Fuji Xerox 4036 Printer Interface Options .......................................... 8-54
  - Pen Widths ........................................................................................................ 8-55
  - Using a Folder with the 8845 ......................................................................... 8-55
- XEROX WIDE FORMAT 721p, 8855 and KIP 8000 .............................................. 8-56
- KIP 3620 Printer Interface Options ...................................................................... 8-58
- KIP 2950 Options .................................................................................................. 8-59
- KIP 1230 Options .................................................................................................. 8-60
- KIP 7095 Options .................................................................................................. 8-61
- KIP 9010 Options .................................................................................................. 8-62
- Océ 9600 Printer Interface Options ....................................................................... 8-63
- Océ 9800 Options .................................................................................................. 8-64
- Generic Embedded Controller Printers .................................................................. 8-65
  - Selecting a Different Printer Interface from an open one .................................. 8-65
  - Change from a Color to a Monochrome Printer .............................................. 8-66
- Socket Printers ....................................................................................................... 8-67
  - Enable LMHOSTS Lookup ............................................................................. 8-67
  - Obtaining the IP Address: ............................................................................ 8-67
- AccXES Controller Driven Printers ....................................................................... 8-71
- Océ Power Logic Controller Driven Printers ....................................................... 8-73
- Kyocera-Mita Controller ...................................................................................... 8-74
- Windows Printers .................................................................................................. 8-76
  - Selecting a Windows Printer ........................................................................... 8-76
  - Change from Color to Monochrome .............................................................. 8-77
- Paper Sizes Supported by Windows Printers ...................................................... 8-77

# Chapter 9

## The Scanner Interface

- Opening the Scanner Interface .......................................................................... 9-1
- The Scanner Interface Window ........................................................................... 9-2
- Setting Up the Scanner Interface ........................................................................ 9-17
  - Set Basic Scanning Parameters ...................................................................... 9-17
  - Set Up File Naming ....................................................................................... 9-17
  - Image File Formats ......................................................................................... 9-20
  - Set the Scanning Resolution .......................................................................... 9-20
  - Set the Scanning Speed .................................................................................. 9-20
  - Choose a Document Ejection Option ............................................................. 9-20
  - Right Edge Scanning ..................................................................................... 9-21
  - Reduce or Enlarge an Image ......................................................................... 9-21
  - Invert Images ................................................................................................. 9-21
  - Mirror Image ................................................................................................. 9-21
  - Set the Document Size .................................................................................. 9-21
  - Set the Document Offset ............................................................................... 9-22
Chapter 10

Advanced Reporting Utility (ARU) ................................................................. 10-1

Producing a Job Report .............................................................................. 10-1
Specifying what Data the ARU Log Collects ......................................... 10-2
Editing the DEF File ................................................................................ 10-2
ARU Data Fields ...................................................................................... 10-3
Disabling the Printer ARU ....................................................................... 10-14
LOG Files ................................................................. 10-15
  Archiving a log file ...................................................... 10-15
  ARU file size .................................................................. 10-15
Using the ARU Log to Generate Reports ................................. 10-16
  Importing the ARU Log File into Microsoft EXCEL ............ 10-16
  Importing the ARU log file into Microsoft Access ............... 10-17

Chapter 11

Folder Information ............................................................. 11-1
  Supported Folders .......................................................... 11-1
  Setting up the Folder ....................................................... 11-2
    Connecting the PlotWorks Folder Cable ......................... 11-2
    Setting up GFI Folders .................................................. 11-4
  Media Requirements for Folding ...................................... 11-7
  Setting up the Printer Interface to use your Folder .............. 11-8
  Fold Types and Options .................................................. 11-11
    Fold Types .................................................................... 11-11
    Folding Options ........................................................ 11-14
  Folding and Image Orientation ........................................ 11-17
    Specifying the Title Block Location ............................... 11-17
  Specifying Folding Options in Job Tickets ......................... 11-20
    Folding Options for All Folders .................................... 11-20
    Folding Options for the MAX 200 NACO ......................... 11-27
    Folding Options for the MAX 200 EO ............................. 11-29
    Folding Options for GFI Folders .................................... 11-31

Chapter 12

Print-to-Queue ................................................................. 12-1
  Just What is Print-to-Queue? ............................................. 12-1
    Considerations before installing Print-to-Queue ................. 12-2
  Installing Print-to-Queue .................................................. 12-3
  Editing a PFS File .......................................................... 12-3
    Sample Custom PFS File ................................................. 12-4
    Selecting a Driver ........................................................ 12-6
    Mapping a Local Printer to the PlotWorks Port on Windows NT ...... 12-6
  Using a Network Printer on Windows NT ......................... 12-12
    Mapping a Local Printer to the Port (Windows XP) ............ 12-13
  Output a Job to the Print-to-Queue Printer .......................... 12-20
  Configuring LPD to Work with PlotWorks ......................... 12-20
    Configuring PlotWorks and Print-to-Queue ....................... 12-20
    Configuring NT Workstation 4.0 to support LPD ............... 12-20
  Setting Up a Line Printing Utility (LPR)-Compatible Printer .... 12-22
    Printing to PlotWorks using LPR .................................... 12-23
Configuring Linux to Submit to Plotworks Job Queue .........................12-24
Printing from AutoCAD or Microstation to the Job Queue .................12-24
Troubleshooting ..................................................................................12-24

Appendix A

Memory Requirements ................................................................. Appendix A-1
How to calculate the amount of RAM needed for each Computer: Appendix A-1
To calculate: ................................................................................. Appendix A-1
Imaging Memory Setting Guidelines for the Printer Interface Appendix A-3
Windows and Generic Embedded Controller Printers ................. Appendix A-4
Image Data Buffer Size Guidelines for the Scanner Interface Appendix A-5

Appendix B

Error Messages and Common Problems ........................................ Appendix B-1
The Job Queue ............................................................................... Appendix B-1
Network Polling ........................................................................... Appendix B-5
The Printer Interface .................................................................... Appendix B-8
Common Printing Problems ....................................................... Appendix B-8
Error Messages ............................................................................. Appendix B-9
Job Editor ....................................................................................... Appendix B-18
Job Processor: ............................................................................. Appendix B-26
Image Viewer ................................................................................ Appendix B-27
Scanner Interface: .......................................................................... Appendix B-27

Appendix C

Image File Requirements ............................................................... Appendix C-1
Plot Files ....................................................................................... Appendix C-1
CalComp Commands ................................................................... Appendix C-3
CalComp Error Codes .................................................................. Appendix C-4
HP-GL Supported Command List ................................................ Appendix C-5
HP-GL/2 ......................................................................................... Appendix C-11

Appendix D

PFS Files ........................................................................................ Appendix D-1
Understanding PFS Files .......................................................... Appendix D-1
PlotWorks Network Polling ......................................................... Appendix D-1
PFS File Types .............................................................................. Appendix D-3
Directory-level Defaults ............................................................. Appendix D-4
Site-level Defaults ......................................................................... Appendix D-4
PFS File Layout ............................................................................. Appendix D-5
JOB section .................................................................................. Appendix D-5
FILE section ................................................................................ Appendix D-5
### Appendix E

Configuring RAS to Output PlotWorks Job Files ................................. Appendix E-1
  Install & Configure a Remote Access Server (Hub) ......................... Appendix E-2
  Verify Current Configuration .......................................................... Appendix E-2
  Install RAS ....................................................................................... Appendix E-4
  Create User Accounts for Remote Access Service ......................... Appendix E-7
  Create Shared Folders ...................................................................... Appendix E-8
  Start the Remote Access Administrator .......................................... Appendix E-9
  Making Remote Access Service Start Automatically ..................... Appendix E-9
  Stopping the Remote Access Admin ................................................. Appendix E-9
  Set Up the Client’s Dial-Up Networking Connection ...................... Appendix E-10
  Be Prepared ..................................................................................... Appendix E-10
Appendix E

Verify Current Configuration .................................................Appendix E-10
Add a Dial-Up Networking Connection ...............................Appendix E-12
Make the Connection .........................................................Appendix E-13
RAS Installation .................................................................Appendix E-14
Set up the Client Dial-Up Networking Connection (Win95) ......Appendix E-15
Add a Dial-Up Networking Connection ...............................Appendix E-16
Make the Connection .........................................................Appendix E-17

Installing Network Protocols (Windows NT) .......................Appendix E-18
Install TCP/IP .................................................................Appendix E-18
Install NWLink IPX/SPX Compatible Transport ..................Appendix E-22
Installing NetBEUI Protocol ...........................................Appendix E-23
Installing the MS Loopback Adapter ..................................Appendix E-24
Installing Network Protocols (Win95) .................................Appendix E-24
Installing TCP/IP .................................................................Appendix E-24
Installing IPX/SPX Compatible Protocol (Win95) ..............Appendix E-25
Installing NetBEUI Protocol ...........................................Appendix E-26
Installing Client for Microsoft Networks ............................Appendix E-27
Installing Dial-Up Networking on Win95 ............................Appendix E-27
Output Job Tickets ..............................................................Appendix E-28
Installing FTP .................................................................Appendix E-29
Installing Internet Information Server on an NT Server .......Appendix E-30
Configuring Windows NT 4.0 Workstation for FTP ............Appendix E-32

Appendix F

Processing AutoCAD Jobs ..................................................Appendix F-1
DWG Direct* File Processing .............................................Appendix F-1
AutoCAD File Processing .................................................Appendix F-1
How AutoCAD Files are Processed ....................................Appendix F-1
Prechecking ..........................................................................Appendix F-2
Preprocessing and Interaction ............................................Appendix F-2
AutoCAD Printing Boundaries ...........................................Appendix F-2
PlotWorks Parameters and AutoCAD ..................................Appendix F-3
Configuring AutoCAD For Use with PlotWorks ..................Appendix F-6
Configuring AutoCAD R14 .................................................Appendix F-6
Configuring AutoCAD 2000 or 2002 ....................................Appendix F-7
Configuring AutoCAD or DWG Direct* in PlotWorks ..........Appendix F-9
AutoCAD and “Error Free Printing™” ................................Appendix F-10
Examples of parameter settings ........................................Appendix F-11
Identifying Errors ...............................................................Appendix F-13
Printing with AutoCAD using Network Polling Mode 1 .......Appendix F-14
.........................................................................................Appendix F-16
Appendix G

Repro Desk Support .................................................................Appendix G-1

Supported Repro Desk Files ................................................. Appendix G-1

Printing Repro Desk Jobs with PlotWorks ...................... Appendix G-3

Processing Files before Outputting from Repro Desk .......... Appendix G-3

Using PlotWorks Network Polling for Repro Desk Jobs ...... Appendix G-3

Polling for Repro Desk VIC Files ........................................... Appendix G-5

Sending Files from Repro Desk to PlotWorks ................... Appendix G-6

Outputting VIC files from the Repro Desk Client ............... Appendix G-7

Outputting Jobs from the Repro Desk Queue ...................... Appendix G-7

Importing Repro Desk Job files ........................................... Appendix G-8

Repro Desk Pens and Patterns .............................................. Appendix G-13

Repro Desk Pen Properties and the PlotWorks Equivalent ... Appendix G-13

PlotWorks Pen Macros not supported by Repro Desk .......... Appendix G-14

Importing Repro Desk Pattern Files ................................... Appendix G-14

Importing a User Defined Repro Desk pattern .................. Appendix G-14

Reverting to the Default Standard Patterns ...................... Appendix G-15

Warnings and Other Print Parameter Issues ....................... Appendix G-16

Warnings ................................................................. Appendix G-16

Print Parameter Issues .................................................. Appendix G-20

PlotWorks Settings Not Supported by Repro Desk .......... Appendix G-24

Printing differences between Repro Desk and PlotWorks .... Appendix G-24

License Agreements

PlotWorks End-User Licence Agreement ......................... Waranty-i

ADOBE ACROBAT READER LICENSE ................................ Waranty-v

Index

.............................................................................................................. Index-i
Introduction

PlotWorks is a software solution that manages all aspects of document production. It offers high-speed copying, scanning, and printing as well as job management, image viewing, and remote job submission. PlotWorks provides the greatest production power of any digital solution available today.

PlotWorks modular, customizable design can be used in any reprographics environment, from service bureaus to in-house production facilities. You can choose individual components to meet your document production needs and combine them any way. Build a customized system using only the equipment you need while establishing a flexible foundation that can be easily updated when your needs change.

This documentation applies, either all or in part, to the following PlotWorks packages:

• PlotWorks Server
• PlotWorks Client
• PlotWorks Connect
• PlotWorks Convert
• PlotWorks 9800 Server

What’s New in PlotWorks Version 5.7.0

We are pleased to announce the release of PlotWorks version 5.7.0. The latest generation of PLP's reprographics software includes new features and methods that improve performance, output quality and interoperability. This release once again affirms our commitment to helping you Take Control of Your Business™.

• 600 DPI Production Printing: PlotWorks now provides optional support for the KIP 7000 printer. With a direct interface to the KIP 7000, PlotWorks users can now enjoy 600 DPI production printing at 13 D size sheets per minute. The KIP 7000 Printer Interface supports independent gamma correction for both raster and vector image components, independent dithering methods (either error diffusion or ordered dither patterns) for both raster and vector components, and full bi-directional communication to obtain media, toner
and printer status. The KIP 7000 Printer Interface is compatible with OpCenter, so that customers may track the status of every job, on every printer, in every location.

- **Improved DWF Processing:** PlotWorks users will experience a dramatic improvement in DWF processing speeds compared to earlier versions:
  - Processing DWF files is approximately 350% faster than the default installation of version 5.5.2
  - Performing DWF to TIFF conversions is approximately 160% faster than the default installation of version 5.5.2
  - Processing DWF files is approximately 85% faster than processing to LDF when using the latest version (1.6.4.002) of Océ Client Tools.

- **Resampling Performance Increase:** Monochrome TIFF resampling was first introduced in version 5.5.1 to help our customers produce half-size output from scanned images with unprecedented quality and clarity. The resampling process is computationally intensive, and requires ample memory and processing power. With a new approach to this complex task, PlotWorks now resamples images approximately 45% faster than earlier versions.

- **PDF Processing Improvements:** PlotWorks 5.7.0 introduces a new interpreter for processing PDF files, resulting in:
  - Faster performance
  - Improved data integrity
  - Ability to handle PDF files from more applications than ever before.

- **Online Plan Room Integration:** Through the Job Submission Connector API, PlotWorks has long supported integration with third party applications such as online plan rooms and document management systems. With this release, operators now have the ability to open and print Job Orders and Multi-Page Submittals, if provided, directly from the Job Queue. Operators now have access to all of the transactional documents from one location, eliminating several steps from the existing workflow and improving quality control.
Supported PlotWorks Devices

This list was current when this document was printed. If your printer is not on the list, please contact PLP.

PlotWorks currently supports the following printers, scanners and folders:

**Printers**

KIP 7000  
KIP 8000  
Kyocera Mita 4850w

Océ 9800  
Océ TDS400  
Océ TDS600  
Océ TDS800

Xerox Wide Format 721  
Xerox Wide Format 510

PlotWorks also supports a variety of other printers, both small and wide format, through generic Windows interfaces.

**Legacy Printers**

KIP 1230  
KIP 3620  
KIP 9010

KIP 2950  
KIP 7095

Xerox Wide Format 8180  
Xerox Wide Format 8830  
Xerox Wide Format 8845  
Xerox Wide Format 8855  
Xerox Wide Format MAX 200 NP

Xerox Wide Format 825  
Xerox Wide Format 8840  
Xerox Wide Format 8850  
Xerox Wide Format MAX 200

**Scanners**

All Twain driven scanners are supported.
Xerox Scanners:
Xerox 7336   Xerox 7356
Xerox 7396   Xerox 7399
XES 8180    XES MAX 200

Xerox Wide Format Scan System

Contex Monochrome Scanners (All at 400 dpi resolution only):
FSS 4300    FSS 8300
FSS 8300 Plus   FSS 8300 Copy
FSS 12300   FSS 18300

Contex Color Scanners (all in monochrome mode at 400 dpi resolution only):
FSC 3010    FSC 5010
FSC 5010 Copy   FSC 6010
FSC 8010    FSC 8010 Copy

KIP Scanners:
KIP 2020    KIP 2030
KIP 2035    KIP 2040
KIP 7095    KIP 2950

Other Scanners:
Océ 9800    Vidar Flash and Flash+
Kyocera Mita 4850

Folders
Xerox 8180    XES MAX 200
XEROX WIDE FORMAT 8830 (Gera and Bay 3)    Xerox 8845
XEROX WIDE FORMAT 8855 (Bay)    PrintFold 2150 / 3150
GFI Folders
Supported File Formats

Support for the following file formats is included with every PlotWorks system:

- CalComp 907/907
- CALS
- HP-GL, HP-GL/2, HP-RTL
- TIFF
- VRF

Support for the following file formats is optional:

- DWF
- PDF/PostScript
- VIC/JOB

Support for the following file formats requires the installation of Global 360 Imaging for Windows:

- BMP
- DCX
- JPG
- PCX
- XIF

Job Ticket Compatibility

PlotWorks 5.7.0 job tickets (.plp files) are fully compatible with systems running versions 5.5.1 or 5.5.2. Job tickets created with PlotWorks 5.7.0 may not be opened by systems running version 5.5 SP3a or earlier. In most cases PlotWorks provides backwards compatibility, so that a system running version 5.7.0 would be able to open job tickets created with versions prior to 5.5.1.
The PlotWorks system consists of several hardware and software components. This section describes the various hardware components and provides step-by-step instructions for installing the software.
Interface Cards

The PlotWorks Interface Card is installed in the Print Server (hub) and is responsible for connecting to the printer. There are four different interface cards available, depending on the printer and scanner you are using.

Scorpion Interface Card

The Scorpion Interface Card supports the XEROX WIDE FORMAT 8855 printer, the Xerox 7396 and 7399 scanners, and all KIP printers and scanners. Input/Output ports are shown in the diagram below.

Gecko Interface Card

The Gecko Interface Card supports the XEROX WIDE FORMAT 8825/1, 8825/2, 8830, 8840D, 8845, and Fuji Xerox 4036 printers. (Input/Output ports are shown in diagram below.)
Fig 1.3
Gecko Card

Security key

P193 input (for future use)

Output to 8825/8830/8845

Output to second 8825/8830/8845

Gecko
The Mesquite Interface Card supports the Océ 9800 printer. (Output ports are shown in diagram below.)

The Tarantula Interface Card provides direct support for the MAX 200 printer.
For parallel printers:
Use a standard parallel port, like LPT1, to drive the following devices:
- Océ 9400, 9600, and 9800 printers with embedded controllers
- Large Format Inkjet Printers (i.e., HP DesignJet, Xerox 2230/2240)
- Large Format Printers with Embedded Controllers (i.e., XEROX WIDE FORMAT 8825, 8855 and 8830 with the AccXES controller; 8825 and 8830 DDS)
- Windows printers

RTL and Windows printers can be connected using Windows NT or Ethernet networking.

For all others:
Use an Adaptec 2940U SCSI I card to drive the following devices:
- XES 8180 Printer and Scanner
- XES MAX 200 Printer and Scanner using the embedded controller
- Xerox 7356
- Xerox 7336
- Vidar Flash and Flash +

Security Key/External Dongle
A provided Security Key must be connected to the computer to run the PlotWorks server software. The Print Server and Scan Station computers usually have the key installed on their interface cards.
PlotWorks User Guide • Introduction • 1-11

Print and Scan Stations that do not have an interface card, like SCSI or parallel port driven printers or scanners, use an externally mounted, keyed dongle, plugged into a parallel port. **Without this key, your software will not run.** If the Security Key or chip is lost, please contact your PlotWorks Service Representative to **purchase** a new one.

---

*If you receive an “Invalid Codes” message when attempting to start PlotWorks, check to see that the External Dongle is pushed firmly into the parallel port and that the key is seated properly. If using a key on the controller board, ensure the board is inserted firmly in the motherboard and that the key is seated properly.*

---

**PlotWorks Smart Switch I**

The PlotWorks Smart Switch I selects the scanning mode for scanning/printing systems like the XEROX WIDE FORMAT 8855 printer, the Xerox 7396 and 7399 scanners, and all KIP printers and scanners.

![Smart Switch I Diagram](image)

Page 8-12 provides more information on scanning modes.

There are four possible configurations using the Smart Switch:

- Single PC workstation as shown in Fig 1.8.
- Dual PC workstations, as shown in Fig 1.9.
- Four port, single workstation configuration, as shown in Fig. 1.10.
- Four port, dual-station configuration, as shown in Fig. 1.11

Select the configuration that best meets your needs and consult the appropriate diagram to connect your cables.
Fig 1.8 Printer Cables, Single Station Configuration

Fig 1.9 Printer Cables, Dual Station Configuration

F = Female end of cable
M = Male end of cable
Fig 1.10
Four Port, Single Station Configuration

F = Female end of cable
M = Male end of cable

Cable Supplied
Fig 1.11
Four Port, Dual-Station Configuration

F = Female end of cable
M = Male end of cable

Scan Station
Print Station

PLP Digital Systems
Smart Switch 1
System Requirements

PlotWorks is certified for use with the following PC models:

- Dell OptiPlex GX260
- Dell OptiPlex GX270
- Dell OptiPlex GX280
- Dell OptiPlex GX620
- Dell OptiPlex 170L

Windows XP Professional, either Service Pack 1 or Service Pack 2, is required. Neither Hyper-Threading nor Dual Core processors are supported.

Most configurations will require one or more full height PCI slots, a parallel port, and possibly a serial port. Please contact PLP Customer Support for a current PC specification including recommended processors and memory capacity.
PlotWorks Software Components

PlotWorks consists of a group of programs that work together to create, transmit, manage, process, scan and print your jobs. PlotWorks contains many features that are purchased and activated separately.

Depending upon your organizations needs and what features are activated, one or more software components or features may not be available. Please see your PlotWorks retailer for more information.

The following PlotWorks programs reside on the Print Server and are included with every PlotWorks installation:

**The Job Queue**

The Job Queue is the heart of the PlotWorks system. All incoming jobs pass through the Queue, where they can be prioritized, edited, and processed.

**The Job Editor**

The Job Editor is used to create and edit electronic job tickets. Job tickets list the images to print and their printing parameters. The Job Editor also lets you view images, process files, and send jobs to a Job Queue.

**The Printer Interface**

The Printer Interface is used to rasterize and output each image to the selected printer. It is also manages the printer and any attached peripherals (i.e., folders). It provides real time feedback on many printer operations. These include displaying information about the sheet and set printing, printer errors, media drawer contents, and media available in inventory.

**The Job Processor**

The Job Processor corrects common errors and converts jobs to PGS (Performance Graphics Standard) format to prepare for printing.

**Network Polling**

Network Polling monitors (polls) a set of target directories for incoming print jobs. These are then submitted to the Queue for printing. The Network Polling program accepts jobs submitted with job tickets or customized text order forms in PFS files. The Network Polling can also apply default printing parameters to single image files.
Optional PlotWorks Components:
Additional components can be added to the PlotWorks system to increase functionality. These include:

The Scanner Interface
The optional Scanner Interface offers copy, Scan-to-File and Scan-to-Print functions. Scanned documents can be added directly to a job ticket, stored digitally or printed. The Scanner Interface can be installed on the Print Server or on a stand-alone Scan Station.

Print-to-Queue
PlotWorks Print-to-Queue is used to print directly to a PlotWorks printer from any Windows application. It is installed on a network server or on local PCs. You can customize Print-to-Queue with PFS files to specify printing parameters like output, media size, fold types, etc.

PlotWorks Client
The PlotWorks Client is a limited version of the Job Editor. It is used to create "job tickets" at remote sites to send to the Job Queue via modem, network or floppy disk. The Client resides on remote user workstations, not on the Print Server.
Software Flowchart

Fig 1.12
PlotWorks Software

- Job Queue
  - File System (direct copy into polled directory)
  - Scanner Interface
  - Removable Media
  - Windows applications can print directly to the Queue using Print-to-Queue
  - Network Polling
  - Job Editor/Client submits jobs to the Queue or to a remote polled directory.
  - Watched Directory
  - Standalone applications that makes PFS files submit directly to the polled directory.

- Printer Interface
  - Printer 1
  - Printer 2
  - Windows Printer
  - HP-RTL Printer

- Scanner Interface

- Job Queue
Using this Manual

This manual is a comprehensive guide to the PlotWorks system. It provides instructions for using the PlotWorks software applications, and troubleshooting information. The following is a list of chapters and what each provides:

Chapter 1: Introduction

Describes the features and capabilities of the PlotWorks system, as well as information on using this manual and other sources of technical help. It also lists the image file formats supported, and any special requirements for using them.

Chapter 2: Getting Started

Provides instructions for hardware setup, software installation and configuration.

The following chapters provide instructions for each PlotWorks module:

Chapter 3: The Job Queue

Chapter 4: The Job Editor

Chapter 5: The Network Polling Program

Chapter 6: The Job Processor

Chapter 7: The Post Processor

Chapter 8: The Printer Interface

Chapter 9: The Scanner Interface

Chapter 10: Advanced Reporting Utility (ARU)

Chapter 11: Folder Information

Provides information on using PlotWorks with folding devices.

Chapter 12: Print-to-Queue™

Appendices:

Provide additional information, including how to calculate memory requirements, warning and error messages, and device specific options. The appendices also provide information on PFS files, and using RAS and Dial-up Networking with PlotWorks.
Before You Start

This manual assumes that the reader has an understanding of the following:

- Basic computer use, including keyboard and mouse operation
- Windows conventions such as toolbars, pull-down menus, the Start menu and Windows Explorer
- Image file formats used
- Hardware used. This includes printers, scanners, folders, modems, network servers, and removable media drives

If you are unfamiliar with any of the above topics, please research the appropriate documentation before proceeding.

Before using PlotWorks, be sure that you understand the operation and maintenance of your:

- Large-format printer
- Network, if applicable
- Peripheral products like scanners, folders, and modems

Documentation Conventions

This guide uses several conventions to help you identify different types of information.

Menu names and commands are printed in **bold** type. For example:

Open the **File** menu and select **Exit**.

Dialog box names begin with uppercase letters. For example:

This is the **Configure Destination** dialog box.

Information to be typed is displayed in Courier text. For example:

**Type this sentence.**

Many menu commands also are accessible as buttons on the toolbar. These buttons are displayed in the left margin, as shown here.

This guide also provides warnings to help avoid errors and prevent damage to your system. These are marked with the caution symbol as below.

---

**Do not ignore these warnings!**

Special tips and hints are marked with a light bulb icon.

---

**These tips make your job easier!**
Help and Technical Support

Several methods of help and technical support are available. These include:

- Online Help
- PLP Technical Support
- PLP Internet Support
- Electronic Documentation on the PlotWorks CD-ROM
- The PLP Knowledge Base on our web site, www.plp.com

Online Help

Each PlotWorks application contains an online Help file that provides detailed information on operating the program. To access an online Help file from within a program either:

- Press F1
- Open the Help menu and select Help Topics. Or click on the Help button.

Technical Support

All PlotWorks customers receive 90 days of free telephone technical support after receipt of their new software. To receive support beyond this 90-day period, you must purchase the PLP Maintenance and Warranty Plan.

You can contact PLP technical support at:

- PLP Digital Systems
- 2300 Clarendon Boulevard
- Suite 711
- Arlington, Virginia 22201
- Phone: 1 (800) 444-7568 or 1 (703) 740-8909
- FAX: 1 (703) 995-4398
- E-mail: support@plp.com

When you call for technical support, be sure to have the following information available:

- The version number and type of PlotWorks software you are using
- Printer model and configuration
- Computer hardware and software configurations
- Available RAM and hard disk space on the PC
The PlotWorks sample files listed below. These files are usually located on your computer hard drive under Program Files\PLP\Plotworks\Sample Files. These files can also be found on your PlotWorks CD-ROM.

- Samples.PlotWorks
- SampleCC1.PLT
- Sample CC3.PLT
- Sample HP1.PLT
- Sample HP2.PLT
- SampleHPRTL.PLT
- Sample Acad 12.DWG
- Sample Acad 13.DWG
- Sample Acad 14.DWG
- Sample multipage.PDF
- Sample.PS
- Sample.TIF
- Sample.VRF
- Sample multipage.PDF

---

You need a phone line available at your printing and scanning stations for Technical support to be able to help you solve your PlotWorks problems.

PLP Internet Support

PLP’s World Wide Web site (http://www.plp.com) offers a “Customers Only” section for customers on the Maintenance and Warranty Program.

The section offers:

- Frequently Asked Questions (FAQs) about PlotWorks system software and hardware
- Product documentation
- Early announcements of new products and services

Printing Electronic Documentation

PlotWorks documentation is provided in PDF format on the PlotWorks CD-ROM in the Documentation folder. These files print on 8.5" x 11" or A4 size paper to fit in a 3-ring binder.

The following guides are available on the CD-ROM.

- **Getting Started Guide:** This manual provides basic information on using the PlotWorks system.
- **The PlotWorks User Guide:** This manual provides comprehensive information on the PlotWorks system, including a description of each software component, installation, and instructions.
- **The PlotWorks Preinstallation Guide:** This guide contains information on preparing for installation.
Viewing and Printing PDF Files
Adobe’s Acrobat Reader is required to view and print PDF files. A copy is provided on the PlotWorks CD-ROM.

To Install Adobe Acrobat Reader 5.0
1. Insert your PlotWorks CD in the CD-ROM drive. The PlotWorks Installation window opens.
2. Click on Install Acrobat Reader.
3. Click on the text Adobe Acrobat Reader. The Adobe Acrobat Reader Auto Install application opens and leads you through the installation process.

To View a PDF File:
1. Once the Acrobat Reader is installed open Windows Explorer
2. Select your CD ROM drive
3. Open the Documentation folder
4. Double Click on the PlotWorks guide you wish to open. The guide will open in Adobe Acrobat Reader

To Print a PDF File:
1. Open the Guide you wish to print in Adobe Acrobat Reader.
2. Select Print from the Acrobat Reader File menu
Chapter 2

Getting Started

Installing PlotWorks®

Before beginning the PlotWorks installation please note the following:

• If you were previously running the Tiered version of PlotWorks, it is necessary to uninstall PlotWorks and then reinstall PlotWorks version 5.5.1.

• If you plan to process MicroStation DGN files, install MicroStation SE before PlotWorks.

• If you plan to process AutoCAD DWG files install AutoCAD, Release 14 or later, and ensure that it is configured to use only the PGS Driver for printing.

• If Adobe Acrobat Reader 5.0 is not already installed, please install it before PlotWorks.

The PlotWorks Installation Wizard scans the computer for existing copies of PlotWorks. If PlotWorks 4.2 or an earlier version is detected, the entire PlotWorks directory, including subdirectories, is deleted. PlotWorks is then reinstalled completely. If a newer version is found, the installation application allows you to choose whether to update PlotWorks, preserving all previous settings, or reinstall the application completely.

Click the Back button to return to the previous screen anytime during the installation process.

Installing PlotWorks Server or Demo For the First Time

1. Exit any open Windows applications.

2. Insert the Activation Code disk in the floppy drive. If installing the Demo version, skip this step.

3. Insert the PlotWorks CD-ROM in the CD-ROM drive. The Installation application automatically opens.

4. Click on Install Packages. The Install Packages window opens.

5. Click on PlotWorks Server. The installation wizard opens.

6. Select the language you are most comfortable with from the list provided. The default is English.

To switch to a different language at a later date, use the Language Selector program in the PlotWorks directory.
7. Click on the **OK** button. The installation wizard begins the PlotWorks Setup program and a Welcome page appears.

8. Click **Next**. The PlotWorks license agreement displays.

9. Please read the license agreement and click **Yes** (if you agree with it). The User Information dialog box appears.

10. Enter your name and the company name in the appropriate text boxes.

11. Click **Next** to continue. The Choose Destination Location dialog box appears. By default, PlotWorks is installed in C:\Program Files\PLP\PlotWorks.

12. Click **Next** to accept the default destination or click on the Browse button to select a different destination. Then a Setup Type dialog box appears.

13. Select the radio button for the unit of measurements you prefer.

14. Click **Next**. The ARU Size warning dialog box appears.

15. The default maximum ARU size is 10MB. Click **Next** to accept this size or enter the desired maximum size in the text box and then click Next. A dialog box appears asking if you want to automatically start PlotWorks programs when the computer is restarted.

16. Select the appropriate radio button depending on if you wish to automatically or manually start PlotWorks.

17. Click on the **Next** button. The Task Bar options dialog box opens.

18. Select the appropriate radio button depending on if you want to leave your applications on the task bar when minimized or not.

19. Click on the **Next** button. The Job Queue path dialog box opens.

20. Select a Job Queue path. All jobs sent to the Queue are received in this directory. The default is C:\Queue. Click the **Browse** button to select a different directory or click **Next** to accept the default. The Automatic PlotWorks Pen and Patterns Printing After Install dialog box opens.

21. Select the Yes radio button if you wish to print the pen and patterns chart after completing the installation process. This chart is helpful when choosing what pen or pattern to apply. Select No to skip this step.

   If your activation codes are not on the disk in the A drive, you are prompted to locate the codes. Click on the Browse button and navigate to the directory containing your activation codes and then click on the **OK** button.

22. Select whether you want AutoCAD or DWG Direct to process your AutoCAD files. Select “Use DWG” if you do not have AutoCAD R 14 or later installed.

23. Confirm the location of AutoCAD fonts. The default file path is provided. Click **Next** to accept the default or click on the Browse button to select a different directory and then click **Next**.
24. Confirm the location of AutoCAD support files. The default file path is provided. Click on the Browse button if you need to select a different directory. Then click **Next**.

25. Select a folder for the PlotWorks program icons (usually PlotWorks) and click **Next**.

26. If Adobe Acrobat Reader is not detected, you are prompted to install it. Then click **Next**.

The upgrade begins. A dialog box containing a status bar indicates the installation progress.

Once the file transfer process is complete, if MicroStation is installed, the Important Information dialog box opens. In this case, read the information provided and then click on the Next button.

The Setup complete dialog box appears prompting you to restart the computer.

27. Select **Yes**, I want to restart my computer now radio button.

28. Click on the **Finish** button. The computer will shut down and restart completing installation.

29. If you purchased MicroStation, run MicroStation and configure it to use PlotWorks. See Appendix I of your PlotWorks manual for instructions.

You have now completed the installation.

**Updating from Version 4.3 or above preserving previous settings**

If PlotWorks version 4.3 or higher is already installed, you have the option of updating to the latest version. This preserves all your previous settings. To update:

1. Exit any open Windows applications.
2. Insert the Activation Code disk in the floppy drive. If installing the Demo version, skip this step.
3. Insert the PlotWorks CD-ROM in the CD-ROM drive. The Installation application will automatically open.
4. Click on **Install Packages**. The Install Packages window opens.
5. Click on **PlotWorks Server**. The installation wizard opens.
6. Select the language you are most comfortable with from the list provided. The default is English.

To switch to a different language at a later date, use the Language Selector program in the PlotWorks directory.
7. Click on the **OK** button. The installation wizard begins the PlotWorks Setup program and a Welcome page appears.

8. Click **Next**. The PlotWorks license agreement displays.

9. Please read the license agreement and click **Yes** (if you agree with it). A Question dialog box appears asking if you want to update your existing version of PlotWorks keeping your old settings.

10. Click **YES**.

    If your activation codes are not on the disk in the A drive, you are prompted to locate the codes. Click on the Browse button and navigate to the directory containing your activation codes and then click on the OK button.

    The upgrade begins. A dialog box containing a status bar indicates the upgrade progress.

    Once the file transfer process is complete, if MicroStation is installed, the Important Information dialog box opens advising you of the final steps needed for MicroStation. Read the information provided in this dialog box. Then click on the Next button.

    The Setup Complete dialog box appears prompting you to restart the computer.

11. Select the **Yes, I want to restart my computer now** radio button.

12. Click on the **Finish** button. The computer will shut down and restart completing the upgrade.

**Updating from Version 4.2 or Below**

**or Updating a Higher Version not Saving Previous Settings**

If you want to completely delete an existing version of PlotWorks, or your existing version is 4.2 or lower, follow the steps below:

1. Exit any open Windows applications.

2. Insert the Activation Code disk in the floppy drive. If installing the Demo version, skip this step.

3. Insert the PlotWorks CD-ROM in the CD-ROM drive. The Installation application will automatically open.

4. Click on **Install Packages**. The Install Packages window opens.

5. Click on **PlotWorks Server**. The installation wizard opens.

6. Select the language you are most comfortable with from the list provided. The default is English.

   To switch to a different language at a later date, use the Language Selector program in the PlotWorks directory.
7. Click on the **OK** button. The installation wizard begins the PlotWorks Setup program and a Welcome page appears.

8. Click **Next**. The PlotWorks license agreement displays.

9. Please read the license agreement and click **Yes** (if you agree with it). A Question dialog box appears asking if you want to update your existing version of PlotWorks keeping your old settings.

10. Click **NO**. A dialog box appears confirming your decision.

11. Click on the **Yes** button. The User Information dialog box appears.

12. Enter your name and the company name in the appropriate text boxes.

13. Click **Next** to continue.

14. Click **Next**. The Choose Destination Location dialog box appears. By default, PlotWorks is installed in C:\Program Files\PLP\PlotWorks.

15. Click **Next** to accept the default destination or click on the Browse button to select a different destination. Then a Setup Type dialog box appears.

16. Select the radio button for the unit of measurements you prefer.

17. Click **Next**. The ARU Size warning dialog box appears.

18. The default maximum ARU size is 10MB. Click **Next** to accept this size or enter the desired maximum size in the text box and then click Next. A dialog box appears asking if you want to automatically start PlotWorks programs when the computer is restarted.

19. Select the appropriate radio button depending on if you wish to automatically or manually start PlotWorks.

20. Click on the **Next** button. The Task Bar options dialog box opens.

21. Select the appropriate radio button depending on if you want to leave your applications on the task bar when minimized or not.

22. Click on the **Next** button. The Job Queue path dialog box opens.

23. Select a Job Queue directory. All jobs sent to the Queue are received in this directory. The default is C:\Queue. Click the Browse button to select a different directory or click **Next** to accept the default. The Automatic PlotWorks Pen and Patterns Printing After Install dialog box opens.

24. Select the Yes radio button if you wish to print the pen and patterns chart after completing installation. This chart is helpful when choosing what pen or pattern to apply. Select No to skip this step.

25. Click the **Next** button.

If your activation codes are not on the disk in the A drive, you are prompted to locate the codes. Click on the Browse button and navigate to the directory containing your activation codes and then click on the OK button.
26. You might be prompted to select whether you want AutoCAD or DWG Direct to process your AutoCAD files. Select Use DWG if you do not have AutoCAD R 14 or later installed.

27. Confirm the location of AutoCAD fonts. The default file path is provided. Click Next to accept the default or click on the Browse button to select a different directory and then click Next.

28. Confirm the location of AutoCAD support files. The default file path is provided. Click on the Browse button if you need to select a different directory. Then click Next.

29. Select a folder for the PlotWorks program icons (usually PlotWorks) and click Next.

30. If Adobe Acrobat Reader is not detected, you are prompted to install it. Then click Next.

   The upgrade begins. A dialog box containing a status bar indicates the upgrade progress. Once the file transfer process is complete, if MicroStation is installed, the Important Information dialog box opens advising you of the final steps needed for MicroStation.

31. Read the information provided in this dialog box. Then click on the Next button. The Setup Complete dialog box appears prompting you to restart the computer.

32. Select the Yes, I want to restart my computer now radio button.

33. Click on the Finish button. The computer will shut down and restart completing installation.

34. If you purchased MicroStation support, run MicroStation and configure it to use PlotWorks. See Appendix I of your PlotWorks manual for instructions. You have now completed the installation.
Opening PlotWorks Applications

1. Make sure all the printer media drawers contain media. For information on loading media into the printer, refer to the printer User Guide.

2. Turn on the scanner, printer, and the computer (in this order). Always turn on the computer last.

If you chose to “Automatically start PlotWorks” during installation, you will not need to perform all of the remaining steps as the applications are already open. Click on their icons in the system tray to maximize.

3. Once Windows is open, click the Windows Start button.

4. Select Programs then PlotWorks then the Job Queue. The Job Queue opens.

When a PlotWorks application is first opened a splash screen displays. This screen disappears automatically in a few seconds. You can click on it to make it go away faster.

5. Open the Job Processor similarly by selecting Start/Programs/PlotWorks/Job Processor.

6. Open the Printer Interface by selecting Start/Programs/PlotWorks/Printer Interface.

7. Open the Job Editor: Select Start/Programs/PlotWorks/Job Editor.

8. Open the Scanner Interface: Select Start/Programs/PlotWorks/Scanner Interface. If applicable.

Do not open a second instance of a PlotWorks application.

If you have logged on to the computer running the PlotWorks Server using a User ID and/or password and then it is necessary to log on using a different User ID and/or password, you must first close all PlotWorks applications before logging on again. Otherwise PlotWorks will encounter problems.
Configure Your PlotWorks Applications

This section takes you through the basic steps required to configure PlotWorks. You will not have to repeat this section unless you add more printers or scanners, or reinstall the software.

Configure the Job Queue

The Job Queue is the heart of the PlotWorks system. All incoming jobs pass through the Queue. The Printer prints jobs from the Queue in order of priority. The Job Queue lets you place jobs on hold, change a job’s print priority, reprint and delete jobs.

1. Open the Job Queue. The Job Queue window displays. If a Queue directory does not exist, you are prompted to create one. The default Job Queue directory is C:\Queue.

2. If the Job Queue you desire is not displayed in the title bar of the Job Queue window, select **Open Queue** from the **File** menu or click on the **Open** button.

3. Select the appropriate queue directory and click **OK**. The Job Queue directory is ready.

Configure and Start the Job Processor

The Job Processor preprocesses print jobs in the Job Queue. It is also used by Network Polling, FTP, or other submission methods where the Job Editor is not used.

1. Open the Job Processor. The Job Processor window opens.
2. If the Job Queue you created earlier does not appear in the **Process jobs in queue** field, click on the **Queue** button. Select the queue directory listed on the title bar of the Job Queue window and click **OK**. If it is listed, ignore this step.

3. Select the **Start** button to start monitoring the Job Queue.

4. Minimize the Job Processor, ensuring that it stays running to process jobs in the Job Queue.

**Configure the Printer Interface**

1. Open the Printer Interface. The Printer Interface window opens.
2. From the **Setup** menu, select **User Interface Units**. Select either the **Inches** or **Millimeters** radio button depending on your preference.

3. Click on the **OK** button

4. If you selected the “Windows” or “Generic Embedded Controller” Printer Interface, select **Device Specific Options** from the **Setup** menu (or press **Ctrl+D**) and select the appropriate Windows printer driver from the **Printer name**: list near the bottom of the dialog box (see figure 2.4).
Add media to the media inventory

Configure the Printer Interface for media:

1. Click on the Inventory button. The Media Inventory dialog box displays.
2. Click Add.
3. The Add/Edit Media Inventory dialog box appears.
4. Select **Yes, always**.

5. Enter the **Actual Width**. You do not need to set the Actual Length for roll-fed media.

6. Enter the **Actual Type**: Bond, Blue Bond, Film, etc.

7. Use the **Width Detected** drop-down box to select a value for the detected width. This is usually the closest standard width. Refer to your printer manual for details.

8. Use the drop-down list in the **Type Detected** box to select either: Bond, Vellum, or Film. Select the type that most closely matches the actual media type. See your printer manual for details.

9. Select either the Roll Feed, Sheet Feed, or Manual Feed radio button depending on how the media type is loaded.

10. Click **OK**.

The printer diagram changes to show the type and amount of media detected in the media “drawer.”

See “” on page 8-19 for more information.
Setup the Job Editor

The Job Editor is used to create and send electronic print order forms called “job tickets.” Job tickets list all the images in a job and their associated printing parameters.

Configure the Job Editor Destinations

1. Open the Job Editor
2. Click on the Setup menu
3. Click on Configure Destinations. The Configure Destinations dialog box opens.
4. Click on the Job Queue listed. (If the Job Queue is not listed then Click on the Add button and Add the Job Queue)
5. Click on Edit.
6. Confirm the Queue name and path is correctly listed in the destination path text box.
7. Click on OK
Set Default Print Parameters

Default print parameters are assigned to the prototype line. This is the first row of the job grid. When images are added to the job ticket, they are assigned the prototype print parameters by default. You can change these parameters for any row, including the prototype row at any time.

1. Open the Job Editor.
2. Click the Properties button to display the Detail property sheet. The fields here correspond to the fields on the grid. Changes made here are automatically applied to the grid.
3. Click through each tab of the Detailed Property Sheet selecting your most commonly used print parameters.
4. Select Save Configuration from the File menu. This saves job-wide settings to the configuration file (conf.plp) as well as to the prototype line and will be applied to all new job tickets.

Add Files to a Job Ticket

The Add Files button is used to add image files to your print job. Once added, the file names appear on the job grid. The prototype print parameters are applied to all images added to the job ticket by default.

---

Long filenames are supported when the job output destination supports long filenames. Long filenames are not supported, and are then truncated, when outputting to a removable disk, DOS applications, or older Novell networks or servers.

---

To add images to a job ticket:

1. Click Add Files. The Add Files dialog box opens.
2. Navigate to the directory containing your image files and select the file(s) you want to print.
3. Click OK. If a file format is not recognized, an error message displays. You can then choose to skip the file or add it. The file will be added with a format value of User Specified.
   You can then change the print parameters if desired. For more information, see “Changing Print Parameters” on page 4-15.

---

PlotWorks supports the “drag-and-drop” method of adding files. Simply drag the image files from Windows Explorer and drop them onto the Job Editor grid.
Saving Job Tickets

Save completed job tickets in case you need to reprint the job in the future. Saving the Job Ticket does not save the image files. If the original image files are deleted, it might not be possible to reprint the job.

To save a job ticket:

1. Click **Save Job**.
   
   If the file was not previously saved, enter a filename in the **File Name** field. Long filenames are acceptable.

2. In the **Save In** field, select a directory in which to save the file.

3. Click **Save**.

Sending Jobs for Print

A print “job” can consist of one copy (set) of one file, multiple copies of one file, one copy of multiple files, or multiple copies of multiple files.

Output the Job

The **Output Job** button is used to send your job ticket, image files, and information file (if any) to the Job Queue for processing and printing.

To output a job:

1. Click the **Output Job** button (or select **Output Job** from the **File** menu). The Output Job dialog box displays.
2. Select your output options in this dialog box. Options include:

   - **Send To:** This drop-down list is used to select an output destination. Options include destinations configured using the Configure Destinations dialog box as well as available disk drives. The default destination is “Default Queue”.

   - **# of Sets:** Enter the number of sets (copies) to print.

   - **Selected Files Only:** Select this check box to print only files selected in the grid. If there is only one file in the job grid, or the Proto row is selected, this option is unavailable.

   - **Reverse standard print order:** Select this box to reverse the order the images are printed.

   - **Folding Options:** Click this button to access the Folding Options dialog box to select folding options. This dialog box offers the same options as the Finishing Options tab window under Setup/Preferences.

   - **Job Priority:** Enter a number between 1 and 10, with 10 being the highest priority. This value determines which jobs are printed first.

   - **Device #:** Select the printer’s device number – Any (default), 1, 2, 3, or 4. This number is defined in the Printer Interface program, in the Printing Configuration dialog box under the Setup menu. If you select Any, jobs are printed on the first available printer.

3. Click **OK** to send your job.

   The job name displays in the Job Queue and the Printer Interface displays the job’s print progress. For more information refer to, “Output Jobs” on page 4-123.
System Tray Icons

When the Job Queue, Job Processor, Network Polling, Printer Interface, and Post Processor applications are open, the System Tray (lower right corner) displays an icon for each application. Right clicking on each icon displays a menu. Double clicking on the icon maximizes the application.

When a program is running, that program’s icon appears in the system tray. Program icons are visible on the task bar only if you chose to have the applications run minimized on the task bar during installation.

Icons are identified and defined as follows.

<table>
<thead>
<tr>
<th>Icon and Application</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Job Queue</td>
<td>Right-click options include minimize, restore, disable task bar button, and exit the application. Dragging the cursor over the icon displays the current queue path and application name.</td>
</tr>
<tr>
<td>Job Processor</td>
<td>Right-click options include start and stop processing, minimize, restore, disable task bar button, and exit the application.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Red</strong>: Job Processor is stopped.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Green</strong>: Job Processor is started and idle.</td>
</tr>
<tr>
<td></td>
<td>• <strong>Yellow</strong>: Jobs are being processed. Dragging the cursor over the icon, displays the current queue path and application name.</td>
</tr>
<tr>
<td>Network Polling</td>
<td>Right-click options include start and stop polling, minimize, restore, disable task bar button, and exit the application. Red arrows on the icon indicate polling has stopped; green arrows indicate polling. Dragging the cursor over the icon displays the application name.</td>
</tr>
</tbody>
</table>
### Printer Interface

<table>
<thead>
<tr>
<th>Icon Color</th>
<th>Status Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Red</strong></td>
<td>The printer is either stopped or paused.</td>
</tr>
<tr>
<td><strong>Green</strong></td>
<td>The printer is ready to print.</td>
</tr>
<tr>
<td><strong>Yellow</strong></td>
<td>The printer is printing. This icon is animated and displaying paper ejecting.</td>
</tr>
</tbody>
</table>

Right-clicking on the icon displays a menu. Menu choices include: Restore, Minimize, Disable task bar button, Automatic, paused and Stopped. Moving the cursor over the icon displays the current queue path and application name. In the event of an error, the printer interface icon alternately blinks and displays a warning. Moving the cursor over the icon then displays an error message.

### Post Processor

Right-clicking on the icon displays a menu. Choices include: Restore, Minimize, Start, Stop, and Exit. The color of the Post Processing icon denotes its status:

<table>
<thead>
<tr>
<th>Icon Color</th>
<th>Status Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Red</strong></td>
<td>This denotes that Post Processing has stopped due to completion or error.</td>
</tr>
<tr>
<td><strong>Green</strong></td>
<td>This indicates that the Post Processor is trying to contact an external application or is waiting to begin.</td>
</tr>
<tr>
<td><strong>Yellow</strong></td>
<td>Indicates that the Post Processor is using an external application. This icon is animated.</td>
</tr>
</tbody>
</table>

Moving the cursor over the icon displays the current queue path and application name.

---

Unless you chose to have the applications run minimized on the task bar during installation, the task bar will not display active, minimized applications.
**Demo Mode**

PlotWorks can be installed in Demo Mode for demonstration purposes.

**Network Polling**

If the user does not have a code (or key) for either PLP or PFS polling modes, Network Polling runs in “Demo Mode”. In Demo Mode, a “Demo System” watermark displays on each image in the job. In the Add Directory dialog box, the Polling Mode name changes to “Demo System”.

---

**NOTE:** Mode 2 and Mode 4 are linked. They both enter or exit demo mode together.

---

If the user has a key and expired activation codes for polling, Mode options are greyed out in the Add Directory dialog box.

**Job Editor**

If a job ticket is created by Network Polling in demo mode, each image file and the prototype will contain a “Demo System” watermark. This watermark cannot be removed.

---

**WARNING:** When in demo mode, the Output size (Output Setup tab) is restricted to size A or A4, depending on the Measurement Units selected.

---

**Printer Interfaces**

Only the Windows Printer Interface can print in “demo mode” and only size A or A-4 is outputted. All other printer interfaces will ‘Print to Display’ only.

---

Following chapters discuss each PlotWorks application in depth.
Chapter 3

The Job Queue

The Job Queue is the heart of the PlotWorks system. The Job Queue manages all incoming print jobs and then sends the job to a printer.

Within the Job Queue, the user can:

- View and edit parameters for each job
- View special instructions by clicking on the Special Instructions icon
- Determine the status of a job in the Queue based on the color of the text
- Sort jobs in the Queue in Ascending or Descending order by clicking on a column header
- Send jobs to a printer manually or automatically
- Set the order and priority of printing
- View job logs
- Retain the original job number in the description field when dragging-and-dropping jobs from one queue into another
- Drag-and-drop jobs into Windows Explorer for archiving
- Choose a selected WAV file to play when a job enters the queue instead of the default beeping sound
- Delete jobs
The Job Queue Window

The Job Queue window displays a list of jobs in the Queue Directory. It also displays information such as the sender, status, activity, and destination of each job.

Toolbar Buttons

The following buttons appear on the Job Queue tool bar:

- **Open Queue**: Opens an existing Job Queue directory to displaying its contents.
- **Import from Job Editor**: Imports a PlotWorks Job file (.PWJ) created using the Client or Job Editor.
- **Delete a job**: Deletes the selected job from the Job Queue. Deleted jobs are sent to the Windows Recycle Bin, where they can be recovered if needed (unless the Recycle Bin is emptied).

**Ctrl+ Delete bypasses the Windows Recycle Bin deleting files from the system’s hard drive.**

- **Hold**: Puts the selected job on hold. If the job is printing, it is held after the current page leaves the printer.
- **Reprint**: Reprints the job, starting from a user-specified image and set, with a specified priority.
- **Print Next**: Assigns the selected job a priority of Print Next. The job prints as soon as the current job (if any) finishes.
• **Print Immediate**: Sends the selected job to the printer immediately. If another job is printing, it is interrupted and will resume printing after the Immediate job.

• **Job Information**: Displays the job information (.INF) file, if submitted with the selected job.

### File Menu

The File menu contains options for the Queue directory.

![Job Queue File menu](image)

The following options are available under the File menu:

• **New Queue Directory**: Creates a new Queue directory and QUEUE.QUE file.

• **Open Queue**: Opens an existing Job Queue directory and displays its contents.

• **Rebuild Queue**: This option is used only if the Job Queue becomes corrupted and you need to rebuild it.

• **Import Job**: Imports a PlotWorks Job file (.PWJ) created using the Client or Job Editor.

• **Import DOS Job**: Imports individual compressed job files created using the DOS-based Remote Module.

• **1, 2, 3, etc.**: Opens the listed Job Queue.

• **Exit**: Quits the application.

### View Menu

The View menu contains options related to the appearance of the Job Queue window.
Column Options: Is used to select which columns appear in the Job Queue window.

Status Bar: Is used to hide or show the status bar.

Toolbar: Is used to hide or show the tool bar.

Setup Menu

The Setup menu contains options to configure the selected Job Queue.

Options: Is used to set:
- How often the Queue gets polled for new jobs
- Whether or not to sound a beep or play a WAV file when new jobs enter the Queue
- Which devices are online and should be monitored (polled)

Colors: Is used to select colors for the Job Queue window background, and to select colors to indicate print job statuses.

To see all the color choices in the Color dialog box, change the color settings for your computer. Open the Windows Start menu, select Settings, then select Control Panel. In the Control Panel window, click Display, then the Settings tab window. Go to the Color Palette group box and select True Color (24 bit) from the drop-down list. Click OK.

Job Menu

The Job menu contains options related to a selected job. These options are also accessed by right clicking on a job in the Job Queue.

The following options are available under the Job menu:

Delete: Deletes the selected job from the Job Queue.

Priority: Sets a printing priority for the selected job

Reprint: Reprints the selected job, starting from a specified image and set
**Set Job Position:** Is used to specify a set, page, and copy to print of a selected job. (This function is disabled.)

**Change Destination:** This function only changes the text that appears under the Destination/Source File column heading.

**Edit Description and Comment:** This option is used to edit the text in the Description and Comment column for the selected job.

**Ignore Warnings:** This option is used to print the job regardless of warnings or errors detected during processing.

**View:** This option is used to view job information, processing, printing, capabilities/media logs, the job order, and the submitted PFS file for a selected job.

**Abort Job:** Halts the selected job immediately. If a job is printing, it is interrupted immediately.

**Output to File:** This option is used to convert and save a file or job as a TIFF or PDF file. It can also be used to create multi-page TIFF or PDF files and change other file properties. For more information refer to Page 3-21 under "Output to File".

**Reset Job:** Resets the Activity field for a selected job. This option is used when a system error occurs that causes the Activity field to display incorrect information.

**Help Menu**

The Help menu contains information about the Job Queue.
The following options are available under the Help menu:

- **Online Manual**: Opens the online manual at the Job Queue chapter
- **Index**: Displays an index of help topics
- **Table of Contents**: Displays the help table of contents.
- **Release Notes**: Displays the latest PlotWorks release notes
- **About Job Queue**: Displays the software name and version and copyright information

### Columns and Icons

The 12 columns of the Job Queue display information about the jobs in the Queue.

- **Job #**: A unique number assigned to each job.
- **Priority**: The job print priority. Jobs are printed in the following order:
  1. **Print Immediate**: This priority is assigned to jobs that must be printed immediately. If another job is printing, it is interrupted to print the job with the Immediate priority. Only one job at a time can be selected for Print Immediate.
  2. **Interrupted jobs**: This priority is assigned to a job that was interrupted during printing by a job that needed to be printed immediately. The interrupted job will resume printing where it left off as soon as the rush job finishes.
  3. **Print Next**: A job with this priority prints as soon as the currently printing job finishes. Only one job at a time can be selected for Print Next.
  4. **Copy**: When the Scanner Interface is set to Scan to Print, scanned images are assigned the Copy priority.
  5. **10-1**: Numbered jobs are printed starting with the highest number. Jobs with a priority of 10 are printed first, jobs with a priority of 1 are printed last.
  6. **Hold**: Jobs on hold are not printed. To print a job on hold, change its print priority.
7. **Hold After Next Set:** Hold the job after printing the current set.

- **Activity:** Displays icons that indicate the job’s current status. The following icons are used:
  - ![Copies](#) The job is being copied to or deleted from the Job Queue.
  - ![Edit](#) The job is being edited.
  - ![Processing](#) The job is processing.
  - ![Printing](#) The job is printing.

- **Status:** Displays icons indicating the last process completed. The following icons are used:
  - ![Success](#) The job was processed successfully.
  - ![Printed](#) The job was printed successfully.
  - ![Partially Printed](#) The job is partially printed.
  - ![Interrupted](#) The job was interrupted during printing.

- **Problems:** Displays icons to indicate job warnings and errors. The following icons may display:
  - ![Errors](#) This red icon indicates that the Job Processor encountered processing errors. The job cannot be printed until the errors are resolved or the Job Processor is set to ignore them.
  - ![Ignored Errors](#) This blue icon indicates that the Job Processor encountered errors during processing which were ignored.
  - ![Hardware Error](#) This icon indicates that a hardware error occurred. These errors often occur when a folder, media, or a requested fold is not available.

- **Description/Company/Project:** This column displays the project and company name, as entered in the Project and Company fields of the PlotWorks or PFS file.

- **Job size:** This column displays the number of sets and images in the job. During printing, this field displays the number of sets and images that have been printed.

- **Submitted by:** This column displays the job submitters computer, user, and contact names when the job is sent via Network Polling or the Client. The computer and user name is displayed if the job was sent via the Job Editor. If long or multiple E-mail addresses are specified in the PFS file, only the E-mail addresses are displayed. Data displayed in this field is limited to 64 characters.
• **Device:** This column displays the device number of the printer assigned to print the job. This number is specified in the Job Editor or by Network Polling. If “Any” is selected, the job is printed on the first available device.

• **Destination/Source File:** This column lists destination information if entered in Network Polling. To change the information displayed in this field, select Change Destination in the Job menu. This option is rarely used.

---

> PlotWorks returns a “Job Printed” notification to the Client or Job Editor when a job completes printing. If a destination is configured in the Job Queue, the notification displays that information, otherwise, the destination is blank.

---

• **Time submitted:** This column displays the time the job was submitted to the Queue.

• **Comment:** Customer comments, taken from the Comment field of the PlotWorks or PFS file.

**To add or remove columns from the Job Queue window:**

1. Click on the View menu
2. Select **Column Options.** The Column Options dialog box opens.

![Column Options dialog box](image)

3. Select check boxes for the columns you want. Deselect check boxes for the columns you do not want.
4. Click **OK.**
To change a column width:

1. Place your cursor on the right-hand edge, next to the column heading, of the column you want to resize. The cursor will change to a vertical bar crossed by a double-arrow.
2. Press the left button on your mouse and drag the cursor until the column is the desired width.

You can autosize a column width by double-clicking on the right side of the column header. This makes the column the width of the column text. This may truncate the column heading.

A column can be removed from the Job Queue by reducing its size until it disappears. Restore the column from within the Column Options box described above.

To sort jobs in the Queue:

All columns can be sorted except for Job Size. Jobs are sorted in Ascending order (1, 2, 3...) by default. To sort files in Descending order (10, 9, 8...), click the desired column heading. Toggle between Ascending and Descending order by clicking the column heading.

When the Job Queue is closed, the current sort parameters are saved.

If you want to save a specific sort parameter, and you have more than one Job Queue open, close all other Queues first. Then close the Job Queue containing the sort parameters you want saved.

Job Queue Structure

During PlotWorks installation, a Queue directory was created. When a job is submitted to the Queue, the software creates a numbered subdirectory within the Queue directory. The job ticket, image files, and information files are copied to this subdirectory.

The Queue directory contains a database file called QUEUE.QUE. This file contains a record of every job submitted to the Queue directory. The Job Queue window displays information from the QUEUE.QUE file. When jobs are added, edited, or deleted from the Queue, this information is updated in the QUEUE.QUE file.
Setting up the Job Queue

**Open an Existing Job Queue**

If using more than one Job Queue, you can open a different Queue from within the Job Queue program.

1. Click **Open Queue**. The Select Queue Directory to open dialog box appears.

2. Select the appropriate Queue Directory.

3. Click **OK**.

*When a new job enters an open minimized Job Queue, the icon on the Windows task bar becomes highlighted (usually blue).*

**Create a New Job Queue**

When you installed PlotWorks, you were prompted to create a Queue directory. All PlotWorks components center around this Queue. You can use multiple Job Queues. You create a new Queue from an existing Job Queue window.

If the QUEUE.QUE file (the queue database) does not exist or cannot be found, you are prompted to create it when the Job Queue is opened for the first time.

**To create a new Queue:**

1. Click on the **File** menu.

2. Select **New Queue Directory**. The Enter The Queue Directory To Create dialog box opens.
3. Select the directory you want to use for your Queue directory. Or, enter the path for a directory you want to create.

4. Click **Create**.

The title bar of the Job Queue window displays the name of the new Queue directory.

*If using multiple Job Queues, connect Network Polling (if used), Job Processor (if needed), and Printer Interface(s) to the appropriate Queue directories.*

**Set Queue Options**

The Options dialog box is used to set Job Queue polling and printing configurations.

**To set Queue options:**

1. Click on the **Setup** menu.
2. Select **Options**. The Options dialog box opens.
3. Fill in the fields in the Options dialog box as follows:

- **Poll queue every**: Enter how often the Queue should search the Job Directory for incoming jobs in this field.

- **Beep on new queue entries**: Select this check box to sound an alert when new jobs arrive in the Queue. The default sound is a beep. To select a different sound, open the Windows Control Panel, select Sounds and Audio Devices, click on the Sound tab, navigate to PlotWorks from the Program Events select box, and click on JobReceived. Then select a sound from the Sounds drop down list.

  Seven WAV files were installed with PlotWorks. These are named: chirp.wav, incomingjobx-cyborg.wav, incomingjobx-voice.wav, jobrecieved-cyborg.wav, jobrecieved-voice.wav, steamwhistle.wav, and sweep.wav.

- **Devices Online**: The Job Queue uses this setting to determine which devices are online. Select check boxes for devices connected to this Queue. The device numbers correspond to the number specified as Device Number, in the Printer Interface General Configuration dialog box, under Setup.

  If the Job Queue cannot determine which devices are online, or if a device is specified as online but is not connected, then jobs can remain indefinitely in the Job Queue without printing or showing an error.

4. Click **OK**.
Select Queue Colors

The Color dialog box is used to choose a background color for the Job Queue window, and to select job status colors.

To select Colors:

1. Click on the Setup menu
2. Select Colors. The Colors dialog box opens.

3. Click on the Background button. The Color dialog box opens.
4. Click on a color to select it. You can select from Basic Colors or Custom Colors. To select a custom color click on the Define Custom Colors button.

5. Click on the **OK** button.

6. Select colors for Normal Status, Hold Status and Done similarly by clicking on their appropriate buttons. PLP suggests that you select the following colors for these values:
   - **Normal Status**: Green
   - **Hold Status**: Yellow
   - **Done**: Red

7. After selecting the desired colors, click **OK**.
Working with Jobs in the Queue

Importing Jobs

Jobs created on the Client or Remote Module that are saved on a floppy disk, or CD can be imported into the Job Queue. These jobs have a .PWJ extension and are called parameter files.

ZIP and CD-RW drives cannot be installed on the same computer as the PlotWorks Server. Therefore if your .PWJ job exists on a CD-RW or ZIP disk you can add it to the Job Queue via another computer, containing a ZIP or CD-RW drive, on your network.

To import a job (from a directory, CD, or floppy disk):

1. If applicable, insert the CD or floppy disk containing the job into the appropriate drive.
2. Click Import Job. The Select Parameter File to Import dialog box displays.
3. Select the desired parameter file (it has a .PWJ extension) and click Open.
4. Click Done when the import finishes, unless you want to import additional files.

Importing a DOS Job from a Floppy Disk

To import a job created on a Remote DOS Module:

1. From the File menu, select Import DOS Job. The Import DOS Job From Floppy Disk dialog box opens.
2. Select the radio button for your disk drive.
3. Select the check box labeled Hold Job to place if you wish to place the job on Hold.
4. Click **OK**. If the job spans more than one disk, you are prompted for the next disk. Insert the next disk and click **Next** to continue.

5. Click **Done**.

---

When moving a job from one Queue to another, the job moved retains the job number in the Description/Company/Project field, assigned in the first Job Queue window. If a job in the second Queue has the same file number, the new job would overwrite the existing job.

---

See also: “The Job Grid Columns” on page 4-12, “Changing Print Parameters” on page 4-15, and “Viewing Image Files” on page 4-111.

---

**Prioritize Jobs (Automatic Printing)**

Every job that enters the Queue is assigned a priority. This priority determines the order in which jobs are printed.

**To set a job priority:**

1. Right click on the job you wish to set a priority for. You can also open the Priority menu from the Job menu.

2. Select **Priority** from the right click menu. The Priority menu displays.

3. Select a priority. Jobs are printed in the following order:
   - **Print Immediate:**
   - **Interrupted jobs:**
• Print Next:
• Copy:
• 10-1:
• Hold:
• Hold After Next Set:

See page 3-6 for a detailed description of each Priority menu choice.

**Put Jobs on Hold**

You can put any job in the Queue on hold to prevent it from printing automatically. Three hold options are available:

**To abort a job that is printing:**
1. Right-click on the job.
2. Select *Abort Job*. The job is put on pending hold. A white pending hold icon appears in the Priority column and the job stops printing. Any partially printed media is ejected. The icon then turns yellow.

**To put a job on hold:**
1. Select the job you want to hold.
2. Click *Hold*.

The job is put on hold. A yellow hold icon appears in the Priority column. If the job is already printing, it is put on hold after the current sheet has left the printer.

**To hold after the current set has printed:**
1. Right click on the job.
2. Select *Priority* from the right click menu.
3. Select *Hold After Next Set*. The job is put on hold as after the current set leaves the printer. The hold icon appears in the Priority column.

**To print a job on hold:**
1. Right click on the job.
2. Select *Priority* from the right click menu.
3. Choose a priority for the job. The job will resume printing where it left off.

The Job Editor and Network Polling can be set to submit jobs on hold. These jobs appear in the Queue with a Hold icon and will not print until their priorities are changed. This feature is useful for printing some jobs manually while the rest are printed automatically.
Process Jobs

The Job Processor needs to be set up to automatically process jobs for printing.

**To set up the Job Processor:**
1. Open the Job Processor.
2. Click on the File menu.
3. Select Connect to Queue (or press Ctrl + O).
4. Select the Queue directory from which to process jobs and click OK.
5. Open the File menu and select Start Processing to begin automatic processing.
6. Click the minimize button in the top right corner of the Job Processor window. The Job Processor is still minimized and running.

*If you exit the Job Processor program, the software cannot process and print jobs that enter the Queue.*

Printing Jobs Manually

PlotWorks can be configured for manual printing. When the Printer Interface is in Manual mode, only jobs with a priority of Print Next or Print Immediate are printed. (See page 8-3 for more information on manual printing.)

**To print a job in the Queue manually:**
1. In the Queue, select the job you want to print.
2. Click Print Next.

**Interrupting a Job to Print Another Immediately**

You can interrupt large print jobs to print a rush job or make a copy and then continue printing the original job.

1. Select the job you want to print immediately.
2. Click the Print Immediate or NOW! button. A dialog box opens.
3. Click OK to interrupt the job currently printing. This causes:
   - The sheet currently in the printer finishes printing
   - The original job is put in “Interrupt” mode.
   - The “Print Immediate” job begins printing.
   - The Printer Interface printer diagram displays red lines to indicate that the job being printed interrupted another job.
• The Print Status window, displays both jobs including their current job status
• When the urgent job finishes printing, the interrupted job resumes printing.

Reprint a Job
You can reprint a job that was printed previously. You can start the reprint from any set or sheet in the job.

To reprint a job:
1. Select the job to reprint.
2. Click Reprint.
3. Fill in the fields in the Reprint Job dialog box as follows:
   • Select where to begin printing: Select this box to start printing from a specific file or set in the job and then specify where to start using the following options.
     • Set: Enter the number of the set from which to start printing.
     • Image: Enter the number of the image from which to start printing.
     • Copy: Enter the number of the copy from which to start printing.
     • Page: Enter the number of the page from which to start printing.
   • Number of sets: Enter the total number of complete sets to print.
   • Job Priority: Enter the printing priority of the job.
   • Device: Select the number of the printer to use for the job.
   • Reverse standard print order: Select this option to reverse the print order.
   • Use set memory: (OCE 9800, Xerox MAX 200 and the 8180 only) Set memory allows the job request to be sent to the set memory of a printer instead of sending each set over again.
4. Click OK. The job is printed according to the priority defined in step 3.

Delete a Job from the Queue
The Delete command removes a job from the Queue and sends it to the Windows Recycle Bin. You cannot delete a job while it is being processed, printed, or edited. To stop a job once it has begun printing, use the Hold, Hold After Next Set, or Abort Job options. See “Select a priority. Jobs are printed in the following order:” on page 3-16.
To delete a job:

1. Select the job to delete.
2. Click **Delete**.
3. Click **Yes** to confirm the deletion. The job directory and all of its contents are deleted from the Queue directory.

When you delete jobs from the Queue, they are sent to the Windows Recycle bin where they can be permanently deleted or restored to the Job Queue (using the drag-and-drop method). If you want the files removed permanently, hold down the **Shift** key and press **Delete**.

Saving Jobs from the Queue to a different location

You can save jobs from the Queue onto your hard drive, a removable disk drive, or a network location. To save a job to a different location, drag and drop the job from the Queue to the desired location in Windows Explorer. The Job Queue saves the image files, parameter file, and any information files in the selected location.
Output to File

The Output to File option is used to save a file as a TIFF or PDF file. It can also be used to create multi-page TIFF or PDF files and change other file properties.

To save a file as a PDF it is necessary to have purchased and installed the PDF Option

All pen settings, macros, sizes and other print parameters assigned to each file in the job is saved in the converted file.

To Output to File follow the instructions below:

1. Ensure the job you wish to Output to File is listed in the Job Queue window.
2. Right click on the job. The right click menu displays. (The Output to File option is also available from the Job menu.)
3. Click on Output to File. The Job Editor will open listing all the files in the job. The Output to File dialog box will also open.
4. Select options from this dialog box. More detailed information is available on Page 4-94 under "Output to File".
5. Click on the OK button

If the ARU file support option is enabled, ARU logs are created for the Output to File function. Information collected by the Output to File function is stored in the ARUPublisher.log file.
Logs and Reports

Processing Log
The Processing Log displays processing information about the selected job, including any warnings or error messages received during processing.

To view the Processing Log:
1. Right click on the job.
2. Select View.
4. Close the log file by selecting Exit from the File menu in Notepad when you are done.

Printing and Print to File Logs
The Printing Log displays printing information about the selected job. Information on printed jobs is written to a log file called ARU<printer>.LOG. Where <printer> is replaced with the name of your printer. This log includes all fields defined in the ARU log definition in comma-delimited format (see “Producing a Job Report” on page 10-1).

The Print to File log contains the same information as the printing log except for media type and "OUTPUT_DEVICE" information as these don’t apply here. The "FINAL_XSIZE" and "FINAL_YSIZE" fields reflect the size set in the "Output Setup" field not the final printed paper size. Information collected by the Output to File function is stored in the ARUPublisher.log file.

To view the Printing Log:
1. Right click on the job.
2. Select View.
4. Close the log file by selecting Exit from the File menu in Notepad when you are done.

Media/Capabilities Log
The Media/Capabilities Log displays media errors (such as “Media Out,” “Invalid Size,” etc.) that might have occurred while printing.

If Devices Online selections are not made in the Setup Options menu, Media/Capabilities warning messages do not display in the Problems column of the Job Queue.
To view the Media Log:
1. Right click on the job.
2. Select View.
4. Close the log file by selecting Exit from the File menu in Notepad when you are done.

Job Information
If the print job was submitted with a job information (.INF) file, you can view this file from the Job Queue in the Job Information log.

To view the job information (.INF) file:
1. Right click on the job.
2. Select View.
4. Close the log file by selecting Exit from the File menu in Notepad when you are done. See also: “Send a Special Instruction File” on page 4-120.

Job Order
If the print job was submitted with a job order file, you can view this file from the Job Queue.
1. Right click on the job.
2. Select View.
4. Close the log file by selecting Exit from the File menu in Notepad when you are done.
Troubleshooting

Rebuild the Queue

If the Queue database becomes corrupt, you can repair and recreate it.

Some information might be lost if the data is corrupt.

To rebuild the Queue:

1. Close all other PlotWorks programs except the Job Queue.
2. Open the File menu
3. Select Rebuild Queue.
4. A warning box confirms that you want to rebuild the Queue. Click Yes to continue.
5. If the rebuild function detects any problems with a job(s) in the queue, a dialog box displays to alert you.

6. Select one of the following options:
   - To delete the indicated job or file, click Delete.
   - To delete all jobs with problems, click Delete All.
   - To skip the displayed job and leave it in the Queue, click Skip.
   - To skip the all jobs with problems and leave them in the Queue, click Skip All.
   - To change your mind about rebuilding the Queue, click Abort.

When you rebuild the Job Queue, the original Queue database (QUEUE.QUE) is renamed and saved as BACKUP.QUE. The software then creates a new Queue database by combining the information in BACKUP.QUE with the actual job data contained in the Queue directory.
If the software finds a job in the Queue directory that is not listed in the BACKUP.QUE, it adds the job to the new Queue database. Some job information, such as the priority, device number, destination, status, problems, and administrative information will be lost.

Reset the Activity Field for a Job

The Reset Job feature is useful when system errors cause the Activity field to display incorrect information. For example, if you experience a power failure while a job is processing, the Activity field will show the processing icon although the job is no longer being processed.

To reset jobs:
1. Right click on the job.
2. Select Reset Job.
3. Click OK to confirm your selection. The Activity field returns to an idle (blank) setting.
Chapter 4

The Job Editor

The Job Editor’s main function is to collect files for printing, set printing parameters, create the print job ticket and send the file for printing. The Job Editor can also:

- Create print jobs containing multiple format image files
- Sort files
- Choose which page to print from a multipage document
- Create and save pen sets
- Reduce and enlarge images
- Add watermarks, labels and overlays
- Add margins and justify the image on the medium
- Nest jobs
- Send jobs over a network, modem or disk
- Print digitally collated sets
- View images before printing
- Process files to check for errors before submitting
- Apply finishing options like folds, binding, hole punching etc.
- Add images to a job directly from a Twain device.
- Poll a Network or FTP directory
- Compare two documents and report changes or differences
- Convert files into TIFF or PDF file formats
The Job Editor is used to add images to a job file, also referred to as a job ticket. You can then edit print parameters for each job individually. You can also apply commonly used print parameters to the Prototype job. Print Parameters applied to the Prototype job, are applied by default to each image added to a job. Print parameters for images, or the prototype, can be changed, as desired.
Creating a simple job ticket

To start a new job ticket:

1. Open the Job Editor.
2. Click on the New Job button, or select New from the File menu.

Now add image files to the job. These can be in any supported format. Multiple supported file formats can be added to the same job. Image files are printed in the order they are listed in the job ticket.

To add images to a job ticket:

1. Click Add Files.
2. The Look In field displays the directory in which you last saved files.
3. Select the file(s) you want to add. Select multiple files using the Shift or Ctrl keys.

PlotWorks supports the Windows “drag-and-drop” method of adding files. Simply drag the image files from the Window Explorer window and drop them onto the Job Editor grid.

4. Click Open. The Job Editor automatically detects the image file formats and adds the images to the job grid. If the Job Editor does not recognize a file format, the Unrecognized File Format dialog box appears. You can then choose to skip the file(s) or add them with the format value User Specified.

Fig 4.2 The Unrecognized File Format dialog box.
To Skip a File Listed in the Unrecognized Format Dialog Box:
1. Click on the file in the select box.
2. Click on the **Skip** button

To Add a File as listed in the Unrecognized Format Dialog Box
1. Click on the file in the select box. The Add button becomes available.
2. Click on the **Add** button. The file is added to the job ticket as User Specified.

5. Once image files are added to a new job ticket, you can set printing parameters. When done, click on the Output button to send the job for printing.

**Adding DWF Files to the Job Editor**

Before a DWF file can be added to the Job Editor, it is necessary to ensure that all fonts are already embedded in the DWF file.

DWF files can be manually added or imported from AutoDesk. Manually add a DWF files the same way you add other files to the job grid.

When a multiple sheet DWF file is added, each sheet appears as a separate line item in the job grid with the sheet name and number appended to the file name. Individual sizes are supported for multipage DWF files.

If the DWF file is password protected, the Missing or Invalid Password dialog box appears. Enter the password and then click **OK**. When multiple password protected files are added, PlotWorks will prompt you as necessary for additional passwords.
The Job Editor Window

This section provides a brief description of the Job Editor window components.

The Toolbar

The following buttons appear on the Job Editor toolbar:

- **New Job**: Creates a new, blank job file.

- **Open Job**: Opens an existing job file.

- **Add Files**: Adds image files to the print job.

- **Save Job**: Saves the current job file.

- **Cut**: Removes the selected row from the grid placing it in temporary memory. From there, it can be pasted into a new position or in a different job file.

- **Copy**: Places a duplicate of the selected row in temporary memory. The duplicate can be pasted and edited apart from the original.

- **Paste**: Pastes the last row placed in temporary memory onto the grid.

- **Delete**: Removes the selected row(s) from the grid.

- **Properties**: Displays or hides the Detail Property Sheet.

- **Process**: Processes selected images or all images in a job.
- **Revision Highlighting**: Compares two documents that are generated in the same way, and illustrates the differences between the two files. Revision Highlighting cannot be used with scanned images.

- **View**: Processes the selected image and displays it in the viewing application.

- **Output**: Is used to set up output options and to send entire jobs or selected files to a specified destination.

- **Scan**: Opens the optional Scanner Interface application.
The Menus

The File Menu

The File menu contains options for job tickets.

These include:

- **New Job:** Creates a new, blank job ticket. (Keyboard shortcut: Ctrl+N)
- **Open Job:** Opens an existing job ticket. (Keyboard shortcut: Ctrl+O)
- **Open Pen Set:** Applies an existing pen set to the selected image.
- **Add Files:** Adds images to the print job. You can add files from a directory on your network, or from an FTP directory. (Keyboard shortcut: Insert)
- **Templates:** Is used to save and open settings created for watermarks, margins and labels.
- **Scan:** Opens the Scanner Interface application if installed. (Keyboard shortcut: Ctrl+A)
4-8 • PlotWorks User Guide

- **Twain**: Adds images from a Twain scanner to a job ticket.
- **Process All**: Processes all images in a job.
- **Process Selected**: Processes the selected file(s) in the grid.
- **Output to File**: Is used to convert and save a file as a TIFF or PDF file. It can be used to create multi-page TIFF or PDF files and change other file properties. For more information refer to page 4-94.
- **Output Job**: Is used to select output options and output the job. (Keyboard shortcut: Ctrl+J)
- **Save Job**: Saves the active job ticket. (Keyboard shortcut Ctrl+S)
- **Save Job As**: Saves the active job ticket under a selected new name. The original document will still exist under its original name. The new document displays in the active window.
- **Save Pen Set**: Saves the selected file’s pen set, under a specified filename.
- **Save Configuration**: Saves job-wide settings to the configuration file, conf.plp.
- **1, 2, 3, 4 . . . etc.**: Opens the selected job ticket.
- **Exit**: Exits the Job Editor, prompting you to save unsaved changes, if any.

**The Edit Menu**

The Edit menu contains options used to organize image files on the grid.

![Edit Menu](image)

The following items are available under the **Edit** menu:

- **Cut Row**: Removes the selected row from the grid and places it in temporary memory. From there, it can be pasted into a new position in the same or different job ticket. (Ctrl+X)
- **Copy Row**: Places a duplicate of the selected row in temporary memory. (Ctrl+C)
- **Paste Row**: Lets you paste a row from temporary memory onto the job grid. (Ctrl+V)
- **Delete Row**: Deletes a row from the job ticket. *This does not delete the actual image file from your computer.*
- **Copy Row to Prototype**: Copies all image file parameters to the Prototype row.
- **Copy Field**: Copies the value of a selected field to other fields in the same column. This is useful when you want to change all values in a column efficiently. (Ctrl+R)
- **Copy Field Up**: Copies the value of the selected field to all fields above the selected field in the same column. (Ctrl+U)
- **Copy Field Down**: Copies the value of the selected field to fields below it in the same column. (Ctrl+I)
- **Sort by Column**: Sorts selected columns alphabetically. (Ctrl+M)
- **Revision Highlighting**: Compares two documents that are generated in the same way, and illustrates the differences between the two files. Revision Highlighting cannot be used with scanned images.

### The View Menu

The View menu is used to change the appearance of the Job Editor window, and for processing and viewing options.

<table>
<thead>
<tr>
<th>View menu</th>
<th>Options</th>
<th>Key</th>
</tr>
</thead>
<tbody>
<tr>
<td>Toolbar</td>
<td>Hides or shows the toolbar.</td>
<td></td>
</tr>
<tr>
<td>Status Bar</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Property Sheet</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Scale View</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Move Up</td>
<td>F7</td>
<td></td>
</tr>
<tr>
<td>Move Down</td>
<td>F8</td>
<td></td>
</tr>
<tr>
<td>View Image...</td>
<td>Ctrl+Shift+V</td>
<td></td>
</tr>
<tr>
<td>Title Block Location Viewer</td>
<td>Ctrl+T</td>
<td></td>
</tr>
<tr>
<td>Refresh Viewer</td>
<td>F5</td>
<td></td>
</tr>
<tr>
<td>Always Use PlotWorks Viewer</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Do not show splash screens</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

The following items are available under the View menu

- **Toolbar**: Hides or shows the toolbar.
Status Bar: Hides or shows the status bar.

Property Sheets: Hide or shows the Detail Property Sheet.

Scale View: Hides or shows an illustration depicting the original and output size of a selected image.

Move Up: Moves the cursor up one row in the grid. (F7)

Move Down: Moves the cursor down one row in the grid. (F8)

View Image: Processes the selected image and displays it in the selected viewing application. (Ctrl+Shift+V)

Title Block Location Viewer: Opens the Title Block Location dialog box when an image is selected in the job grid. This is useful when using a GFI folding device. For more information refer to “Using the Title Block Location Dialog Box” on page 11-19.

Refresh Viewer: Updates the Image Viewer window. (F5)

Always Use PlotWorks Viewer: Forces the PlotWorks Image Viewer to open when you select View Image, regardless of the file format.

NOTE: Double-clicking on a file in the Job Editor opens the Viewer with the selected image file displayed.

Do not show splash screens: Select this option to disable the splash screens. Splash screens are the windows that appear briefly when PlotWorks applications are first launched. The splash screens are enabled by default. When disabled a check mark appears beside this option.

The Setup Menu

The Setup menu is used to configure the job ticket.

The following items are available under Setup:

Preferences: Is used to set job-wide preferences.

Processing Options: Is used to set job processing options.

Configure Destinations: Is used to set up output destinations.

Configure Viewers: Is used to select third party image viewers. Selecting this menu item opens the Configure Viewers dialog box.
Select the file type from the Data Type drop down list and then select the viewer you would like to use for this file type from the Viewer path drop down list. The viewer must support the file format that you wish to display. If the Viewer you wish to use is not listed, click on the provided browse button and select the application file for the viewer you want.

- **Twain Options**: Is used to access the Twain Scanning Options dialog box. This is described in detail under “Adding Files from a Polled Directory” on page 4-78

**The Help Menu**

The **Help** menu provides access to online help files and program information. The following options are available under **Help**:

- **Online Manual**: Opens the online manual at the Job Editor chapter
- **Index**: Displays the help index file.
- **Table of Contents**: Displays the table of contents for the online manual
- **Release Notes**: Displays the latest PlotWorks information.
- **About**: Displays program version and copyright information.
The Job Grid

When images are added to a job ticket, they are listed in the job grid and assigned the same parameters as the Prototype row, except for the file name and type. Each row of a job grid represents an image file and the parameters assigned to it.

Print parameters can be changed directly on the job grid. Simply click in the cell you want to edit. Either the cursor will flash, indicating that you can type in your changes, or the cell will change to display a drop down list that you can select from.

The first row of the grid, Proto, lists a set of default parameters. Images added to a job are listed beneath the Proto row.

To move through the grid use the:

- Scroll bars
- Arrow keys on your keyboard
- Arrow keyboard equivalents: F7 (up) and F8 (down)
- Page Up and Page Down keys
- Click on the desired cell with the mouse

The Job Grid Columns

The columns of the grid display the assigned printing parameters for each job. Depending on the image format, some print parameters do not apply. Those cells display a line.

The following columns are available:

- Filename: The image file name, not including its three-character extension.
- Ext: The file extension.
- Status: The processing status of an image file is displayed automatically in the status column. The following processing statuses are used:
  - O: User selected Ignore Warnings or Ignore All
  - W: Processing warnings
  - -: The image was skipped during processing
• C: The image was prechecked successfully. All needed information and reference files, etc., exist
• P: The image was processed successfully
• F: The file could not be processed or printed due to fatal errors.

Job tickets created with DOS PlotWorks, display the following statuses:
• ?: The image was printed with warnings
• ±: The image was corrected with Error Free Printing
• *: The image was printed successfully

• Qty: Stands for Quantity. Enter the number of copies to print, up to 99. Enter X or 0 for overlays and other files you do not want to print.
• Size: Select the original image size. To enter a custom size, select User Specified, then enter the width, height, and origin values on the Specified Size tabbed dialog box. To auto detect the image size, select Auto Detected.
• Media: Select a printing medium.
• Output: Select a finished size for the print, or select a percentage of the original size. To enter a custom size, open the Detail Property Sheet and click on the Output Setup tab. In the field labeled Output Size, select User Specified, then enter the width, height, and origin values. To force the use of the closest standard media size, select Auto Standard.
• Pens: This field always displays User Specified. To use a different pen set, use the Pens tabbed dialog box or import a previously defined pen set.
• Format: The image file data format. The Job Editor automatically detects this format when you use the Add Files option. PLP recommends that you do not change automatically detected format values.
• Scale: This column is used only for AutoCAD or MicroStation files. Enter one of the following in this cell:
  • A valid AutoCAD scale (printed units = drawing units).
  • A valid MicroStation scale (master units per inch) for MicroStation DGN files.
  • FIT, for automatic scaling depending on the Specified Size. Refer to “Specified Size tabbed dialog box” on page 4-18 for more information.

Scaling to FIT cannot be used when the Specified Size is set to Auto Detected.

• Plot by: This column only applies to AutoCAD or MicroStation drawings and is used to select printing boundaries. The following boundaries are available:
• **Extents**: Prints all drawn entities in the image file.
• **Display**: Prints the last saved screen display of the image.
• **Limits**: Prints a specified range of coordinates.
• **View**: Prints a predefined view. MicroStation drawings are always printed based on a view.
• **Layout**: This boundary can only be used with AutoCAD 2000 processing. It prints a predefined layout.
• **View Name**: Cells in this column are only available when View is selected in the Plot By field for AutoCAD or MicroStation drawings. Allowable entries for Microstation files are:
  • the saved view name
  • the special view names of 1 through 8 (representing the allowable MicroStation view window numbers);
  • a selection cell name in addition to a view name or number. For example: `topview CELL<linepa>` where `topview` is a name given to a view and `linepa` is a named cell.
• **Watermark**: The watermark text is displayed in this field when a watermark is applied to the image. See “Watermarks tabbed dialog box” on page 4-34.
• **Justification**: This field is used to justify the image on the media. See “Adding Margins” on page 4-39.
• **Mirror**: Select whether or not to mirror the image.
• **Label**: This field is used to enter label text. See “Adding a Label to the Printed Image” on page 4-43.
• **Overlays**: This field displays the number of files selected as overlays. Up to ten images can be layered on an image.

*Overlay file(s) have to be added to the job ticket with a quantity of X or 0. See “Overlays tabbed dialog box” on page 4-31.*

• **Title Block**: This option is used with GFI folding devices. Select either the location of the title block or Don’t Care from this drop down list. For more information refer to “Specifying the Title Block Location” on page 11-17.

**To change a column width:**
1. Place your cursor on the right-hand edge of the column heading. The cursor changes to a vertical bar crossed by a double-headed arrow.
2. Drag the cursor to the desired width.
Changing Print Parameters

To change prototype parameters:

Changes made to the Proto line affect all files you added thereafter. Changes do not affect files already added to a job ticket.

1. Either:
   - Edit the fields on the Prototype row of the grid or on the Detail Property Sheet.
   - Select a row on the grid that contains the desired print parameters. Then select Copy to Prototype from the File menu. The print parameters are copied to the Prototype row.

2. Click on the File menu
3. Select Save Configuration.

Editing Functions

The editing functions are useful for changing the order of image files and for copying multiple parameters at once.

To cut a row from the grid:

1. Select the row you want to cut by clicking on its row number. To select more than one row, hold down the Shift or Ctrl key while selecting.
2. Click Cut (or press Ctrl+X).

To copy a row on the grid:

1. Select the row you want to copy by clicking on its row number. To select more than one row, hold down the Shift or Ctrl key while selecting.
2. Click Copy (or press Ctrl+C).

To paste a row onto the grid:

1. Cut or copy the row you want to paste (see above).
2. Select the row above the spot where you want to paste.
3. Click Paste (or press Ctrl+V).

To delete a row from the grid:

1. Select the row that you want to delete by clicking on its row number. To select more than one row, hold down the Shift or Ctrl key while selecting.
2. Click Delete.
To copy a field to the entire column:
1. Select the field.
2. Open the Edit menu and select Copy Field. The value is copied to all images in the job including the Prototype row.

Change Image Filenames
You can change the name or extension of a file listed in the grid.

*The Job Editor supports duplicate filenames in a job as long as the files are the same.*

To edit a file name:
1. Select (highlight) the filename or extension you wish to rename.
2. Type the desired filename or extension and press Enter.
3. You are prompted: “Rename <oldfile.ext> to <newfile.ext>?”. Click Yes. The file is renamed in the job grid as well as in the source directory.

Saving a Job Ticket
Once you have created a job ticket, you can save it for future editing or print-on-demand.

To save a job ticket:
1. Click Save Job.
   
If you have not previously saved the file, you will be prompted to enter a filename and to select a location for your new job ticket. See below for instructions.

To save a job ticket under a new name:
1. Open the File menu and select Save Job As.
2. Type the new name of the file in the Filename field. You can use long filenames for your job tickets.
3. In the Save In field, select a directory to save the file in. Always save the job ticket in the same directory as the source files that are in the job.
4. Click Save.
When you use the **Save Job As** command, if the job was previously saved under a different name, the old job is still saved with its original name and the new job is active in the Job Editor grid.
The Detail Property Sheet

The Detail Property Sheet is a set of nine tabbed dialog boxes used to enter and edit parameters for individual image files. The Main tabbed dialog box contains most of the basic parameters shown on the grid. The other tabbed dialog boxes are used to further customize printing parameters.

To view the Detail Property Sheet:

To display the Detail Property Sheet if it is not already displayed, either:

- Select Property Sheet from the View menu
- Click on the Properties button.

The Detail Property Sheet can be moved around your computer screen as needed. Simply click on its title bar and while holding the mouse button down drag the dialog box to a new location and then release the mouse.
Selecting parameters on the Detail Property Sheet:
1. Select an image on the grid by clicking on its row number.
2. Choose the tabbed dialog box you want by clicking on its tab.
3. Enter or edit the fields provided.

Main Tabbed Dialog Box
The Main tabbed dialog box of the Detail Property is used to define basic print parameters. It contains many of the fields shown on the job grid.

The Main tabbed dialog box contains the following fields and button:
- **Filepath**: The complete path to the file, e.g., C:\Program Files\PLP\Plotworks\SampleCC1.
- **Filename**: The name of a linked image file (not including its three-character extension).
- **Browse**: Is used to navigate and select a file to replace the file currently selected on the job grid.
- **Quantity**: Enter the number of copies desired. Enter “X” or “0” for overlays and for files that you do not want to print.
- **Specified size**: Select the original image size. To enter a custom size, select User Specified, then enter the width, height, and origin values on the Specified Size tabbed dialog box (refer to Fig 4.12). To automatically detect the image size, select Auto Detected.
- **Output size**: Select a finished size for the print, or select a percentage of the original size. To enter a custom size, select User Specified, then enter the width, height, and origin values in the Output Setup tabbed dialog box (refer to Fig 4.14). To print on the next largest standard media size, select Auto Standard.
- **Media**: Select a printing medium from this drop down list. Choices include:
  - Bond
  - Vellum
  - Film
  - T-bond
  - Unspecified: Unused media type
  - Heavy Bond: This is equivalent to Repro Desk’s Bond 110g
  - Heavy T-Bond: This is equivalent to Repro Desk’s T-Bond 110g
  - Film 4.5mil: This is equivalent to Repro Desk’s Film 4.5mil
- Special Bond: This is equivalent to Repro Desk’s *Bond 110g
- Special Heavy Bond: This is equivalent to Repro Desk’s *Bond
- Special Vellum
- Special Film
- Special T-Bond
- Premium Bond
- Premium Vellum
- HPH (High Pressure Heat) Vellum
- Antistatic Film
- Opaque Film
- Clear Film
- Contrast Film
- Bond 80g
- T-Bond 80g
- Bond 90g/24lb
- T-Bond 90g/24lb
- Recycled Bond
- Medium Blue Bond
- Bright Blue Bond
- Goldenrod Bond
- Bright Yellow Bond
- Green Bond
- Orange Bond
- Pink Bond
- Gray Bond
- Beige Bond
- Fluorescent Yellow Bond
- Fluorescent Green Bond
- Fluorescent Orange Bond
- Fluorescent Pink Bond
- Glossy Presentation
- Satin Presentation
• Special Media 1 through Special Media 10: These options are used for customer-defined media types:

The following media options are not actual media types, but are used to specify a particular roll, tray, or manual feed.

• Roll 1 through Roll 8
• Tray 1
• Tray 2
• Manual Feed: It is necessary to select this option to force manual feed.

• **Mirror:** Select whether or not to mirror the image.

• **Data format:** The actual image file format which is automatically detected when the file was added to the job grid. We recommend that you do not change this value.

For information on processing and printing TIFF files, see Appendix J - Tiff Helper.

---

- **Scale:**

**For AutoCAD DWG files enter either:**

- A valid AutoCAD scale (printed units = drawing units)
- FIT for automatic scaling, **R1** through **R5** for **SETVAR** values
- **DIMSCALE** to use the Dimension Entity Scaling for the drawing scale.

**For MicroStation DGN files enter either:**

- A valid MicroStation scale (master units per inch)
- FIT to automatically scale to the Specified Size.

*Scaling to FIT cannot be used when the Specified Size is set to Auto Detected.*

- **Title Block:** Use this drop down list to specify where the title block is located on the selected image. If the location of the title block is irrelevant, select **Don’t Care** from the drop down list. Selecting a title block location is necessary when folding.

---

**Specified Size Tabbed Dialog Box**

The Specified Size tabbed dialog box is used to define custom (User Specified) values for the Specified Size field. When **User Specified** is selected for the Specified Size on the grid or on the Main tabbed dialog box, you must define custom values here.
The Specified Size tabbed dialog box contains some or all of the following fields:

- **Specified Size**: When a size other than Auto Detected or **User Specified** is selected in this field, the following fields display in the Specified Size Settings box:
  - **Width**: If User Specified is selected in the Specified Size field, the selected file’s width displays in this text box. If the width value is changed, Specified Size automatically changes to User Specified.
    
    If the Specified Size field is set to User Specified, you must enter a value in the **Width** field.
  
  - **Height**: If User Specified is selected in the Specified Size field, the selected file’s height displays in this text box. If the height value is changed, Specified Size automatically changes to User Specified.
    
    If the Specified Size field is set to User Specified, you must enter a value in the **Height** field.
• **X Origin:** This field is used to specify a horizontal coordinate for the image origin. By default, this field is set to 0. If you change the X Origin value, the Specified Size field changes to User Specified. This feature can be used, along with the Height and Width parameters to specify a portion of the original image.

You can also use the PlotWorks Image Viewer to specify a portion of the document to print. The Specified Size data is then automatically updated.

• **Y Origin:** This field is used to specify a vertical coordinate for the image origin. By default, this field is set to 0. If you change the Y Origin value, the Specified Size field changes to User Specified. This feature can be used, with the Height and Width parameters to specify a portion of the original image.

The default origin of an image is usually the lower left corner. However this can vary depending on the image format. For example, TIFF images consider the top left corner the origin. Therefore view the image in the Image Viewer to confirm the origin location.

**Fig 4.12**
The default location of the X and Y origins

![Image origins (lower-left corner)](image)

• **Bottom edge:** Is used to select which edge of an image, as seen in the Image Viewer, should be considered the bottom. The selected edge becomes the bottom edge when the image is printed. The bottom edge=top and bottom edge=bottom settings apply to landscape-oriented images, while the bottom edge=left and bottom edge=right settings apply to portrait-oriented images.
The Bottom edge option is useful when you plan to collate or fold scanned images and you want to make sure they all face the same direction. For example, the Bay folder requires the title block to enter the folder last in order to get a properly folded package. Other folders require the title block to enter the folder first.

The diagrams below illustrate how the printed document is orientated depending upon the value selected for Bottom edge. Note where the title box ends up in each diagram.
The Output Setup tabbed dialog box is used to define custom or User Specified values for the Output Size field. The following options are selected here:
**Output Size:** From this drop list, select either one of the standard sizes or percentages offered. If you wish to specify a custom size, select User Specified and then enter values for **Final height** and **Final width**.

**Scale by:** Select whether to scale the selected image to a specific size (**Final Size**) or to a percentage of the original size (**Percentage**). Percentage values between 1 and 1000 are accepted.

If the Output Size field is set to a standard size (A, A1, B, C, etc.), the Scale By field is automatically set to **Final Size**.

In addition to standard media sizes, you can select **Auto-Standard** to automatically print the image at 100% on the smallest standard sheet the complete image will fit on. Centering, margins, etc., will be implemented as normal for any given sheet size.

If the Output Size field is set to a standard percentage (75%, 100%, etc.), the Scale By field is automatically set to **Percentage**.

If the Output Size field is set to User Specified, you must select either **Final Size** or **Percentage** in the Scale By field.

For best results when printing PostScript files, use **Scale by Percentage** and set a **Scale** that is a multiple of 100 (100%, 200%, 400% for example). This not only produces the desired printout, but prevents moire (those unsightly crosshatched patterns that show up when printing some PostScript files).

- **Scale:** is used to specify what percent to reduce or enlarge the original image when **Scale By** is set to **Percentage**.

  If the Output Size field is set to a standard percentage (75%, 100%, etc.), the Scale field displays the correct value automatically.

  If the Output Size field is set to User Specified, you must enter a percent value, between 1 and 1000, in the **Scale** field.

- **Specify final media size:** When **Scale by:** is set to **Percentage**, this check box is enabled. It is used to specify the media size the image should be printed on.

  For example, if the specified size is **A**, and you scale the Output size by **200%**, but you want to print on a D-size sheet, specify the D size measurements for the width and height. Then the image will print at double an A-size, on a D-size sheet. This does not use up the whole sheet.

- **Final width:** Select the final, printed width of an image when the Scale By field is set to Final Size or percentage. If the Scale By field is set to Final Size, the image is scaled up to best fit the Final Width and Height.
If the Output Size field is set to a standard size (A, A1, B, C, etc.), then the Final Width field displays the correct width automatically. If you change the width, the Output Size setting changes to User Specified.

If the Output Size field is set to User Specified, you must enter a value in the Final width field.

- **Final height:** Select the final, printed height of an image when the Scale By field is set to Final Size or percentage. If the Scale By field is set to Final Size, the image is scaled to best fit the Final Width and Height.

If the Output Size field is set to a standard size (A, A1, B, C, etc.), then the Width field displays the correct width automatically. If you change the width, the Output Size field changes to User Specified.

If the Output Size field is set to User Specified, you must enter a value in the Final height field.

- **Scale Pens:** When this check box is selected, pens on vector images are scaled when the image is scaled.

- **Output Quality Levels:** Select either Best, Normal, or Draft. These refer to device-specific or driver-specific quality levels. These options are used with Windows and Generic Embedded Controller printers, or when processing PostScript or PDF files. The quality level is used to determine the rasterization resolution to use for PostScript or PDF files, unless the resolution is set manually. See “Data Format tabbed dialog box” below for more information.

Output quality is dependant on the printer. **Best** mode for a DesignJet printer is 600 dpi in Enhanced Graphics printing mode. **Best** on a laser printer may be 600 dpi without Enhanced Graphics mode.

<table>
<thead>
<tr>
<th>Warning</th>
</tr>
</thead>
<tbody>
<tr>
<td>If your printer does not support multiple output resolutions, use caution when changing this value — the scale of the printed image can be affected.</td>
</tr>
</tbody>
</table>

Output quality values can also be changed in the Printer Interface. See “Configure Device-Specific Options” on page 8-15.

**Data Format Tabbed Dialog Box**

This tabbed dialog box contains file format information for the selected file. This information is automatically detected when the file is added to the job.

Available data formats are:

- AutoCAD files (DWG, DXF, ACADM)
- HP-GL, HP-G/L2,
- Generic Embedded Controller
- CalComp files (906/907)
The fields available depend on the Data Format detected.

Fig 4.15
Detail Property Sheet

Changing autodetected data can cause serious printing errors! We recommend that you not change the Data Format or Data Type settings on this tabbed dialog box.
One or more of the following fields are used on the Data Format tabbed dialog box:

- **Data format**: Displays the detected file format
- **Data type**: Used to select the actual type of data being used.
- **Origin** (HP-GL only): Displays the origin (0, 0) of the HP-GL image: Center or Lower Left.
- **Resolution**: The print resolution of the image.

  For vector formats this refers to the coordinate resolution.

  For Postscript, DWF, and PDF files, this option is only available when the “Base resolution on output size and quality check box” is not selected.

- **Sync code** (CalComp files only): The sync code notifies the printer that a print job is coming. Either one or two sync codes can be sent.
- **End of message** (CalComp files only): Notifies the printer that the end of the CalComp image has been sent.
- **Checksum** (CalComp files only): Verifies the integrity of the CalComp image.
- **Enable Precheck Pass** (AutoCAD files only): If this check box is selected, then PlotWorks performs the precheck pass done by DWG Direct, which looks for XREFs, ATTACHMENTS and FONTS.
- **Print page range**: For use with PostScript, TIFF, PDF, BMP, DCX, JPG, HP-GL/2, XIF, and PCX files. Allows you to specify which pages to print in multipage documents.

  Select from two options, **All** or **Pages**. If **All** is selected, all pages are printed. If **Pages** is selected, specify a range in the form “xxx-yyy” (1-5, for example), or print only specific pages (1,3, 5-9, for example). If the page range is invalid, PlotWorks corrects it based on a valid range.

- **Base resolution on output size and quality**: This option is selected by default to automatically determine the resolution for PostScript and PDF files. When selected, output quality is changed using the Output Quality Level option from the Output Setup tabbed dialog box.

  If the output is still not right, set the resolution manually by unchecking this option and entering a resolution in the Resolution text box.

- **Automatically add showpage**: This option is selected by default for PostScript files. When selected the “showpage” command is either detected or added automatically. Leave this box checked unless you get extra blank pages when printing, in which case uncheck it.

**AutoCAD file options:**

The Data Format sheet contains the following special options for AutoCAD files:
- **English or metric** (ACAD/ACADM only): If the data type is ACAD, measurements are in *English*. If the data type is ACADM, *Metric* is selected.

---

_English or metric (ACAD/ACADM only): If the data type is ACAD, measurements are in English. If the data type is ACADM, Metric is selected._

---

- **Remove hidden lines**: This option is used during AutoCAD processing to remove lines behind other planes when 3-dimensional rendering.
- **Reverse Z order**: This option is only available with DWG Direct processing. Normally, PlotWorks prints the main AutoCAD image first, and any XREF files second. As a result, the XREFs are layered on top of the main image. When the **Reverse Z order** option is selected, the XREF files are printed _first_, making them appear as though they are underneath the main image.

---

_AutoCAD actually processes the XREFs as they occur in the DWG file. So your output using this option can still vary from those generated directly by AutoCAD._

---

- **Scale**: If an ACAD scale is selected from the Main tabbed dialog box or on the grid, that number displays here. You can also set the ACAD scale here and it will then display on the Main tabbed dialog box and on the grid.
- **Plot by**: Select this option to print the AutoCAD image by Extents, Display, Limits, View, or Layout. If View is selected, the View name field displays:
  - **View name**: (AutoCAD) If **Plot by View** is selected, you can enter the name of the view to be printed. If **Plot by Layout** is selected, enter the name of the layout to be printed.
  - **View name**: (DGN) Prints an area defined in MicroStation under a specified view name. If you select this Plot By option, you must enter the correct view name in the View Name field in the Job Editor. Allowable entries are:
    - the saved view name in Microstation;
    - the special view names of 1 through 8 (representing the allowable MicroStation view window numbers);
    - a selection cell name in addition to a view name or number. For example: `topview CELL<linepa>` where `topview` is a name given to a view and `linepa` is a named cell.
When printing DGN files, you can also specify a cell or shape specifications to restrict the view. For example, in the view name field: TOPSIDE
CELL<PLOTME> would plot the view 'Topside' and further restrict the view to just the cell selection(s) called 'Plotme' within that view. To plot based upon shape(s), the following options are available: TOPSIDE SHAPE<level, color, style, weight>. If one of the settings is not used, you must enter '-1' as the value: TOPSIDE SHAPE<-1,255,-1,0>.

- **Advanced** button (DGN files only): This button brings up the DGN Advanced Options dialog box which lets you determine which DGN design elements are processed. For an explanation of each option, refer to your MicroStation manual. Grayed out options are not available. The check boxes for each entry on the new dialog box can have three values:
  - **Blank**: Turn off these design element types and do not process them.
  - **Black check**: Turn on these design elements and process them.
  - **Gray check** (default): Use the setting for these design elements as originally saved in the design file view being processed.

*Plot by cell* or *Plot by shape* normally allows you to specify the same cell multiple times on the same page, creating a “multi-page” printout.

- **Added RTL Raster Resolution**: This drop down list appears if an HP-GL/2 file is detected. In this case select a print resolution. Choices are:
  - Auto
  - 300 DPI
  - 400 DPI
  - 600 DPI
- **Use drawings page size**: This option appears if an HP-GL/2 file is detected. Select this check box to use the page size specified in the drawing.

**DWF file options:**

The following options display when DWF is selected for Data format:

- **Data type**: Used to select the actual type of data being used.
- **Resolution**: The print resolution of the image. This option is only available when the “Base resolution on output size and quality check box” is not selected.
- **Print page range**: These fields display the current sheet number and the number of sheets in the DWF file. These values cannot be changed.
• **Base resolution on output size and quality:** When selected, the output quality specified in the Output Setup tabbed dialog box is used. If the output is still not right, set the resolution manually by unchecking this option and entering a resolution in the Resolution text box.

• **Minimum Pen Width (Pixels):** Select a minimum pen width in pixels. Increase the value in this text box if lines are not printing or are printing too light. When this value is changed, it is necessary to reprocess DWF files in the job grid.

---

**Fig 4.16 DWF Data Format tabbed dialog box**

---

**Pens tabbed dialog box**

The Pens tabbed dialog box is used to define custom (User Specified) pen sets. The Pens tabbed dialog box contains the following fields:

• **Macro:** This text box is used to enter a pen macro value. Pen macros control the color model used when a drawing is rasterized. There are three pen color models currently available:
• **Black and White**: All colors (including white) are printed as black lines. Screens from 0% to 100% or patterns can be applied to any pen.

• **Gray**: All colors are converted to the appropriate intensity and screened (greens are lightest, blues are darkest). Screens or patterns can still be applied. A screen will modify the intensity created from a selected color.

• **Black and Red** (Xerox MAX 200 and 8180 only): The red component of each color is separated along the red plane and a screen of the appropriate percentage is applied. Other colors are converted on the black plane and the appropriate gray intensity and screen is applied.

![Fig 4.17 Pens tabbed dialog box](image)
The following pen macros are available:

<table>
<thead>
<tr>
<th>Macro</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>*</td>
<td>Turns off sharpening for raster blocks and files.</td>
</tr>
<tr>
<td>~</td>
<td>Resamples all monochrome TIFF files. Reapplies patterns when scaling. Using this option may cause some thin lines in a line drawing to become dim or even disappear when the drawing is reduced in size. Using this option may prevent a TIFF from being used as a RED overlay on top of a main file printed in monochrome on the MAX 200. Resampling all monochrome TIFF files dramatically increases computer processing requirements. This results in slower printing. Slower computers or those containing less memory may freeze if this option is selected.</td>
</tr>
<tr>
<td>A</td>
<td>Flattens all color pixels to solid black. Use this macro with color line drawing to print all lines solid black. Also when anchor points in the title block text are banded or when white lines appear in solid black text. Do not use this macro with photos as it will create solid black blocks.</td>
</tr>
<tr>
<td>B</td>
<td>Forces all pens to black resulting in a black and white monochrome print. This is similar to the Repro Desk option “No flatten all vector pens to solid black.” Forces monochrome output for vectors for DWF files. The rendering type in PlotWorks is used to dither the grayscale and color images to monochrome.</td>
</tr>
<tr>
<td>C</td>
<td>Use color definitions from the HP-GL/2 file instead of the pen set. This allows the drawing to get pen colors from the plot file.</td>
</tr>
<tr>
<td>E</td>
<td>Fills pen strokes with patterns defined in the HP-GL/2 file instead of the pattern defined in the pen set. Drawing will use pen screens and patterns from the plot file.</td>
</tr>
<tr>
<td>F</td>
<td>Enables the drawing to get fill screen and pattern information from the plot file. Polygons are then filled with patterns defined in the HP-GL/2 file instead of the pattern defined in the pen set.</td>
</tr>
</tbody>
</table>
G  Prints the grayscale representation of colors in HP-GL/2 files.  
Sets all vector pens to grayscale.  
When used with Repro Desk jobs, pen colors are mapped to a  
shaded halftone when Color is set to “No.”  
Forces grayscale output from DWF files. The rendering type in  
PlotWorks is used to dither the image to monochrome.

H  Prints the entire image using the highlight color, if available.  
This is red on the XES MAX 200 or 8180. On the MAX 200 all  
vector pens and raster data will be printed red.

I  Inverts the entire output sheet, including all overlays, watermarks,  
labels, and nested images. Inverts Generic Embedded Controller or  
RTL embedded data in HP-GL/2 files. Use this macro when the  
attached raster in a file is inverted (black is printing as white, etc.) or  
if the embedded raster file appears reversed.  
Selecting this macro has the same effect as selecting the "Negative"  
checkbox in Reprodesk pen sets.

J  Forces the use of the HP-GL/2 Plot Size (PS) command  
instead of the drawing’s extents as specified by actual marks  
drawn on the page.

K  This macro is provided so that PlotWorks can emulate  
Reprodesk/Apprentice HP-GL/2 support. In particular, to ensure that:  
• the Plot Size (PS) command landscape orientation imitates  
Reprodesk behavior  
• Winding fill is used as the default polygon fill type for HP-  
GL/2 files.  
• if a color is not defined in the HP-GL/2 file but the 'P' or 'C'  
pen macro is used, PlotWorks uses the color specified in the  
pen set.
Enables printing in multiple colors on the XES MAX 200, 8180, Windows Color, and Generic Embedded Color Controller printers. This macro is necessary to print red components and full color. Note the following:

- Color printing on Windows and Generic Embedded Controller printers is only possible when printing HP-GL/2 files using embedded pen values and the P macro which extracts color data from the internal file definitions.
- Other vector file formats must have the pen definitions specified in the Pens tabbed dialog box.
- Raster files can be printed entirely in red on the MAX 200 or 8180 by setting pen 1 to color 6 in the Job Editor.
- Forces color output from the DWF Tool Kit.
- To print red and black representations of all colors with the Xerox MAX 200 or 8180, use the W, P, and M macros.

Ensures RTL raster data is not scaled to provide the same results as selecting the "Do NOT Scale RTL Raster Data" option in Reprodesk/Apprentice.

Prints embedded patterns, types and specified opacity in HP-GL/2 files. Provides the same functionality as specifying the macro combination of CFETV

Forces NOT using the RTL palette for monochrome raster blocks. The pen 0 and 1 in the RTL palette is instead used to determine the color of 0 and 1 pixels. This macro is provided for Reprodesk/Apprentice support as in Reprodesk, pen 1 is always set to black.

Forces using merge control and transparency data from the HP-GL2 file instead of from the pen set. The pen type and/or effect is taken from the plot file.

Allows the drawing to manipulate line ends (round, butt, square) from the file. The line end selection is taken from the HP-GL/2 file not the pen set. This macro is not supported by Repro Desk.

Forces using pen widths defined in the HP-GL/2 or plot file instead of from the pen set. Prints embedded pen widths in HP-GL/2 files
The following macros control what type of dither or diffusion patterns are used for vector images. Printers that have good small dot printing characteristics will use the diffused dot dither by default.

<table>
<thead>
<tr>
<th>Macro</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>D</td>
<td>Use error diffusion dithering for vector parts of drawing. Forces order dot dither patterns to diffused dot dither patterns on the XEROX WIDE FORMAT 8830.</td>
</tr>
<tr>
<td>O</td>
<td>Forces ordered dot dither patterns. This macro overrides random dot dither patterns on the 8855, 8180 and KIP 3620. On Reprodesk jobs this macro ensures that vector areas in the drawing are rasterized using an ordered (pattern) dither.</td>
</tr>
</tbody>
</table>

The following macros control what type of dither or diffusion patterns are used for raster images. For raster images, Error diffusion is the default.

<table>
<thead>
<tr>
<th>Macro</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>R</td>
<td>Forces diffused dithering.</td>
</tr>
<tr>
<td>Z</td>
<td>Forces progressive pattern dithering.</td>
</tr>
</tbody>
</table>

*When printing with embedded patterns, the output can differ depending on the printer used. This is because different devices have different resolutions. For example, a user-defined pattern created for the 650C at 300 dpi could end up condensed, reduced in size, on a 400 dpi printer.*

The following two macros control image rotation, which is useful for forcing
prints into a particular orientation for folding

<table>
<thead>
<tr>
<th>Macro</th>
<th>Effect</th>
</tr>
</thead>
<tbody>
<tr>
<td>S</td>
<td>Prints the short end first (portrait orientation).</td>
</tr>
<tr>
<td>L</td>
<td>Forces the a selected image to print landscape or long edge first.</td>
</tr>
</tbody>
</table>

Pen macros can be combined. For example, entering WP would enable printing both embedded pen widths and patterns.

For information on Repro Desk Pen Macros refer to Repro Desk Pen Properties and the PlotWorks Equivalent in Appendix G page 13.

Because the pen macro list is so extensive, PlotWorks now provides a more intuitive way to select pen macros from the Pen/Print Options tabbed dialog box. For more information see page 4-39.

We recommend using the minimum pen width (found in the drawing) for Fill Space values.

- **Pen Grid:** There are several columns in the pen grid. The first cell in the first column displays the measurement unit that measurements should be provided in. The rest of this column lists all the pens in numerical order. The rows represent properties for each pen. The following pen properties are provided in the pen columns:
  - **Width:** Enter a pen width for each pen in this column. The default values are
    - 13 if pen units are set to Mils
    - 5 pixels if pen units are set to 400dpi
    - .32 if pen units are set to Millimeters.
  - **Shape:** The Pen Shape field is used to select the line or vector end shape for HP-GL/2 files. This option is primarily for wide lines, where the end shape is readily apparent. The following choices are available:

    - **Round:** This is the default value equivalent to the HP-GL/2 Round LA option.
    - **Square:** This is equivalent to the HP-GL/2 Extended LA option.
    - **Butt:** This is equivalent to the HP-GL/2 Butt LA option.
Extended butt: This is equivalent to the HP-GL/2 Square LA option.

The ‘HP-GL/2 internal LA command is ignored unless the ‘W’ pen macro is specified. If the ‘W’ pen macro is not specified, the line end shape is taken from the Pen Grid, not the HP-GL/2 file. If shape values are not entered in the Pen Grid and the W Pen Macro is not specified, the following warning displays: “Pen #1 used but not defined.” In this case all lines default to the Round pen shape.

- **Pattern:** Enter a pattern number or a percent value (from 1 to 100%) to print diffused or ordered dot halftone patterns. If using a percentage, be sure to include a percent sign (%). Diffused dot patterns are not supported by all printing devices.

Pattern numbers are arbitrary. Refer to the Pen and Pattern sheet provided on the PlotWorks CD-ROM.

- **Type:** Specify a line type here. Click in this column to display the drop down list. The following choices are available:
  - **Opaque:** This choice makes the line appear to be “on top” of any intersecting lines. An opaque line will hide any line beneath it at the point where the two cross. If more than one opaque line intersects, the last line drawn will be on top.
  - **Transparent:** This is the default setting. This choice makes a line appear transparent when it intersects other lines. Black lines cannot be transparent.

- **Color:** Enter a color number between 1 and 255. This column applies to color printers only.

Once you have specified a pen set you can save it for future use. For more information see page: 4-61.

**Pen/Print Options Tabbed Dialog Box**

The Pen/Print Options Tabbed dialog box provides an intuitive method of selecting pen and print options. Some options that are available here can also be selected from the job grid or from the Pens tabbed dialog box.

**Using the Pens/Print Options Tabbed Dialog Box**

Many options selected in this dialog box can be selected by specifying a macro. So if you know what macro you need, simply enter it in the **Macro** text box.
Options available from this dialog box are also set up in a select box that is organized in a tree view. Clicking on a plus (+) sign will expand that category of options. Clicking on the minus (-) sign will collapse that category of options. Clicking on an underlined item displays either a drop down list or a check box that you can select options from by double clicking.

You can make these same selections using keyboard shortcuts:

- Right arrow: Expands a category
- Left arrow: Collapses a category
- Arrow up: Moves you up the list
- Arrow down: Moves you down the list
- Space bar: Selects or deselects a check box
- ALT + Arrow down: Expands a drop down list
- Enter: Selects an option

When an option is selected from the tree view, its corresponding macro displays in the Macro text box.
Options Available from the Pens/Print Options Tabbed Dialog Box

The options available from this dialog box are divided into four main categories. These are: **Pen Configurations**, **Processing Options**, **Print Options**, and **Rendering Options**.

**Pen Configurations**

These Pen Configuration options are provided so that you can choose to apply pen options specified in the HPGL2 file or from the pen set. The following pen configuration options are available:

- **Pen Widths:**
  - **From File:** Select this option to use pen widths defined in the HPGL2 file. This is the same as selecting the **W macro**.
  - **From Pen Set:** Select this option to use the pen widths specified in the pen set.

- **Pen Colors:**
  - **From File:** Select this option to use pen colors defined in the HPGL2 file. This is the same as selecting the **C macro**.
  - **From Pen Set:** Select this option to use the pen colors specified in the pen set.

- **Polygon Fills:**
  - **From File:** Select this option to fill polygons with patterns defined in the HPGL2 file. This is the same as selecting the **F macro**.
  - **From Pen Set:** Select this option to fill polygons with patterns specified in the pen set.

- **Pen Strokes:**
  - **From File:** Select this option to fill pen strokes with patterns defined in the HPGL2 file. This is the same as selecting the **E macro**.
  - **From Pen Set:** Select this option to fill pen strokes with patterns specified in the pen set.

- **Transparency:**
  - **From File:** Select this option to use merge control and transparency data defined in the HPGL2 file. This is the same as selecting the **T macro**.
  - **From Pen Set:** Select this option to use the Transparent or Opaque option as specified in the pen set.

- **Line Ends:**
• **From File:** Select this option to use the line ends defined in the HPGL2 file. This is the same as selecting the **V macro**.

• **From Pen Set:** Select this option to use the line ends specified in the pen set.

**Processing Options**

The following processing options are available:

• **HPGL2 Plot Size:**
  - **From File:** Select this option to use the page size specified in the drawing. This is the same as selecting the **Use drawings Page Size** check box. This is the same as selecting the **J macro**.
  - **Extents:** Select this option to use the image extents.

• **Repro Desk Emulation:**
  - **Yes:** Select this option if you want your print output to match Repro Desk print output. This is the same as selecting the **K macro**. When **Yes** is selected:
    • HPGL2 files are not rotated when the plot size is set as portrait
    • Winding fill is used for all polygon fills instead of the type specified in the HPGL2 file.
    • If a color is not defined in the HPGL2 file and the 'P' or 'C' pen macro is used, the color specified in the pen set is applied.
  - **No:** Select this option if you do not want your print output to match Repro Desk print output.

• **Alternate VIC Merge Control**
  - **Yes:** Different versions of VIC files merge transparency differently. This option is provided to resolve this issue. Select **Yes** if your VIC file is not printing as expected. This is the same as selecting the **^ macro**.
  - **No:** Select this option if your VIC files are printing just fine.

• **Scale RTL Raster Blocks:** This option is provided to match a function available in Repro Desk.
  - **Yes:** Repro Desk compensates for differences in resolution by sometimes scaling RTL images. Select **Yes** if a printed image from a Repro Desk job does not seem to be properly rendered. This is the same as selecting the **N macro**.
  - **No:** Select this option if your files are printing just fine.
• **Use RTL Pallet for Monochrome**: This option is provided to print monochrome raster blocks the same way that Repro Desk does.
  - **Yes**: Select this option to use the RTL palette to determine the color of Pens 0 and 1. This is the same as selecting the **Q macro**.
  - **No**: Select this option to set pen 1 as black as is done in Repro Desk.
• **Error-Free Plotting**: When a specified size is selected for printing and the extents of the drawing are over or under such that the image will be clipped, PlotWorks compensates if the amount that will be clipped is within the amount specified in the Size Tolerance Sheet (see page 4-75). However this causes problems with some jobs that are imported from Repro Desk.
  - **Yes**: Select this option if your Repro Desk jobs are printing just fine. This is the same as selecting the **% macro**.
  - **No**: Select this option if an image from a Repro Desk job disappears off the page or is clipped.
• **Process PS/PDF/DWF files in Color**: Select **Yes** if your printer is capable in printing in more than one color. This is the same as selecting the **M macro**.

**Print Options**: The only print option available here is **Print Orientation**. Select from one of the following:

  - **Auto Rotate**: Select this option to rotate the image such that the least amount of media is used.
  - **Long Edge**: Select this option to print the image oriented landscape or long edge first. This is the same as specifying the **L macro**.
  - **Short Edge**: Select this option to print the image oriented portrait or short edge first. This is the same as specifying the **S macro**.

**Rendering Options**: Rendering Options are subdivided into **Color Model and Rendering Options** and **Advanced** options.

**Color Model and Rendering Options**:
  - **Color Model**: Select what color model to use from the following options:
    - **Printer Default**: Select this option to print in grayscale on black and white printers and color on color printers.
    - **Grayscale**: Select this option to print all vector pens and HP-GL/2 files in grayscale. When used with Repro Desk jobs, pen colors are mapped to a shaded halftone when Color is set to “No”. This is the same as selecting the **G Pen Macro**.
• **All Black:** Select this option to print all pens as black resulting in a black and white monochrome print. This is similar to the Repro Desk option “No flatten all vector pens to solid black.” This is the same as selecting the **B Pen Macro**.

• **Print Image in Highlight Color:** Select Yes if your printer can print in a different color (such as the MAX 200) and you want to print in two colors. This is the same as selecting the **H Pen Macro**

• **Allow Color if Available:** Select Yes if your printer can print in color. This is the same as selecting the **M Pen Macro**

• **Vector Rendering:** Options selected here can also be selected from the Vector Imaging tabbed dialog box of the Printer Interface. For more information see page 8-35 of this user guide. The following options are available here:

  - **Printer Default:** Uses the rendering method selected in the Printer Interface.

  - **Diffused:** When Diffused is selected, dots are placed to approximate source pixels. The amount of "error" in the approximation is balanced with adjoining source pixels to better approximate the source image. This option is ideal when printing a continuous gradient from black to white or printing line drawings.

    This type of dithering is applied when the Repro Desk option “Use Error Diffusion for Gray or Color RTL images” check box is selected.

    This option provides the same functionality as specifying the **R macro**.

  - **Ordered:** When Ordered is selected, dots are placed in a regular pattern to approximate the source pixel. A lighter source pixel is mapped to a pattern containing fewer pixels, while a dense pattern is applied for dark pixels. This is the default option for color and RTL printers. This option is ideal:

    - When printing in color
    - When printing drawings that contain fills
    - When printing photos.
    - When printing using the Océ 9800 series of printers.
    - When you want print output to resemble output from the Océ 9800 printers

    This option provides the same functionality as specifying the **Z macro**.
• **Reduce Coverage**: This option is mainly used with the 8845 printer. This is the same as selecting the **U macro**.

• **Raster Rendering**: Options selected here can also be selected from the Raster Imaging tabbed dialog box of the Printer Interface. For more information see page 8-35 of this user guide. The following options are available here:
  
  • **Printer Default**: Uses the rendering method selected in the Printer Interface.
  
  • **Diffused**: When Diffused is selected, dots are placed to approximate source pixels. The amount of "error" in the approximation is balanced with adjoining source pixels to better approximate the source image.

  This option is ideal when printing a continuous gradient from black to white or printing line drawings.

  This type of dithering is applied when the Repro Desk option “Use Error Diffusion for Gray or Color RTL images” check box is selected. This option provides the same functionality as specifying the **R macro**.

  • **Ordered**: When Ordered is selected, dots are placed in a regular pattern to approximate the source pixel. A lighter source pixel is mapped to a pattern containing fewer pixels, while a dense pattern is applied for dark pixels. This is the default option for color and RTL printers. Ordered Dither is also automatically applied when a Repro Desk job is imported into PlotWorks and the “Use Error Diffusion for Gray or Color RTL images” check box is not selected in Repro Desk. This option is ideal:

  • When printing in color
  • When printing drawings that contain fills
  • When printing photos.

  For printing output similar to Repro Desk raster output when the Repro Desk option “Use Error Diffusion for Gray or Color RTL images” check box is not selected. In this case select Ordered Dither from the Raster Imaging tabbed dialog box.

  • When printing using the Océ 9800 series of printers.
  • When you want print output to resemble output from the Océ 9800 printers

  • This option provides the same functionality as specifying the **Z macro**.

  • **Ordered Pattern Set**: Options are:
• **Printer Default:** Select this option to use the default Pattern Set used by the Printer Interface.

• **Normal:** Select this option to use the 64 Gray Level Order Dither Pattern Set

• **High-Res:** Select this option to use the 256 Gray Level Order Dither Patterns.

**Advanced Options:** Options are:

• **Invert:** Select Yes to print image colors inverted. This is the same as selecting the I macro.

• **Make Raster Pixels Solid Black:** Select Yes to print raster pixels solid black. This is the same as selecting the A macro.

• **Force Pens Solid on all Planes:** Select Yes to print all vector pens a solid color in each color plane, black, black and red, or CMY. This produces the same effect as when "Map pen colors to a shaded halftone" is not selected in Repro Desk. This is the same as selecting the X macro.

• **Force Even/Odd Polygon Fill:** Select Yes to use alternate or even/odd fills instead of the fill type specified in the HPGL2 file. This option is provided for Repro Desk support. This is the same as selecting the Y macro.

• **Resample All Monochrome TIFF:** Select Yes if you are printing:
  - Monochrome TIFF files, aerial photos, gray scale images, or scanned images and you want to improve print quality.
  - A portion of a monochrome TIFF file or a scanned image.
  - A monochrome TIFF file or a scanned image that is resized.

  This is the same as selecting the ~ Macro.

---

*Resampling all monochrome TIFF files dramatically increases computer processing requirements. This results in slower printing. Slower computers or those containing less memory may freeze if this option is selected.*

• **Sharpen Raster Blocks:** Select Yes to print raster images crisper when scaling.

**Overlays Tabbed Dialog Box**

This tabbed dialog box is used to apply and position overlays. Typical overlays include placing a title block, logo, or an approval stamp over an image. You can layer up to ten images on top of a base print.
Overlaying Images

For best results when applying overlays, make the overlays relative to the main image. Then if the base image is mirrored, enlarged or reduced the overlay is adjusted accordingly.

Making overlays relative to the main image:
1. From the Setup menu, click Preferences.
2. Click the Finishing Options tab.
3. Select the Make overlays relative to main image check box.

Overlays and base files must reside in the same directory.

Printing images with overlays:
1. Add your base and overlay images to the job ticket using the Add Files button.
   If you want to use a file as an overlay and print the file individually, you must add that file to the job grid twice.

PlotWorks supports the Windows “drag-and-drop” method of adding files. Simply drag the image files from the Windows Explorer window and drop them onto the Job Editor grid.

2. Set the quantity to X or 0 in the Qty (quantity) cell for each image that will be used as an overlay.
3. Select the base image by clicking on its row number on the grid.
4. Enter a quantity of 1 or more for the base image.
5. Click on the **Properties** button from the Job Editor tool bar to open the Detail Property Sheet.

6. Click on the **Overlays** tab.

7. You can overlay up to 10 files on the base image. Click on the first **Filename** drop down list and select the first file to use as an overlay. If you want to overlay a second file select it from the second **Filename** drop down list and so on.

   *If the file you wish to use as an overlay does not display in the drop down list, ensure it is listed in the job grid and that it is assigned a Quantity of X*

8. Position the overlay by entering an X and Y offset in the provided text boxes. Drawings are overlaid, by default, on the lower left corners.
   - **X Pos:** Enter the X coordinate for the origin of the overlay image (horizontal).
Y Pos: Enter the Y coordinate for the origin of the overlay image (vertical).

For an example of X and Y coordinates, please see the diagram “The default location of the X and Y origins” on page 4-23.

9. Repeat steps 7 and 8 for the next file to use as an overlay by selecting it from the second Filename drop down list and assigning it an X and Y coordinate. Repeat as necessary.

10. Save the job ticket and output the job to the printer. The overlay image(s) will print on the main image file.

Watermarks Tabbed Dialog Box
A watermark is usually a light line of text printed under the main file. A watermark is usually text such as Preliminary, Not for Construction, or a name. Below is an example of a watermark.

You can select the font, pattern number or percentage, and the position of the watermark.

To create a watermark:
1. Select a file in the job grid that you want to add the watermark to.
2. Click the **Watermarks** tab on the Detail Property Sheet.

3. Select the desired **Watermark Direction** by selecting one of the buttons provided. These buttons determine the direction the watermark prints across the page:

   - Lower left to upper right
   - Upper left to lower right
   - Top to bottom
Watermarks are always scaled to fit the page centered in the direction selected.

4. Enter up to 80 alphanumeric characters, to make up the watermark, in the **Watermark Text** box. Special characters like ASCII characters entered from the numeric keypad or CR/LF are not supported.

5. Click the **Font...** button to display the Font dialog box.

![Fig 4.23 The Font dialog box](image)

**PlotWorks currently supports Windows system fonts only. Other True Type fonts are not supported at this time.**

6. Select a font, style, and size for the watermark. Ensure that the selected font is available on the PlotWorks Server or the desired output may not be achieved.

7. Next select a pen color if you are printing to a color printer. Otherwise the default pen color (black) is used.
8. Select a pen pattern by entering a pattern number or percentage. If specifying a percentage include the percent symbol (%). Refer to the Pen and Pattern charts provided on the PlotWorks CD-ROM to select a pattern.

To print a watermark or label in red on HPGL/2, HPGL-RTL, PDF or PostScript files it is necessary to apply the "M" Pen Macro. For more information see page 4-32

9. Click **OK** to return to the Watermarks tabbed dialog box.

The text specified for the watermark displays in the watermark column of the job grid. You can save the watermark for future use. For more information see page 4-61.

### Margins Tabbed Dialog Box

The Margins tabbed dialog box is used to apply and adjust margins and position the image file on the medium.
Setting Margins and Justifications

1. Click on the Margins tab on the Detail Property Sheet.
2. **Justification**: Select the desired justification for the printed image by clicking on the appropriate button. Choices are:

   - ![Upper left](image)
   - ![Top center](image)
   - ![Upper right](image)
   - ![Center left](image)
   - ![Center](image)
   - ![Center right](image)
   - ![Lower left](image)
   - ![Bottom center](image)
   - ![Lower right](image)

   *Top refers to the top of the actual image and the leading edge of the printed image.*

3. Margins are measured in the selected units (inches, centimeters, or millimeters). Add a **Top, Bottom, Left** or **Right** margin by entering the desired margin width in the provided text boxes.
4. Select the **Finishing margin** check box to add a finishing margin (for binding) on the left side of the medium. This activates the **Finishing margin** text box. Enter the desired width for the finishing margin. This width is added to the extent of the image plus any edge margins set.

Once margin specifications are selected, they can be saved for future use. For more information see page 4-61.

Margins and scaling

The final media size is affected when applying margins depending on the scaling type selected.

- **Percent scaling**: If scaling to a percentage, the image itself will be the exact percent scale specified and the margins are added to it. If scaling to 75%, with 1” margins selected all around, the final print size will be the image shrunk to 75% of its original size and will have an inch margin all the way around.
**Final size scaling:** If scaling to a final size, the image is scaled down to a size that equals the final size minus any margins. For example, if scaling to a final size of 36 x 24 with 1" margins, the image extents will be 34 x 22, printed on 36 x 24 media. Margins are subtracted from the actual final media size and the image prints on the remaining media, thus reducing the final “image size.”

Fig 4.25
(A) Scale to Percent
(B) Scale to Final Size

<table>
<thead>
<tr>
<th>A.</th>
<th>B.</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image" alt="Diagram" /></td>
<td><img src="image" alt="Diagram" /></td>
</tr>
</tbody>
</table>

1 inch margins all around - media selected based on scale size plus margins

1 inch margins all around - image scaled to fit inside area left after margins

**Examples of different margin settings**

Fig 4.26
Image printed with no margin specified
The outlined blue rectangle in the image above, represents the image extent. Note how the image is centered on the media.

Setting margins increases the width and length of the image.

**Fig 4.27**
Illustration of an image printed with a 0.5 margin set on all sides.

**Fig 4.28**
Image printed with top-center justification. The image is centered horizontally, but is positioned at the top of the page.
This example below shows how a finishing margin is applied to the left side of the image. Notice that the width of the finishing margin is added to the overall image size.

Notice that the image below, which is upper-right justified, is cropped. The .5” margins plus the 1.0” finishing margin, in addition to the justification, cause the image to be larger than the actual medium. Change the Output Size or Specified Size, or select larger media, and try again.
Margins and justification are only applied if the Specified Size, which includes the image extents, plus margins, plus the finishing margin is smaller than the final Output Size (the actual medium) selected.
This tabbed dialog box is used to create and apply a single line text label. You can select the label font, style size, and position. You can also select a pen and pattern for the label.

**Default label is applied to the lower-left edge of media.**

**Rotation is applied relative to the lower left corner of the label.**
To create a label:

1. Click on the **Labels** tab of the Detail Property Sheet.
2. To offset the label from its starting point, the lower-left edge of the medium, enter the desired offset amount in the **X Pos** and **Y Pos** fields.
   - **X Pos**: X’ refers to the horizontal axis. Entering a positive number shifts the X position to the right while a negative one shifts the X position to the left.
   - **Y Pos**: Y’ refers to the vertical axis. A positive number here shifts the Y position up, a negative number shifts it down.

   *Entering a number larger than the actual medium size causes the label to snap to the edge of the medium. This is an easy way to offset the label to the opposite side of the medium. See example below.*

3. Label rotation is applied so that the label is never cut off. Select the desired degree of rotation relative to the lower-left corner of the label by clicking on one of the **Label Rotation** radio buttons. Choices are: 0, 90, 180, and 270.

4. Enter content for the label by either entering text in the **Labels text** box or use the **Label macros**.
   - **Label macros**: These are predefined macros that are used to enter commonly used information for labels. These macros can be combined.
with other label macros or any other text specified. The following label macros are available:

- Date: Adds the current date in month/day/year format.
- Time: Adds the current time in hour/minute/second format
- Filename: Adds the file name.
- Job: Adds the job name
- Set: Adds the number of print sets requested
- Image: Adds the image number as per the job grid. This is useful for troubleshooting purposes.

Click a Label macro button to enter the selected macro. The macro name, enclosed in square brackets ([Date]), will display in the Label text box, as shown on the screen shot on page 4-58.

- **Label text**: Enter up to 255 text characters for the label in this text box. If a label macro was also selected, it will appear in this text box as well. You can enter text of your choice before, or after each macro. This label data will appear in a single line when printed.

5. The **Label** group box displays the font style, type, size, color and pattern currently selected. To change any of these options, click on the **Font** button to open the Font dialog box.

- Select a font, style, and size for the label. Ensure that the selected font is available on the computer and is a Windows system font. Other True Type fonts are not supported.
- Next select a pen color if printing to a color printer. Otherwise the default pen color (black) is used.

---

HPGL/2, HPGL-RTL, PDF and PostScript files will not print Watermarks or Labels in red unless the "M" Pen Macro is specified.

- Select a pen pattern by entering a pattern number or percentage. If specifying a percentage include the percent symbol (%). Refer to the Pen and Pattern charts provided on the PlotWorks CD-ROM to select a pattern.

6. Click **OK** to return to the Labels tabbed dialog box.

You can save configured labels for future use. For more information see page 4-61.
Saving and applying options selected from the Detail Property Sheet

Saving and applying a Pen Set
You can save the pen sets you create in the Job Editor for later use in the same job ticket or in other job tickets.

To create and save a pen set:
1. Select the image from which you want to save the pen set, or open the Pens tabbed dialog box and create the desired pen set.
2. Open the File menu and select Save Pen Set.
3. Enter a name for the pen set. The Job Editor automatically adds a .PEN filename extension.
4. Select a directory in which to save your pen set and click on Save.

See also: “The Detail Property Sheet” on page 4-16.

Open an Existing Pen Set
You can create and save your own reusable pen sets in the Job Editor or Client. Once saved, pen sets are available for reuse in the same or other job tickets.

To apply a pen set to an image in a job ticket:
1. Select the image to which you want to apply the pen set. The Job Editor does not allow multiple selections for this command, but by applying it to the prototype you can cause all files added thereafter to take on that pen set.
2. Open the File menu and select Open Pen Set.
3. Select the appropriate pen set.
4. Click Open. The selected pen set replaces the existing pen values.

Saving and applying watermark, margin and label settings

Saving a watermark, margin or label setting
Once you have specified a watermark, margin or label from the Detailed Property Sheet, you can save the watermark, margin or label to use again. To do so:
1. Click on the File menu
2. Select **Templates**...
3. Click on either **Save Watermark**, **Save Margin**, or **Save Label** depending on what you are saving. The Save As dialog box opens.
4. From the **Save in** drop down list, select the directory you wish to save the configuration in.
5. Type a name for the configuration in the **File name** text box.
6. Click on the **Save** button.
Applying a Saved Watermark, Margin or Label

Once a watermark, margin or label is saved, you can apply it to any image. To do so:

1. Select the image you want to apply the configuration to from the job grid.
2. Click on the File menu
3. Click on Templates...
4. Select Open Watermark, Open Margin, or Open Label. The Open dialog box opens.
5. From the Look in drop down list, select the directory the configuration is saved in.
6. Double click on the saved configuration. The watermark, margin or label is applied to the selected file.
The Scale View

The Scale View is a diagram available from the View menu.

This window provides a visual representation of several printing parameters including:

- **Size**: A “before and after” comparison of specified size and output size.
- **Scale**: The percent of reduction or enlargement between the Specified and Output size.
- **Media type**: The color of the Output Size representation reflects the media type selected. Gray represents vellum, white represents bond, blue represents film, green represents T-bond, and red represents none.
- **Quantity**: The Output Size diagram shows the number of copies requested, up to three. If the quantity is greater than three, the bottom copy shown on the diagram is outlined with a dotted line.
- **Mirroring**: When the mirroring option is selected, the word “MIRROR” or the letters “MR” appear on the Specified Size diagram. The same letters appear reversed on the Output Size diagram.

The Scale View can be positioned anywhere on the desktop. Click and hold the mouse on the title bar of the Scale View window and drag it to the desired location. To close the Scale View, either select it again from the View menu or click on the square box in the upper-right corner of the Scale View window.
Setting Preferences

The Preferences dialog box is used to set job-wide preferences and record administrative data for the job ticket.

To set preferences:
1. Open the Setup menu and select Preferences.
2. Select a tab window by clicking on its tab.
3. Edit the fields as desired.
4. Click OK. If you wish to save this particular configuration for later use, select Save Configuration from the File menu. The information is saved to your configuration file (conf.plp) and used as the default for later job tickets that you create.

The Preferences dialog box contains the General, User Information, Finishing Options, and Nesting Options tab windows. These are described on the following pages.

General Preferences tabbed dialog box
The General Preferences tabbed dialog box contains the following options:

- **Size units**: Select the units of measure for use.
- **Pens**: Select the units of measure for pen values.
- **Default number of sets to request**: Enter the default number of sets to request when you output a job. This number can also be set in the Output Job dialog box.
- **Default file paths group box**: Options here specify the default directory for common functions
  - **Open jobs**: From this drop down list select a default directory to open jobs from. Choices available are:
    - **from the specified job path**: Selecting this option activates the Browse button below it. Click this button to browse and select a default directory to open jobs from.
    - **from last path used to open/save jobs**: When this option is selected, the last directory used to open jobs from or save jobs too is opened.
    - **from the last path used to add files**;
    - **from the current working directory**.
• **Add Files:** Use this drop down list to select a default directory to add files from. Choices available are:
  • **from the specified job path:** Selecting this option activates the Browse button below it. Click this button to browse and select a default directory to add files from
  • **from last path used to open/save jobs:**
  • **from the last path used to add files:**
  • **from the current working directory:**

• **Scan Files:** This drop down list is used to select a directory to place scanned image files into when the Scanner Interface is opened from the Job Editor. Choices available are:
• to specified scan path; Selecting this option activates the **Browse** button below it. Click this button to browse and select a directory to place scanned files too.
• to the last path used to open/save jobs;
• to the last path used to add files;
• to the current working directory.

**User Information Tabbed Dialog Box**

The User Information tabbed dialog box is used to specify administrative information that can be used for job tracking and accounting with the Advanced Reporting Utility (ARU). For more information on the ARU, see Chapter 10. This information is also included in job information (.INF) files, which are used to send additional information and instructions along with your print job. For further information on .INF files, see “Send a Special Instruction File” on page 4-67.

![User Information tab of the Preferences dialog box](image-url)
All fields are limited to 405 characters.

The Company, Project, Contact, and Comment fields are used when the job is output directly to a Job Queue to identify the job origination and provide additional information. The Company and Project information is displayed in the Job Queue’s **Description** field. The Contact information shows up in the Job Queue’s **Submitted by** field, after the computer name and user name (for the above example: \computer\user: Customer Support).

The computer name and user name can also be used by the Job Processor and Printer Interface to send processing error information and/or print confirmation if those options are enabled.

**Finishing Options**

![Finishing Options](image.png)
The Finishing Options tabbed dialog box is used to set folding and finishing parameters, to remove borders from images and reverse printing orders. See *Chapter 11 - Folder Information* for more information.

The Finishing Options tabbed dialog box contains the following fields:

- **Folding User Interface:** Use this drop-down list to select device specific folding options. Choices are:
  - **Default:** Select this option if you are not running a MAX 200 NACO or EO or a GFI folding device.
  - **MAX 200 NACO**
  - **MAX 200 EO.**
  - **GFI Folder**

Depending on what item is selected here, this tab window changes to display folder specific options. *Chapter 11 - Folder Information,* provides more information on folders.

- **Enable fold:** Select this box to enable a folder. Be sure the folder you are using is supported. You must select this box to enable other folding options.
- **Width:** Enter the fold width for the first fold in this text box. The measurement units specified on the General preferences sheet is used.
- **Add fold margin:** Select this check box to enable a fold margin and to enable the Punch and Reinforce options.
- **Margin:** Enter the desired fold margin width in the measurement units selected from the General Preferences sheet.
- **Cross-fold:** Select this check box to enable cross folding.
- **Punch:** Select this check box to enable hole punching. Select the **Add fold margin** check box to enable this option.
- **Reinforce:** Select this check box to add reinforcing strips to the margin. Select the **Add fold margin** check box to enable this option.
- **Tab:** This feature is currently unavailable.
- **Finishing macro:** Finishing macros are used to simplify sending special commands to the printer and/or folder. Additional information on folders and macros is provided in Chapter 11.
- **Remove borders from prints:** Select this check box to remove trim line borders from prints.

---

*The Reverse Standard Print Order option is generally used with printers that output sheets facedown. In this case, the first image listed in the job ticket winds up at the end of the set. If you reverse the print order, the first image listed in the job ticket ends up at the beginning of the set.*
• **Make overlays relative to main image:** Select this check box to scale or rotate overlays in relation to the main image.

### Nesting Options Tab

Nesting enables printing several images on one piece of medium to prevent media waste. For example, if D-size media is loaded, you can nest two C-size images so that they print side by side on D-size media.

The Job Editor select the medium that it can print most drawings on by default. If more than one media available allows the same number of drawings, the Job Editor uses the one that wastes the least media.

![Fig 4.41 Example of a nested print job](image)

| “B” size image | “A” size image | 2 images nested on “C” sized media |

To nest images:

1. Open the Setup menu.
2. Select Preferences.
3. Click on the Nesting Options tab.
4. Select Enable nesting.
5. Enter the Maximum images to nest (up to 100). This specifies when to start a new nested job. The default maximum nest length is 36 inches. To change this value, see page 8-19.
6. In the Border between nested images field, enter the amount of margin space you want between nested images.
7. Click OK.
**About Nesting**

Only drawings in the same job and set can be nested together. This keeps different jobs and sets separate.

All drawings in each nest are oriented the same way, depending on what allows more drawings and saves media. Drawings are placed across the width of the roll until no more fit (we call this “one stack”). Then the position of the next stack starts just below the previous one.

By default, the Job Editor will use the media entry allowing the most drawings. This does not always use the least media, however. For instance, if three 18"x12" drawings are printing on a 24" roll there will be an empty space of 18"x12" because the drawings do not nest evenly.
On a color printer, it is possible to have both color and black and white drawings in a job. It can be disadvantageous to nest these because the color prints take more time and use more memory.

**Media Override on Nested Jobs**

Use media override and the Printer Interface (at the service bureau or print server) re-nests the drawings to the best fit on the selected medium. The Printer Interface selects the paper size based on the first image in a group to be nested. If the first image is smaller than the following ones, clipping can occur.
Processing Options

The Processing Options tabbed dialog box is used to select how to process AutoCAD files, deal with processing errors, and what to do with files after processing.

To set processing options:
1. Click on the Setup menu
2. Select Processing Options.
3. Click on the appropriate tab.
4. Edit the fields as desired.
5. Click OK. The information is saved and used as the default for future job tickets.

The Processing Options dialog box contains the Processing, Size Tolerances, and AutoCAD/DWG Direct Setup tabbed dialog boxes. These are described below:

Processing tabbed dialog box

The Job Editor saves processed images in a special file format called Performance Graphics Standard (PGS). Options selected from the Processing tabbed dialog box determines what to do with the PGS files when a job is outputted.

Do not store archived files in the same directory as a PGS file! The Job Editor deletes files in the directory where PGS files are created. If files are stored in the same directory as a PGS file, if one of those files is added to the Job Editor, when the Job Editor is next closed all files in that folder, except for the PGS files, are deleted.
The following options are available from the Processing tabbed dialog box:

- **Send PGS files only:** When this option is selected, the Job Editor sends only the processed files to the output destination. The original image files are not sent.

- **Send original image files only:** When this option is selected, the Job Editor sends only the original image files to the output destination. The processed files are not sent. The Job Processor must be open and started to process these jobs.

- **Send both PGS and original image files:** When this option is selected, the Job Editor sends both the processed files and the original image files to the output destination.

Files transferred via FTP do not maintain their current date and time stamps. Therefore, **Send original image files only** or **Send PGS files only** are the only options available when FTP is the selected destination.

- **In directory:** Select this radio button to specify an existing directory to put processed files in. Please note that if this option is selected, no files should be stored in the same directory where the processing takes place as all files in this folder are deleted when the Job Editor is closed.
• **Below PLP file**: Puts the processed files in a subdirectory within the directory containing the job ticket. This selection assumes that a directory called Preproc already exists in this location. If you do not have a Preproc directory, select the **Automatically create preprocessing subdirectory** option to have the Job Editor create it for you.

• **Automatically create preprocessing subdirectory**: When this option is selected, the Job Editor creates a Preproc subdirectory within the directory containing your job ticket when the images are processed.

**Size Tolerances Sheet**

This sheet lets you specify a range of error within which Error Free Printing (EFP) corrects size and origin problems automatically on images submitted with an incorrect specified size. If a discrepancy exceeds the allowable range, the Job Editor warns the operator that attention is required before printing.

*If you submit an image using Auto Detected for the Specified size, the Size tolerances are not used.*

![Size Tolerances sheet](image)

The following fields appear on the Size Tolerances sheet:

• **Oversize %**: The allowable percentage that the ACTUAL size can be greater than the SPECIFIED size.

• **Undersize %**: The allowable percentage that the ACTUAL size can be less than the SPECIFIED size.

• **Offset origin %**: The allowable percentage that the ACTUAL origin can be offset while the size is within over/under size limits.
• **Big offset origin size %:** Compensates for printing specifications that are both offset origin and slightly over or undersized. As long as an image is within this amount of the specified size (over or under), then it will be printed regardless of how far off-origin it might be.

**AutoCAD/DWG Direct Setup Sheet**

The AutoCAD/DWG Direct Setup sheet tells the Job Editor how to do AutoCAD file processing. If you are not printing AutoCAD images, skip this part. For more information on processing AutoCAD files, please see **Processing AutoCAD Jobs** in Appendix H.

The following fields appear on the AutoCAD / DWG Direct Setup sheet:

- **Drawing is over-sized by percentage:** Enter an allowable error range for the specified print size. If an error is within this range, the Job Editor corrects it automatically and continues processing the AutoCAD file. When an error exceeds this range, the Job Editor requests operator attention.

- **Drawing is under-sized by percentage:** Enter an allowable error range for the specified print size. If an error is within the acceptable range, the Job Editor corrects it automatically and continues processing the AutoCAD file. When an error exceeds this range, the Job Editor requests operator attention.

- **AutoCAD path:** Enter the full path and filename of your AutoCAD executable.

- **Font search path:** Enter the full path/name of the directory that contains the AutoCAD font (.SHX) files used in the job.
• **Substitute font**: Enter the path/name of the substitute font to be used when a specified font is not available.

• **Use DWG Direct**: Select this if you want to use DWG Direct to process AutoCAD files.

• **Use AutoCAD**: Select this to use AutoCAD to process AutoCAD files. You must have AutoCAD installed and properly configured to use AutoCAD.
Adding Files from a Polled Directory

You can add files to the Job Editor from a specified polled directory, while using other PlotWorks functions. When a file is found in the polled directory, it is copied to a destination directory and added to the job ticket. The files are then deleted from the polled directory.

This function is useful when using Océ Power Logic driven scanners.

To use this function, first create the destination and polling directories.

Creating the Directories:

1. Right click on the Windows Start button.
2. Click on Explore. Windows Explorer opens.
3. Click on the Drive or Directory you wish to create the Polling directory in. For example, click on Local Disk (C:) to create the directory in the C drive.
4. Click on the File menu.
5. Select New
6. Click on Folder. A folder is added towards the bottom left of your screen named New Folder.
7. Right click on the **New Folder**.
8. Select **Rename** from the right click menu. The text New Folder is highlighted.
9. Type in a name for the directory to poll.
10. Repeat steps 3 to 9 to create the destination folder.
11. Close Windows Explorer

If the Polling directory is located on the same computer as PlotWorks, the directory needs to be “shared”.

**To Share a Directory:**
1. Right click on the directory you want to share.
2. Select **Sharing** from the right click menu.
3. Select the **Shared As** radio button.
4. Click on the **OK** button.

The directory is now shared.

**Using the Poll Directory Function:**
1. Click on the Job Editor **File** menu.
2. Select **Add Files**.
3. Click on **Poll Directory**. The Polling Directory Options dialog box opens.
4. The **Directory to Poll** text box is empty the first time this function is used, otherwise the text box displays the last directory polled. Click on the first **Browse** button to select a new Polling Directory. The Browse for Folder dialog box opens. Select the directory to poll. If you have not already created this directory, follow the steps outlined on the previous page and create a Polling and a Destination Directory before continuing. Click on the **OK** button. The Browse for Folder dialog box disappears and your Polling Directory is entered in the first text box.

5. The **Destination Directory** text box is empty the first time this function is used, otherwise the text box lists the last directory used. To select a new Destination Directory, click on the second **Browse** button. The Browse for Folder dialog box opens. Select the desired Destination Directory. Click on the **OK** button. The Browse for Folder dialog box disappears and your Destination Directory is entered in the second text box.

6. The **File Filter** text box is used to specify what file type to poll for. To select all files enter `*.*`. To specify only certain file types enter `*.` and then the file extension. For example to only poll for TIFF files enter `*.tif`. 
7. Select automatic file naming options from the File Name Generation and File Naming Options group boxes. Options include:

- **Prefix:** Enter text to make up the first part of the file name.
- **Suffix:** Enter text to use as the last part of the file name, before the file extension.
- **Don’t generate File name:** Select this radio button if you do not want a file name automatically assigned.
- **Prefix only:** Select this radio button if you only want a prefix assigned to file names.
- **Prefix with auto-increment:** Select this radio button if want a prefix and then an incrementing number assigned for the file names.
- **Prefix and suffix with auto-increment:** Select this radio button if want a prefix, then an incrementing number, and then a suffix assigned for file names.
• **Start number:** Enter a starting number for this polling session. This number becomes part of the file name.

• **End number:** Enter an ending number for this polling session. This is the last number used for the file name before the automatic numbering system rolls back to the starting number.

• **Next filename:** Text following this label, displays what the next file will be named.

• **Use original filename, adding a unique number if needed:** Select this radio button to use the original filename.

• **Prompt for manual entry of filename after each file:** Select this radio button if you prefer to individually enter a file name for each file.

• **Auto-generate a filename (don’t prompt after each file):** Select this radio button to automatically generate file names, using options selected in the File Name Generation group box.

8. Once you have selected your Directory Polling options and are ready to start polling, click on the **OK** button. A Polling Directory dialog box opens. If there are already files in the Polling Directory, they are added to the Job Editor. The progress bar on the dialog box illustrates the file transfer progress.

Every time a file enters the Polling Directory it is moved to the Destination Directory and added to the job ticket. The files are then deleted from the Polling Directory.

---

**Fig 4.49**
Polling Directory dialog box indicating the directory being polled

You can perform other tasks on the Job Editor while polling. However only one directory can be polled at the same time.
Duplicating file names while polling a directory

While polling, if a file has the same name as an existing file in the Destination directory or the Job Editor, a dialog box opens asking how you would like to handle the new file.

Click on the appropriate button to select what to do with the new file. Choices are:

- **Retry**: Select this button to retry adding the file.
- **Overwrite**: Selecting this button will replace the old file with the new one.
- **Specify Name**: Select this button to manually enter a name for the new file.
- **Auto-Rename**: Select this button to automatically rename the new file.
- **Ignore**: Selecting this button ignores the new file. The file is not added to the job ticket or to the destination directory.
- **Abort**: Selecting this button stops the polling process.

Select the check box labeled **Apply to all items**, if you want all files with duplicate file names handled in the same way during the polling session.

**Stopping Polling**

To stop polling click on the **Stop** button on the Polling Directory dialog box.
Adding Files from a Polled FTP Directory

You can add files to the Job Editor directly from a polled FTP directory while using other PlotWorks functions. When a file is found in the FTP directory it is copied to a destination directory and added to the job ticket. The files are then deleted from the FTP directory.

This function is useful when using AccXES Controller driven scanners.

To use this FTP polling function you must first set up your FTP directory, including the polling directory, user names and passwords, and create a destination directory.

Using the Poll Directory Function:
1. Click on the Job Editor File menu.  
2. Select Add Files.

3. Click on FTP Directory. The FTP Polling dialog box opens. This dialog box may contain information last entered. Edit this information as necessary.

The following information is entered in the FTP Polling dialog box:

- **User**: Enter the assigned user name.
- **FTP Server**: Enter the FTP address in this text box.
- **Port**: Enter your FTP port number in this text box, usually 21.
- **Password**: Enter the password assigned to the user.

- **Remote Directory to Poll**: Enter the complete path on the FTP server for the directory to poll. For example: `/public/mydirectory`

- **File Filter**: Enter the file type to poll for. To select all files enter `*.*`. To specify only certain file types enter `*.` and then the file extension. For example to only poll for TIFF files enter `*.tif`.

- **Remember Password**: Select this check box if you entered a password and want the application to remember your username and password so that you do not have to enter it each time.

- **Destination Directory**: Enter the path for the Destination Directory or click on the Browse button and select a path.

The File Name Generation and the File Naming Options group boxes contain automatic file naming options. These include:
• **Prefix**: Enter text for the first part of the file name.
• **Start number**: Enter a starting number for this polling session. This number becomes part of the file name.
• **Suffix**: Enter text for the last part of the file name, right before the file extension.
• **End number**: Enter an ending number for this polling session. This is the last number used for the file name before the automatic numbering system rolls back to the starting number.
• **Don’t generate Filename**: Select this radio button if you do not want a file name automatically assigned. Do not select this option when **Auto-generate a filename (don’t prompt after each file)** is selected, as this will create blank file names.
• **Prefix only**: Select this radio button if you only want a prefix assigned for file names.
• **Prefix with auto-increment**: Select this radio button if want a prefix and then an incrementing number assigned for file names.
• **Prefix and suffix with auto-increment**: Select this radio button if want a prefix, then an incrementing number, and then a suffix assigned for file names.
• **Next filename**: Text following this label, displays what the next file will be named.
• **Use original filename, adding a unique number if needed**: Select this radio button to use the original file name. A hyphen and a unique number is appended to the original file name when necessary.
• **Prompt for manual entry of filename after each file**: Select this radio button if you prefer to enter a file name for each file.
• **Auto-generate a filename (don’t prompt after each file)**: Select this radio button to automatically generate file names, using options selected in the File Name Generation group box.

4. Once you are ready to start polling, click on the **Start Polling** button. Polling options cannot be edited during Polling. If there are already files in the Polling Directory, they are added to the Job Editor.

When a file enters the FTP Polling Directory it is moved to the Destination Directory and added to the job ticket. The file is then deleted from the Polling Directory.
If you are running a XEROX WIDE FORMAT device using the AccXES controller, and a TIFF and a JPG version of the file is added to the Destination Directory every time a file is downloaded, disable the scanner’s preview option.

Appendix B lists all the errors that FTP Polling may generate.

---

You can perform other tasks on the Job Editor while polling. However only one directory can be polled at the same time.

---

**Stopping Polling**

To stop polling click on the **Stop Polling** button on the FTP Polling Directory dialog box.
Scanning from Twain Devices

You can scan images directly into the job grid from TWAIN devices. TWAIN is a standard method for communicating between software and image acquisition devices. The Kyocera Mita 4850 and the Xerox Synergix are Twain scanners. Most small format scanners are TWAIN devices. Please see Appendix F for more details.

PlotWorks supports monochrome, 8-bit grayscale, and 24 bit color images using TWAIN devices.

Before you can add images to a job from a TWAIN scanner, you must ensure that the scanner is detected by your computer.

Confirming your computer detects the scanner:

The instructions below assume you are running Windows XP. If not please consult your Windows or scanner documentation on how to confirm your scanner is detected. The steps involved will not vary greatly.

1. Click on the My Computer icon on your Windows desk top. The My Computer window opens.
2. Click on the Control Panel icon. The Control Panel window opens.
3. Click on Scanners and Cameras. The Scanners and Cameras property dialog box opens. If your scanner is properly installed and detected, it is listed in this dialog box. If not, follow the instructions below to add the scanner to your computer.

Adding a TWAIN imaging device to your computer:

1. Click on My Computer, then Control Panel, then Scanners and Cameras. This opens the Scanners and Cameras property dialog box.
2. Click on the Add button. The Scanner and Camera Installation Wizard dialog box opens. Follow the prompts this wizard provides until your scanner is properly installed.

There are many ways to add a scanner to your computer. If the instructions here did not work for you, follow the documentation provided by your scanner manufacturer.

Twain Scanning Options

The Twain Scanning Options dialog box is used to select file naming options for scanned images, and set other TWAIN scanning options.
Setting Twain Scanning Options

1. Click on the **Setup** menu.
2. Click on **Twain Options**. The Twain Scanning Options dialog box appears.
3. Enter values for options provided in this dialog box. The following options are available:

   **Scanning Options:**

   - **Show on scanner startup**: Select this check box if you want the Twain Scanning Options dialog box to appear every time you select **Acquire** from the TWAIN sub menu.
   - **Confirm file replacement**: Select this check box if you want a dialog box to warn you every time you are about to overwrite a file.
   - **Scan directory**: This drop down list is used to select a location to save scanned images to. This same option is available under **Default file paths** in the Setup Preferences menu. Changes made in either location is reflected in both places. For more information refer to Page 4-66 of this chapter.
   - **Specified Path**: This field and its associated **Browse** button is only enabled when “to the specified path” is selected in the Scan directory drop down list. The Browse button is used to specify the desired path.
File name Generation: Options selected here are used to create automatically assigned file names for scanned images.

- **Prefix**: Text entered in this text box is used as the file name prefix.
- **Suffix**: Text entered in this text box is used as the file name suffix.
- **Don’t generate file name**: Select this radio button if you do not want a file name automatically assigned.
- **Prefix only**: Select this radio button if you only want a prefix assigned for file names.
- **Prefix with auto-increment**: Select this radio button if want a prefix and then an incrementing number assigned for the file names.
• **Prefix and suffix with auto-increment**: Select this radio button if want a prefix, then an incrementing number, and then a suffix assigned for file names.

• **Start number**: Enter a number in this text box. This number is used as the first number for the automatic naming sequence. For example if the number 0 is entered here, the first scan will be named "Stadium0".

• **End number**: Enter the largest value you would like for the suffix number in this text box. When the automatic name generator reaches this number, it will roll back to 0. If you wish to roll back to a different number you will need to manually increment it.

• **The Next filename**: Text following this label displays what the next filename will be.

**File Naming Options:**

• **Prompt for manual entry of filename after each file**: Select this radio button if you wish the application to prompt you for a filename for each scan.

• **Auto-generate filename (don’t prompt after each file)**: Select this radio button if you wish the application to automatically generate file names using information entered in the Auto naming options group box.

**File format options**

• **Save as**: Select **TIFF** or **PDF** from the drop down list.

• **Extension**: Enter **tif** or **pdf**. The scanned image is assigned the file extension specified in this text box. This extension is automatically appended to all filenames even when not using the automatic naming feature.

4. When you have completed setting your options, click on the **OK** button.

**Adding images to the Job Editor from a TWAIN scanner:**

This involves two tasks. First you select the TWAIN scanner you wish to add images from and then you add the images.

**Selecting the TWAIN scanner:**

1. Click on the **File** menu.
2. From the File menu, select TWAIN. Under the TWAIN sub menu are two options:
   - **Acquire**: Gets images from the currently selected twain device.
   - **Select Source**: Shows a list of twain drivers on the machine and lets the user select one.

3. Click on **Select Source**. The Select Source dialog box opens listing all the TWAIN devices detected.
4. Select the scanner that you wish to acquire images from. If the scanner you want is not listed here you need to add the scanner to your computer. Refer to the instructions above on Adding a TWAIN imaging device to your computer.

5. Click on the Select button. The scanner is selected and the Select Source dialog closes.

**Acquiring images from a TWAIN scanner:**

Before you can acquire images from the TWAIN scanner you need to select the TWAIN source. Refer to the previous page for instructions on how to select your TWAIN source.

1. Click on the File menu
2. Select TWAIN.
3. Click on Acquire. Either the scanner manufacturers TWAIN scanner driver dialog box will open ready for scanning, or the TWAIN Scanning Options dialog box will.

   The TWAIN Scanning Options dialog box will only open if the **Show on scanner startup** check box is selected. Confirm the options selected are still desired. For more information on these options see “Twain Scanning Options” on page 4-88.

   Click on the OK button. The scanner manufacturers TWAIN scanner driver dialog box will now open for scanning.
Output to File

The Output to File option is used to save any file as a TIFF or PDF file. You can create multi-page TIFF or PDF files. All print parameters assigned in the job grid are included in the saved file including watermarks, overlays and labels.

To save a file as a PDF it is necessary to have purchased and installed the PDF Option

Using Output to File

1. Open the Job Editor if it is not already open.
2. Add the files you wish to convert to the job grid.
3. Select printing and size properties for each file.
4. Click on the File menu

5. Select Output to File from the File menu. This opens the Output to File dialog box.
6. Enter values for the following options:
• **Destination Path:** Click on the **Browse** button to select a folder to save the converted file/s in. Or enter the folder name and path in the text box.

• **Selected Files Only:** This option is only available if a file is selected (highlighted) in the job grid. Select this check box if you only want to convert the files currently selected in the job grid.

• **Use Original Filenames:** Select this check box to assign the same file name as the original file with either a TIFF or PDF extension. When this option is not selected, you are prompted to enter a name for each file.

• **Create PLP Job File:** Select this check box to convert the files into TIFF or PDF files and also create a print job using the converted files and the print parameters assigned in the job grid. When this check box is selected, the text box becomes available so that you can enter a name for the PLP Job file. The default name is Output.plp

• **Create Multipage Document:** Select this check box to save all the files as one multipage document. Each individual page of the multipage document retains its original size or if a size is specified in the job grid, each page is scaled to that size.

When Create Multipage Document is selected, the Multi Page Selected dialog box appears. This dialog box informs you that if a multipage document contains multiple final sizes, PlotWorks *may not* be able to print the files correctly.

![Multi Page Selected dialog box](image)

Clicking on the **Cancel** button will return you to the Output to File dialog box and **Create Multipage Document** will no longer be selected. Clicking on the **OK** button will return you to the Output to File dialog box. **Create Multipage Document** will still be selected and the text box next to it is now available for you to enter a name for the multipage file.

• **Format:** Select either **TIFF** or **PDF** depending on the file format you wish to save the file as. Depending on whether TIF or PDF is selected, different Compression options are available.
To save a file as a PDF it is necessary to have purchased and installed the PDF Option.

- **Compression**: From this drop down list select the desired compression type.
  
  TIFF compression choices:
  - **DEFAULT**: When this option is selected, the best compression based on the color model, bit depth, etc. is applied
  - **NONE**
  - **PACKBITS**
  - **GROUP 3**
  - **GROUP 4**: This is the default value.
  - **RLE**

  PDF compression choices:
  - **DEFAULT**: When this option is selected, the best compression based on the color model, bit depth, etc. is applied
  - **NONE**
  - **LOW**
  - **MEDIUM**: This is the default value.
  - **HIGH**

- **Resolution**: From this drop down list select the desired image resolution in DPI. Choices available are:
  - **200**: This is the default value.
  - **300**
  - **400**
  - **600**

- **Compress files into ZIP file**: Select this check box to compress the converted file/files into a compressed ZIP file so that the files are easier to send electronically and will occupy less drive space. When this check box is selected, the text box becomes available so that you can enter a unique name for the ZIP file. The default name is Output.zip

- **Disable ARU log**: Select this check box if you do not want to generate an ARU log for Output to File functionality. Otherwise an ARU log is created (if ARU file support is enabled). Information collected by the Output to File function is specified in the `rptPublisher.def` file.
7. Click on the **OK** button. If you did *not* select the **Use Original Filenames** check box, the Please enter a file name dialog box appears.

---

**Ensure you select a different name for each file or else you will overwrite a previously saved file.**

---

Enter a unique filename in the text box and click on the **OK** button. If the **Create multipage document** check box is not selected and there is more than one file to convert, the dialog box will continue to reappear until all the files are named.

The Outputting dialog box will appear to display the file creation process.

---

To cancel the process, click on the **Cancel** button.

---

The Process Cancelled dialog box will appear. You then have three options:

- **Yes**: Click on the Yes button to keep the created files.
- **No**: Click on the No button to delete the created files.
Resume: Click on the Resume button to resume the Output to File process.

If a problem occurs during this process an Error during processing dialog box appears. Click on the OK button or click on the View Log button to determine what the problem was.

Once all the files have been converted and saved successfully, the dialog box below will appear.

8. Click on the OK button.
Revision Highlighting

The Revision Highlighting function is designed to compare two image files and illustrate the differences between the two files. This is useful when you have two copies of the same file and you want to know if the files are identical or not.

To use the Revision Highlighting option it is necessary to have purchased and installed the Revision Highlighting Option Code.

Revision Highlighting only works when comparing HPGL and HPGL 2 files that are the same size, and are generated using the same software and driver. Revision Highlighting cannot be used with scanned in image files.

PlotWorks creates a file that illustrates the differences, if any, between the two files. This file is referred to as the Compared file. The Compared file is a TIFF file that can be viewed, saved or printed.

Because the changes indicated by the Compared file are displayed in color, it is best to confirm that the viewer selected to view TIFF files is a color viewer. Instructions on selecting viewers for various file types are provided on Page 4-10. The PlotWorks Image Viewer is not a color viewer. Therefore it will not show the differences between the two files.

Using Revision Highlighting

Only users logged onto the PlotWorks computer with Local Administrative rights can use the Revision Highlighting feature.

1. Ensure that the two files you wish to compare are listed in the Job Editor grid. If not, add the two files.

2. Click on the Revision Highlighting button or select Revision Highlighting from the Edit menu. The Revision Highlighting dialog opens displaying the Compare Configuration tabbed dialog box.
3. Click on the **Old Revision** drop down list. The drop down list displays listing all the files contained in the Job Editor grid.

4. Select the file you think is the older of the two files you want to compare.

5. Click on the **New Revision** drop down list. The drop down list displays all the files listed in the Job Editor grid.

6. Select the file you think is newer of the two files you want to compare.

---

*You can also select the two files you wish to compare in the Job Editor grid. Then click on the Revision Highlighting button. In this case the selected files will populate the Old and New Revision drop down lists when the Revision Highlighting dialog box opens. The first file listed in the grid populates the Old Revision drop down list. To reverse the two listings click on the **Reverse Order** button.*

7. Click on the **Compare** button. The generated Compared file is listed in the Job Editor grid and the selected TIFF Image Viewer may open displaying a preview of the Compared file.
Revision Highlighting Options

Before comparing the two files it is best to select if and where you want to save the Compared file, what files you will want to print, and whether to preview the Compared file or not. If you do not select these options before comparing the files the default settings are applied.

The Compare Configurations Tabbed Dialog Box

The following options are available from this dialog box:

- **File Settings options**
  - **Old Revision**: Select the older of the two files you wish to compare from this drop down list.
  - **New Revision**: Select the newer of the two files you wish to compare from this drop down list.
  - **Reverse Order**: Select this button if you wish to switch the files selected for Old and New Revision.
  - **Compare File**: This text box is used to enter a name for the Compared file. A default name is automatically provided. This is always Comp_ followed by the filename selected in the New Revision drop down list.
• **Batch compare:** Select this check box to compare multiple drawings. In this case, the first half of the images listed in the Job Editor grid are compared to the second half of the images. The first half of the files listed are considered the old files and the second half are considered the new files. Each pair of files is referred to as a set.

For example, if there are 6 files in the job there are 3 sets, File 1 is considered old and is compared to File 4, File 2 is compared to File 5, and File 3 is compared to File 6.

*It is necessary to have an even number of images listed in the Job Editor to use the Batch compare option.*

When **Batch compare** is selected the following options are unavailable: "Old Revision", "New Revision", and "Reverse order". Nor are you able to view files.

• **Subtractions Setup:** These options refer to items that are contained in the file specified as the Old Revision that are not included in the file specified as New Revision.
  
  • **Grey:** Select this radio button to display items contained in the Old Revision, not included in the New Revision, in grey. This is the default.
  
  • **Exclude:** Select this radio button if you do not want to display items contained in the Old Revision, that are not included in the New Revision.
  
  • **Specify:** Select this radio button to select a color to display items contained in the Old Revision, not in the New Revision. Use the provided drop down list to select the color.

• **Unchanged Setup:** These options refer to items that are unchanged in the Old Revision and the New Revision files.
  
  • **Black:** Select this radio button to display unchanged items in black. This is the default.
  
  • **Exclude:** Select this radio button if you do not want to display unchanged items.
  
  • **Specify:** Select this radio button to select a color to display unchanged items. Then use the provided drop down list to select the color.

• **Additions Setup:** These options refer to items that are contained in the file specified as the New Revision that are not included in the file specified as Old Revision.
  
  • **Highlight Color:** Select this radio button to display items contained in the New Revision, not included in the Old Revision, in your printers
highlight color. On the MAX 200 printer this is red. This is the default setting.

- **Exclude**: Select this radio button if you do not want to display items contained in the New Revision, that are not included in the Old Revision.

- **Specify**: Select this radio button to select a color to display items contained in the New Revision, that are not in the Old Revision. Use the provided drop down list to select the color.

- **Graphic Sample**: This part of the Compare Configuration tabbed dialog box contains graphics to intuitively illustrate how Revision Highlighting works and how the Compared file will display. As options selected under Subtractions and Additions Setup are changed, the image called Comparison changes to illustrate your choices.

**The File Configuration Tabbed Dialog Box**

Select this dialog box by clicking on the File Configuration tab of the Revision Highlighting dialog box.

The following options are available from this dialog box:

- **Save Compared File**: Options here are used to select if and where to save the Compared file.
  
  - **Don't save**: Select this option if you do not want the Compared file saved. The file is created in the preproc folder specified under the Setup pulldown menu in the Processing Options section of the Job Editor.
  
  - **Save with old rev**: Select this option if you want the Compared file saved in the same folder as the file selected as the Old Revision (see Page 4-101 of this chapter for more information).
  
  - **Save with new rev**: Select this option if you want the Compared file saved in the same folder as the file selected as the New Revision (see Page 4-101 of this chapter for more information).
**Specify location:** Select this option if you want to specify which folder to save the Compared file to. If selected enter the folder name and path in the text box below. You can either type in this information or you can use the provided Browse button to select the folder (The browse button is indicated by three tiny dots. To do so:

- Ensure the folder exists. If not use Windows Explorer and create the folder.
- Click on the **Browse** button. The Browse for Folder dialog box opens.
Navigate to the folder you wish to save the file in.

Click on the OK button. The Browse for Folder dialog box disappears and the selected folder and its path are listed in the Specify location dialog box.

**Print Settings:** These options are used to select which files to print once the files have been compared and Output is selected from the Job Editor

- **Compare file only:** Select this option if you wish to only print the Compared file. When this option is selected, and the files are compared in the Job Grid, an X will appear under Quantity for the files selected as Old and New Revisions and 1 is entered for the Compared file.

- **Compare file and old rev:** Select this option if you wish to print the Compared file and the file indicated as the Old Revision. When this option is selected, and the files are compared in the Job Grid, an X will appear under Quantity for the file selected as the New Revisions and 1 is entered for the Compared file and for the file selected as Old Revision.

- **Compare file and new rev:** Select this option if you wish to print the Compared file and the file indicated as the New Revision. When this option is selected, and the files are eventually compared, in the Job Grid, an X will appear under Quantity for the file selected as the Old Revision and 1 is entered for the Compared file and for the file selected as New Revision.

- **Compare file and both revs:** Select this option if you wish to print the Compared file and the both the files being compared once the
Comparison is made. In the Job Grid, 1 will appear under Quantity for all three files.

- **Viewing**: Select the Auto preview compared file check box if you always want to always view the Compared file.

### The Revision Highlighting Dialog Box Buttons

The following buttons are found on the Revision Highlighting dialog box:

- **Compare**: Select this button to compare the files listed in the Old and New Revision fields. The Compared file is added to the Job Grid. If the Auto preview compared file check box is selected, the Compared file displays in the Viewer.

#### When Batch Comparing

If the Batch compare option is selected, the Batch Compare dialog box displays providing the following information:

- The set number currently being compared and the total number of sets in the batch.
- The old revision filename
- The new revision filename
- The compared file filename.

![Fig 4.67 The Batch Compare dialog box](image)

Clicking on the Cancel button on the Batch Compare dialog box stops batch comparing. If a set had already completed being compared, its comparison file is added to the job grid.
When the batch comparison is completed the Batch Compare Finished dialog box appears displays whether each set was compared successfully. If a problem is encountered, it is reported here.

- **Cancel**: Closes the Revision Highlighting dialog box without saving the options selected.
- **Close**: Closes the Revision Highlighting dialog box saving the options selected.
- **Help**: Opens the Job Editor chapter (Chapter 4) of the User Guide.

**Possible error messages generated by Revision Highlighting**

- **Could not create output directory. Operation Aborted.**
  If the specified output directory does not exist the user is prompted to create it.

- **Couldn’t launch the Publisher because it could not be found.**
  The Publisher is not installed or not installed correctly

- **Couldn’t launch the Publisher because it is not registered properly.**
  The Publisher is not installed or not installed correctly

- **The file C:\Compare\Comp_v2.tif already exists. Would you like to overwrite?**
  - Click OK if you wish to overwrite the compared file.
  - Click No if you do not wish to overwrite the compared file. If No is selected the Operations canceled dialog box appears:

- **Operation canceled.**
The last operation being performed is canceled.

- **Please select an old and a new revision.**
  This occurs if an old and/or new revision file is not selected in the drop lists.

- **The PlotWorks image viewer does not support color tiff images.**
  This error occurs if auto view is checked and the Plotworks Image Viewer is set as the default viewer for tiff files.

- **There is no image data in either of the files. The images can not be re-aligned.**
  This message appears when both images are blank and **Re-align to first pixel** is selected.

- **There is no image data in the file [Filename]. The images cannot be re-aligned.**
  This message appears when one of the images is blank and **Re-align to first pixel** is selected.

- **Revision images are incompatible**
  This occurs when the two original images are different sizes.

- **The specified output directory C:\Compare doesn’t exist. Would you like to create it?**
  If the specified output directory does not exist the user is prompted to create it.

- **Unable to batch compare the job when it contains an uneven amount of images.**
  This occurs when there are an uneven number of images listed in the Job Editor and **Batch compare** is selected. To resolve this problem, click on the **OK** button. The Batch compare option is automatically deselected. Then edit the Job Editor grid so that an even number of files are listed and try again.
Process Image Files

All images in a job ticket must be processed before they are printed. Processing converts the images to PlotWorks’ proprietary file format, Performance Graphics Standard (PGS). During processing, the Error Free Printing function checks for inconsistencies between actual image data and specified printing parameters (unless set to Auto Detected or User Specified) and either corrects them automatically or requests operator intervention.

When you view an image, the Job Editor automatically processes it, if needed, before opening the PlotWorks Image Viewer (if an external viewer is being used, no processing is done).

You can process individual images, groups of images, or an entire job by selecting the Process button

The Process Job dialog box
When the Process button is selected the Process Job dialog box opens.

![Process Job dialog box](image)

The following options are available here:

- **Process selected files**: Select this check box to process only the files already selected in the job grid. This option is only available if a file is selected in the job grid. When this option is not available all files listed in the job grid are processed when the OK button is clicked. If this check box is not available and you wish to only process selected files, click the Cancel button, select the files to process and click on the Process button again.

- **Continue processing**: Select this option to automatically process required files as necessary.

- **Show all notices**: Select this option to display all processing notices. We recommend only using this option for trouble shooting purposes.

- **OK**: Click this button to start processing. The Job Editor processes the files and displays any warning or error messages that occur. If an error occurs, a warning dialog box may appear and you will need to select one of the following options:
• **Print Anyway**: This option continues processing a job that has been partially processed and ignores warnings that have already been okayed.

• **Skip Image**: This option tells PlotWorks to skip the image that contains the error or warning and continue with the next image in the job.

• **Halt Processing**: This option cancels the processing of all images in the job and returns you to the Job Editor screen.

• **Ignore all**: This option processes the entire job and ignores (automatically accepts) all Error Free Printing notices.

• **Cancel**: Select this option to close the Process dialog box without processing any files.
Viewing Image Files

You can view any image file listed in the job grid. Before you attempt to do so it is necessary to ensure you have selected what image viewer to use.

You can choose to use the PlotWorks Image Viewer for all image types by selecting Always use PlotWorks Viewer from the View menu. (See page 4-10.) Or you can choose a different image viewing software product for each type of image file by using the options provided in the Configure Viewers dialog box. See page 4-10.

The PlotWorks Image Viewer

The PlotWorks Image Viewer lets you view the files in your print jobs and make adjustments to the prints. You can access the Image Viewer from within the Client or Job Editor. The PlotWorks Image Viewer lets you:

- Zoom in and out.
- Show or hide individual pens (display only).
- Adjust the origin of the image.
- Adjust the output size.

More information on using the PlotWorks Image Viewer is provided in Chapter 4B of this User Guide.

The Windows XP Viewer

The Windows XP Viewer can also be used to view images from the Job Editor. When using this viewer to view TIFF images, do not rotate or change the image. This is because the XP Viewer will then automatically save the image in a format that PlotWorks does not support. To resolve this problem it will be necessary to open the image in a third party application like Adobe PhotoShop and then save the file, using no compression.

Viewing an image

To view an image listed in the job grid do one of the following:

- Double click on the image number in the job grid
- Select an image and then click on the View button
- Select an image and then click on the View menu and select View image.
Configure an Output Destination

If you are sending jobs over a local network or modem, or to a Queue directory from the Print Server, you must specify your destination and transmission mode. If you are sending your job to a disk, you do not need to configure a destination.

Configuring Multiple Destinations

PlotWorks supports multiple destinations. This makes it much easier to manage multiple Network Polling directories and multiple Job Queues. Configure the different destinations and then select it from the Send to: drop-down list when you are ready to output the job.

1. Open the Setup menu and select Configure Destinations. The Configure Destinations dialog box displays.

2. Click Add to display the Add Destination dialog box.
3. Enter a descriptive name in the **Destination name** field. This name appears as a selection in the Output Job dialog box.

4. Select one of the **Destination Type** radio buttons depending on what type of output destination you are setting up. Information on each Destination Type follows.

5. In the **Destination Path** field, specify a destination directory using the **Browse** button, or by typing in the UNC path (`\Computer\Shared Folder\Folder`).

6. From the Options group box, select options by clicking in the appropriate check box. Options available are:

   - **Send Additional Information from TEMPLATE.INF file**: Select this option if you wish to send information contained in the Template. INF file with the job ticket. The Template.INF is required if selecting this option.

   - **Prompt for user information on submission**: This check box is selected by default. User Information is automatically included in the .INF file. Selecting this option generates the User Information dialog box when the job is submitted for printing. This allows you to make final changes to the user information if required.

   - **Use dial-up networking to connect to destination**: Select this option if you wish to use Dial-up Networking and RAS/Dial-up Networking is installed and configured correctly. This activates the fields in the Dial-up Configuration group box. Select the destination phonebook entry, and enter your account and password in the appropriate fields. Appendix G contains more information on this subject.

---

**If the client is running on Windows 95 or 98, the client must notify the service bureau or the PlotWorks hub administrator if the network logon user name changes. This name must be changed at the receiving server as well before jobs can be sent.**

---

**If RAS is not installed, this field is disabled. RAS (Remote Access Service) is the Windows NT version of Dial-up Networking (Windows 95). RAS/Dial-up Networking must be installed (from your Windows NT or Windows 95 CD) and configured in the Windows operating systems for both the client (for sending) and server, or hub (for receiving). Refer to Appendix G “Configuring RAS to Output PlotWorks Job Files” or check with your Network Administrator for instructions.**
• **Compress all files into single file prior to submission:** Selecting this option compresses all files in the job grid and the PLP file into a single **PWC file**. This speeds up the file transfer process when submitting from the Job Client to a Network Polling Mode 2 or 3 directory. This option is only available when Network Poling is selected for destination type.

**PWC files** are compressed files that contain image files as well as the PLP file that make up a job. These files are created when **Compress all files into single file** is selected in the Job Editor or Client. If the PlotWorks DOS version is used, the files are compressed into a **PWJ file**.

7. Click **OK**.

**Destination Types**

The Job Editor takes different actions when outputting depending on the destination type selected. The following destination types are available:

- **Directory:** This option is used mainly for archiving files or sending them via RAS to a specified directory location. Subdirectories are not created. Therefore, if two files with the same name are submitted, one will overwrite the other. This option is not used for Network Polling directories as it does not support PGS files. Selecting this option disables the 'Compress all files into single file prior to submission' check box.

- **Network Polling:** This option sends your job to a target directory used by the Network Polling program or the DOS-based NetQuery program. When you send jobs to this destination, the Job Editor automatically creates a numbered subdirectory for your files within the polling directory. This selection is recommended for service bureau environments because it prevents remote users from directly accessing the Queue. This option should be used when submitting PGS files.

- **Job Queue:** This option sends your job directly to a Job Queue. When you send jobs to this destination, the Job Editor automatically creates a job directory for your files within the Queue directory. This selection is recommended for in-house industrial/architectural/engineering environments.

- **FTP:** This option lets you send your job to a polled directory on an FTP server. FTP uses the connection-oriented services of TCP to transfer text and/or binary files between a local host running TCP/IP and a host configured with an FTP server program. See “Installing FTP” on page G-531 for information on installing FTP service on the host server and client workstation, if necessary.
See also: “Output Jobs” on page 4-70.

To set up a local area network destination:

1. Open the Setup menu and select Configure Destinations. The Configure Destinations dialog box displays.
2. Click Add to display the Add Destination dialog box (see Fig. 4.38).
3. Enter a descriptive name in the Destination name field. This name appears as a selection in the Output Job dialog box.
4. In the Destination path field, either enter the path and directory to which the files will be sent, or use the Browse button. Be sure the network destination is accessible from the PC you are configuring before choosing this path.
5. Select a Destination type (see Destination Types above for more information).
6. Select Send additional information from Template.INF file if needed (Template.INF is required if selecting this option).
7. The Prompt for User Information on submission check box is checked by default. User Information is automatically included in the .INF file. When this box is selected, the User Information dialog box is generated when the file is submitted for printing. This allows you to make any final changes to the User Information before submission.
8. Click OK.

To set up a local Queue directory destination:

1. Open the Setup menu and select Configure Destinations. The following dialog box displays.
2. Click Add to display the Add Destination dialog box (see Fig 4.38).
3. Enter a descriptive name in the Destination Name field.
4. In the Destination Path field, either enter the path and directory to which the files will be sent, or use the Browse button. Be sure the network destination is accessible from the PC you are configuring before choosing this path.
5. Select Job Queue in the Destination Type field.
6. Select Send additional information from Template.INF file if needed (Template.INF is required if selecting this option).

A queue must exist before choosing it as a Queue destination. See “Create a New Job Queue” on page 3-82.
7. The **Prompt for User Information on submission** check box is checked by default. User Information is automatically included in the .INF file. When this box is selected, the User Information dialog box is generated when the file is submitted for printing. This allows you to make any final changes to the User Information before submission.

8. Click **OK**.

**Setting Up an FTP Destination**

File Transfer Protocol (FTP) allows you to transfer one or more files between the local client and remote host fast. It can handle larger files than e-mail and uses the Internet as its means of connection.

Use this destination type when the remote host requests that you transfer your files using FTP. See “Installing FTP” on page G-531 if you need help installing and configuring FTP on your workstation or setting up an FTP server.

In order to send job tickets from a client site using FTP, the client (Job Editor or PlotWorks Client) must have:

- TCP/IP installed on the end user’s computer
- A user account on the FTP server

To set up the client site, you need to know:

- The account name and password of the end user (who will be sending files)
- The host computer’s IP address. Then, in order to use a computer name, the LMHOSTS file must be configured on the client computer (see “Create an LMHOSTS File” on page G-526).
- Windows 95/98 or Windows NT 4.0 Workstation — check to make sure that TCP/IP is configured on your computer (see “Verify Current Configuration” on page G-501 or page G-10).

**Configuring PlotWorks to output jobs using FTP:**

1. Open the **Setup** menu and select **Configure Destinations**. The Configure Destinations dialog box displays.

2. Click **Add** to display the Add Destination dialog box (see Fig 4.38).

3. Enter a descriptive name in the **Destination name** field (optional). This name will appear as a selection in the Output Job dialog box.

4. Click on the **FTP** radio button to select it as the **Destination type**.

5. In the **Destination path**, first enter your **User Account name**. Then a colon (:), your **Account Password**, an @ sign, and finally the **IP Address** of the remote Print Server, i.e., **username:password@IP Address**.
Example: If the destination is using LAN, WAN or Dial-Up Networking, this information is required:

- FTP Username: PlotWorks
- FTP Password: smith
- Host’s IP Address: 131.107.2.2 (or computer name, if an LMHOSTS file has been configured)

Therefore you would enter in the Destination path:
PlotWorks:smith@131.107.2.2

Example: If the destination is using a proxy, the destination path will contain:

- Remote-Username: PlotWorks
- Host-Site: Xerox
- Remote-Password: smith
- Proxy Name or IP address (a name is usually used): printserver

Therefore, you would enter in the Destination path:
PlotWorks@Xerox:smith@printserver (see Fig 4.49).

6. Select the box that says Use dial-up networking to connect to destination.

7. Select the destination phonebook entry, and enter your account name and password in the appropriate fields.

8. Select Send additional information from Template.INF file if needed (Template.INF is required if selecting this option).

9. The Prompt for User Information on submission check box is checked by default. User Information is automatically included in the .INF file. When this box is selected, the User Information dialog box is generated when the file is submitted for printing. This allows you to make any final changes to the User Information before submission.

10. Click OK to save the configuration and close the dialog box.

When you are ready to send a job using FTP, click Output Job and select the FTP site as the destination (if it is not already selected). See “Output to FTP” on page 4-72 for more information.
Edit an existing Output Destination

1. Open the Setup menu and select Configure Destinations. The Configure Destinations dialog box displays.

2. Click on the destination you wish to edit. This makes the Edit button available.

3. Click Edit. This displays the Edit Destination dialog box.

4. This dialog box contains the same options as the Add Destinations dialog box. Simply make the edits you desire and then press on the OK button.
Delete an existing Output Destination

You may only delete a destination if you have more than one destination configured and listed in the Configure Destinations dialog box.

1. Open the Setup menu and select Configure Destinations. The Configure Destinations dialog box displays.

2. Click on the destination you wish to delete. This makes the Delete button available.

3. Click Remove. This displays a dialog box confirming that you wish to remove the destination.

4. Click Yes the destination is removed.
Sending Print Jobs

Send a Special Instruction File

You can specify within the Job Editor that you would like to send a job information (.INF) file with your job. This option requires that the TEMPLATE.INF file reside in your PlotWorks program directory, or in the directory from which you last added a file (the current directory). PlotWorks searches the current directory first.

A TEMPLATE.INF file is a customizable form that lets you attach additional information and instructions to your print job. The TEMPLATE.INF file is particularly useful in a service bureau setting, where many customers with different requirements are submitting jobs.

To create a TEMPLATE.INF file:

1. Open Notepad (click the Windows Start button, select Programs, then select Accessories).
2. Enter the questions that you want the .INF file to ask. End each sentence with either a ? or ^.

? Makes an optional question in the TEMPLATE.INF dialog box (you can click Next or OK without filling in the field).

^Makes a mandatory question in the TEMPLATE.INF dialog box (the Next and OK buttons remain grayed out until an answer is entered in the field).
3. Save the file as TEMPLATE.INF in the directory in which the PlotWorks Client or hub version of PlotWorks is installed. The default path is usually C:\Program Files\PLP\PlotWorks. For the Client, the default path is C:\Program Files\PLP\PlotWorks Client.
To send a TEMPLATE.INF file:

1. Open the Setup menu and select Configure Destinations. The following dialog box displays.

2. Click Add to display the Add Destination dialog box (see Fig 4.38).

3. Select Send additional information from Template.INF.

4. Click OK.

5. When you select Output to send your print job to a disk, network or modem, the TEMPLATE.INF file displays as the Special Instruction dialog box, shown below:

6. Click Next to proceed through the questions, or Back to return to the previous question. If the TEMPLATE.INF file requires you to answer a particular question, you cannot select Next or OK until you have entered a response.

7. When you have answered the last question, click OK. The job information file will be created and submitted with the job.
**Job Information**

If a job information file was submitted with a job, you can view this file from the PlotWorks Job Queue in the Job Information log. Jobs with Special Instructions attached display a blue and white “i” icon in the Job Queue.

**To view the job information file:**

- Double-click on the blue and white “i” icon, or:
  1. In the Job Queue, click the right mouse button on the job to display the Job menu.
  2. Select **View**. A second menu displays.
  3. Select **Job Information**.
  4. When you are finished viewing the information file, click **Exit** under the file menu.

See also: *Send a Special Instruction File* on page “Send a Special Instruction File” on page 4-67.

---

*Shortcut:* Select the job you want to view and click the **Job Information** button.
Output Jobs

The **Output Job** command lets you send your job ticket, image files, and information file (if any) to a Job Queue for processing and printing. You can send a job over a network, modem, or disk, or directly to the Job Queue.

Before you output a job, be sure that you have configured your output destination properly. (Refer to “Configure an Output Destination” on page 4-58.)

To output a job:
1. Click on the **Output** button.
2. Make your desired selections in the Output Job dialog box (shown above).

   The following options are available:
   - **Send to:** Select a destination for the job.
   - **# of sets:** Enter the number of sets you wish to print.
   - **Selected files only:** Select this box to print only the files.
   - **Reverse standard print order:** Select this box to reverse the order in which the software prints your sheets.

   *If files are sent using RAS/Dial-up Networking, the connection is made automatically by the Job Editor. If the modem is being used by another program, the connection will fail.*
- **Folding Options**: Click this to generate the Folding Options dialog box to configure folding margins, cross-folds, etc., before outputting your files. The folding functionality controlled through the Folding Options dialog box is exactly like that found in the Preferences/Finishing Options tab window. More information on these options are provided on 4-68.

![Folding Options dialog box](image)

- **Continue processing**: Select this option to tell PlotWorks not to display warning messages which have already been displayed for an image and okayed by the user.

- **Show all notices**: Select this option to tell PlotWorks to show all warnings, even if they have been okayed.

---

**The Processing options are available only when you have chosen to send PGS files.**

- **Job priority**: Enter a number between 1 and 10, with 10 being the highest priority. This value determines the order in which jobs are printed.

- **Device #**: Select the printer’s device number. This number is defined in the Printer Interface program, in the Printing Configuration dialog box under the Setup menu. If there is only one printer, or you do not care which printer is used, select Any.

- **Place job on hold**: Select this to send the job to the Queue with a Hold priority. The job will not print until you change its priority in the Queue.
• **Ignore warnings:** Select this to print the job regardless of processing warnings. Warnings are ignored only by the Job Processor. If the Job Editor processes the files, all warnings will display, unless you choose “Continue Processing” and have already processed or viewed the file and okayed the warnings.

• **Use set memory:** (Xerox MAX 200 and 8180, Océ 9800) Set memory allows the job request to be sent to the set memory of a printer instead of sending each set over again. In some cases, this function speeds up the printing process.

3. Click **OK** to send your job.

### Output to FTP

FTP uses the connection-oriented services of TCP to transfer text and/or binary files between a local host running TCP/IP and a host configured with an FTP server program.

1. Make sure you have configured FTP as the destination. “Configure an Output Destination” on page 4-58.

   When outputting jobs to FTP, be sure to select **Send original image files only** or **Send PGS files only** on the Processing Options sheet. This is due to the fact that the date/time stamp on files is not maintained when sending via an FTP connection.

2. In the Job Editor grid, select the file or files you wish to send.

3. Click the **Output** button or select **Output Job** from the **File** menu. The Output Job dialog box appears.

4. Select the FTP destination and other desired options and click **OK**.

   A connection is made between your computer and the remote server, using the FTP protocol and RAS/Dial-up Networking as needed, to connect to the remote machine.

5. The Transfer Job progress box displays the progress after each file is transferred. The destination progress bar indicates when the job is done. Once your files have transferred, the connection disconnects.

   *The transfer of your files is taking place over a phone modem so it is only as fast as the modem speed. Therefore, the larger the file the longer it will take.*
Chapter 5

The Image Viewer

Viewing Image Files

The PlotWorks Image Viewer lets you view and adjust files in your print jobs. You can access the Image Viewer from within the Job Editor or the Scanner Interface.

You can also view images using the Printer Interface but you cannot use the Adjust Size and Adjust Origin editing functions using the Printer Interface.

When you view a file from the Job Editor, the Job Editor processes the selected image and displays it in the Image Viewer window. The Viewer lets you:

- Zoom in and out as you move through the files in a job
- View a file simply by clicking on it in the Job Editor Grid, and then move through all the files in a job with the touch of a button.
- Print the file you are viewing with the touch of a button
- Show or hide individual pens (display only)
- Identify a specific pen
- Adjust the origin of the image
- Adjust the output size
- View the image using a white or black background
- View all pages of a multipage TIFF, HP-GL/2, PostScript or PDF file

The Job Editor’s View menu has an option, **Always Use PlotWorks Viewer**, that forces the PlotWorks Image Viewer to open when you select View Image, regardless of the format. Otherwise, you can configure third party viewers to display selected file formats. For instance, you can configure the Job Editor to open Adobe’s Acrobat Reader when you select View Image on a .PDF file. See “Configure a Third Party Viewer” on page 4-9 for more information.

Open the Image Viewer

You can view the images in your job tickets and adjust them before printing using the Image Viewer.
To open the Image Viewer in one of two methods:

- Double-click on the selected file in the Job Editor
- Select the image you want to view in the Job Editor. Then click on the Job Editor View button.

The Job Editor processes the image and displays it in the Viewer outlined with a red and white border.

The Viewer Window

![Image Viewer Window](image.png)

**Toolbar Buttons**

The following buttons appear on the Image Viewer toolbar:

- **Zoom All**: Fits the entire image in the Viewer window.

- **Zoom Out**: Reduces the display by 50%.

- **Zoom In**: Lets you enlarge a selected area of the display.

- **Adj. Size**: Lets you select a portion of the image to print.
• **Adj. Orig:** Lets you set the origin of the image.

• **Black:** Reverses the background of the displayed image to black, making it easier to view certain colors. For viewing only; black does not print.

• **Identify:** Lets you identify the pens used in a specific area of the image.

• **First:** Displays the first page in a multipage TIFF, PDF, or PostScript image file.

• **Previous:** Displays the page before the current page on the screen.

• **Go To:** Lets you view a specific page in a multipage image file.

• **Next:** Displays the next page in a multipage image file.

• **Last:** Displays the last page in a multipage image file.

• **Prev File:** Displays the previous file in the job.

• **Next File:** Displays the next file in the job.

• **Print:** Click this button to immediately print the image open in the viewer.

---

*To print from the Image Viewer, you must first open the Job Editor or Job Client Processing Options Processing tab window and select either the **Send PGS File Only** or the **Send Both PGS and Original Image Files**.*
5.5.1 The File Menu

Fig 5.2
The File menu

- **Print**: Click this menu item to immediately print the image you are viewing.
- **Exit**: Quits the application.

The Edit Menu

Fig 5.3
The Edit menu

The Edit menu contains commands for editing the image’s parameters. The following commands are available under the Edit menu:

- **Adjust Size**: Lets you select a portion of the image to print.
- **Adjust Origin**: Lets you set the origin of the image.

The View Menu

Fig 5.4
The View menu

The View menu contains commands for changing the appearance of the Viewer window and the displayed image. The following commands are available under the View menu:

- **Toolbar**: Lets you hide or show the toolbar.
• **Status Bar:** Lets you hide or show the status bar.
• **Dialog Bar:** Lets you hide or show the dialog bar.
• **Ruler:** Lets you hide or show the ruler. The units of measure shown on the ruler reflect the units set in the Job Editor preferences.
• **Pixel Ruler:** Changes the ruler units to pixels.
• **Go To Page:** Lets you view a specific page in a multipage image file.
• **Zoom All:** Fits the entire image in the Viewer window.
• **Zoom In:** Lets you enlarge a selected area of the display.
• **Zoom Out:** Reduces the display by 50%.
• **Stop:** Stops the viewing area from painting. This command is useful when you mistakenly zoom in or out of a complex image and do not want to wait for the Image Viewer to redraw the entire image.

### The Image Menu

![Image menu with buttons: Black Paper, Identify Pens](image)

This menu contains commands that let you reverse the white background of the viewed image to black and to identify the pens used in an image.

• **Black Paper:** Lets you change the white background of the Image Viewer to black (black pens are inverted to white). This is useful if you want to locate white or light colored pens in a vector file. Raster files do not invert and will display as all black.

• **Identify Pens:** Lets you move a “locator” cursor over the displayed image (vector images only) and click to identify the various pens used in an area of the image.
The Help Menu

This menu contains commands for accessing online Help files and program information. The following commands are available under the Help menu:

- **Online Manual**: Opens the online manual to the Viewer chapter
- **Index**: Displays the index of help topics
- **Table of Contents**: Displays the table of contents for the online manual
- **Release Notes**: Displays late-breaking product enhancements and documentation changes.
- **About**: Displays program version and copyright information.

The Viewing Area

The viewing area displays the selected image and shows how it fits on the page at the specified size. You can crop or reposition your images by using the Adjust Size command or the Adjust Origin command.

- **Adjusted Size**: The final size of an image, as adjusted by the user in the Image Viewer window. The Adjusted Size box in the Viewer shows:
  - Size X/Size Y
  - Origin X/Origin Y

- **Specified Size**: The final size of an image, as specified by the user in the job ticket. The Specified Size box in the Viewer shows:
  - Size X/Size Y
  - Origin X/Origin Y

- **Original Size**: The actual size of the image as read, by PlotWorks, from the image file. The Original Size value is fixed and will not change. The Original Size box in the Viewer shows:
  - Size X/Size Y
  - Origin X/Origin Y
**Zoom In or Out**

You can enlarge or reduce the image in the viewing area using the three zoom buttons:

- To fit the entire image in the viewing area, click **Zoom All**.
- To zoom out by 50%, click **Zoom Out**.
- To zoom in by 50%, click **Zoom In** and then click once inside the viewing area.
- To zoom in on a specified area, click **Zoom In** and select the area by dragging with your mouse.

**Adjust the Size of a Print**

The Adjust Size command lets you change the Final Size of your printed sheets from within the Viewer. The Adjust Size command is helpful for cropping images.

*The Adjust Size command does not scale the image to fit the area you specify. If your adjusted size is smaller than the extent of the image, the image will be cropped.*

**To adjust the size of an image:**

1. Click **Adj. Size** on the Viewer toolbar. The cursor is outside the image, it changes to a hand: ⤴
2. Click and drag on the image to form a rectangular border around the area you want to print.
3. Use **Adj. Orig**, if necessary, to position the printing area and to fine-tune the edge positions.

**Adjust the Origin of a Print**

The Adjust Origin tool lets you change the origin of your image. In addition, this tool lets you precisely adjust the edges of your printing area.

**To adjust the origin of the printing area:**

1. Click **Adj. Orig**. If the cursor is outside the image, it changes to a hand: ⤴
   - If the cursor is inside the image, it changes to a “crossed arrows” icon:
2. Drag the printing area (displayed as a black and white rectangle) to the desired position.
When the Adjust Origin tool is selected, each edge and corner of your printing area displays a handle. You can use these handles to resize the printing area and place the edges at the exact coordinates you want.

**To adjust the edges of your printing area:**
1. Zoom in on the edge or corner you want to adjust.
2. Drag the handle to the desired location with your mouse.

**Black Paper**
The Black Paper option lets you change the white background of the Image Viewer to black. This makes it much easier to view lighter colors like yellow and orange. The “black” paper is active only when viewing the image – it does not print the image on a black background. It is only for vector images (raster images become completely black).

**To enable Black Paper:**
1. Click Black (or select Black Paper from the Image menu).
2. The image background changes to black.

**To disable Black Paper:**
- When you want to turn Black Paper off, click the Black button to deselect it.

**Show or Hide Pens**
The Job Editor lists the pens used in the image on the left side of the Viewer window. You can remove one or more pens from the viewing area by choosing a pen from the list and then clicking Hide. Click Show to make the pen reappear.

*Hiding pens in the Viewer window does not remove them from the print.*

**Identify Pens**
Identify Pens is a handy feature that lets you move a “locator” cursor over the displayed image (vector images only) and identify the various pens used in the image.

**To identify pens in the image:**
1. Click Identify (or select Identify Pens from the Image menu).
   The cursor changes to a small square.
2. Move the cursor over the image displayed in the Viewer. Click on the line your want to identify. The pen number displays in a pop-up box.
3. Turn off the Identify feature by clicking any other button to deselect it.
Refresh the Viewer Window

The **Refresh Viewer** command updates the Image Viewer window to reflect any changes made in your job ticket.

To refresh the Viewer:
1. Select the **Job Editor** window to make it active.
2. If you have more than one Image Viewer window open, select the image that you want to update.
3. Open the **View** menu and select **Refresh Viewer**.

Configure a Third Party Viewer

PlotWorks supports the use of third party image viewing applications. PlotWorks defaults to a Windows standard viewer for TIFF, BMP, DCX, JPG, XIF, and PCX images, and the PlotWorks Image Viewer for all other formats except **User-specified**. If your Windows operation system is Windows NT the standard viewer is the Wang/Kodak Imaging viewer. If running Windows XP it is the Windows XP Viewer.

You can elect to have the Job Editor always use the PlotWorks Image Viewer (select **Always Use PlotWorks Viewer** from the Job Editor’s **View** menu) or you can define a different viewer to use. You could use a different viewing application for each file format if you choose.

To configure additional viewers:
1. Open the Job Editor’s **Setup** menu and select **Configure Viewers**. The Configure Viewer dialog box appears.

2. Use the **Data type** pull-down menu to select the data type to view with this viewer. See “Data Format Tabbed Dialog Box” on page 4-27 for supported data types.
3. Use the **Viewer path** pull-down menu to select PlotWorks Image Viewer or Wang Imaging, or click ![button] to browse for the desired viewer. For example, you might want to select AutoCAD’s AutoView to view DWG files before printing them.
Chapter 6

The Network Polling Program

The Network Polling program searches a set of directories for print jobs received over a local network or modem. These directories, called target directories, can reside on the PlotWorks computer or on any network drive. When Network Polling finds jobs, it sends them to the Job Queue for automatic processing and printing.

When using Network Polling, ensure the Job Processor is open. If you do not start the Job Processor first, the job is submitted to the Job Queue but will not print.

Advantages of Network Polling

- Network Polling accepts individual image files with ASCII text order forms, therefore users can submit jobs from any computer without using Repro Desk, the Job Editor or Client.
- Network Polling offers additional security. Users can submit jobs to a target directory, without directly accessing the Job Queue.
- Network Polling moves jobs from the target directory, to numbered subdirectories in the Queue Directory. This prevents jobs with the same name from overwriting each other.
The Network Polling Window

**Fig 6.1**
*Network Polling*

### The Network Polling Toolbar

- **Start:** Starts polling target directories for incoming jobs.
- **Stop:** Stops the polling process.
- **Add Dir:** Is used to add a target directory.
- **Delete:** Deletes the selected target directory.
- **Modify:** Is used to make changes to the selected target directory.
- **Params:** Is used to modify printing parameters for the selected target directory.
- **Options:** Is used to specify the log file location, PFS editor, and the polling frequency.

<table>
<thead>
<tr>
<th>Directory</th>
<th>Filename</th>
<th>Count</th>
</tr>
</thead>
<tbody>
<tr>
<td>C:\Program Files\PlotWorks\Polling</td>
<td>*.PLS</td>
<td>0</td>
</tr>
<tr>
<td>C:\Program Files\PlotWorks\Polling</td>
<td>*.PLP</td>
<td>0</td>
</tr>
<tr>
<td>C:\Program Files\PlotWorks\Polling</td>
<td>*.PFS,*JOB</td>
<td>0</td>
</tr>
<tr>
<td>C:\Program Files\PlotWorks\Polling</td>
<td>UPLOAD.DIR</td>
<td>0</td>
</tr>
</tbody>
</table>
Network Polling Menus

The File Menu

The following options are available under the **File** menu:

- **Start Polling**: Begins polling target directories for incoming jobs.
- **Stop Polling**: Stops the polling process.
- **Exit**: Quits the application.

The View Menu

The following viewing options are available here:

- **Status Bar**: Click here to display or hide the status bar at the bottom of the Network Polling window. A check mark next to this option indicates that the status bar is currently visible.
- **Toolbar**: Click here to display or hide the tool bar. A check mark next to this option indicates that the tool bar is currently visible.

The Setup Menu

The Setup menu contains options for polling, target directories, the Log file, and default parameters. The following options are available here:

- **Add Directory**: Is used to add a target directory for polling.
- **Delete Directory**: Is used to delete the selected target directory.
- **Modify Directory**: Is used to edit options for the selected target directory.
- **Edit Parameter File**: Is used to edit default printing parameters for the selected target directory.
**Fig 6.4  
Network Polling Setup menu**

<table>
<thead>
<tr>
<th>Setup</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Add Directory...</td>
<td>Insert</td>
</tr>
<tr>
<td>Delete Directory..</td>
<td>Delete</td>
</tr>
<tr>
<td>Modify Directory..</td>
<td>&lt;Enter&gt;</td>
</tr>
<tr>
<td>Edit Parameter File</td>
<td></td>
</tr>
<tr>
<td>Edit Default PFS File</td>
<td></td>
</tr>
<tr>
<td>Polling Options...</td>
<td></td>
</tr>
<tr>
<td>View Log</td>
<td>Ctrl+L</td>
</tr>
</tbody>
</table>

- **Edit Default PFS File:** Is used to modify the master PFS file that is used to create the directory PFS files (also referred to as parameter files).
- **Polling Options:** Is used to specify the location of log file and the PFS Editor, as well as select the polling frequency.
- **View Log:** Displays the file NETPOLL.LOG, that records incoming job information.

**The Help Menu**

**Fig 6.5  
Network Polling Help menu**

<table>
<thead>
<tr>
<th>Help</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Online Manual</td>
<td>F1</td>
</tr>
<tr>
<td>Index</td>
<td>Shift+F1</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>Ctrl+F1</td>
</tr>
<tr>
<td>Release Notes</td>
<td>Ctrl+Shift+F1</td>
</tr>
<tr>
<td>About Network Polling...</td>
<td></td>
</tr>
</tbody>
</table>

The Help menu provides information about the Network Polling Program and how to use it. The following topics are available under the Help menu:

- **Online Manual:** Opens the Network Polling chapter of the manual.
- **Index:** Displays the help index
- **Table of Contents:** Displays the table of contents for the online manual
- **Release Notes:** Displays late-breaking product enhancements and documentation changes.
- **About Network Polling...:** Displays program version and copyright information.

**Columns**

The following columns display on the Network Polling window:

- **Directory Column:** Displays the name of the target directory.
- **Filename Column:** Displays the type of files being polled (e.g., job tickets [*.PLP], PFS files [*.PFS], or a specific image file format).
• **Count Column**: Displays the number of files detected in the directory.

**To change the width of the columns:**

1. Place your cursor on the right-hand edge of the column you want to resize, next to the column heading. The cursor changes to a vertical bar crossed by a double-headed arrow.

2. Drag the cursor until the column is the desired width. You can also double-click on the right side of the column header to expand the column.
Setting Up Network Polling

Set Polling Options

Before you begin polling for print jobs, you need to set up Network Polling.

To set Network Polling options:

1. Click Options.

2. Fill in the fields in the Polling Options dialog box as follows:
   - **Log Filename:** The path and name of the log file that Network Polling creates.
   - **PFS Editor:** The path and filename of the application to be used to edit parameter and PFS files (for example; c:\Winnt\Notepad.exe).
   - **Poll Every . . . Seconds:** The number of seconds the Network Polling program waits between consecutive polls. Once Network Polling has queried all of the target directories, it waits this amount of time before repeating the process.
   - **Sort files by:** The order in which multiple files are inserted into a single job. The sorting is determined either by name or modified time.

3. Click OK.

Your polling options and directory setups are saved in the registry, not in the netpolling file. You should back up this file periodically to save your program configuration.

Add a Target Directory

When polling is started, Network Polling scans target directories for print jobs and sends any found print jobs to the Queue.
To add a polling directory:

1. If Network Polling is started click the Stop button on the Network Polling toolbar.


3. Select options from the Add Directory dialog box as follows:

   - **Polling Path**: Enter the path and name of the target directory you wish to add, or click Browse to locate it. If the directory does not already exist, the software prompts you to create it.

   - **Files of type**: Enter a value in this field only if you are going to poll the target directory for single image files (Polling Mode 1, see page 6-9 for more information). In this case enter the type of image files you wish to search for, using a star (*) as a wildcard. You can enter up to six file types. Separate each file type with a semicolon: For example:
- to poll for AutoCAD .DWG files only, enter *.DWG.
- to poll for all files, enter *. In this case, all incoming files are polled.
- To exclude certain file types from a wildcard search, enter a minus sign before the file type(s) to exclude. For example to poll for all files except for Text and Word files enter: */.*; -*.txt; -*.doc
- to poll for only DWG and TIFF files enter *.DWG; *.TIF.
- **Default PFS file:** Enter the path and name of the Directory PFS file. This file provides default printing parameters for Mode 1 and Mode 3 target directories.

By default, Network Polling uses a copy of the Master PFS file (DEFAULT.PFS) for the Directory PFS file. The DEFAULT.PFS file is located in the PARAM subdirectory. To modify the Directory PFS file, stop Network Polling, right-click on the directory and select Edit Parameter File. You can also click the Prams button on the tool bar.

- **Queue Directory:** Enter the path and directory for the Job Queue the polled files should be sent too. You can also select this directory by clicking on the Browse button.

- **Destination Device:** Enter a descriptive name for the output destination (optional).

- **Device #:** Select either Any or the number of the printer to send jobs too. This number is defined in the Printer Interface (See “Set General Printing Options” on page 8-10).

- **Maximum Files:** Enter the maximum number of image files to remove from a Mode 1 directory and place in a single job.

- **Age Timeout:** The number of seconds Network Polling should wait before processing a group of files as a job when there are fewer files than the value selected for Maximum Files.

This option is provided so that when a group of files is submitted to a Polling Mode 1 directory the application knows when all of the files have been sent. If Network Polling finds one or more files in a Mode 1 directory, it waits the full Age Timeout period before sending the files to the Queue. If no additional files arrive in the directory during the Age Timeout period, Network Polling considers the job complete and submits the files to the Job Queue. If additional files appear in the directory during the Age Timeout period, Network Polling restarts the count.
• **Priority**: Select a print priority number from 1 (lowest priority) to 10 (highest priority). Jobs with higher priorities are printed first.

• **Enable Polling**: Select this check box to poll the directory when the **Start Polling** button is clicked. This check box is selected by default. When this check box is deselected the directory will not be polled.

*When Enable Polling is deselected, the stop sign icon displays next to the target directory in the Network Polling window. The stop sign icon also appears if a target directory becomes unavailable while polling. When the directory becomes available the target directory is automatically re-enabled and the stop sign icon disappears. However, if the Stop Polling button is clicked while polling, polling is stopped and the stop sign icon disappears even if the directory is still unavailable. If the directory is still unavailable when Network Polling is started the stop sign icon re-appears.*

• **Submit on Hold**: Select this option to place all jobs sent using Network Polling on Hold in the Job Queue. The jobs will not be printed until they are assigned a new priority within the Queue.

• **Ignore Warnings**: Select this check box if you wish to print the job ignoring any noncritical processing errors that may occur.

• **Use set memory**: This option is relevant only when printing on the Xerox MAX 200, 8180, or the Océ 9800. Select this option to use the printers set memory option. This may speed up printing.

• **Convert PFS keywords to INF file**: This option only applies when adding a Mode 3, PFS Polling directory and is mainly used with web applications. Select this option to convert keywords in the PFS file into an INF file and to place macro folding information in the PFS file.

• **Polling Modes**: Select a Polling mode depending on the type of files that will be submitted. You can use any or all of these Polling modes at the same time for as many target directories as needed. Polled files can be sorted by NT order, time received, or alphabetically.

  • **Mode 1: Simple Polling**: This mode polls target directories for single image files. These images are printed according to a set of default parameters defined at the Control Station. A unique set of printing parameters can be specified for each target directory. The remote user then sends images to the directory that provides the most suitable parameters.

  • **Mode 2: Parameter Files**: This mode is used to poll directories for job tickets created using the PlotWorks Client, Job Editor or the
DOS-based Remote Module. Use this mode also for PWC, PWJ and ZIP files. Please refer to page 4-114 for more information on PWC and PWJ files. Network Polling Mode 2 automatically decompresses PWC, PWJ, and ZIP files.

**Zip files must be copied into a sub directory of the Mode 2 polling directory. A decompression utility such as PowerArchiver or WinZip is required.**

If it is necessary to send files that are not compressed to a Network Polling Mode 2 directory, ensure that the image files are copied to the Mode 2 directory before the job ticket.

- **Mode 3: PFS Polling:** This mode is used to poll directories for PFS files. PFS files are discussed in detail in Appendix D of this user guide.

  Ensure that the image files are copied to the directory before the PFS file — unless the PFS files are on the same machine or network as the polling directory.

  A directory-level PFS file can be used to fill in any information that is omitted from the incoming job, or overwrite user specified printing parameters.

  Network Polling Mode 3 automatically decompresses .zip files. Zip files have to be copied into a sub directory of the Mode 3 poll directory and a decompression utility such as PowerArchiver or WinZip is required.

- **Mode 4: OVR Polling:** This mode is for the old DOS version of PlotWorks. It polls for jobs created with the Remote Module that are submitted by modem. A .PLP file is not required in this mode. The Remote Module creates an .OVR file that is submitted after the job ticket and all the image files.

- **Mode 5: JOB Polling (Repro Desk):** This mode is used to poll directories for Repro Desk JOB files.

  **Mode 5 polling is only available if the Repro Desk/Apprentice support is purchased and activated.**

4. Select **Enable processing application** if you have an external third party application set up to work with Mode 3 polling. Third party applications can perform functions like:

   - Modify items in the PFS file on an individual basis before processing the job and placing it in the Job Queue.
   - Calculate and print an invoice or cover sheet.
• Alert the operator of job requirements or instructions.
• Check the job submitters credit status

Enable processing application is only available when Mode 3 is selected. To set up a processing application enter options in the following fields:

• **Processing application:** Enter the full path to the selected external application in this field or you can click on the **Browse** button and select the EXE file.

• **Command line switches:** Enter command-line switches to customize the external processing application for each directory.

• **Time out (sec):** Enter a time-out interval that is used, if the external processing application “hangs”. The default is 60 seconds. In this case the application is shut down, the operator is alerted and polling for that directory is paused. The operator can then correct the problem and restart polling for the directory.

If the external application encounters an error, the print job is placed in the Job Queue on Commercial Hold. If the external application fails and the “Submit on Hold” check box is selected, the print job is placed in the Job Queue on normal Hold if .

5. Click **OK**.

---

**See also:** “Modify a Polling Directory” or “Delete a Target Directory” below.

---

### Modify a Polling Directory

You can change the parameters for any target directory using the **Modify Directory** dialog box. The fields available on this dialog box are the same as the ones on the Add Directory dialog box.

---

**Network Polling must be stopped before you can edit a directory.**

---

**To modify a target directory:**

1. Right-click on the directory and select **Edit** (or click the **Modify** button).
2. Edit the fields in the Modify Directory dialog box.

---

**See:** “Add a Target Directory” on page 6-6 for more information about the fields in the Add/Edit Directory dialog box.
Delete a Target Directory

The software offers two options for deleting directory listings from Network Polling. You can delete the entry from the Polling program only, leaving the directory intact. Or, you can delete the directory entirely, including all of its contents.

To delete a directory from Network Polling:

1. Select the directory you want to delete.
2. Right-click on the directory and select **Delete** (or click the **Delete** button).

3. Select one of the two deletion options
   - If you select **Delete Network Polling Entry**, the software removes the directory listing from the Network Polling program but leaves the actual directory intact on your computer or network drive.
   - If you select **Delete Network Polling Entry and Polling Directory**, the software removes the directory listing from the Network Polling program and deletes the directory and its contents from your computer or network drive. This deletion includes the directory-level PFS file.

*If you want to stop polling a directory without deleting it, you can put it on hold. To do so, right-click on the directory and select **Disable Polling**.*

Edit the Directory PFS File

When you add a target directory to the Network Polling utility, the software automatically creates a default parameter file for that directory. This file, called the *directory PFS file*, is used with Polling Modes 1 and 3. In Mode 1, the directory PFS file defines *all* of the printing parameters for the incoming images.
In Mode 3, the directory PFS file fills in any parameters that are omitted from the incoming PFS file. The software also copies the original PFS file into the Job Queue as “Submitted.PFS”.

**To edit the directory PFS file:**

1. Select the directory you want to edit.
2. Right-click on the directory and select **Edit Parameter File** (or click the **Params** button).
3. The PFS file opens into Notepad. Edit the file as desired.
4. Open the Notepad **File** menu and select **Save**.
5. Open the **File** menu again and select **Exit**.

---

For more information on PFS files, see Appendix D

---

**Edit the Master PFS File**

When you run Network Polling for the first time, the software creates a PARAM subdirectory inside the Polling program directory. This subdirectory contains a file called DEFAULT.PFS. The DEFAULT.PFS file is your master parameter file.

When you create a target directory in Network Polling, a copy of DEFAULT.PFS is created for that directory. In Mode 1, all of the printing parameters will be taken from this file. In Mode 3, any parameters that are missing from the PFS file which was submitted will be taken from this file. The software also copies the original PFS file into the Job Queue as “Submitted.PFS”. The converted PFS file created from the directory-level PFS is saved as “Queue Name”.PFS.

You can edit the PFS file for individual target directories using the **Edit Parameter File** option and saving it to the target directory. You also can edit the original DEFAULT.PFS file in order to reduce the amount of editing that you have to do for each target directory.

**To edit DEFAULT.PFS:**

1. Open the **Setup** menu and select **Edit Default PFS File**. DEFAULT.PFS opens into Notepad.
2. Edit the PFS file as desired.
3. Open the Notepad **File** menu and select **Save**.
4. Open the **File** menu again and select **Exit**.

---

For more information on PFS files, see Appendix D: “PFS Files” on page G-1
Polling for Jobs

Receiving Jobs from a Remote Source

Network Polling can receive jobs sent over a local area network, or over a modem or ISDN connection.

Modem Software Requirements

Network Polling can use Dial-up Networking (RAS). Remote clients must use the same modem software that is used at the Print Server to send jobs. In order to set up a modem station using RAS on a Windows 95 computer, you must purchase the Windows 95 Plus Package and install Dial-up Server to receive incoming jobs. (See “Configuring RAS to Output PlotWorks Job Files” on page G-1)

If you want to run both RAS or another communications software package at the Control Station, you must set up a dedicated modem for each communications software package. Do not try to switch between RAS and another communications software package on the same modem!

Receiving Jobs from a Client

The Client is a limited version of the Job Editor software. The Client allows remote users to create job tickets, define printing parameters, and send jobs to the Print Server via network, modem or floppy disk. It is possible for the Client to send jobs directly to a Job Queue, though this is not recommended. Instead, PLP recommends sending jobs to a Network Polling directory or FTP site. See “Output to FTP” on page 4-125

Currently, the software does not provide any network security features for the Job Queue. Therefore, we recommend that you only accept remote jobs through the Network Polling program.

Receiving Jobs from a Remote Module

The Remote Module is a DOS-based program used to create and send job tickets. PlotWorks can print jobs created on the Remote Module as easily as it prints jobs created on the Client.

Remote Module submissions can be received in different ways, depending on the mode of transmission:

- Jobs submitted over a local network or RAS connection should be sent to a Mode 2 Network Polling directory.
• Jobs submitted on a floppy disk should be imported directly into the Queue using the Import DOS Job command.

Poll Target Directories
Once you have set up your Network Polling configuration, you can begin to poll your target directories.

To start polling, click Start.

To stop polling, click Stop.

You cannot change your Polling configuration once polling is started. You must first stop polling then make your changes.

Polling Status
The color of the directory listings in the Network Polling window indicates their status:

• Black: no activity
• Dark Gold: on hold (Directories on hold also display a red hold icon.)
• Red: processing files

The Polling Log
Whenever a job is sent to a Network Polling target directory, an entry is added to the Polling log file (NETPOLL.LOG). The location of the Polling log is specified in the Polling Options dialog box.

To change the location of the Polling log file:
1. Click Polling Options.
2. Enter the path and name of the log file in the Log Filename field. Be sure to use the .LOG filename extension. If the log file does not exist, the software creates it automatically.

To view the Polling Log:
1. Open the Setup menu and select View Log.
2. The log file opens in Notepad. You can print the log, if desired, or exit from the Notepad when finished viewing.
Chapter 7

The Job Processor

The Job Processor converts image files to the PlotWorks proprietary file format, Performance Graphics Standard (PGS). In addition, the Processor uses Error Free Printing to detect and correct common job errors.

The Job Processor automatically processes jobs as they enter the Queue. Once processed, jobs can be sent to the printer for high-speed output.

The Job Processor Window

The Job Processor now has a tool bar to make common functions previously located in menus more accessible. The following buttons make up the Job Processor tool bar:

Queue: Opens the Select Queue Directory to Process dialog box used to select a Job Queue. The Job Processor monitors this Queue and processes incoming jobs automatically.
The following fields appear on the Job Processor window:

- **Process jobs in queue**: Displays the path to the Job Queue that is being processed.
- **Job name**: Displays the Job ID number and description (from the Job # and Description fields in the Job Queue).
- **Job progress bar** (beneath the Job Name field): Shows the percentage of the current job that has been processed for the Job Name.
- **__ of __ files**: Displays the number of the current file and the total number of files in the job. For example:
  
  3 of 7 files
  
  means that the program is processing the third of seven image files in the job.
- **Current file in job**: Displays the name of the image file currently being processed.
- **File progress bar**: Shows the percentage of the current image that has been processed for the Current File in the Job.

**The File Menu**

The File menu contains options to connect to a Queue and process jobs.

- **Notify**: Opens the Error Notification Options dialog box. See “Setup Error Notification Options” on page 7-5.

- **Start**: Begins processing files from the Job Queue.

- **Stop**: Stops processing files from the Job Queue.

- **Help**: Opens the online manual to the Job Processor chapter
The following options are available under the File menu:

- **Connect to Queue...**: Connects the Job Processor to the selected Job Queue. The Job Processor monitors this Queue and processes incoming jobs automatically.
- **Start Processing**: Begins processing files from the Job Queue.
- **Stop Processing**: Stops processing files from the Job Queue.
- **Exit**: Quits the application.

**The View Menu**

The following option is available under the View menu:

- **Status Bar**: Lets you hide or show the status bar.

**The Setup Menu**

The following options are available under the Setup menu:

- **Configure Error Notification**: Selecting this menu item displays the Error Notification Options dialog box. See “Setup Error Notification Options” on page 7-5.
- **Process Files on Hold**: Select this option to process files in the Job Queue that are on hold. Selecting this option enables the job to print faster when you are ready to print.
The Help Menu

The Help menu contains information about the Job Processor and its use.

- **Online Manual**: Opens the online manual to the Job Processor chapter
- **Index**: Displays the index of help topics
- **Table of Contents**: Displays the table of contents for the online manual
- **Release Notes**: Displays late-breaking product enhancements and documentation changes.
- **About**: Displays program version and copyright information
Setting Up the Job Processor

Connect to a Queue

The Job Processor monitors a Job Queue and automatically processes any jobs submitted to that Queue. When you installed the software, you were prompted to create a Queue directory. By default, the Job Processor is connected to this Queue. If you did not specify a Queue directory during installation, the Job Processor prompts you to do so when you run the application for the first time. If you want to use a different Job Queue, you must connect the Job Processor to the appropriate Queue directory.

To connect to a Queue:

1. Open the **File** menu and select **Connect to Queue** or click on the **Queue** button on the toolbar. The Select Queue Directory to Process window opens.
2. Select the Queue directory in the scrollable window.
3. Click **OK**. The Job Processor monitors the selected Queue for incoming jobs.

Setup Error Notification Options

1. Click on the **Notify** button or select Configure Error Notification from the Setup menu. The Error Notification Options dialog box opens.

   - Select the check box labeled **Notify remote sender of processing error**, if you want to notify the remote sender, via a Windows messenger dialog box, if a processing error occurs.
- Select the check box labeled **Send e-mail notification of errors**, if you want to send an e-mail, instead of the Windows messenger dialog box, when a processing error occurs. Selecting this check box activates the **E-mail Sender** and **E-mail Server** text boxes. The e-mail can be sent to either the job submitter or the print hub administrator. The e-mail address can be specified in the Network Polling Directory level default PFS file or in the Incoming PFS file. See Appendix D for information on how to add e-mail addresses to the PFS file.

- In the text box labeled **E-mail Sender**, enter the name that you want to have appear in the 'From' portion of an error notification e-mail. PLP recommends that long e-mail, or multiple e-mails not be entered in this field. Long e-mails will over write the contact information in the Job Queue.

- In the text box labeled **E-mail Server**, enter the name of the mail server that will handle the error notification e-mail.
Running the Job Processor

Start and Stop Processing

To Start Processing Jobs in the Queue:

1. Be sure that you are connected to the appropriate Queue. The Job Queue path is displayed in the field titled Process Jobs in Queue.
2. Click on the Start button.

To Stop Processing:

- Open the File menu and select Stop Processing or click on the Stop button.

When you open the Job Processor, it retains the processing status it held when you last quit the application. For example, if you select Start Processing before exiting the program, it will automatically start processing the next time it is opened.

Run Processing in the Background

All jobs must be processed before they can be printed. Therefore, either the Job Processor must be running at all times, or the Job Editor or Client must be configured to “Send original and PGS files” or “Send PGS files only.” If you close the Job Processor window, processing stops and you will be unable to print files that have not been preprocessed. However, you can minimize the Job Processor window so that it runs in the background, without taking up space on your screen.

To Minimize the Job Processor Window:

- Click the Minimize button on the upper-right side of the window. The window will be reduced to a button on the taskbar and/or the system tray. To restore the Job Processor window, select it on the taskbar and/or the system tray.

View Processing Log

Whenever a job is processed, the Job Processor creates a log file that lists the images processed and any warnings or errors that occurred. You can access this log from within the Job Queue.

To view the Processing Log:

1. Open or activate the Job Queue.
2. Right-click on the job whose log you want to see. This will open the Job menu.
3. Select **View**.
4. Select **Processing Log** to display the log file.
5. When you have finished viewing the log, select **Exit** from the **File** menu in Notepad.
Chapter 8

The Printer Interface

The Printer Interface prints processed jobs sent from the Queue. Options available for each Printer Interface differ depending on the printers capabilities.

The Printer Interface provides real-time feedback on the job printing, any errors that occur, and the media loaded. Other features include:

- A print queue displaying the print status of jobs printing and scheduled to print.
- A printer display showing pages printing, the media drawer contents, and the location of printer errors depending on the printers capabilities.
- High-speed printing recovery when jams or other errors occur.
- A printer information box showing the printing mode, the job and drawing printing, error descriptions, and more.

Each printer has its own Printer Interface. You can operate a lower end printer from a higher end Printer Interface if they use the same connection. For example, if an 8825 and an 8850 printer are attached to a Gecko v2 card, the 8850 Printer
Interface can operate the 8825 printer. However if you attempt to operate the 8850 printer from the 8825 Printer Interface an error message appears indicating that this is not possible.
The Printer Interface Window

The Toolbar Buttons

The following buttons appear on the Printer Interface toolbar:

- **Pause/Resume Printer**: Click this button to pause the printer. When this button appears depressed and the text Paused appears in the Information box the printer is paused. Deselect this button to resume printing.

- **Stopped Mode**: Click this button to stop printing completely.

- **Manual Mode**: Select this mode to manually print jobs. Only jobs with a priority of Print Next or Print Immediate are then printed without operator intervention.

- **Automatic Mode**: In this mode the Printer Interface automatically prints jobs sent from the Queue in the order of priority.

- **Override Media**: Is used to override the medium requested when it is not loaded. The job is instead printed on the next best media.

- **Media Change**: Is used to select the correct medium when a Multiple Match error occurs. This happens when the medium loaded in the printer matches more than one type of media in inventory. Select this button to select the media actually loaded.

- **Media Inventory**: The media inventory lists the media types and sizes in stock. If an incoming job ticket requests a media type in stock, but not loaded, the Printer Interface stops and requests the media. Select this button to view, add, delete or edit entries, in media inventory.

- **Help**: Opens the Printer Interface Help file.
The Menu Options

The File Menu

The File menu contains options related to starting and stopping the printer and connecting to a Queue.

8.2 File menu

The following options are available from the File menu:

- **Connect to Queue**: Connects the Printer Interface to the selected Job Queue. The Printer pulls jobs from this Queue.

If a new or different Queue is selected, a dialog box appears prompting you to close and reopen the Printer Interface for the Queue change to take effect. Select Yes the Printer Interface automatically closes and reopens.

- **Set Printer Mode**: Clicking this option opens a sub menu where you can select printer modes. More information on printer modes are available under “Set Printing Modes” on page 8-28. A check mark next to a mode option indicates the mode currently selected.

- **Pause Printer**: Select this option to pause the printer after the current image, if applicable, finishes printing.

- **Import Pattern File**: Select this option to import a Pen Pattern file. For more information see “Importing Repro Desk Pattern Files” on page 14 of Appendix G.

- **Revert to Standard Patterns**: Select this option to revert to the default Pen Pattern file. For more information see “Importing Repro Desk Pattern Files” on page 14 of Appendix G.

- **Exit**: Closes the Printer Interface.
### The View Menu

8.3

**View menu**

- **Toolbar**: Hides or shows the toolbar.
- **Status Bar**: Hides or shows the status bar.
- **Image List**: This option is unavailable.
- **Do not show splash screens**: Select this option to disable the splash screens. Splash screens are the windows that appear briefly when PlotWorks applications are first launched. The splash screens are disabled by default.

### The Setup Menu

8.4

**Setup menu**

- **User Interface Units**: Is used to select the units of measure for the Printer Interface.
- **General Configuration**: Is used to configure general printing options, such as imaging memory, print notifications and device number. (Ctrl + G)
- **Device Specific Options**: Is used to configure options specific to your printer model, including folder setup and scanner control. (Ctrl+D)
• **Generic Embedded Controller Options...**: This option is designed for advanced users. Selecting this option opens the Generic Embedded Controller Options dialog box which is used to specify embedded controller commands specific for each device. These include commands that allow PlotWorks to communicate which media roll to use as well as commands that manipulate print output. Commands that are recognized here differ from printer to printer. Please consult your printers manual for more information on what embedded controller options are supported by your printer. (Shortcut: Ctrl+E)

• **Separator Pages**: Is used to configure and print a separator page between sets and jobs. (Ctrl+S)

• **Media Inventory**: Is used to view, add, edit, or delete entries in media inventory. (Ctrl+I)

• **Media Change**: Is used to select the correct medium when a Multiple Match error occurs. This occurs when the medium loaded in the printer matches more than one type of media in inventory. (Ctrl+M)

• **Override Media**: Is used to override the medium requested when it is not loaded. The job is instead printed on the next best media

• **Simulation/Demo**: Opens the Simulation Options dialog box used to set simulation printing options. When the printer is in simulation mode, you can set up hypothetical media drawer contents and printer errors. The Printer Interface displays paper moving through the printer, but no jobs are actually printed.

• **Advanced Options**: Clicking this menu item opens the Advanced Options tabbed dialog box. Refer to “Advanced Options” on page 8-33 for more information on options available here.

### The Help Menu

8.5

*Help menu*

<table>
<thead>
<tr>
<th>Help</th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Online Manual</td>
<td>F1</td>
</tr>
<tr>
<td>Index</td>
<td>Shift+F1</td>
</tr>
<tr>
<td>Table of Contents</td>
<td>Ctrl+F1</td>
</tr>
<tr>
<td>Release Notes</td>
<td>Ctrl+Shift+F1</td>
</tr>
</tbody>
</table>

The **Help** menu contains information about the Printer Interface. The following options are available under **Help**:

• **Online Manual**: Opens this chapter. (F1)
The Printer Interface

The printer diagram displays real-time printer activity. It shows the location of prints in the printer (on most printers), media drawer contents, and printer errors. The printer diagram varies depending on the printer. *When the Printer window is maximized, the media rolls display more comprehensive information about the media type, size, and errors.*

**Embedded Generic Controller Printers don’t have the bidirectional communications necessary for real-time feedback, so paper moving graphics are not displayed.**

8.6 Sample printer diagram

The rotating “notch” indicates what roll is being used. These lines represent paper moving through... ...and exiting the printer.

The media rolls and trays in the printer diagram display the type, size, and amount of media in the drawer. The number in the center of the roll is the medium width. The color of the inner circle represents the media type. The white outer circle represents the percentage of medium remaining.

For example:

![Sample printer diagram](image)

This drawer contains 36 inch bond. The roll is 50-75% full. The center color of the “roll” indicates the media type. Bond is white, Vellum is gray, T-Bond is green, and Mylar is cyan (blue).

*When the Printer Interface is maximized, the media type is written in the center of the roll. When the Printer Interface is smaller, the roll end only shows the size.*
This drawer contains 17 inch vellum. The roll is 0-25% full.

All black indicates the drawer is empty.

All white means that this drawer has not yet been read by the Printer Interface.

All red means this drawer has a Multiple Match or No Match error. (Multiple Match indicates that a medium was loaded that matches more than one type of media in the inventory. No Match indicates that a medium was loaded that has no match in the Media Inventory).

The Printer Information Box

This area provides information about the current print job, including:

- The printing mode
- The job number and description (if any)
- The name of the image file being printed
- The set, image, copy, and page being printed
- Error messages (if any)

The Print Status Box

The Print Status box shows the status of every image or job being processed by the printer. One or more jobs or image can be in process at one time.

The following columns appear in the Print Status box:
• **Job #:** Displays the job ID number, as assigned in the Job Queue.

• **Image:** Lists the names of the image files.

• **Status:** Tells you the status of an image in the printing cycle. These are listed in order of occurrence:

  • Started
  • Waiting
  • Printing
  • Imaging
  • Feeding
  • Exiting

  • Folding (if a folder is attached to the printer)

Not every printer displays every status. More information on specific printers, is provided later in this chapter.

*Note:* The Print Status Box displays a warning message when the ARU logging file exceeds the maximum size set in the registry.
Setting Up the Printer Interface

The Printer Interface is usually ready for use immediately after installation. When using a socket printer, those printers that require a TCP/IP address, some additional steps are required. Socket printers include the AccXES and the Océ Power Logic controller driven printers. Please refer to “Socket Printers” on page 8-67, for more information on setting up the Printer Interface for these printers.

The Printer Interface contains a pre configured media inventory list. You do not have to add media to the inventory list before sending jobs to the printer. However you may want to change certain parameters and settings to fit your requirements.

The following sections describe options available in the Printer Interface. Default settings are provided for most options.

Set General Printing Options

The General Configuration dialog box is used to select options available for all printers.

---

When General Printing Options are changed, the Printer Interface may close and reopen registering the changes.

---

To set General Printing Options:
1. Open the Printer Interface, if it is not already open.
2. From the Setup menu select General Configuration....
3. Edit the desired fields in the General Configuration dialog box.
The following fields appear on the General Configuration dialog box:

- **Printer type**: Select your printer model from the drop down list.
- **Device number**: Assign the device a unique number between 1 and 4.
- **Maximum Imaging memory**: Enter the maximum amount of memory (RAM), in megabytes, to allocate for imaging. The default amount is 68MB, which is enough for most tasks. Maximum Imaging Memory can be set as high as 1MB less than the total amount of memory your computer contains.

When a print job starts, the Printer Interface processes (rasterizes) as many drawings as it can into physical memory and sends them to the printer. This continues until it reaches the limit set under Maximum Imaging Memory.

Running multiple Printer Interfaces, or a Scanner Interface, requires memory as well. To determine how much memory to allocate to each application, consult Appendix A of this user guide.

The more memory the Printer Interface is allocated, the less memory is available for other PlotWorks applications. When your computer reaches its memory limits, the Printer Interface and other applications become less responsive.
and slower, or may encounter other problems. Therefore, limit the amount of memory allocated to the Printer Interface.

- **Sheet Size Preferences**: Sheet Size Preference options are useful when you want to print all large sheets on one printer, and all small sheets on another. For example, if you are using both a XES 8180 and an 8830, you can use Sheet Size Preferences to have files that are 24" wide or less print on the 8180 (which supports files up to 24" max width), and other files print to the 8830. The 8180 can print a 24" x 36" job much faster in portrait orientation than an 8830 can in landscape.

To use this field both of the following circumstances must occur:

- More than one printer is connected to the same Queue
- The selected printer for one or more incoming jobs is set to “Any.”

When using Sheet Size Preferences, the smallest image dimension is considered. Select one of these radio buttons to set limits on the sheet size printed. Options include:

- **None**: Select this radio button if you do not wish to set print size limits.
- **Less or equal**: Select this radio button to set a less than or equal to print width. When this button is selected the text field following the label becomes available to enter the maximum width you want printed on this device.
- **Greater than**: Select this radio button to set a greater than print width limit. When this button is selected the text field in the line above this label becomes available to enter the minimum width you want printed on this device.
- **Save paper when nesting**: By default, PlotWorks uses the media type allowing the most drawings to be nested. This does not always use the least amount of media. Selecting the Save paper when nesting check box will enable printing multiple images on the least amount of media. If selected, printing is slightly slower due to the additional processing required.

- **Save memory when nesting**: (For color printers) It is possible to nest black-and-white and color images. This can slow down the printer and use more memory. Selecting this option prints images that require more than one color pass on a separate sheet.
- **Add crop marks when needed**: Select this check box to add crop marks when the paper is larger than the image.
• **Disable ARU logging:** Select this box to turn off the ARU (Advanced Reporting Utility) logging feature.

• **Job goes on hold when media out:** Select this option to put a job on hold when the printer does not contain the correct medium for that job. The printer will bypass the job, notify the user, and begin printing the next job.

When this option is not selected, the printer does not print any job when it runs out of a medium. Instead it waits for you to load the missing media.

_You must select “Always Available” in the Add/Edit Media Inventory dialog box for the print medium, or the job will not be held. The images will instead print on another roll of medium._

• **Center output on media:** Select this check box to print the image centered on the medium. Centering is based on the image extents. Image margins, justification, or labels are part of the image extents. This can sometimes cause the image to not appear centered.

• **Notify Remote Submitter on Error:** Select this check box to notify the job submitter, via a Windows dialog box, when a job cannot be printed due to print errors.

• **E-Mail Remote Submitter on Error:** Select this check box to notify the job submitter, via e-mail, when a job cannot be printed due to print errors. The submitters e-mail address is acquired from the Network Polling Directory level default PFS file, the Incoming PFS file, or the PlotWorks Web Job Submission Tool. See Appendix D for information on how to add e-mail addresses to the PFS file.

• **Jobs Printed Successfully Should Be...:** Select one of the choices provided to determine what to do with successfully printed jobs. Choices include:

  • **Held:** Select this option if you want to place successfully printed jobs on hold.

  • **Deleted:** Select this option if you want to delete successfully printed jobs.

  • **Deleted after:** Select this option if you want to delete successfully printed jobs after a determined amount of time. When this radio button is selected, the text field following the label becomes active. Enter the number of minutes from 1 to 9999 (almost 7 days) to hold a printed job before it is automatically deleted.
• **Jobs Printed with Errors Should Be...**: Select one of the choices provided to determine what to do with printed jobs containing errors. Choices include:
  - **Held**: Select this option if you want to place jobs printed with errors on hold.
  - **Deleted**: Select this option if you want to delete jobs printed with errors.
  - **Deleted after**: Select this option to delete jobs, printed with errors, after a determined time period. When this radio button is selected, the text field following the label becomes active. Enter the number of minutes from 1 to 9999 (almost 7 days) to hold a job printed with errors before it is automatically deleted.

• **When Printing is Complete**: This group box contains options to notify job senders of successfully printed jobs. Options include:
  - **Send notification to local submitter**: Select this check box to notify a local submitter that their job has completed printing, via a dialog box that pops up when the job exits the printer. This is only possible when the job is submitted directly to the Queue and the submitter is on the same network as the Printer Interface.
  - **Send notification to remote submitter**: Select this check box to notify a remote submitter that their job has completed printing via a dialog box that pops up when the job exits the printer. This is only possible when the submitter is on the same network as the Printer Interface.
  - **Send e-mail notification to remote submitter**: Select this check box to e-mail a submitter that their job has completed printing. When this check box is selected, the **E-mail Sender** and **E-mail Server** text boxes become active. The submitters e-mail address is acquired from the Network Polling Directory level default PFS file, the Incoming PFS file, or the PlotWorks Web Job Submission Tool. See Appendix D for information on how to add e-mail addresses to the PFS files.
    - **E-Mail Server**: Enter the name of your local e-mail server. (e.g. “abcmail.abc.com”). The e-mail function will not work unless the correct value is entered.
    - **E-Mail Sender**: Enter the name you want to have appear in the 'From' portion of the e-mail. Enter a value in this field or the e-mail function will not work. PLP recommends that long e-mails, or multiple e-mails not be entered in this field. Long e-mails will overwrite the contact information in the Job Queue.
• **OK**: Click this button to save your changes and close the General Configuration dialog box.

• **Cancel**: Click this button to close the General Configuration dialog box without saving any changes that may have been made.

### Configure Device Specific Options

The Device Specific Options dialog box is used to specify parameters specific to each printer, folder and scanner. Options not available for your printer are grayed out. For device-specific setup information, refer to “Printer-Specific Options” on page 8-46.

**To set Device Specific Options:**

1. Click on the **Setup** menu.

2. Select **Device Specific Options**. The Device Specific Options dialog box opens.

![Device Specific Options dialog box](image)
3. Edit the fields in the Device Specific Options dialog box. Available fields are:

- **Folder type**: Select either:
  - The folder attached to the printer if it is listed in the drop down list
  - **No Folder/Auto Detected Folder**.

  *The Folder type drop down list does not list the 8180, MAX 200, Gera and 8845 folders. PlotWorks automatically detects these folders.*

- **Serial port**: If using a folder with a serial connection, enter the serial port number in this field.

- **8180 automatic set rotation**: This check box is only available for the 8180 or MAX 200 and is used to enable automatic set rotation. Automatic set rotation outputs each successive collated set at a 90-degree angle to previous ones.

- **Send flat output to finisher**: This check box is only available for the MAX 200 and is used to output drawings not folded to the folder tray instead of the slot at the top of the printer.

- **Punching**: Select this check box to enable punching if supported by your folder.

- **Rotation feature**: Select this check box to enable rotation if you have a rotation table.

- **Reinforcement**: Select this check box to enable margin reinforcement if supported by your folder.

- **Smart Switch control**: This option is provided for Printer/Scanner combinations that are driven by the Scorpion controller. These include the XEROX WIDE FORMAT 8855 printer, and the Legacy XES 7396 or 7399 scanners. Options include:
  - **Automatic**: If selected, the scanner automatically switches back and forth between copy and print/scan mode. This works when the operator presses the “OP mode” button on the scanner itself.
  - **Manual**: This setting is used when the scanner and the printer are connected to different computers. If you are going to use Manual mode, pause the Printer Interface before pressing the “OP mode” button on the scanner.
Due to the complexity of the Smart Switch and Printer Interface, the PlotWorks job recovery feature will not work if the printer runs out of media and you pause the Printer Interface to add more. In this case, use the Reprint feature in the Job Queue to start the print job where it left off (select Reprint from the Job Queue Job menu and enter a starting position).

- **None:** This setting is used if there is not a scanner attached to the Smart Switch.
- **Copy Mode Timeout:** This field is active only when the Smart Switch control is set to Automatic. Enter the number of seconds the scanner should remain idle in Copy mode before reverting to Scan/Print mode.
- **Print density:** Enter a number between 1 and 50. This number determines the density of the image based on the amount of toner used. 50 is the most dense and 1 is the least. Print Density does not affect the 8845 printer.

A density setting of 10 to 15 is recommended. Higher densities rarely print darker but do waste toner.

- **Power Save Timeout:** Enter the number of minutes the printer should remain idle before switching to the Power Save mode.
- **Reduce pen widths:** This option is designed for the XEROX WIDE FORMAT 8830, 8825 and 8845. Select this check box to reduce pen widths by 1 pixel. This improves image quality.
- **Minimum Pen Width (pixels):** Enter a number from 1-10. 1 is the default. Increase the number if your lines are printing too light or not at all. This option is mainly provided for new printers that are able to print very fine lines.
- **Add lead/trailing edge:** This option is useful when documents are printed clipped. Select this check box to add length to the image extents to compensate for this clipping. This enables the following two fields:
  - **Leading:** Enter the amount of media to add to the drawing edge that exits the printer first.
  - **Trailing:** Enter the amount of media to add to the drawing edge that exits the printer last.

Adding leading or trailing edges to the paper will print crop marks if the crop mark option is enabled.
• **Windows and Generic Embedded Controller Printer Options:** The following two options are used with Windows and Generic Embedded Controller printers and the 2230 and 2240 InkJet printers
  
  • **Printer Name:** Select your printer from this drop down list.
  
  • **Output quality:** Select a value from 0 to 1200 dpi for each output quality type. Refer to your printer manual for recommended values. Set the desired level for each image in the Job Editor. See “The Bottom edge option is useful when you plan to collate or fold scanned images and you want to make sure they all face the same direction. For example, the Bay folder requires the title block to enter the folder last in order to get a properly folded package. Other folders require the title block to enter the folder first.” on page 4-24.

  If *Output Quality is set at a higher DPI than supported by the printer, a larger or smaller print than desired may result.*

  • **Minimum Paper Length:** Enter a value for the minimum paper length to use. This helps to avoid paper jams when folding.

  • **Hardware port number:** Enter the port number on the Scorpion or Gecko controller card that the printer is connected to (usually 1).

4. Click **OK**.

**Generic Embedded Controller Options**

The Generic Embedded Controller Options dialog box is used to communicate which roll to use for each image. Depending on your printer all or some of these fields may be disabled.

The following fields appear on the Embedded Controller Options dialog box:

• **Header:** Contains printer Opcodes and Instructions that are sent to the printer before the image is printed.

• **Rolls 1-6:** These fields function as the ‘Print Roll Specific Command’ to determine when to switch rolls. Specify the sizes and types of media using Media Change and set the printer Opcodes/Instructions for the roll here. The Printer Interface will select the roll and send the necessary printer Opcodes/Instruction to the embedded controller.

• **Trailer:** Specify finishing options such as folding etc. in this text box. These printer Opcodes/Instructions are sent directly to the printer after the image is printed.
The Registry key “RTL Roll Manual”, made for all Generic Embedded Controller printers contains the Printer Opcodes/Instructions to engage a printer’s manual feed option. To manually feed media on a Generic Embedded Controller printer, set the RTL Roll Manual Registry key. This setting is not modifiable in the Embedded Controller Options dialog box because once set, the setting requires little, if any, modification.

If manual feed is required and the printer’s Printer Opcodes/Instructions aren’t set by the PlotWorks installation program, manually set the Registry key by typing the following text in the Header text box:

```
"HKEY_LOCAL_MACHINE\SOFTWARE\PLP\ Printer Interface\Name of Printer\RTL Roll Manual"
```

Refer to the printer’s manual for more Printer Opcodes/Instructions.

*The 8830 with an Embedded Controller doesn’t require this Registry key setting.*
Selecting Notification Sounds
When a printer error or a priority job is received, the Printer Interface plays a default sound to notify the user. To select a different sound, open the Windows Control Panel, select Sounds and Audio Devices, click on the Sound tab, navigate to PlotWorks from the Program Events select box, and click on the appropriate event. Then select a sound from the Sounds drop down list.

Seven WAV files were installed with PlotWorks. These are named: chirp.wav, incomingjobx-cyborg.wav, incomingjobx-voice.wav, jobrecieved-cyborg.wav, jobrecieved-voice.wav, steamwhistle.wav, and sweep.wav.
Setting Up Media Inventory

About the Media Inventory

The Media Inventory is a record of all the media you have in stock. When PlotWorks is installed, a preconfigured inventory containing commonly used media sizes and types, is provided. Add, edit, and delete media types from this list as needed.

The Printer Interface compares the size and type of media in each printer drawer with media in your inventory list. If the media detected in a drawer is not listed, the Printer Interface displays a “No Match” error and will not print from that drawer until the new media type is added to Media Inventory.

If more than one listing matches the detected media, the Printer Interface displays a “Multiple Match” error and will not print from that drawer until you select Media Change to select the correct media type. See “Change Media Type” on page 8-25 for more information.

If “Hold When Media Out” is not selected, and a print job requests a media type in stock but not loaded, the Printer Interface displays an error message asking you to load the correct medium or use Media Override to select an alternate media type. See “Media Override” on page 8-24 for more information.

Adding Media to Inventory

1. Click **Inventory**. The Media Inventory dialog box displays.

2. Click the **Add** button. The **Add/Edit Media Inventory** dialog box appears.
8.13 Add/Edit Media Inventory

The following fields appear on the Add/Edit Media Inventory dialog box:

- **Is this media available for automatic media selection?** Select one of the following options:
  - **No:** Select this radio button when the medium is unavailable.
  - **Yes, always:** Select this radio button if this medium is in stock and you want the Printer Interface to prompt you for it when it is not loaded.
  - **Yes, but only when loaded in the printer:** Select this radio button for media you only want to automatically select when loaded in the printer. The media will then display as “Now Loaded” in the inventory list.

- **Media Size and Type:**
  - **Actual Width** (required): Enter the actual medium width in this field. Then select either the inches or mm radio button depending on the actual media width. This measurement is not affected by the Units selected in the Setup menu.
  - **Actual Length:** Enter the actual medium length for sheet-fed or

---

*Media is not auto detected on Windows and Generic Embedded Controller printers, such as the 8830 AccXES printer.*
manually-fed media. Use the same units of measure as selected above. Select 0 if using roll-fed media.

- **Actual Type** (required): Enter the actual medium type: Bond, T-Bond, Vellum, or Film. You can enter a color or other descriptive text (such as Blue Bond) as desired. This is useful for separator pages.

- **Width Detected** (required): Select the width detected by your printer for this medium from the drop down list.

- **Type Detected** (required): Select the medium type that will be detected by the printer for this roll: Bond, Vellum, or Film.

---

*If the manual feed option requires an RTL Roll Manual Registry key, see “Embedded Controller Options” in the previous section.*

---

- **How is This Media Loaded?:** Select either:
  - Roll Feed
  - Sheet Feed
  - Manual Feed

- **Advanced Media Options:**
  - **X offset:** Enter the horizontal distance to offset all images. This is useful for odd-sized medium. For example, if the actual paper width is 15 inches, and the printer-detected width is 17 inches, a Multiple Match occurs. To use less paper, enter 2 in the X offset field (the difference between 17 and 15).

---

*When a Multiple Match error occurs, open the Media Change dialog box and use the drop down list next to the Multiple Match entry to select the desired media type.*

---

- **Y offset:** Enter the vertical distance to offset all images. This field is only used to add or remove space from the leading edge of the page.

- **Max nest length:** Enter the maximum media length to print from this roll. This field is used when nesting documents.

  When nesting, PlotWorks determines what length is most efficient. To ensure that the print won’t go on forever and to conserve memory, it is a good idea to set a maximum length. The default maximum length is 36 inches.
Standard U.S. media rolls are 500 feet long, however media rolls can be 650 feet long.

3. Click OK to return to the Media Inventory dialog box.
4. Click Done to save your changes and close the dialog box.

**Edit the Media Inventory List**

1. Click Inventory.
2. Select the entry that you want to edit.
3. Click Edit.
4. Edit the fields in the Add/Edit Media Inventory box as desired. See “About the Media Inventory” on page 8-21 for a description of these fields.
5. Click OK to return to the Media Inventory.
6. Click Done to exit the Media Inventory dialog box.

Media Inventory can be edited during printing. You can view and select a different roll in case of a media out error. See Media Override for more information.

**Deleting Media from Inventory**

1. Click Inventory.
2. Select the entry you want to delete.
3. Click Delete.
4. Click Done.

**Media Override**

If media runs out in the middle of a job, use the Media Override feature to select a different roll.

1. Click on the Setup menu
2. Select Override Media. The Override Media dialog box displays the current media type and size.
8.14 Override Media dialog box

3. Select the media to use from the **New Media** drop down list. All media available in Media Inventory is included in this list.

4. Click **OK**. The job(s) finishes printing on the new media.

**Change Media Type**

The Printer Interface displays a “Multiple Match” error when the inventory contains more than one medium that matches a requested media size and type. In this case we use the Media Change feature to select the desired medium.

1. Click on the **Setup** menu
2. Select **Media Change**. The Change Media dialog box displays loaded media.
3. Use the drop down list next to the Multiple Match entry and select the desired media type.
4. Click **OK**. The job(s) prints on the selected medium.
Manual Feed

When manual feed is specified in media inventory, the Printer Interface requests that you manually feed media into the printer. You can put manual feed on hold or override the media type or size before actually inserting paper. After the paper is inserted printing continues.

You cannot select manual feed when a fold is also specified.

To use manual feed on the MAX 200

2. Click the Manual Feed Continue button.
3. Load the cut sheet of paper
4. Press Start on the MAX 200 panel.

The orientation graphic on the manual feed panel of the MAX 200 always displays paper size as portrait. The manual feed panel displays all paper sizes by width, except for 8.5 x 11”, which displays by height (11). The MAX 200 does not accept media requests for widths as small as 8.5. To use manual feed for a 8.5 x 11 paper size, set the paper size to 11 and feed the paper as landscape.
8.16 XES MAX 200 Printer Interface displaying the Manual Feed Continue button
Printing Basics

Set Printing Modes

The Printer Interface polls the Job Queue for print jobs. You can set the Printer Interface to act upon jobs in the Queue in the following different modes:

- **Stopped**: Stops the printer after the job currently printing completes printing. No other jobs print when in this mode.
- **Manual**: Puts the printer in manual mode. In this mode, only jobs with a priority of Print Next or Print Immediate are printed without operator intervention.
- **Copy**: Puts the Printer in Copy mode. In this mode, only jobs with a priority of Copy, Print Next or Print Immediate are printed without operator intervention.
- **Automatic**: Puts the printer in Automatic mode. All jobs are then printed according to the priority assigned.

To set a printing mode:

1. Open the **File** menu and select **Set Printer Mode** (or click the appropriate button on the tool bar).

2. Select the desired mode. The Set Printer Mode sub menu displays a check mark next to the selected mode.

Printing Rush Jobs

Jobs given a priority of Print Immediate in the Job Queue are printed immediately. If a job is currently printing it is interrupted to print the rush job. See “Interrupting a Job to Print Another Immediately” on page 3-18 for details.
8.18 Sample job interrupt in progress

The Printer Interface window reflects that a rush job is printing. Both the rush job and the interrupted job are listed in the Printer Status window. The red line designates the “urgent” job. The Printer Information box displays the rush job information in red. The illustration below shows what the average Printer Interface looks like when a job is interrupted to print a rush job.
Display Images When Printing

You can display a WYSIWYG representation of images in an image viewer as they are printed by selecting **Print to Display**. This does slow the printing process.

1. Open the **Setup** menu
2. Select **Simulation/Demo**.
3. Select **Print to display on viewer**
4. Select the desired viewer from the drop-down list or click the Browse button to select a different viewer.

5. Click **OK**. When an image is printed, it displays in the selected Viewer.
   - The PlotWorks Image Viewer automatically refreshes and displays each image as it prints.
   - The Wang Imaging viewer displays each image in a new window. You are prompted to click **OK** for the next image. Close each window after viewing.

Printing Separator Pages

PlotWorks can create separator pages. A separator page is a sheet that is usually a different color or slightly larger that is printed or placed between jobs or sets of images to make it easier to separate them. You can select the media type and size for separator pages. Windows printers automatically include separator pages for each job. To disable separator pages on Windows printers, do so from the printer or Windows Printer Options dialog box, not PlotWorks.

The following information is printed on the separator page:

- Submitter (UNC Login name and machine name)
- Image Files and Quantities
- Set #
- Job #
- Company
- Project
- Contact
- Date*
The Date and Time are based on the current date and time as formatted in the Windows Control Panel/Regional Settings feature of the PlotWorks server.

To enable separator pages:
1. Click on the Setup menu.
2. Select Separator page. The Separator Pages dialog box displays.

3. To print a separator page between sets, select Set of at least. Then enter a number for the minimum number of images that should be contained in the set to print a separator page. For example if you enter 5, only when you print a set of 5 or more images will a separator page be included between the sets.

4. To print a separator page between jobs, select Job of at least. Then enter the desired number of images that should be contained in the job to print a separator page. For example if you enter 5, only when you print a job of 5 or more images will a separator page be included between the jobs.

5. Select the media type from the Media type drop down list. Or, enter a custom media type by typing the name of the “Actual Type” of media. Ensure this media is listed in the Media Inventory with the “Actual Type” defined.
6. In the **Media width** and **Media length** fields, enter the desired medium size to use for the separator page.
   Minimum allowed width is 8" or 210mm (Letter size or A4), maximum width is 100" or 2540mm.
   Minimum allowed length is 8" or 210mm, maximum length is 100" or 2540mm.

7. Select **Include separator pages in ARU reports** if you use the ARU (Advanced Reporting Utility) to track the total media used.

8. Click **OK**.
Advanced Options

The Advanced Options dialog box offers Vector and Raster imaging options and RK Color Model Specific options. These options are used to enhance the quality of printed images.

Opening the Advanced Options dialog box.
1. Click on the Setup menu
2. Click on Advanced Options the Advanced Options dialog box opens.

There are three tabs on this dialog box. Vector Imaging, Raster Imaging, and the RK Color Model Specific tabbed dialog boxes. Click on the appropriate tab depending upon the type of image you are printing.
The Vector Imaging and Raster Imaging Tabbed Dialog Boxes

The Vector Imaging and Raster Imaging tabbed dialog boxes offer similar options. These are described next.

**Gamma Correction**

The Gamma Correction option is provided to control the overall brightness, hue, and contrast of a particular color in an image.

Adjusting the gamma setting for a color can help improve contrast so that lines and fills display better. If you have an image where one particular color does not display well, you can adjust the Gamma Correction for that color. For example, if you have a black line that intersects a red fill and the black line does not show on a monochrome print, you can lower the red gamma setting so that the line stands out from the fill.

Gamma Correction settings do not affect black and white areas of a drawing. Changing the Gamma Correction has little impact on light colors.

To apply Gamma Correction, use the Gamma Correction slider for the color you wish to correct. The selected color becomes lighter as you lower the Gamma Correction setting and darker as you increase the Gamma Correction setting.
All Color Models Option
To change how dark or bright the overall image prints, move the **Image Intensity** slider to increase or decrease the value reported in its text box. Higher values cause the image to print darker.

For example, if you have a very light background that does not show when the image is printed, you can increase the Image Intensity value to display the light background.

<table>
<thead>
<tr>
<th>8.23</th>
<th>Original Image and Monochrome Representation</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image1.png" alt="Original Image" /></td>
<td><img src="image2.png" alt="Monochrome Representation" /></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>8.24</th>
<th>Same image with Image Intensity increased</th>
</tr>
</thead>
<tbody>
<tr>
<td><img src="image3.png" alt="Same image" /></td>
<td><img src="image4.png" alt="Image Intensity increased" /></td>
</tr>
</tbody>
</table>

Increasing the Image Intensity will make darker areas of the image print even darker. Decreasing the Image Intensity will make lighter areas of the image print even lighter. Sometimes this decreases the contrast between different fill patterns in an image. Therefore it may be necessary to adjust the Gamma Correction for a color to compensate for increasing or decreasing the Image Intensity value.

Default Dithering Type
Depending on the image, viewer preference, and printer, changing the type of dithering pattern can improve printing results. The following dithering options may be available depending upon the type of image you are printing:
• **Diffused:**
  When Diffused is selected, dots are placed to approximate source pixels. The amount of "error" in the approximation is balanced with adjoining source pixels to better approximate the source image.

  This option is ideal:
  • When printing a continuous gradient from black to white.
  • When the Repro Desk option “Use Error Diffusion for Gray or Color RTL images” check box is selected.
  • When printing in grayscale
  • For documents mainly containing lines.

  This option provides the same functionality as specifying the R macro.

• **Ordered:**
  Ordered dither places dots in a regular pattern to approximate the source pixel. A lighter source pixel is mapped to a pattern containing fewer pixels, while a dense pattern is applied for dark pixels. This is the default option for color and RTL printers.

  This option is ideal:
  • When printing in color.
  • Printing photos
  • Printing documents containing fills.
  • For printing output similar to Repro Desk raster output when the Repro Desk option “Use Error Diffusion for Gray or Color RTL images” check box is *not* selected. In this case select Ordered Dither from the Raster Imaging tabbed dialog box.
  • When printing using the Océ 9800 series of printers.
  • When using the Finess or AccXES controllers

  This option provides the same functionality as specifying the Z macro.

• **Reduced Coverage Ordered:** This option is designed to use with the 8845 printer and is not available for Raster images.

• **High Resolution Patterns:** This option is not available when Diffused is selected for Default Dithering Type. Select this option if:
  • There is not enough variance in your fill patterns.
  • If your printer prints single pixels well
• To emulate output from Repro Desk
• If your print output contains missing lines

8.25RK Color Model Specific Tab

Image Rendering Defaults can be specified in the Job Editor, Job Client and in PFS files by specifying macros. The "Z" macro specifies Ordered dither use and the "R" specifies using Error Diffusion.

The RK Color Model Specific Tab Window

The RK Color Model Specific tab window contains options to control how red and black copies of color files are printed.

Options available in the RK Color Model Specific tab window:

• Red Threshold:
  Use this slider to select a value between 1 and 255. The value chosen is referred to as the Red Threshold value. Above this level, red areas of the drawing print without any black pixels. Below this level, black and red pixels print. 255 is the default Red Threshold value. A higher red threshold prints red areas a darker red. A low red threshold prints red areas a lighter red.

• Flatten Red:
  When this option is selected, red values greater than the Red Threshold value
are printed a pure solid red. When this option is not selected, the various red values appear as shades of red.
Connect to a Different Queue

The Printer Interface monitors a single Job Queue and prints jobs from that Queue. When PlotWorks was installed, a Queue directory was created. By default, the Printer Interface is connected to this Queue.

To use a different Job Queue, connect the Printer Interface to the new Queue directory.

See also “The Menu Options” on page 8-4.

1. Click on the **File** menu
2. Select **Connect to Queue**. The Select Queue Directory to open dialog box appears.

3. Select the drive the Queue is in from the **Drives** drop down list.
4. Select the Queue directory in the select box.
5. Click **OK**. A warning dialog box displays stating that changes to the Printer Interface do not take effect until it has closed and reopened.
6. Click **OK**. The Printer Interface closes and reopens automatically.
Job Recovery

The PlotWorks Error-Free Printing system, for supported printers, detects and displays print errors, like paper jams or low toner.

The Printer Interface displays the location of paper jams, if doors are open (on most printers), if toner or print medium is low, or if there is a media mismatch error so that you can easily correct the error. PlotWorks then completes the print job.

The following illustrations show examples of some possible errors and the steps necessary to recover from them.
Printer Errors

Out of Toner

The Printer Interface below displays that the printer is out of toner.

Correct the problem as per the printer’s owners manual and printing will resume.

Media Type Unknown Error

This error appears when a medium is unavailable in the Media Inventory list. PlotWorks reports “Media Type Unknown” and the roll/s display no match. Similar errors occur when the image is larger than the selected medium, or is sent to a media type that conflicts with the media type assigned to the job.
8.28 Media

Type Unknown error

Two ways to recover:

1. Select **Override Media** from the **Setup** menu and select the type of medium you want the job to print on. Printing resumes.

2. If the medium is available, go to **Media Inventory** and add it (if necessary). Change it to **Available**. Printing resumes.

---

See “Media Override” on page 8-24 and “” on page 8-19.

---

**Paper Jam**

PlotWorks displays the error location in the status window for some printers. The image below simulates multiple paper jams.
8.29 Paper Jam error

To recover:
1. Locate and correct the jam. You may have to refer to your printer’s owner’s manual.
2. Close the printer drawers and wait for it to warm up.
3. The jammed sheet reprint.
Simulate Printing

You can set up the Printer Interface to simulate printing even when the printer is turned off or disconnected. The simulation mode is useful for training, demonstrations or problem-solving.

In simulation mode, you can specify the types of media “detected” in the printer and you can display any printer errors that can be viewed on-screen. When you send a job to the Queue, the Printer Interface simulates its passage through the printer.

Rolls cannot be simulated in RTL or embedded printers by setting a roll here. Medium must be in the Inventory and use Media Change to set it as the active roll.

To simulate printing:
1. Click on the Setup menu
2. Select Simulation/Demo. The Simulation Options dialog box appears.
3. Select Simulate printer.
4. Select the desired simulations. Be sure to select contents for the media drawers.

5. Click **OK**. The Printer Interface simulates printing.
Printer-Specific Options

Options available for each type of printer or plotter are similar. However each printer has a Printer Type, ID number, and certain other settings that are unique to that printer. This section details those differences for each PlotWorks supported device.

The printer diagram on the Printer Interface screen is a graphical representation of the device’s side view, showing media rolls and/or drawers. Some of the printing devices can send PlotWorks information that can then be displayed on the printer diagram: No media, out of toner, paper jams, etc.

XES MAX 200 and 8180 Printer Interfaces

The XES 8180 Printer Interface, provides the following notices in the Status Box and Printer Diagram. The XES MAX 200 Printer Interface is very similar.

- Toner empty (this also causes an audible warning beep)
- Waste toner full (this also causes an audible warning beep)

The Status Box also displays notices and error messages that do not show up on the Printer Diagram:
- Paper jam (this also causes an audible warning beep)
- Cover open
- Printer is off or is not connected

When setting up a XES MAX 200 or 8180 printer/scanner combination, open the Windows Control Panel > Settings > Devices and ensure that both SCSI Scan and SCSI Print is disabled.

**Highlight Color Printing**

The XES 8180 and MAX 200 can print in red and black provided the M pen macro is used. The Printer Interface can separate red data in a drawing.

In HP-GL/2 files, the red data is extracted provided that the P and M pen macros are specified. When printing HP-GL/2 files with the ‘P’ pen macro, the internally-defined HP-GL/2 colors control the density of each primary color printed.

For all other vector file formats (i.e., CalComp, DWG, and DGN), using the Job Editor, Job Client or the PFS file, set the pen you wish to print in red to six (6) and use the M pen macro.

On single-color printers, colors other than pure black or red are converted to a shade of gray or to black, depending on the pen macros used. If you print in grayscale, you get different shades of gray depending on how dark the color is. RGB colors are converted to CMYK for printing. Yellow is lightest, cyan is medium, and magenta is darkest.

When a two-color mode is specified for the XES 8180 or MAX 200 (by using the M pen macro), the Printer Interface converts an equal percentage of yellow and magenta into the same percentage of red. The leftover yellow or magenta is converted to a shade of black.

Color selections come either from the Pen info in the Job Editor and PFS or from HP-GL/2 files. The Job Editor/PFS only support the following colors:

<table>
<thead>
<tr>
<th>Value</th>
<th>Name</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>0/blank</td>
<td>Black</td>
<td>Black on XES 8180 or MAX 200</td>
</tr>
<tr>
<td>1</td>
<td>Black</td>
<td>Black on XES 8180 or MAX 200</td>
</tr>
<tr>
<td>2</td>
<td>Cyan</td>
<td>Lighter on XES 8180 or MAX 200</td>
</tr>
<tr>
<td>3</td>
<td>Magenta</td>
<td>Darkest on XES 8180 or MAX 200</td>
</tr>
<tr>
<td>4</td>
<td>Yellow</td>
<td>Lightest on XES 8180 or MAX 200</td>
</tr>
<tr>
<td>5</td>
<td>Blue</td>
<td>Lighter on XES 8180 or MAX 200</td>
</tr>
<tr>
<td>6</td>
<td>Red</td>
<td>Red on XES 8180 or MAX 200</td>
</tr>
<tr>
<td>7</td>
<td>Green</td>
<td>Dark on XES 8180 or MAX 200</td>
</tr>
<tr>
<td>8</td>
<td>Black</td>
<td>Black on XES 8180 or MAX 200</td>
</tr>
</tbody>
</table>
This is true for all supported color printers as well.

**Color Planes**

The Printer Interface generates a separate raster image for each color the printer prints. This is called a "Color Plane." For single color prints, only one color plane is needed -- either black or red. But for two-color prints the Printer Interface needs to create two color planes, so twice as much memory on the PC and twice as much memory on the XES 8180 and MAX 200 are used when generating two-color prints. Up to 208 MB of plot data can be accepted per color plane on the XES MAX 200. It also takes additional time to generate an additional color plane -- about 25-50% longer, and additional time to transmit the additional color plane to the XES 8180 or MAX 200 for printing.

**MAX 200 and 8180 Color Performance Limitations**

The MAX 200 and the 8180 have special performance limitations when using color. Black and white prints can generally be printed full speed on the MAX 200 and the 8180. However, color prints require sending twice as much data over a SCSI interface that is already bandwidth limited. The MAX 200 and the 8180 can only contain up to 66 MB of plot data. Plot data for each drawing is stored until that drawing exits the MAX 200 or the 8180. Color prints require twice as much memory. This means the MAX 200 and the 8180 become limited in speed for color prints because they can only hold two D-size prints. This means if you send ten D-size color prints only two will be received. The first print must exit the MAX 200 and the 8180 before the third can be received, and so on. This creates significant delays. About seven D-size color prints per minute can be generated as opposed to 16 per minute black.

---

*If a drawing only uses red and no black there is no speed penalty as there is only one plane used.*

The Printer Interface will evaluate all of the colors used in a print and only generate the color planes needed for these colors. (If you want to force a drawing to be generated in Black you can put a ‘B’ in the Pen Macro in the Job Editor). This means there is no disadvantage if the entire print uses only colors that can be generated in one plane on the selected device, for example, drawings that are all red or shades of red on the 8180.
Currently the Printer Interface automatically determines the color planes required only when they are specified in the Job Editor or PFS files. When using the HP-GL/2 pen macro it is not automatic and the Printer Interface defaults to generate only Black. This can be overridden by using an ‘M’ in the Pen Macro field.

If an entire color print does not require a black pass then crop marks and labels will be generated in a color available in passes that were generated.

**Patterns Used**

The Printer Interface has 100 patterns that generate halftones from 0-100% in 1% steps. These patterns are automatically used to generate color. They are selected in the Pattern field of the Job Editor (see page 4-33), or in the PFS file (see page Appendix D-7) by entering a percentage. The patterns are randomly generated.

**Printing CALS or TIFF Files with Patterns or in Color**

CALS and TIFF files do not have pens like an HP-GL or CALCOMP file. For these files use Pen #1 to define patterns and colors. If Pen #1, on a raster file, is set to color 6, 50% it will print 50% red.

Also note that TIFF color files using LZW compression are not supported.

**Printing Postscript or PDF files in Color**

To print Postscript or PDF files with color use the “M” pen macro. While this is slightly slower the results will be better.

**Red and Black Printing Options**

The MAX 200 and the 8180 can print red and black copies of color files. The RK Color Model Specific tab window contains options to control how these colors are printed. For more information on this option refer to “The RK Color Model Specific Tab Window” on page 8-37

**Accessing the RK Color Model Specific tab window:**

1. Open the Printer Interface if it is not already open.
2. Click on the **Setup** file menu.
3. Click on the **Advanced Options** menu item. This opens the Advanced Options window.
4. Click on the **RK Color Model Specific** tab. This displays the RK Color Model Specific tab window.
Hardware Stamping on the XES 8180 and the MAX 200

Stamping is similar to an overlay in terms of PlotWorks’ functionality. A hardware stamp is a graphic image that is predefined in the printer. (See Xerox ES8180/MAX 200 User Guide for further details on manipulating stamps.) For PlotWorks to use a stamp in prints, first load the stamp into active memory on the printer if it does not already exist. Note that the stamp must be reloaded if the printer/scanner is turned off.

The optional parameters for stamping are:

- **ROTATION** - <0, 90, 180, 270> The Default is 0 (zero) if entry is missing or invalid.
- **DATE** - <YES>, An ASCII text string ten characters long. YES will put in the local date (formatted based on the settings Windows was configured to use); use any ten ASCII characters. The Default is no date if this entry is missing or invalid.
- **COLOR** - <RED>. The default is black if entry is missing or invalid.
- **NUMBER** - <SET, an ASCII text string 8 characters long>. The Default is no number if entry is missing or invalid.

Every parameter must be followed by an equals sign (=) and a setting. Use a comma to separate each parameter and setting.

---

**DATE and Number are mutually exclusive. They use the same printing area.**

You can manually set the X and Y positions to specify where on the image the stamp is printed. The units of measure in the Overlay tab are dependant on the units selected in the Preferences dialog box. The X position can be set from 0-999 millimeters (39 in) and the Y position can be set from 0-9999 millimeters (393 in). If the stamp is set in an X or Y position beyond these parameters, the image will print cropped.

---

*If you specify a position outside the boundaries of the printed image, or if the raster stamp is too large to fit on the image, the printer will print the job without displaying an error message, but the stamp will not appear on the image.*
8.32 Hardware Stamping

XEROX WIDE FORMAT 8825, 8830, & 8850

Printer Interface Options

These Printer Interfaces provide the following notices:

- Printer Warming Doors open
- Toner empty Waste toner full

The status box also displays notices and error messages. These include:

- Paper jams
- Folder jams
- Printer is in Power Save mode
- In menu (the printer was taken offline at the front panel)
- Printer is off or is not connected

The Printer Diagram illustrates media moving off the roll and out of the printer as each job is printed.
Xerox 8840D/Fuji Xerox 4024 Printer Interface Options

The 8840D/4024 Printer Interface, shown below in Fig. E.3, provides the following notices in the Status Box, as well as on the Printer Diagram:

- Printer Warming
- Doors open
- Toner empty (also causes an audible warning beep)
- Waste toner full (also causes an audible warning beep)

The status box also displays notices and error messages that will not show up on the Printer Diagram:

- Paper jam (also causes an audible warning beep)
- Printer is in Power Save mode
- In menu (the printer was taken offline at the front panel)
- Printer is off or is not connected

The Printer Diagram for the 8840D can illustrate media moving off the roll and out of the printer as each job is printed.
**Xerox 8845/Fuji Xerox 4036 Printer Interface Options**

The 8845/4036 Printer Interface, shown below in Fig. E.4, provide the following notices in the Status Box, and on the Printer Diagram:

- Printer Warming
- Doors open
- Toner empty (causes an audible warning beep)
- Waste toner full (causes an audible warning beep)

The status box also displays notices and error messages that will not show up on the Printer Diagram:

- Printer is off or is not connected
- Paper jam (causes an audible warning beep)
- Folder jam
- Printer is in Power Save mode
- In menu (the printer was taken offline at the front panel)
- Media out or mismatched to job (causes an audible warning beep)

The Printer Diagram for the 8845 displays media moving off the rolls and out of the printer as each job is printed.
Pen Widths

The 8845 printer supports changing pen widths. Using the Printer Interface you can reduce pen widths by one pixel. To do so:

5. Click on the Setup menu
6. Select Device Specific Options.
7. Select the Reduce pen widths check box.

Using a Folder with the 8845

The 8845 Folder must have the appropriate fold card inserted in order to work properly. Up to two fold cards can be inserted at one time. Refer to the Operator Manual for the Xerox 8845 Folder for more information.
XEROX WIDE FORMAT 721p, 8855 and KIP 8000

The XEROX WIDE FORMAT 721p, the XEROX WIDE FORMAT 8855 and the KIP 8000 Printer Interfaces display the following notices in the Status Box or on the Printer Diagram:

- Printer Warming
- Doors open (causes an audible warning beep)
- Paper jam (causes an audible warning beep)
- Out of toner (causes an audible warning beep)
- Waste toner full (causes an audible warning beep)
- Media out or mismatched to job (causes an audible warning beep)

The Printer Diagram for these printers illustrates media moving off the roll and out of the printer as each job is printed in real-time.

Pen Patterns

100 new patterns that generate halftones from 0-100% in 1% steps are supported. These patterns are used to automatically generate color. They are selected in the Pattern field of the Job Editor (see page 4-33), or in the PFS file (see page Appendix D-7) by entering a percentage.
Printing PDF files

To print PDF files set Output Quality Level to “Best” from the Detail Property Sheet/Output Setup tab window. Otherwise the print output may be lighter than expected.
The KIP 3620 Printer Interface, provides the following notices in the Status Box, and on the Printer Diagram:

- Doors open (also causes an audible warning beep)
- Paper jam (also causes an audible warning beep)
- Toner empty (also causes an audible warning beep)
- Waste toner full (also causes an audible warning beep)

The status box also displays notices and error messages that will not show up on the Printer Diagram:

- Printer warming
- Printer is off or is not connected

The Printer Diagram for the 3620 displays media moving off the rolls and out of the printer as each job is printed.

When a printer door, besides the media doors/drawers, is open the Printer Interface displays “Door open.”
KIP 2950 Options

The KIP 2950 Printer Interface, shown in Fig. E.6, provides the following notices in the Status Box, as well as on the Printer Diagram:

- Doors open (causes an audible warning beep)
- Paper jam (causes an audible warning beep)
- Toner empty (causes an audible warning beep)
- Waste toner full (causes an audible warning beep)

The status box also displays notices and error messages that will not show up on the Printer Diagram:

- Printer warming
- Printer is off or is not connected

The Printer Diagram for the 2950 displays media moving off the rolls and out of the printer as each job is printed.

Additional Information

When a printer door (except media doors/drawers) is open the Printer Interface displays “Door open.”
KIP 1230 Options

The KIP 1230 Printer Interface, shown in Fig. E.7, provides the following notices in the Status Box, as well as on the Printer Diagram:

• Toner empty (causes an audible warning beep)
• Waste toner full (causes an audible warning beep)

The status box also displays notices and error messages that will not show up on the Printer Diagram:

• Printer warming
• Doors open (causes an audible warning beep)
• Paper jam (causes an audible warning beep)
• Printer is off or is not connected

The Printer Diagram for the 1230 displays media moving off the rolls and out of the printer as each job is printed.

When a door is open on the printer, the Printer Interface displays “Transport open.”
KIP 7095 Options

The KIP 7095 Printer Interface provides the following notices in the Status Box, as well as on the Printer Diagram:

- Toner empty (causes an audible warning beep)
- Waste toner full (causes an audible warning beep)

The status box also displays notices and error messages that do not display on the Printer Diagram:

- Printer warming
- Doors open (also causes an audible warning beep)
- Paper jam (also causes an audible warning beep)
- Printer is off or is not connected

The Printer Diagram for the 7095 is able to depict the media moving off the rolls and out of the printer as each job is printed. This is a useful real-time feature — however, not all printers report this information to PlotWorks.

When a door is open on the printer, the Printer Interface displays “Transport open.”
KIP 9010 Options

The KIP 9010 Printer Interface provides the following notices in the Status Box, as well as on the Printer Diagram:

- Printer warming
- Doors open (causes an audible warning beep)
- Paper jam (causes an audible warning beep)
- Toner empty (causes an audible warning beep)
- Waste toner full (causes an audible warning beep)

The status box also displays notices and error messages that will not show up on the Printer Diagram:

- Printer is off or is not connected

The Printer Diagram for the 9010 displays media moving off the rolls and out of the printer as each job is printed.

When a door is open on the printer, PlotWorks indicates which door. The Printer Information box also displays “Transport open.”
Océ 9600 Printer Interface Options

The Océ 9600 Printer Interface, Printer Diagram always shows the media rolls as full. Paper moving through the printer is not indicated. The Status Box informs you when media needs adding or if a media mismatch error occurs. An audible warning beep also sounds.
**Océ 9800 Options**

The Océ 9800 Printer Interface provides the following notices in the Status Box:

- Printer Warming
- Door or panel open
- Add media or media mismatch (causes an audible warning beep)

The Printer Diagram for the 9800 displays the media rolls as always full and does not display paper moving through the printer.
Generic Embedded Controller Printers

The RTL Printer Interface supports both color and monochrome printers. The Status Box only warns you if you need to add media or a media mismatch error occurs. An audible warning beep is then also heard.

The RTL Printer Interface drawing displays the media rolls as always full.

Selecting a Different Printer Interface from an open one

With the HP-RTL Printer Interface open, you can select the desired printer from a list of printers installed on the network, if any.

1. In the Device Specific Options dialog, use the Printer name: pull-down list and select the desired RTL printer.
2. Click OK. Remember to set up the media inventory if this is the first time to use this printer.

This makes it easy to switch between network printers if one is busy.
Change from a Color to a Monochrome Printer

With the HP-RTL Printer Interface open, select **General Configuration** from the **Setup** menu. Use the pull-down list in the **Printer type:** field to select **RTL color printer** or **RTL monochrome printer**. You will be prompted to close the Printer Interface and then reopen it so the change can take effect.
Socket Printers

Socket printers are those printers that require a TCP/IP address. These include the AccXES Controller and the Océ Power Logic Controller driven printers and the Kyocera Mita 4850w. When installing these printers you need to enable LMHOSTS Lookup and know the IP Address for the computer containing the Controller. If using the AccXES controller ensure you are running firmware 6.5 or greater.

Enable LMHOSTS Lookup

1. Close all open applications ensuring that your work is saved.
2. Right click on Network Neighborhood on your Windows desktop.
3. Select Properties from the right click menu. The Network tabbed dialog box opens.
4. Click on the Protocols tab.
5. Click on TCP/IP Protocol to select it.
6. Click on the Properties button. The Microsoft TCP/IP Properties tabbed dialog box opens.
7. Click on the WINS Address tab.
8. Ensure that the Enable LMHOSTS Lookup check box is selected.
9. Click on the OK button. The Microsoft TCP/IP Properties tabbed dialog box closes.
10. Click on the Close button. The Network tabbed dialog box closes and a Network Settings Change dialog box opens.
11. Click on the Yes button. Your computer will shut down and then restart.

Obtaining the IP Address:

1. Click on the Windows Start button.
2. Click All Programs from the Windows Start menu.
3. Click on Accessories.
4. Select **Command Prompt** from the Accessories menu. The Command prompt window opens.

5. If you are working on the computer containing the Controller, type `ipconfig`
If you are on a computer connected to the same network as the one containing the Controller and you know the name of the computer containing the Controller, type `ping`, then a space and then the name of the computer containing the Controller.

6. Press **Enter** on your keyboard. The Command prompt window will list the IP address. Write the IP Address down.

**Adding a printer using the Windows Add Printer utility**

The Kyocera Mita and Océ controllers require that you add the printer using Windows Add Printer utility. Instructions for doing so are provided below:

1. Click on the Windows **Start** button.

2. Click on **Settings** from the Windows Start menu.
3. Click on **Printers** from the Settings menu.
4. Then select **Add Printers**. The Printers window opens.

5. Double click on **Add Printer**. The add Printer Wizard dialog box opens.
6. Select the radio button for **Network Printer**.
7. Click on the **Next** button.
8.50
Locate Your Printer step of the Add Printer Wizard

8. Select the radio button titled **Type the printer name, or click Next to browse for a printer**.

9. In the **Name** field enter your printers name if you know it otherwise skip to the next step.

10. Click on the **Next** button. The Connect to Printer dialog box opens.

11. Select your printer from the Shared Printers option box.

12. Click on the **OK** button.

13. Choose not to make this printer your default printer by selecting the **No** radio button.

14. Click on the **Finish** button.

**AccXES Controller Driven Printers**

The AccXES Controller runs the XEROX WIDE FORMAT 8825, 8830, 8850, 8855, 721p and the 510dp.

PlotWorks supports printer and roll status, automatic media rollover, optimized submission, printing, and folding options using the AccXES Controller.

PlotWorks connects to the AccXES controller using TCP/IP. Each print is sent as an individual file to the AccXES Job Queue with a print priority of 8. The AccXES Job Queue allows a maximum of 10 Job Queue entries.

**Configure the Printer Interface for the AccXES Controller**

1. Open the **Printer Interface** if it is not already open.
2. Click on the **Setup** menu.
3. Click on **Device Specific Options**. The Device Specific options dialog box opens.

4. In the text box titled **IP Address** enter the IP Address. Instructions for obtaining an IP Address are available under the heading “Obtaining the IP Address:” on page 8-67.

5. In the text box titled **Socket Port Number**, enter the Socket Port Number. The default port number is 2000. If you are unable to connect to your AccXES Controller with this port number contact XEROX or PLP tech support.

6. Click on the **OK** button
Océ Power Logic Controller Driven Printers

The Océ Power Logic Controller runs the TDS400, TDS600, and the TDS800 printers.

Please note that the Manual feed option does not work with this controller.

Installing Océ Power Logic Controller driven printers

Images are sent to the Océ printer via a windows printer connection. Therefore it is necessary to use the Windows Add Printer utility to add the printer to the computer running the Printer Interface first. (Appendix E contains detailed instructions on how to add a printer.)

Configure the Printer Interface for the Océ Power Logic Controller

1. Open the Printer Interface if it is not already open.
2. Click on the Setup menu.

8.52 Device Specific Options

![Device Specific Options](image-url)
3. Click on **Device Specific Options**. The Device Specific options dialog box opens.

4. Ensure that your printers name appears in the text box titled **Printer name**.

5. In the text box titled **IP Address** enter the IP Address. Instructions for obtaining an IP Address are available under the heading, “Obtaining the IP Address:” on page 8-67.

6. In the text box titled **Socket Port Number**, enter the Socket Port Number. The default port number is 2000. If you are unable to connect to your AccXES Controller with this port number contact PLP tech support.

7. If your printer uses a PDF controller, the Username and Password fields are available. In this case, enter values for these fields.

8. Click on the **OK** button.

**Kyocera-Mita Controller**

The Kyocera-Mita controller runs the 4850w printer. This controller requires that the Windows printer driver be installed using Windows Add Printer utility. (Appendix E contains detailed instructions on how to do so.) This driver is available on the CD that came with the printer.

PlotWorks communicates with this controller using SNMP, ports 60-61. This connection provides bi-directional support on roll information and printer status.

In order for the Kyocera-Mita controller to function properly, either connect the Kyocera-Mita controller directly to the PlotWorks printer or ensure that port 80 is open on the network.

**Configure the Printer Interface for the Kyocera-Mita Controller**

1. Open the **Printer Interface** if it is not already open.

2. Click on the **Setup** menu.

3. Click on **Device Specific Options**. The Device Specific options dialog box opens.
4. Ensure that your printer’s name appears in the text box titled **Printer name**.

5. In the text box titled **IP Address** enter the IP Address. Instructions for obtaining an IP Address are available under the heading, “Obtaining the IP Address:” on page 8-67.

6. Click on the **OK** button.
Windows Printers

The Windows Printer Interface, shown in Fig. E.14, supports both color and monochrome printers. The Status Box provides the following notice only:

- Add media or media mismatch (causes an audible warning beep)

The Windows Printer Diagram resembles a laser printer with four media trays. Windows printers do not generally report what percentage of paper has been used, therefore the Printer Interface displays the trays as always full.

Selecting a Windows Printer

With the Printer Interface open, you can select the desired printer from a list of printers installed on the network, if any.

1. From the Setup menu, select Device Specific Options.
2. In the Device Specific Options dialog, use the Printer name: pull-down list and select the desired Windows printer.
3. Click OK. Remember to set up the media inventory if this is the first time using this printer.

This makes it easy to switch between network printers if one is busy.
Change from Color to Monochrome

With the Windows Printer Interface open, select **General Configuration** from the **Setup** menu. Use the pull-down list in the **Printer type:** field to select **Windows color printer** or **Windows monochrome printer**. You will be prompted to close the Printer Interface and then reopen it so the change can take effect.

**Paper Sizes Supported by Windows Printers**

PlotWorks supported supports the following sizes on Windows printers:

<table>
<thead>
<tr>
<th>Media Type</th>
<th>Media Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>LETTER</td>
<td>8.5 x 11 inches</td>
</tr>
<tr>
<td>LETTER SMALL</td>
<td>8.5 x 11 inches</td>
</tr>
<tr>
<td>TABLOID</td>
<td>11 x 17 inches</td>
</tr>
<tr>
<td>LEDGER</td>
<td>17 x 11 inches</td>
</tr>
<tr>
<td>LEGAL</td>
<td>8.5 x 14 inches</td>
</tr>
<tr>
<td>STATEMENT</td>
<td>5.5 x 8.5 inches</td>
</tr>
<tr>
<td>EXECUTIVE</td>
<td>7.25 x 10.5 inches</td>
</tr>
<tr>
<td>A3</td>
<td>297 x 420 millimeters</td>
</tr>
<tr>
<td>A4</td>
<td>210 x 297 millimeters</td>
</tr>
<tr>
<td>A4 SMALL</td>
<td>210 x 297 millimeters</td>
</tr>
<tr>
<td>A5</td>
<td>148 x 210 millimeters</td>
</tr>
<tr>
<td>B4</td>
<td>250 x 354 millimeters</td>
</tr>
<tr>
<td>B5</td>
<td>182 x 257 millimeters</td>
</tr>
<tr>
<td>FOLIO</td>
<td>8.5 x 13 inches</td>
</tr>
<tr>
<td>QUARTO</td>
<td>215 x 275 millimeters</td>
</tr>
<tr>
<td>10X14</td>
<td>10 x 14 inches</td>
</tr>
<tr>
<td>11X17</td>
<td>11 x 17 inches</td>
</tr>
<tr>
<td>NOTE</td>
<td>8.5 x 11 inches</td>
</tr>
<tr>
<td>Envelope (9)</td>
<td>3.875 x 8.875 inches</td>
</tr>
<tr>
<td>Envelope (10)</td>
<td>4.125 x 9.5 inches</td>
</tr>
<tr>
<td>Envelope (11)</td>
<td>4.5 x 10.375 inches</td>
</tr>
<tr>
<td>Envelope (12)</td>
<td>4.75 x 11 inches</td>
</tr>
<tr>
<td>Envelope (14)</td>
<td>5 x 11.5 inches</td>
</tr>
<tr>
<td>C Sheet</td>
<td>17 x 22 inches</td>
</tr>
<tr>
<td>D Sheet</td>
<td>22 x 34 inches</td>
</tr>
<tr>
<td>E Sheet</td>
<td>34 x 44 inches</td>
</tr>
<tr>
<td>Envelope (DL)</td>
<td>110 x 220 millimeters</td>
</tr>
<tr>
<td>Envelope (C5)</td>
<td>162 x 229 millimeters</td>
</tr>
<tr>
<td>Envelope (C3)</td>
<td>324 x 458 millimeters</td>
</tr>
<tr>
<td>Envelope (C4)</td>
<td>229 x 324 millimeters</td>
</tr>
<tr>
<td>Envelope (C6)</td>
<td>114 x 162 millimeters</td>
</tr>
<tr>
<td>Envelope (C65)</td>
<td>114 x 229 millimeters</td>
</tr>
<tr>
<td>----------------------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Envelope (B4)</td>
<td>250 x 353 millimeters</td>
</tr>
<tr>
<td>Envelope (B5)</td>
<td>176 x 250 millimeters</td>
</tr>
<tr>
<td>Envelope (B6)</td>
<td>176 x 125 millimeters</td>
</tr>
<tr>
<td>Envelope (ITALY)</td>
<td>110 x 230 millimeters</td>
</tr>
<tr>
<td>Envelope (MONARCH)</td>
<td>3.875 x 7.5 inches</td>
</tr>
<tr>
<td>Envelope (PERSONAL)</td>
<td>6.75 x 6.5 inches</td>
</tr>
<tr>
<td>FANFOLD U.S.</td>
<td>14.875 x 11 inches</td>
</tr>
<tr>
<td>FANFOLD STD GERMAN</td>
<td>8.5 x 12 inches</td>
</tr>
<tr>
<td>FANFOLD LGL GERMAN</td>
<td>8.5 x 13 inches</td>
</tr>
<tr>
<td>ISO B4</td>
<td>250 x 353 millimeters</td>
</tr>
<tr>
<td>JAPANESE POSTCARD</td>
<td>100 x 148 millimeters</td>
</tr>
<tr>
<td>9X11</td>
<td>9 x 11 inches</td>
</tr>
<tr>
<td>10X11</td>
<td>10 x 11 inches</td>
</tr>
<tr>
<td>15X11</td>
<td>15 x 11 inches</td>
</tr>
<tr>
<td>Envelope INVITE</td>
<td>220 x 220 millimeters</td>
</tr>
<tr>
<td>RESERVED 48</td>
<td>0 x 0</td>
</tr>
<tr>
<td>RESERVED 49</td>
<td>0 x 0</td>
</tr>
<tr>
<td>LETTER EXTRA</td>
<td>9.75 x 12 inches</td>
</tr>
<tr>
<td>LEGAL EXTRA</td>
<td>9.75 x 15 inches</td>
</tr>
<tr>
<td>TABLOID EXTRA</td>
<td>11.69 x 18 inches</td>
</tr>
<tr>
<td>A4 EXTRA</td>
<td>9.27 x 12.69 inches</td>
</tr>
<tr>
<td>LETTER TRANSVERSE</td>
<td>8.75 x 11 inches</td>
</tr>
<tr>
<td>A4 TRANSVERSE</td>
<td>210 x 297 millimeters</td>
</tr>
<tr>
<td>LETTER EXTRA TRANSVERSE</td>
<td>9.75 x 12 inches</td>
</tr>
<tr>
<td>A PLUS</td>
<td>227 x 356 millimeters</td>
</tr>
<tr>
<td>B PLUS</td>
<td>305 x 487 millimeters</td>
</tr>
<tr>
<td>LETTER PLUS</td>
<td>8.5 x 12.69 inches</td>
</tr>
<tr>
<td>A4 PLUS</td>
<td>210 x 330 millimeters</td>
</tr>
<tr>
<td>A5 TRANSVERSE</td>
<td>148 x 210 millimeters</td>
</tr>
<tr>
<td>B5 TRANSVERSE</td>
<td>182 x 257 millimeters</td>
</tr>
<tr>
<td>A3 EXTRA</td>
<td>322 x 445 millimeters</td>
</tr>
<tr>
<td>A5 EXTRA</td>
<td>174 x 235 millimeters</td>
</tr>
<tr>
<td>B5 EXTRA</td>
<td>201 x 276 millimeters</td>
</tr>
<tr>
<td>A2</td>
<td>420 x 594 millimeters</td>
</tr>
<tr>
<td>A3 TRANSVERSE</td>
<td>297 x 420 millimeters</td>
</tr>
<tr>
<td>A3 EXTRA TRANSVERSE</td>
<td>322 x 445 millimeters</td>
</tr>
</tbody>
</table>

Please refer to your printer manual for the actual sizes supported by your printer.
Chapter 9

The Scanner Interface

The Scanner Interface application adds copying and scan-to-file capability to your PlotWorks system. You can use the Scanner Interface as a stand-alone application or with the Job Editor.

The Scanner Interface offers a wide variety of image enhancement tools and scanning options, these include:

- Fine-tuning image quality (background, sharpness, darkness, etc.)
- Adjusting image resolution and scanning speeds
- Inverting images (white areas become black, and vice versa)
- Reducing and enlarging the image output size (images are scanned at 100%)
- Setting image offsets
- Saving scanned files as CALS 1, TIFF Group 3, TIFF Group 4, CT1, or PDF files
- Scanning directly to a PlotWorks job file (called a job ticket)
- Scanning to print and file simultaneously
- Viewing images as they are scanned
- Making copies
- Scanning and replacing files
- Creating and maintaining customer and scanning records

Opening the Scanner Interface

The Scanner Interface can be opened directly or from the Job Editor. When the Scanner Interface is opened from the Job Editor, all scanned images are added to the Job Editor Job Grid as well as saved in the designated folder.

Opening the Scanner Interface Directly

1. Click on the Windows Start button, then Programs, then PlotWorks.
2. Click on the Scanner Interface

Opening the Scanner Interface from the Job Editor

Simply click on the Scan button from the Job Editor tool bar.
The available fields and settings on the Scan Controls tab differ for individual scanners. Scanner-specific information is provided later in this chapter.

There are five tabs on the Scanner Interface:

- **Scanner Main**: This tab window is used to set up basic scan parameters such as number of copies, size and scan type.

- **Scan Controls**: This tab window is used to select scanner settings for each type scan. Predefined configurations are provided for some image scan types including blueline, dirty blueline, sepia, etc.

- **File Naming/Viewing**: This tab window is used to enable and configure automatic and consecutive file naming, as well as to select an image viewer to use for viewing scanned images.

- **General Configuration**: Use this tab window to select your scanner type, configure its parameters and set image size and offset.
• **About:** Displays legal information and PlotWorks software versions.

**The Main tab window**

The following fields and buttons appear on the Main Scanner Interface tab window:

• **Title bar:** Displays the scanner type, and either the name of the most recently scanned file or the file currently selected in the Job Editor.

• **Configuration:** Displays the current scanner configuration. You can save scanner settings for later use.

• **Mode:** Select the appropriate scanner mode for your scan type. Modes available depend on the scanner used.

• **Scan directory:** Enter the directory path to save scanned images in.

*If the Scanner Interface is launched from the Job Editor, the Scan directory field is unavailable. Scanned images are then saved in the directory specified in the Job Editor’s Preferences dialog box.*

• **Browse button:** Lets you look for the desired scan directory (this button is only available when you launch the Scanner Interface from Windows Explorer, or its shortcut. If you launch the Scanner Interface from within the Job Editor, the Browse button is not available, and files will be scanned into the default directory.).

• **Next file:** The file name that will be given to the next scan.

• **Scan Controls:** Click this button to display the Scan Controls tab window.

• **Scan to Disk:** Click this button to scan image files to the Job Editor job grid. You can add multiple scanned images to a new or existing job. (This button cannot be disabled.)

• **Scan to Print:** Click this button to send the scanned file to the Queue for processing and printing. The image prints using the most recent parameters set up in the Job Editor.

*This option is only available when you access the Scanner Interface from within the Job Editor.*

• **Number of Copies:** This field is not available unless the Scanner Interface is opened from within the Job Editor. It is used to enter the desired number of print copies.

• **Last Scan Size:** Displays the size of the last image scanned.
• **Reduce or Enlarge**: Reduces or enlarges the scanned image to a percent of its original size. Preset buttons allow you to scale the image from 25% to 400% depending on the scanner. You can also enter the desired percentage in the field above the buttons. To select a size based on a particular paper size, click a pre configured ISO, ANSI, or Architectural size button.

This option is only available when you access the Scanner Interface from the Job Editor.

• **Stop**: Click this button to stop the scanner and eject the image being scanned.
• **Start**: Click this button to start the scanner when Auto scan is not selected.

On some scanners, when the Main Scanner tab window or Scan Controls tab window is active, you can press **Enter** to start the scanning process.

• **Status**: Displays the status of the Scanner Interface and the scanner.
• **View**: Click this button to open the Image Viewer and display the current file.
• **ReScan**: Scans the loaded document and replaces the current file with the new scanned image. Use when testing changes in the configuration settings.
• **Print**: This button is enabled only when the Scanner Interface is launched from the Job Editor (by clicking the **Scan** button). Use it to send the image just scanned to the Job Editor, where it can be sent to your PlotWorks printer.

• **Close button**: Exits the Scanner Interface.
• **Help button**: Opens the Scanner Interface online help file.
The following options are available on the Scan Controls tab window:

- **Configuration:** Is used to view, save, and select a configuration file.

- **Mode:** Select the appropriate scanner mode (available modes depend on the scanner).

  Possible modes are:

  - **Bilevel (Manual):** This mode works best with line art that has a fairly constant background

  - **Bilevel (Adaptive Area):** This mode works best with line art that uses text or other fine lines, with a varying background (such as a faded blueline). Adaptive thresholding allows the Scanner Interface to set different white point (background) values for different areas of the image. The white point is set by determining the difference between the background and the data in a set area. The size of this area is specified in the Area Size setting. This mode does not work well with documents containing large black areas.
• **Ordered Dither**: This mode works best with photographic images. Ordered dithering resolves lines clearly, but can produce a grainy image. Ordered Dither creates larger raster file sizes.

• **Error Diffusion Dither**: This mode works best with photographic images and produces very smooth gradients. However, this mode can diffuse the edges of lines, causing a “fuzzy” look. Error Diffusion Dither creates larger raster file sizes.

• **Bilevel**: This mode works best with line art.

• **Dither/Halftone**: This mode works best with photos or grayscale images.

• **Line**: This mode works best with line art.

• **Photo1**: This mode works best with photographic images.

• **Photo2**: This mode works best with dark prints.

• **Text**: This mode works best with text.

• **Photo**: This mode works best with photographic images.

• **Text and Photo**: This mode works best with photographic images and less than perfect originals.

• Use the preset enhancements buttons (below the Configuration and Mode fields) for common settings, then fine-tune with the arrows. Default settings depend on the scanner selected. These options allow you to fine-tune the appearance of your scans by changing darkness, sharpness and other variables. The specific options that appear depend on your scanner model and the configuration selected. Click **ReScan** to test changes.

Possible enhancements are:

• **Threshold**: Lets you set the point that divides black and white data. Any scanned data that is lighter than the threshold value will display as white. Any scanned data that is darker than the threshold value will display as black. Click the **Low**, **Medium**, or **High** button, or enter a value in the field.

• **Background removal**: Is used to remove unwanted specks and smears from the image background. Click the Light, Auto, or Heavy button, or enter a value in the field.

• **Background bias**: If you clicked Auto under Background removal, you can set a strength here. The higher the strength, the more specks and smears will be removed from the background.

• **Edge sharpening**: Lets you sharpen the image to make fine lines clearer. Click the **Soft**, **Normal**, or **Sharp** buttons, or enter a value in the field.
NOTE: When using Edge Sharpening with the Xerox MAX 200 or 8180 scanners, all color sensitivity values must be set to 0.

- **Darkness**: Lets you set the brightness or darkness of the image. Click the **Light**, **Medium**, or **Dark** button, or enter a value in the field.

- **Area size**: Lets you set the size of the area used for adaptive thresholding. This value is a relative number, with 0 representing the minimum area allowed, and 100 representing the maximum area allowed. Set this option to scan past any dark or light leading edges on the image. Click the **Small**, **Normal**, or **Large** button, or enter a value in the field.

- **Contrast**: This option is only available when you have dither/halftone mode selected and allows you to adjust the contrast between light and dark areas.

- **Auto thresholding**: When selected (down), this option automatically determines the best threshold setting for the image being scanned.

- **Auto exposure (Xerox 7396, 7399 and KIP scanners only)**: When selected (down), the software automatically sets the best darkness, white point, and sharpening values as each image is loaded.

- **Image Density**: Use this feature to lighten or darken the scanned image.

On the 8180 scanner, the image density affects the color sensitivity. For example: the lower the image density, the less color the scanner interface detects.

- **Background Suppression**: Removes unwanted background.
  - **Type**:
    - **None**: Background suppression is disabled.
    - **Fixed**: Use when the background is uniform.
    - **Variable**: Use when the background varies from dark to light areas.
  - **Level**: Determines the amount of light or dark to remove from the background.

- **Color Sensitivity (Xerox MAX 200 and 8180 only)**: Is used to adjust the final appearance of colors on the original document. The color areas will appear as their relative shades of black. You can adjust the scanner’s sensitivity to black, red, blue, yellow, and green. Use the “Others” field for all other colors.
- **White point**: Sets the white point of the image. All data that is lighter than the white point value will appear as white in the image.

- **Black point**: Sets the black point of the image. All data that is darker than the black point will appear as black in the image.

These additional options (also scanner-dependent) are available in the Scan Controls window:

- **Scanner speed**: You can set some scanners to operate at full speed or at a percentage of full speed. It is recommended to scan complex documents at a low speed to avoid overloading the system. This option is not available on some scanners.

- **Scan file format**: You can save scanned images as CALS Group 4, TIFF Group 3, TIFF Group 4, CT1 and PDF raster files.

- **Resolution**: Allows you to select a scanning resolution of 200 or 400 dpi. A higher resolution value produces higher quality prints and larger file sizes. A lower resolution reduces scanning time and file size but produces lower quality images.

<table>
<thead>
<tr>
<th>Warning</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>If 200 dpi is selected, some scanners will clip up to 1/4&quot; off the leading edge of the image being scanned. If the actual image does not go all the way to the edge of the medium, this is not a problem.</strong></td>
</tr>
</tbody>
</table>

- **Image buttons**:

  - **Mirror image** button: Click this button if you want the image to be scanned as a mirror of itself.

  - **Invert image** button: Click here to invert the colors in your scanned images. This causes the white portions of the document to become black in the scanned image, and vice versa. This option is not available on the Xerox 7396 scanner.

  - **Auto view** button: When you select this option, images display in the Image Viewer as they are scanned.

  - **Auto length** button (Océ 9800 scanner): The Océ scanner normally scans images to standard sizes. However, if you want the image to be scanned to its actual length, click this button.

  - **Auto scan** button: When you click this, the Scanner Interface is put in automatic scan mode. Auto Scan is useful when you have several images with the same general characteristics (they are all dark sepia, for example). Once
you get the scanner configured correctly for that type of image, click **Auto scan**. All scans will be made at the current settings. (This option is not available for some scanners.)

---

**Please note that due to hardware limitations, when using Auto Scan, digital files cannot be created larger than the original. When Auto Scan is selected, you can only scan in standard, or reduced sizes. If you wish to scan in larger, or non-standard sizes, deselect Auto Scan, and then enter the size manually.**

---

There is no need to click on the Start button because the scanner will start scanning as soon as the document is loaded.

- **Scan right** button (available on the 7356 scanner only): By selecting this option, the user inserts the document on the right 36” mark. The image is not center-oriented.

- **Eject** combo box: Allows you to select one of the following auto eject options; Front, Back and None. This option is available on the Xerox 7356 and Vidar scanners only. The Xerox 7396 always ejects from the back.

- **Error beep** button: Click this button to enable an alarm when the software cannot auto detect the document size (not available on the Xerox MAX 200, 8180, Océ, or KIP scanners).

- **Compress in scanner** (Xerox 7336 only): When enabled, file compression takes place in the scanner memory.

- **Save** button: Lets you save the current scanning configuration. *(Note: You can only save your own custom configurations. You cannot change the Default configuration.)*

- **Delete** button: Lets you delete the selected configuration. *(Note: You cannot delete the Default configuration, or any of the other preset configurations. You can only delete your own custom configurations)*

- **Stop** button: Stops the scanner and the ejects the image being scanned.

- **Start** button: Starts the scanner if it is not set to autoscan mode.

**The File Naming/Viewing tab window**

This tab window lets you set up options for naming and saving scanned images. You can also select an image viewer other than the PlotWorks Image Viewer, with which to view scanned images.
The following options are available on the File Naming/Viewing tab window:

- Auto naming button: Click here to turn on or off automatic file names. Auto naming lets you scan one image after another without having to enter a name for each image. The file name increases by increments of one in the Increment Suffix By box every time a scan is made.
  
  - Filename prefix: This box specifies the prefix of the next scan and the next suffix is appended to the prefix to create the next file name.
  
  - Start suffix at: Enter a starting number (usually 0). This number is added to the end of the first filename (example: Scan00).
  
  - Next suffix at: This specifies which number will be appended and combined with the Filename prefix to create the next file name.
  
  - Restart suffix after: This is the last number used with your chosen prefix (the default is 999) before the autonumbering starts over.
  
  - Long filenames button: Click this to enable or disable long filenames.
  
  - Confirm file replacement button: Click here to be notified when a file is about to be overwritten — this gives you the opportunity to rename the file or change the filename.
• **Viewer Selection** settings let you choose a different image viewer (other than the PlotWorks Image Viewer) with which to view scanned images.
  
  • **TIFF** button: Click this button to automatically select which viewer to use when viewing TIFF files (Wang is the default).
  
  • **CALS** button: Click this button to select a viewer for the CALS files (no Wang).
  
  • **PDF** button: Click this button to select a viewer for PDF files.
  
  • **Viewer path**: Enter the path (including the drive letter, directory and executable) to the desired viewing application executable or shortcut (for example: C:\Program Files\Myriad\Myriad.exe).

You can also include command line parameters on this line.

• **Browse** button: Lets you browse the file system for the viewing application’s executable or shortcut.

• **Scan and Replace Mode** button: This button is used to replace a CAL or TIFF file saved digitally with a new scanned image.

**The General Configuration tab window**

This tab window lets you set up basic parameters such as the size of the original document, image offsets, and units of measurement. In addition, you can enable the foot pedal COM port, if supported by your scanner, and set the paper size standards to use (Architectural, ISO, or ANSI)
The following options are available in the **General Configuration** tab window:

- **Scanned Document Descriptions:**
  - **Original size:** Select the type of the hard copy document to be scanned (the dimensions associated with each type are displayed alongside the specified type). To specify a nonstandard size, select USER and enter the document’s width and height in the Width and Height fields. The Scanner Interface also offers several automatic size detection options.
  
  - **Original width:** The width of the original document in current units of measure. When you select a standard size in the Size field, this field automatically displays the correct width. If you select USER or Auto Height in the Size field, you must enter a correct width value. *(Note: for
the XES MAX 200 or 8180, you cannot specify a width larger than the actual document width.

- **Original height:** The height of the original document in current units of measure. When you select a standard size in the Size field, this field automatically displays the correct height. If you select USER in the Size field, you must enter a correct height value.

- **Document offsets:** You can offset your scanned image from the edge of the page. You can also set a negative* ‘Y’ or ‘X’ offset value to remove large borders from your image. (*Only with KIP scanners)

  - **X offset:** Enter an X offset distance (inches or mm) in this box. The X axis is always the lead/trail edge of the image. The X offset limit is “X + document width” not to exceed 36 inches.

  - **Y offset:** Enter a Y offset distance (inches or mm) in this box. The Y axis is always the height of the image. The Y offset can be from 0 inches to 10 inches.

- **Original Setup** group box:

  - **Bottom Edge:** When the Scanner Interface is opened through the Job Editor, users can use the Bottom Edge pull-down list to set the bottom edge for the page being scanned. Users can select from: Bottom, Left, Right, or Top.

- **Scanner Setup Parameters:**

  - **SCSI capability:** (7356 Scanner only) When the Scanner is set to Auto Scan, this field displays diagnostic information. If you are experiencing scanning problems, Technical Support might ask you for the values in this field to help them resolve the problem. In general, you can ignore this field.
• Scanner type: Allows you to select the type of scanner you are using. It is not currently possible to run more than one Scanner Interface at a time.

• Image data buffer size: You can adjust the data buffer size for the scanner by allocating a certain amount of system memory to the scanner. The amount of memory allocated affects the height of the scans that can be held in the buffer while scanning. Too little memory will slow down the system and your image might not scan fully.

• Foot pedal COM port: The optional scanner foot pedal lets you scan documents at the scanner, without having to send a command from the Control Station. Click the appropriate button to select a COM port for the 7336 foot pedal.

• Scan units: Select the units of measure to use when scanning – inches or millimeters.

• Paper sizes: Select the paper size to use – ANSI or ISO.

Accounting tab window
If required for accounting purposes, all applicable customer/client information can be entered, thus maintaining a tracking system.
The following fields appear in the Accounting tab window when the Same As Company function is enabled:

- **Company/Project/Account**: This is the field where the Company/Project/Account information is displayed.
- The Hierarchical Tree Window displays the layout of accounting information.
- **New Account**: This button will create a new account in the Hierarchical Tree window.
- Standard information fields such as; **Contact** (name), **Address** and **Address** (in case of two addresses), **City**, **State/Province**, **Zip code/Postal Code**, **Phone**, and **Comment** (field for client/job-related explanations).
• **Same As Company:** When enabled, this button displays current company information in the standard information fields, meaning that the project has the same contact, address, city/state, zip/postal code, and phone as the company. When disabled, information can be entered into the standard information fields.

• **Billable** button determines whether the job is billable.

• **Show On Start Up:** When operating the scanner interface, Accounts panel will appear.

• **Disable ARU:** Selecting this button will disable the Advanced Reporting Utility (See "Advanced Reporting Utility (ARU)" on page 10-1 for more information.).

• **Timeout:** Determines the time period (in minutes) after which the scanner device will go into sleep mode. If you set it to “0”, then the device won’t go into sleep mode.

• **Compact Database:** Selecting this button will take the current data and condense the database.

• **Save, Cancel and Delete:** The Save button will save all data entered in the tab window to the database. The Cancel button returns the Accounting tab window to the previous settings. The Delete button clears all data from the tab window.
Setting Up the Scanner Interface

When the Main Scanner tab window or Scan Controls tab window is active, you can press Enter to start the scanning process.

There are a few steps required to set up your scanner parameters before you begin scanning images. This section takes you through the process.

(Note: Once a file is scanned, you cannot change the darkness, cleanliness, or size of the image. You can use third-party applications to perform these tasks. You can scale the size of your print output in the Job Editor. See "Setting the Image Data Buffer Size" on page Chapter 9-23.)

Set Basic Scanning Parameters

To begin:

1. Open the Scanner Interface for your scanner, if it is not already open.
2. Click the General Configurations tab.
3. Under Setup Parameters select the units of measure for scanned images — Inches or mm.
4. Click the desired Paper size unit: ANSI or ISO.
5. If you are using a foot pedal, click the appropriate COM port button (or None if there is no foot pedal attached). These buttons are disabled if your scanner does not support a foot pedal.

Set Up File Naming

The Scanner Interface lets you set up both an automatic naming system and a custom naming system for your scanned files. To use autonaming as it existed in previous versions of PlotWorks, be sure to click the Prefix and Suffix with auto increment button, then specify a prefix name and the Scanner Interface will number each scanned file sequentially.

To set up automatic file naming:

1. Click the File Naming/Viewing tab.
2. Click the Auto naming button.
3. Click **Prefix and suffix with auto increment**.

4. Enter a prefix (usually a descriptive name) in the **Filename prefix** field. If you want to use long filenames, click the **Long filenames** button.

<table>
<thead>
<tr>
<th>Long filenames should be used with caution when scanning for archives or for use with other applications. Long filenames are not compatible with DOS and DOS applications.</th>
</tr>
</thead>
</table>

5. Enter a starting number in **Start suffix at**: (usually 0). This number is added to the end of the first filename: Scan00.

6. Enter a **Next suffix at**: (usually 1). This number is added to the name of the next scanned file, thus providing a sequential numbering system: Scan00, Scan01, etc.

7. Enter a **Restart suffix after** number. This will be the last number used with your chosen prefix (the default is 999) before autonumbering starts over.
If you continue scanning after reaching the Restart suffix number, the Scanner Interface starts over again with the starting number, and overwrites any files in the working directory with the same name. Click the Confirm file replacement button to see a confirmation prompt before overwriting files.

8. Click the Scanner Main tab.

9. In the Scan Directory field, enter the path to the directory in which to save your scanned images. Use the Browse button to look for the directory, if desired.

If the Scanner Interface was launched from the Job Editor, this field is unavailable—the working directory is determined by the location of the current PLP file. This value cannot be changed. EXAMPLE: PLP is saved in directory C:\Scans; the working directory will be C:\Scans. If the PLP is untitled, the working directory will reflect the PlotWorks install directory.

To set up custom file naming:

1. Click the File Naming/Viewing tab.
2. Click the Auto Naming button.
3. Click Prefix only. The Next file text box becomes available. However, the Start suffix at, Next suffix at, and Restart suffix after fields become unavailable.
4. Type a name or prefix in the Filename prefix text box. This name will also appear in the Next file text box.
5. When you type in your custom prefix, the next number is reset to the start number.
6. Click the Scanner Main tab.
7. In the Scan Directory field, enter the path to the directory in which to save your scanned images. Use the Browse button to look for the directory, if desired.
8. After the image is scanned, the Next file text box is replaced with the scan prefix only, and you can name the next file.

If you do not want to use the automatic file naming system, you can name files manually as they are scanned.

To name files manually:

1. Click the File Naming/Viewing tab.
2. Click the Auto naming button (so that it is in the up position). This turns off automatic naming.
3. Before scanning a document, enter a file name in the **Next File** field on the Scanner Main tab window. This name applies to the next image when it is scanned.

4. Repeat step 3 before each new scan.

**Image File Formats**

You can save your scanned images in CALS Group 4, TIFF Group 3, TIFF Group 4, CT1, and PDF raster files formats.

**To choose a format:**

1. Click the **Scan Controls** tab. (See Fig 9.2).
2. In the **Scan file format** field, click the desired format button.

**Set the Scanning Resolution**

**To set the resolution of a scanned image:**

1. Click the **Scan Controls** tab. (See Fig 9.2).
2. Click a preset resolution (200 or 400 dpi) button in the **Resolution** field. A higher resolution value produces higher quality prints, which results in larger files and longer scanning times. A lower resolution reduces scanning time and file size.

**Set the Scanning Speed**

You can set your scanner to operate at full speed or at a percentage of its full speed. We recommend scanning complex documents at a lower speed to avoid overloading the system.

---

**This option is not available for some scanners.**

**To set the scanner speed:**

1. Click the **Scan Controls** tab. (See Fig 9.2).
2. Select a speed in the **Scanner speed** box.

**Choose a Document Ejection Option**

You can determine where scanned documents exit from the scanner.

---

**This option is available for the Xerox 7356 and Vidar scanners only. The Xerox 7396 and 7399 always eject from the back.**

**To choose a document ejection option:**

1. Click the **Scan Controls** tab. (See Fig 9.2).
2. Select which ejection from the scanner is desired; Front, Back, or None from the Eject combo box. Use this option if you plan to rescan. The image does not fully leave the scanner until the next image is loaded. Use this option if you plan to scan multiple images consecutively.

**Right Edge Scanning**

If scanning a nonstandard size document, select the Right Edge Scanning option to have the software automatically detect the document width.

When Right Edge Scanning is selected, load documents to be lined up along the right edge of the scanner. Documents must be at least 16.5 inches (420 mm) wide to use this option.

1. Click the Scan Controls tab.
2. Click the Scan right button (below the Eject combo box).

**Reduce or Enlarge an Image**

To scale the image to a percent of the original document size:

1. Click the Scanner Main tab.
2. Click a button to set a reduction or enlargement value between 25 and 400 percent of the original document size, or enter a percentage in the value field.

This option is not available for all scanners.

**Invert Images**

The Scanner Interface allows you to invert the colors in your scanned images. This causes the white portions of the document to become black in the scanned image, and vice versa.

To invert a scan:

1. Click the Scan Controls tab.
2. Click the Invert button (below the Image label for most scanners).

**Mirror Image**

To mirror an image:

1. Click the Scan Controls tab.
2. Click the Mirror button (below the Image label for most scanners).

**Set the Document Size**

Before scanning a document, you must enter its size into the Scanner Interface. Or, you can set the Scanner Interface to detect the document size automatically.
To select a standard document size:
1. Click the General Configuration tab.
2. In the Original Size pull-down field, select one of the following options:
   • Select the actual document size, or:
   • Select AUTO STANDARD SIZE to have the software automatically detect the closest (higher) standard size.

To select a nonstandard document size:
In the Size field, select one of the following options (some of these settings might not be available, depending on the scanner you are using):
• Select USER SIZE, then enter the document’s width and height values in the Width and Height fields.
• Select AUTO SIZE to have the scanner automatically detect the actual width and height. Only available on the Xerox 7356, Vidar Flash and Vidar Flash+ scanners.
• Select AUTO STANDARD SIZE to have the software automatically detect the closest (higher) standard size.
• Select AUTO STANDARD WIDTH to have the software automatically detect the closest (higher) standard width. PlotWorks detects the actual height of the document, even if it is not a standard size. When this option is selected, a length must be specified.
• Select AUTO HEIGHT to have the software automatically detect the height of the document. The user sets the actual width of the document.
• AUTO SIZE 9” SERIES (Xerox 7336 only). Automatically detects the image size when it is scanned and selects the appropriate Architectural size.
• AUTO SIZE 8.5” SERIES (Xerox 7336 only). Automatically detects the image size when it is scanned and selects the appropriate ANSI size.

Set the Document Offset
You can offset your scanned image from the edge of the page.

Only KIP scanners support negative offsets.

• To set the offset:
  1. Click the General Configuration tab. (See )
  2. Enter an X offset distance (inches or mm) in the X offset box.
     The X offset limit is “X + document width” not to exceed 36 inches.
  3. Enter a Y offset distance (inches or mm) in the Y offset box.
The Y offset can be from 0 inches to 10 inches.

For the Xerox 7356, and Vidar scanners, the offset is from the right edge of the scanner, not the right edge of the paper. Refer to the operator manual for your scanner.

### Setting the Image Data Buffer Size

You can adjust the data buffer size for the scanner by allocating a certain amount of system memory to the scanner. The amount of memory allocated affects the height of the scans that can be held in the buffer while scanning. Too little memory will slow down the system and your image might not scan fully. The Scanner Interface will not allow you to allocate more memory than is available in your system. If you try to set the amount of memory too high, this generates an error message.

Another drain on memory is enlarging or reducing documents while scanning them. If you are planning to resize a document, scan it at 100% and then use the Job Editor to scale it. This is a much faster, more efficient way to size images before printing.

See "Image Data Buffer Size Guidelines for the Scanner Interface" on page Appendix A-5 for more information.

1. Click the **General Configuration** tab.
2. In the **Scanner Setup Parameters** box, enter the amount of memory to use in the **Image data buffer size** field (the default is 35 MB).

If the system is printing and scanning at the same time and too much memory is allocated to the scanner interface, the printing speed and/or the operation of Windows NT could be affected.
Enhancing Images

Each scanner can operate in several different modes, depending on the type of document being scanned. Select the mode you want in the **Mode** field on the Scan Controls tab window.

Beneath the Mode field there are a variety of buttons and fields that allow you to fine-tune the scanned image. The buttons that are active depend on the scanner you are using and the mode you have selected.

When the Main Scanner tab window or Scan Controls tab window is active, you can start the scanning process by clicking **Enter**.

Remove Background Automatically

Even when you are not scanning in Automatic mode, you can set up the Scanner Interface to determine the best Background Removal value automatically. Removing unwanted background specks reduces the file size and allows the image to compress more efficiently.
To set up Automatic Background Removal:
1. Click the Scan Controls tab.
2. Click the Auto button under Background Removal (just below the Configuration: field).

If available and active, you can set the strength of the background removal by using the arrows in the Background bias field. The higher the strength, the more specks and smears will be removed from the background.

Working with Standard Configurations
The Scanner Interface allows the saving of custom scanner settings for later use. Several scanner configurations can be saved under different names, and users will have access to them at any time when scanning similar documents is required. For example, one configuration for scanning line drawings can be created and a different one created for scanning photos or old sepia prints.

To save your current scanner settings:
1. Click the Scan Controls tab (if not already displayed).
2. Enter a name for your custom configuration in the Configuration: field.
3. Click the Save button. The configuration is added to the list.

To open a saved scanner configuration:
• Select the configuration from the Configuration: drop-down list.

To delete a custom scanner configuration:
1. Click the Scan Controls tab (if not already displayed).
2. Select the configuration you want to delete from the Configuration: drop-down list. You cannot delete the default configuration.
3. Click the Delete button.
Scanning, Copying and Viewing

Scan Documents Automatically

The system can be set up to scan files automatically as they are loaded into the scanner. The files are scanned according to current scanner configuration. Auto Standard Size will be selected automatically if your scanner does not support user-defined sizes in this mode. If accessing the scanner through the Job Editor, they are added to the job ticket automatically.

To set up Automatic Scanning:

1. Make sure the scanning configurations are set correctly for the images to be scanned. See "Setting Up the Scanner Interface" on page Chapter 9-17.
2. Click the Auto Scan button (on the lower half of the Scan Controls tab window).

Due to hardware limitations, when using Auto Scan, digital files cannot be created larger than the original. When Auto Scan is selected, you can only scan in standard, or reduced sizes. If you wish to scan in larger, or non-standard sizes, deselect Auto Scan, and then enter the size manually.

3. When a print is positioned on the scanner, Auto Scan takes over and starts scanning, one print after another.
4. You can make this process even more efficient by enabling the Auto Name feature. See "Set Up File Naming" on page Chapter 9-17 for more information.

Scan Images into a Job Ticket

The Scanner Interface allows the addition of image files to a job ticket as soon as they are scanned. Multiple scanned images can be added to a single job, and even combine scanned files with plot files and.DWG files in the same job ticket.

To scan to a job ticket:

1. Open or create a job ticket using the Job Editor.
2. In the job ticket, select the row just above the spot where you want to add a scanned image.
3. Click the Scanner Interface icon to activate it. (If the Scanner Interface is not running, click the Scan button on the Job Editor toolbar.)
4. Load a document into the scanner.
5. Click the Scan button. The file is added to the job ticket.
Scan-to-Print (Copy)

PlotWorks allows the scanner and printer to be used as a copy system. These steps do not apply when using Scan-to-Print with the direct copying method available on some scanners.

To copy a job:

1. Set the destination in the Job Editor to a Job Queue. Set up any other parameters and preferences as desired.
2. Click the Scan button on the Job Editor toolbar.
3. Load the selected document into the scanner.
4. In the Scanner Interface, click the Scan to Print button.
5. Click Start (unless Auto Scan is enabled). PlotWorks scans the image and sends it to the Queue automatically for printing. The file enters the Queue with a priority of “Copy.”

The Copy function sends a single image to the Queue. If there are other images in the job ticket, PlotWorks will not send them to the Queue when the Copy command is in use.

Rescan a Document

Rescan gives the opportunity to “tweak” the scan configurations and test them before doing the final scan. This is useful if Auto Scan of multiple prints is being set up.

- To rescan the current image (listed in the title bar of the Scanner Interface), click ReScan.
- To rescan an image listed in a job ticket, select the image in the job ticket, then click ReScan in the Scanner Interface. The newly scanned image replaces the selected file.

Scanning a Document to Replace a Saved Digital Document

Occasionally you will want to replace a CAL or TIFF file, saved digitally, with a new scanned image.

To use the Scan and Replace feature, the Scanner Interface must be opened using the Scanner Interface shortcut. This feature will not work if the Scanner Interface is opened from within PlotWorks.
To Scan and Replace a TIFF file:

1. Click on the File Naming/Viewing tab to display the File Naming/Viewing tab window.

2. Click on the Scan and Replace Mode button. This opens the Scan and Replace dialog box.

   Note that when the Scan and Replace Mode button is selected the scanner is placed in the Scan and Replace mode, therefore the Start, ReScan, and Auto scan buttons, the Next File text box, and the File Naming options, become unavailable on the Scanner Interface.
3. Click on the **Browse** button. This opens the Browse for Folder dialog box.

4. Select the folder that contains the file you want to replace.
5. Click on the **OK** button.
   - The Browse for Folder dialog disappears.
• The **Current Directory** read-only field displays the folder and path selected in Step 5.
• The Scan and Replace window now lists all TIFF files contained in the folder.

6. Click on the Scanner Interface **Main** tab window to display the Main tab window.
7. Arrange the Scanner Interface **Main** tab window and the **Scan and Replace** window so that you can see them both on your monitor as illustrated below.

8. Highlight the file you want to replace in the Scan and Replace window. This activates the View and Replace buttons on the Scan and Replace window.
9. Click on the **View** button. This opens the image file in the viewer. Confirm that you have selected the correct file to replace.
11. Load the document that needs scanning on the scanner to prepare for scanning.

**Note:** The MAX 200 and 8180 scanners do not notify PlotWorks that a document is inserted, therefore if a document is not loaded in the scanner when the **Replace** button is clicked, the original file is deleted.

12. Click on the **Replace** button.
• The scanner will begin scanning the document.
• The Main tab window will display an animated page that moves between the Scan Controls and Compressing buttons. This indicates that a scan is
in progress. When this animation stops your scan is complete and the original file is replaced with the one just scanned.

13. Click on the View button on the Scan and Replace window again. This opens the image file in the viewer. Confirm that the original file is replaced.

14. Click on the Done button. This closes the Scan and Replace window.

**Send the Current File to the Printer**

Sends the current file to the printer when the Scanner Interface is used with the Job Editor.

**To send the current file to the printer:**

1. Open the Scanner Interface from within Job Editor.
2. Set the destination in Job Editor to the Job Queue. Set up any other parameters and preferences as desired.
3. In the Main Scanner Interface tab window, click Scan to Print. The image is sent to the Queue for processing and printing.

**View a Scanned Image**

Use the Image Viewer to see files as they are scanned. There are two ways to access the Viewer from the Scanner Interface:

**Automatic Viewing:**

- To open the Image Viewer automatically as each image is scanned, click the Auto View button on the Scan Controls tab window.

**Manual Viewing:**

- To view the current file (listed in the title bar), click the View button on the bottom of the tab window.

See “Viewing Image Files” on page 5-1 for more information.

**Change Viewing Applications**

You can select what image viewing application to use for viewing scanned images. There are two preset default viewers. A Viewer Path field is also provided to select a different third party viewer.

**To select a viewer for each file type:**

1. Click on the File Naming/Viewing tab.
2. Click on the TIFF button.
3. From the Viewer Path drop down list, select the viewer to use when scanning to TIFF format. The Wang/Kodak Imaging Viewer is the default when using Windows NT and the Windows XP Viewer when using Windows XP. If a different viewer is desired, enter its path (including the drive letter, directory and executable file name) for example: C:\Program Files\Myriad\Myriad.exe. Command line parameters for this line can also be included. You can also click on the **Browse** button and select the application’s executable file or shortcut.

When an image is scanned with Auto View enabled, the selected viewer will open and display the scan.

Similarly select a viewer for CALS and PDF files.
Scanner-Specific Options

This section provides scanner specific information.

Xerox 7336 Scanner Interface

This section details only the features and settings specific to this scanner. Any features, options, or menus not mentioned are considered to be standard for all scanners. Their descriptions and instructions for use are found in Chapter 9- The Scanner Interface.

7336 Scan Controls tab

Fig 9.12 7336 Scan Controls

The following options are available for the 7336 scanner:

- **Mode:** Lets you select the appropriate scanner mode:
  - **Bilevel:** This mode works best with line art.
• **Dither/Halftone:** This mode works best with photo or grayscale images. The following enhancement buttons are available for the 7336 scanner. The active buttons depend on the mode you have selected.

• **Edge sharpening:** Lets you sharpen the image to make fine lines clearer. Click the Soft, Medium, or Sharp buttons, or enter a value in the field.

• **Threshold:** Lets you set the point that divides black and white data. Any scanned data that is lighter than the threshold value will display as white. Any scanned data that is darker than the threshold value will display as black. Click the Low, Normal, or High button, or enter a value in the field.

• **Contrast:** This option is only available when you have dither/halftone mode selected and allows you to adjust the contrast between light and dark areas.

### 7336 General Configuration Options

The 7336 General Configuration dialog box is standard with the exception of the ability to use a foot pedal. The optional scanner foot pedal lets you scan documents at the scanner, without having to send a command from the Control Station.

---

**When the Main Scanner dialog box or Scan Controls dialog box is active, you can press Enter to start the scanning process.**

---

**To set up a foot pedal:**

1. Connect the foot pedal to a COM port on your scanning control station.
2. In the Scanner Interface, click the General Configurations tab.
3. In the Foot pedal COM port box, click the button corresponding to the COM port to which the pedal is connected.

**To scan using the foot pedal:**

1. Load the document into the scanner.
2. With your foot, press the foot pedal. The document is scanned and saved as if you had clicked on the Scan button.

---

**If you need to remove the foot pedal for some reason, remember to set the COM port to None.**

---
Xerox 7356 Scanner Interface

This section details only the features and settings specific to this scanner. Any features, options, or menus not mentioned are considered to be standard for all scanners. Their descriptions and instructions for use are found in Chapter 9 - The Scanner Interface.

When the Main Scanner dialog box or Scan Controls dialog box is active, you can press Enter to start the scanning process.

The following modes are available in the 7356 scanner’s controls:

- **Mode:** Lets you select the appropriate scanner mode:
  - **Bilevel (Manual):** This mode works best with line art that has a fairly constant background
  - **Bilevel (Adaptive Area):** This mode works best with line art that uses text or other fine lines and has a varying background (such as a faded blueline). Adaptive thresholding allows the Scanner Interface to set different white point (background) values for different areas of the
image. The white point is set by determining the difference between the background and the data in a set area. The size of this area is specified in the Area Size setting. This mode does not work well with documents containing large black areas.

• **Ordered Dither:** This mode works best with photographic images. Ordered dithering resolves lines very clearly, but it can produce a somewhat grainy image. Ordered Dither creates larger raster file sizes.

• **Error Diffusion Dither:** This mode works best with photographic images and produces very smooth gradients. However, this mode can diffuse the edges of lines, causing a “fuzzy” look. Error Diffusion Dither creates larger raster file sizes.

The following enhancement buttons are available for the Xerox 7356 scanners. The active buttons depend on the mode you have selected.

• **Eject:** Determines which direction a scanned document can be removed from the scanner. The scanned document can be selected to withdraw from the Front of the scanner, Back of the scanner or None. If None, the document is scanned for a desired area and then must be removed manually.

• **Threshold:** Lets you set the point that divides black (0) and white (100) data. Any scanned data that is lighter than the threshold value will display as white. Any scanned data that is darker than the threshold value will display as black. Click the **Low, Medium, or High** button, or enter a value in the field. Any scanned data that is lighter than the threshold value will display as white.

• **Darkness:** Lets you set the brightness or darkness of the image. Click the **Light, Medium, or Dark** button, or enter a value in the field.

• **Area size:** Lets you set the size of the area used for adaptive thresholding. This value is a relative number, with 0 representing the minimum area allowed, and 100 representing the maximum area allowed. Set this option to scan past any dark or light leading edges on the image. Use the buttons for preset values (Small, Normal, or Large) or enter a value in the field.

• **Background removal:** Lets you remove unwanted specks and smears from the image background. Click the **Light, Auto, or Heavy** button, or enter a value in the field.

  • **Background bias:** If Auto under Background removal is clicked, you can set the strength here. The higher the strength, the more specks and smears will be removed from the background.

• **Edge sharpening:** Lets you sharpen the image. Click the **Soft, Normal, or Sharp** buttons, or enter a value in the field.
Xerox 7396 Scanner Interface

This section details only the features and settings specific to this scanner. Any features, options, or menus not mentioned are considered to be standard for all scanners. These are described in Chapter 9- The Scanner Interface.

The following Scan Controls options are available for the 7396 scanner:

- **Mode**: Lets you select the appropriate scanner mode:
  - **Line**: This mode works best with line art.
  - **Photo1**: This mode works best with photographic images.
  - **Photo2**: This mode works best with dark prints.

The following enhancement buttons are available for all modes:

- **Threshold**: Lets you set the point that divides black (0) and white (100) data. Any scanned data that is lighter than the threshold value will display as white. Any scanned data that is darker than the threshold value will display as black.
- **Auto exposure:** When selected (down) lets the software automatically set the best darkness, white point, and sharpening values as each image is loaded.

- **Threshold:** Lets you set the point that divides black and white data. Any scanned data that is lighter than the threshold value will display as white. Any scanned data that is darker than the threshold value will display as black. Click the **Low**, **Medium**, or **High** button, or enter a value in the field.

- **Auto exposure:** When selected (down) lets the software automatically determine the amount of background removal, allowing the image to compress more efficiently.
Xerox 7399 Scanner Interface

This section details only the features and settings specific to this scanner. Any features, options or menus not mentioned are considered standard for all scanners.

The following modes are found in the 7399 scanner. Under **Scan Controls**:

- **Mode**: Lets you select the appropriate scanner mode.
  - **Line**: This mode works best with line art.
  - **Text/Photo**: This mode works best with a combination of line and photographic images or less than perfect originals.
  - **Photo**: This mode works best with photographic images.

The following enhancement buttons are available for the 7399 scanner. The active buttons depend on the mode you have selected.
• **Threshold:** Lets you set the point that divides black (0) and white (100) data. Any scanned data that is lighter than the threshold value will display as white. Any scanned data that is darker than the threshold value will display as black. Select the **Low**, **Medium**, or **High** button, or use the arrows to set a value.

• **Threshold Adjustment** (*Only available* when **Auto Exposure** is selected): This selection adds or subtracts the value listed in the box from the threshold value that the scanner detects.

• **Red Threshold:** Lets you set the point that divides red (0) and white (100) data. Any scanned data that is lighter than the threshold value will display as white. Any scanned data that is darker than the threshold value will display as red. Select the **Low** (Level 3), **Medium** (Level 2), or **High** (Level 1) button, or use the arrows to set a value. When Level 1 is selected, a weak red image is not copied; but when Level 3 is selected, the red image is copied.

• **Blue Threshold:**Lets you set the point that divides blue (0) and white (100) data. Any scanned data that is lighter than the threshold value will display as white. Any scanned data that is darker than the threshold value will display as blue. Select the **Low** (Level 1), or **High** (Level 2) button, or use the arrows to set a value. When Level 1 is selected, a weak blue image is not copied; but when Level 2 is selected, the blue image is copied.

• **Edge sharpening:** Lets you sharpen the image to make fine lines clearer. Select the **Soft**, **Normal**, and **Sharp** buttons, or enter a value in the field. Soft (minimum) option blurs the lines. Sharp (maximum) makes lines crisper and thinner. Values range from 4 to 1.

• **400 DPI (Resolution):** Lets you select a higher resolution for scanning. The higher resolution value produces a higher quality print, but increases the scanning time and creates a larger file.

• **200 DPI (Resolution):** Lets you select a lower resolution for scanning. A lower resolution reduces scanning time and file size, but the document will be of lower quality.

• **Masking:** Lets you modify an image on a document that is marked with a specified pen. There are three buttons to control Masking:
  • **Mask:** When an image is enclosed by a circle made by a specified pen, the image is not copied.
  • **Trim:** Only the image is copied when enclosed by a circle made by a specified pen.
  • **None:** When this is selected, masking is not used.
- **Auto exposure**: When selected (down), lets the software automatically determine the amount of background removal, allowing the image to compress more efficiently.

- **AE Pre-scan**: This button activates the scanner’s prescan function. When the button is pressed, the scanner scans in a small portion of the document, records the data, and returns the document to the starting position. When the document completes scanning, the prescan is compared to the background of the image to calculate the correct background removal.
Xerox MAX 200 and 8180 Scanner Interfaces

When the Main Scanner tab window or Scan Controls tab window is active, you can press Enter to start the scanning process.

This section pertains to the Xerox MAX 200 and 8180 scanners only. Features, options, or menus not mentioned here are considered standard for all scanners and are explained earlier in this chapter.

The Xerox MAX 200 and 8180 operate in the following modes:

- **Text**: This mode works best with line art.
- **Photo**: This mode works best with photographic images.
• **Text and Photo:** This mode works best with a combination of line and photographic images or less than perfect originals.

The Xerox MAX 200 has the following additional modes:

• **Picture:** This mode works best with originals that are halftones, or pictures made up of dot matrix, like a newspaper ‘picture’.

• **Low Contrast:** This mode works best with originals that have a low line contrast such as pencil drawings on vellum/tracing paper.

• **Dark:** This mode works best with original drawings that have a dark background such as sepias or blueprints.

The following enhancement buttons are available for the Xerox MAX 200 and 8180 scanners.

• **Image Density:** Use this feature to lighten or darken the output image. Click the **Low**, **Medium**, or **High** button, or enter a value in the field.

• **Edge sharpening:** Lets you sharpen the image to make fine lines clearer. Click the **Soft**, **Normal**, or **Sharp** buttons, or enter a value in the field. Minimum (Soft) sharpness softens lines. Maximum (Sharp) makes lines crisper and thinner.

• **Background Suppression:** Removes unwanted background, allowing the image to compress more efficiently.
  
  • **Type:**
    • **None:** Background suppression is disabled.
    • **Fixed:** Use when the background is uniform.
    • **Variable:** Use when the background varies from dark to light areas.
  
  • **Level:** Determines the amount of light or dark to remove from the background.

---

⚠️ *Use Background Suppression with caution as it can remove light lines or images.*

💡 *When setting up a Xerox MAX 200 or 8180 printer/scanner combination, you must go into the Windows Control Panel > Settings > Devices to disable both SCSI Scan and SCSI Print. SCSI Scan is usually disabled by default, but make sure that both functions are disabled.*

• **Auto scan:** This button is used to scan loaded files automatically, using your current scanner configuration.
Please note that due to hardware limitations, when using Auto Scan, digital files cannot be created larger than the original. When Auto Scan is selected, you can only scan in standard, or reduced sizes. If you wish to scan in larger, or non-standard sizes, deselect Auto Scan, and then enter the size manually.

**Xerox MAX 200 and 8180 Scan Control options:**

- **Colors:** Lets you adjust the final appearance of colors on the original document. The color areas will appear as their relative shades of black. You can adjust the scanner’s sensitivity to black, red, blue, yellow, and green. Use the “Others” setting for all other colors. See “Highlight Color Printing” on page 8-47 for more information.
Océ 9800 TWAIN Scanner

Océ 9800 Scanner support is based on TWAIN technology. You can scan documents directly into the PlotWorks Job Editor, and to a selected directory in one step. Scanned documents can be saved as TIFF, CALS, or PDF files.

Configure TWAIN Scanning options

Select the TWAIN Source

Before you can use the Océ 9800 Scanner you need to select it as a TWAIN source.

1. Open the Job Editor if it is not already open.
2. Click on the File menu.
3. Select Twain from the File menu. The Twain sub menu opens.
4. Click on Select Source. The Select Source dialog box displays.
5. Click on 9800 Scanner 1.3 if it is not already selected.
6. Click on the Select button. The Select Source dialog box disappears.

The Job Editor now knows that the Océ 9800 Scanner is the device to use for scanning.

Select TWAIN scanning options

To do so:

1. Click on the Job Editor Setup menu.
2. Select Twain Options. The Twain Scanning Options dialog box appears. This dialog box is used to select file-naming options for scanned images, and set other TWAIN scanning options.
3. Select Scan button launches TWAIN interface.
4. Enter values for options provided in this dialog box. For more information on options provided refer to "Twain Scanning Options" on page 4-88.
5. When you have completed setting your options, click on the OK button.

Using the Océ 9800 Scanner

Follow the instructions below to scan using the 9800 scanner:

1. Open the Job Editor if it is not already open.
2. Click on the Scan button from the toolbar. The Océ 9800 Scanner TWAIN dialog box opens.
3. Depending upon how many documents you are scanning click on either the single or double arrow buttons. Click the single arrow button if you are only scanning one document. Click the double arrow button if scanning more than one document.

![Fig 9.17 The Océ 9800 Scanner TWAIN dialog box](image)

4. All other scan settings are selected on the scanner itself.

5. Click on the Stop button when you have finished scanning.

**Copying with the Océ 9800 Scanner**

The Océ 9800 scanner does not have a copy function. To use this scanner as a copier, scan all the originals into the Job Editor and then output the files. To print individual files only, select the files in the Job Editor grid, select the "Selected files only" check box from the Output dialog box and output the files.

To change a file orientation use the Job Editors "Bottom Edge" option from the "Specified Size" tabbed dialog box of the Detailed Property Sheet. For more information refer to Chapter 4 of the PlotWorks User Guide.
Synergix Scanner

Synergix Scan System support is based on TWAIN technology. Using the PlotWorks Synergix Scan System software with the XES Synergix Scanner, you can scan documents directly into the PlotWorks Job Editor, and to a selected directory in one step. Scanned documents can be saved as TIFF, CALS, or PDF files.

**Computer Requirements:**
- FireWire card (provided by PLP Digital Systems).
- Windows XP Professional operating system.
- 1.5 GB RAM.

**Firmware Requirements:**
- Synergix Scanner Firmware version 3.1.9.

**Installing the Synergix Scanner**

Before attempting to install the scanner ensure that you are logged onto the computer with Administrative rights and the FireWire card is installed. Instructions to do so follow.

**Confirming Administrative Rights**

1. Click on the Windows **Start** button.
2. Click on **Control Panel**.
3. Double click on **User Accounts**. The User Accounts dialog box opens displaying the Users tab.
4. Locate your user name in the **User Name** column and ensure that Administrator is listed in the **Group** column. If it is not listed in the Group column, contact your organization’s network administrator.

**Installing the FireWire card**

1. Ensure the computer is turned off.
2. Insert the FireWire card according to the manufacturer's instructions.
3. Turn on the computer. Once Windows XP Professional is started, the card is automatically recognized.

---

*Do not plug in the scanner just yet.*

**Configure the Hardware and Software**

1. Install PlotWorks.
2. Once the installation is complete turn the computer completely off.
3. Plug the scanner cable into the FireWire card. Any FireWire port can be used. The Synergix Scanner is connected either to the PlotWorks Print Server computer or to the AccXES controller.

The Synergix Scanner can only be connected to one controller at a time. If the scanner is attached to the AccXES Controller through the FireWire connection, it cannot be connected to the PlotWorks Print Server using a different FireWire connection.

4. Turn the scanner on.
5. Wait for the "P" to appear in the LED display on the back of the scanner.
6. Turn the computer on.
7. Once Windows starts, the display on the back of the scanner should change to "P." If a "P." does not display on the Scanner LED there is no communication between the Synergix Scanner and the computer. Ensure the "P." displays before proceeding.

8. If prompted by Windows to install a driver, do not connect to the Internet to locate drivers. Click on the Cancel button to stop and close the new hardware installation wizard. Then skip to the following section titled Verify the driver is installed.

If you are not prompted to install the driver continue with these instructions.

The last screen of the Wizard contains a check box instructing Windows to not prompt to install this hardware again. Do NOT select this check box.

10. Double click on Add Hardware.
11. Click on Next.
12. Select Yes, I have already connected the Hardware.
13. Select Add a new hardware device.
14. Click on Next.
15. Select Install the hardware that I manually select from a list (Advanced)
16. Click Next.
17. Select Show All devices.
18. Click on **Next**.
19. Click on **Have Disk**.
20. Browse to `WINDOWS\System32\drivers`
21. Click **Next**. The Synergix driver is installed.
22. Once completed click on **Finish**.
23. Reboot the computer.

**Verify the driver is installed**
1. Click on the Windows **Start** button.
2. Click on **Control Panel**.
3. Double click on **Administrative Tools**.
4. Double click on **Computer Management**.
5. Click on **Device Manager**.
6. Locate the **Synergix 1394 Scanner**.
7. Close the **Device Manager**.

**Color Scanning Support**
PlotWorks supports 24-bit color scanning using the Synergix scanner for scan to file engineering color purposes. The **Color Feature Key**, provided by Xerox, is required for color scanning. Install the Feature Key now if you are planning to use color scanning.

PlotWorks color support for the Synergix scanner is designed for:
- Scanning in highlight color originals.
- Scan to color files (CAD and GIS) without color management.

It is not designed for full color graphics, art scanning, or color copying currently.

**Ensure the Scanner is Ready to Use**
When the scanner is first turned on, the firmware version and release date information appear on the scanners user interface screens. (These are the panels on the scanner itself.) Then the user interface screen should display 'Set:OK' if the scanner is ready for use.
Configure TWAIN Scanning Options

Select the TWAIN Source

Before you can use the Synergix Scanner you need to select it as a TWAIN source.

1. Open the Job Editor if it is not already open.
2. Click on the File menu.
3. Select Twain from the File menu. The Twain sub menu opens.
4. Click on Select Source. The Select Source dialog box displays.
5. Click on Synergix Scanner 1.0 if it is not already selected.
6. Click on the Select button. The Select Source dialog box disappears.

The Job Editor now knows that the Synergix Scanner is the device to use for scanning.

Select TWAIN scanning options

To do so:

1. Click on the Job Editor Setup menu.
2. Select Twain Options. The Twain Scanning Options dialog box appears. This dialog box is used to select file-naming options for scanned images, and set other TWAIN scanning options.
3. Enter values for options provided in this dialog box. For more information on options provided refer to "Twain Scanning Options" on page 4-88.
4. When you have completed setting your options, click on the OK button.

If at a later date you want to change any TWAIN scanning option, it is necessary to first close the Synergix Scan System dialog box before opening the TWAIN Scanning Options dialog box to make your changes. Then close the TWAIN Scanning Options dialog box, and reopen the Synergix Scan System dialog box. Otherwise your changes will be ignored.
How to use the Synergix Scan System

This section is designed to provide a general description of how to use the scanner. Each function is not described in detail here, but is described later in this chapter along with common trouble shooting information.

Scanning a drawing into the Job Editor

1. Load the document to scan centered and face down.
2. Open the Job Editor if it is not already open.
3. Open the Synergix Scan System dialog box. There are two possible ways to do this:
   - If you selected the "Scan button launches TWAIN interface" check box in the TWAIN Options dialog box, click on the Scan button on the Job Editor tool bar.
   - Otherwise, click on the Job Editor File menu, select TWAIN, and then Acquire.
4. Select a scanning configuration from the Configuration drop down list depending on the type of document you are scanning. These options are discussed in detail later.
5. Select Size options. The Auto Width option usually correctly detects the document width. If not, rescan the document as before or specify the document size.
6. Click the **Scan** button. The Scan progress dialog box appears. The scan progress bar remains active until the scan is completed. If it is necessary to stop the scanning process click the **Stop** button on the scan progress dialog box. The user then has to remove the document manually from the scanner.

---

**Fig 9.20**
*The Scan Progress dialog box*

Once the image is scanned:

- If you selected the Launch viewer after each scan check box from the TWAIN Scanning dialog box, the Viewer will display the scanned image.
- The scanned document is saved in the Scan directory specified in the Twain Scanning Options dialog box.
- The scanned document is listed in the Job Editor grid. Refer to Chapter 4 for information on how to set print parameters and output print jobs.

---

**Subsequent scans are added in the Job Editor grid one after the other or immediately after a selected document, if one is selected.**

---

**Loading documents to scan**

---

**Fig 9.21**
*Load the document centered on the scanner*

The Synergix Scanner is a center-based scanner. The scanner expects the document to be loaded so that the center of the original document lines up with the center of the scanning area. So for best results insert documents face down and centered on the scanner.

User specified document sizes like **User Size**, **Auto Height**, and selected standard sizes are all dependant on documents loaded centered in the scanner. If the document is not centered the resulting scan may be clipped.
When **Auto Standard Size** or **Auto Standard Width** is selected and the document is not centered, but is instead shifted left on the scanner, the media space added for the standard size may view or print as a black or stripped area on the scanned image depending on the scanning mode used.

*If the document does not load correctly the first time, remove the document and wait for the light on the scanner to blink off, and then back on before reloading the document.*

**Copying with the Synergix Scanner**

The Synergix Scanner does not have a copy function. To use the Synergix Scanner as a copier, scan all the originals into the Job Editor and then output the files. To print individual files only, select the files in the Job Editor grid, select the "Selected files only" check box from the Output dialog box and output the files.

To change a file orientation use the Job Editors "Bottom Edge" option from the "Specified Size" tabbed dialog box of the Detailed Property Sheet. For more information refer to Chapter 4 of the PlotWorks User Guide.

**Production Scanning**

To optimize scanning speed for production scanning load the original documents centered and use the following options:

- Mode: Monochrome
- Document Size: Select one of the standard sizes provided or specify a User Size
- Paper Eject: Rear
- Batch mode: Select this check box
- Scan Speed: Turbo III (requires the Xerox Feature Key)

**Intentionally not scanning a document completely**

In some cases it is necessary to not scan in all elements of an original document. For example the original may contain a hanging strip, a border, etc. that you do not want to include in the scanned image. In this case you can scan the document intentionally clipping the unwanted area, with or without having the unwanted area pass through the scanner.

**Clipping the document**

To clip the document:

1. Specify the size of the document by either:
   - Selecting a size from the Size drop down list
• Selecting User Specified and then entering values in the Width and Height fields.

2. Load the original document in the scanner with an offset from the center that will accommodate the area to clip. Therefore the hanging strip or border is outside the specified scan width.

3. Click the Scan button.

Example

To scan in a 17x22" document that includes a 2" border we want to skip we would:

1. Select User Specified from the Size drop down list.
2. Enter 17" in the Height field.
3. Enter 20" in the Width field.
4. Load the document with a 2" offset from the center of the scanner. This places the border outside of the specified scan width.
5. Click on the Scan button.

The scanned image will measure 17x20".

Clipping without passing through the scanner

To clip the document without passing the unwanted area through the scanner:

1. Select User Specified from the Size drop down list.
2. Select Front (Registration Position) from the Paper Eject drop down list.
3. Enter the document width in the Width field.
4. Enter the document height minus the unwanted area in the Height field.
5. Load the original document in the scanner centered with the hanging strip last.
6. Click the **Scan** button.

The scanner will scan the document up to the specified height then stop and return the document to the front of the scanner without passing the hanging strip through the scanner.

**Scanning thick documents**

Thick documents cannot effectively be pre-scanned to set certain automated values. Therefore when scanning thick documents when the document lever is raised, some options from the Synergix Scan System dialog box will become unavailable. Once the thick document is scanned and the document lever is back in its original position, the Synergix Scan System dialog box will revert to the last saved scanning configuration.

**Using the Synergix Scanner with GFI Folders**

To use the Synergix Scanner with GFI Folders efficiently follow the instructions below:

1. Scan the first document and ensure it is listed in the Job Editor job grid.
2. Press the **CTRL** and **T** keys simultaneously to open the Title Block Location dialog box.
3. Note the location listed for the title block and then click **OK**.
4. Select the **Proto** line in the Job Editor grid.
5. Click on the **Properties** button from the Job Editor tool bar. The Detail Properties Sheet opens displaying the Main tabbed dialog box.
6. From the **Title Block Location** drop down list of the Main tabbed dialog box select the location noted in Step 3.
7. Close the Detailed Property Sheet.
8. Select the first document that was scanned in the job grid.
9. Scan all subsequent files with the title block in the same location as the first document.
If a document is scanned and the title block is in a different location than specified in the Proto line, change the title block location for that document using the Detailed Property Sheet or the Title Block Location Viewer.

10. Select the desired folding program and output the files.

Synergix Scan System options in detail

Scanning Options

- **Scanning Mode**: Select a scanning mode from this drop down list depending on the type of document you are scanning.
  - **Monochrome (1Bit)**: This mode is for black and white scanning.
  - **Grayscale (8 Bit)**: This mode is for scanning documents containing shades of black, white and gray.
  - **Color (24 Bit)**: This mode is for color scanning. The Color Feature Key, provided by Xerox, is required for color scanning.

Depending on the mode selected various other options can be selected from the Synergix Scan System dialog box. All options are not available for all modes to ensure better scanning results.

- **Resolution**: Select the desired resolution in DPI from this drop down list.
- **Scan Speed**: Select the desired scanner speed. The Scan Speed option enables selecting slower speeds to protect fragile originals. The available speeds are dependant on what Speed Feature Keys is are installed.
  - **Turbo III**: Turbo III is only available when the Turbo III Feature Key is installed. Turbo III supports scanning at 7.33 Ips at 400 DPI. This is the optimal scanning speed for copying with the XEROX WIDE FORMAT 721p. If this speed does not provide the desired quality when scanning, select another scanning speed.

Occasionally the scanner may not scan at the selected speed. This may be because the required scanner speed key is not purchased or installed. The scanner may also slow down to meet the required quality or document size as needed.

- **Paper Eject**: There are 3 options for Document Eject:
  - **Front (Registration position)**: This option is available when Auto Scan is not selected. This is to enable rescanning a document with new settings.
  - **Front (Eject in the front)**: This option is available when Auto Scan is selected.
  - Rear (Eject in the back)
Document Size:

- **Series:** This refers to the paper series. Select either ANSI, Arch, or ISO.
- **Size:** Options available in this drop down list depend on the paper series selected. All the standard sizes and orientations for the selected paper series are available, plus the four following automatic width detection functions:

  - **Auto Size:** Select this option to automatically determine the width and height. Thick documents cannot be pre-scanned for edge detection effectively. Therefore this option is not available when scanning thick documents.

    The maximum supported length for Auto Size is dependent on what Mode is selected. The maximum supported length for each mode is provided below:
    - Monochrome (1Bit): 900" or 2286 cm
    - Grayscale (8Bit): 100" or 254 cm
    - Color (24Bit): 30" or 76.2 cm

  - **Auto Standard Size:** Select this option to automatically determine a standard width and height depending on the Series selected with an error margin of .20.

    For example, if a document measuring 11" x 22" is scanned in with Auto Standard Size selected, the resulting scan is justified top and left, and will measure 17" x 22", the next possible standard size that can accommodate the 22" length.

    Thick documents cannot be pre-scanned for edge detection effectively. Therefore this option is not available when scanning thick documents.

  - **Auto Standard Width:** Select this option to automatically determine a standard width depending on the Series selected and the height entered in the Height text box. The resulting scanned image is centered.

    Thick documents cannot be pre-scanned for edge detection effectively. Therefore this option is not available when scanning thick documents.

  - **Auto Height:** Automatically determines the height when the width is entered in the Width text box. The maximum supported length for Auto Height is dependent on what Mode is selected. The maximum supported length for each mode are provided below:
    - Monochrome (1Bit): 900" or 2286 cm
    - Grayscale (8Bit): 100" or 254 cm
    - Color (24Bit): 30" or 76.2 cm
If you wish to add a custom paper size to the size drop down list, contact PLP’s technical support department.

- **Width**: Enter a width between 5 and 36 inches in this text box if User Size or Auto Height is selected. The software automatically detects the width if Auto Size, Auto Standard Size, or Auto Width is selected.

- **Height**: Enter a height of at least 1 inch in this text box if User Size or Auto Standard Width is selected. The software automatically detects the height if Auto Size, Auto Standard Size, or Auto Height is selected.

- **Units**: When ANSI or Arch is selected in the Series select box, all measurements are provided in inches. When ISO is selected in the Series select box, all measurements are provided in millimeters.

**Image Options:**

- **Background Removal Options**:
  - **Background Removal**: The following background removal options are available:
    - **Off**: When Off is selected, no background removal is applied and Seed values are not used. Also note that if Off is selected and Error Diffusion is selected for the Halftoning Method, when a document with a gray background is scanned, a diffusion pattern is applied to the entire background.
    - **Static**: When Static is selected, the same Seed Values are used for the entire image whether user selected or automatically detected. In this case a scanned document containing a background that ranges from dark to light will show some background noise.
    - **Dynamic**: When Dynamic is selected, Seed Values are automatically adjusted as necessary during the scan. This is the default setting.
Fig 9.24  
Effect of Background Removal options

- **Image (Dynamic):** The following Image options are now available:
  - **Dark:** Select this option when the document you wish to scan is very dark.
  - **Invert:** Select this option when you want the scanned image to be inverted. Black areas of the original document will then appear white and vice versa. This option is not available when Auto Size is selected.
  - **Line-Art:** Select this option when scanning line art drawings. This is the default value.

Understanding seed values is useful when selecting scanning options. Seed values define the black and white points of an image. Seed values are automatically set prior to scanning a document. The Synergix Scan System dialog box provides options to select seed values manually or automatically. Setting seed values manually is recommended when you need to improve the quality of a scan when auto detected seed values do not provide the desired scan result.

- **Black Seed:** Enter a value between 0-255 in this text box. This number defines what shades of gray are considered black. If the Black Seed value is set at 8, all darker shades of gray are considered black. To scan in gray lines as black, increase the Black Seed value.
- **White Seed:** Enter a value between 0-255 in this text box. This number determines what shades of gray should be converted to white. If the
White Seed value is set to 200, brighter parts (values from 200-255) of the image are considered white. In this case light, thin, gray lines contained in the image may not be scanned correctly. Increasing the White Seed value ensures that lighter lines are scanned correctly.

- **Halftoning Method**: Halftoning Method options are only available when Monochrome is selected from the Mode drop down list. The following options are available here:
  - **Error Diffusion**: This is the default value that produces the best copy quality. Error Diffusion optimizes the scanned original for printing by applying an error diffusion pattern. This option should not be used when scanning to file since the error diffusion pattern increases the file size and makes the files harder to use for raster to vector conversion.
  - **Fixed Threshold**: When this option is selected, image quality is controlled using a selected Threshold Value. Then every 8-bit pixel is compared to this value. If the pixel value is less than the Threshold selected, the pixel is considered black; if greater than, it is considered white.
  - **Bi-Tonal**: When Bi-Tonal is selected, all lines and marks are scanned in as solid black for improved visibility. Select this option when scanning and copying documents with very fine lines like pencil drawings.
  - **Threshold**: This option is not available when Grayscale (8Bit) or Color (24Bit) is selected from the Mode drop down list. The default Threshold value is 100. Increase or decrease this value as necessary depending on the scanning configuration selected.
  - **Contrast**: Enter a contrast value between 96 and 160 in this text box. Lower values make the image darker and higher numbers make the image lighter. 128 is the default value.
  - **Mirror**: Select this check box to mirror the scanned image.
  - **Batch scanning**: Batch scanning increases scanning speed when scanning multiple documents of the same width. Batch scanning should only be used when scanning documents of the same type. When Batch is selected, the first image loaded from the set is pre-scanned. The resolution, width, height, seed values, and edge detection set for the first document are applied to all subsequent images scanned until Batch scanning is disabled.

When Batch scanning, center the documents on the scanner and ensure that the Batch check box is selected.

To disable Batch scanning, either deselect the Batch check box or change a resolution, width, height, white seed value or black seed value.
To change the image size or other settings simply make the changes then reselect the Batch check box. The next image is then pre-scanned; settings are updated and batch scanning resumes.

- **Auto Detect Seed Values**: Selecting Auto Detect Seed Values automates setting seed values. When a document is loaded in the scanner, the first few inches are automatically pre-scanned to determine the document width and the optimal scan values, including white and black seed values. This option is not available when scanning thick documents or during Batch scanning.

- **Configuration**: The Configuration option is used to apply a default configuration or a previously saved configuration and to save a configuration.

**Saving a new configuration**

Additional configurations are added by selecting the desired options, typing in the name and clicking the **Save** button.

---

_Use caution before clicking the Save button. If one of the Default Configurations is selected in the Configuration drop down list, like Sepia (Medium Quality), and you change any scanning option and then click the Save button, you will overwrite the Default Configuration._

**Applying a default or previously saved configuration**: Simply select the desired configuration from the drop down list. Default configurations and their settings follow:

- **Blue Print (High Quality)**: This is the default configuration for high quality blue print scanning. When this option is selected the following settings are used:
  - Mode is set to Grayscale
  - Resolution is set to 400
  - Scan Speed is set to 4.00 Inches Per Second
  - Paper Eject is set to Front (Registration position)
  - Background Removal is set to Dynamic
  - Image (Dynamic) is set to Lineart
  - Contrast is set to 127
  - Auto Detect Seed Values is selected
  - All other values are either grayed out or user selected
• **Blue Print (Low Quality):** This is the default configuration for low quality blue print scanning. When this option is selected the following settings are used:
  
  • Mode is set to Grayscale
  • Resolution is set to 100
  • Scan Speed is set to 4.00 Inches Per Second
  • Paper Eject is set to Front (Registration position)
  • Background Removal is set to Dynamic
  • Image (Dynamic) is set to Lineart
  • Contrast is set to 127
  • Auto Detect Seed Values is selected
  
  All other values are either grayed out or user selected

• **Blue Print (Medium Quality):** This is the default configuration for medium quality blue print scanning. When this option is selected the following settings are used:
  
  • Mode is set to Grayscale
  • Resolution is set to 200
  • Scan Speed is set to 4.00 Inches Per Second
  • Paper Eject is set to Front (Registration position)
  • Background Removal is set to Dynamic
  • Image (Dynamic) is set to Lineart
  • Contrast is set to 127
  • Auto Detect Seed Values is selected
  
  All other values are either grayed out or user selected

• **Default:** This is the default configuration. When this option is selected the following settings are used:
  
  • Mode is set to Monochrome
  • Resolution is set to 100
  • Scan Speed is set to 4.00 Inches Per Second
  • Paper Eject is set to Front (Registration position)
  • Background Removal is set to Dynamic
  • Image (Dynamic) is set to Lineart
  • Threshold is set to 100
  • Auto Detect Seed Values is selected
All other values are either grayed out or user selected

- **Line:** This is the default configuration for line art. When this option is selected the following settings are used:
  - Mode is set to Monochrome
  - Resolution is set to 400
  - Scan Speed is set to 4.00 Inches Per Second
  - Paper Eject is set to Front (Registration position)
  - Background Removal is set to Dynamic
  - Image (Dynamic) is set to Lineart
  - Halftoning Method is set to None
  - Threshold is set to 100
  - Auto Detect Seed Values is selected

All other values are either grayed out or user selected

- **Maps:** This is the default configuration for maps. When this option is selected the following settings are used:
  - Mode is set to Grayscale
  - Resolution is set to 200
  - Scan Speed is set to 4.00 Inches Per Second
  - Paper Eject is set to Front (Registration position)
  - Background Removal is set to Dynamic
  - Image (Dynamic) is set to Lineart
  - Contrast is set to 127
  - Threshold is set to 100
  - Auto Detect Seed Values is selected

All other values are either grayed out or user selected

- **Mixed:** When this option is selected the following settings are used:
  - Mode is set to Grayscale
  - Resolution is set to 200
  - Scan Speed is set to 4.00 Inches Per Second
  - Paper Eject is set to Front (Registration position)
  - Background Removal is set to Dynamic
  - Image (Dynamic) is set to Lineart
  - Contrast is set to 127
  - Threshold is set to 100
  - Auto Detect Seed Values is selected
All other values are either grayed out or user selected

- **Photo:** This is the default configuration for black and white photographs. When this option is selected the following settings are used:
  - Mode is set to Grayscale
  - Resolution is set to 200
  - Scan Speed is set to 4.00 Inches Per Second
  - Paper Eject is set to Front (Registration position)
  - Background Removal is set to Dynamic
  - Image (Dynamic) is set to Lineart
  - Contrast is set to 127
  - Auto Detect Seed Values is selected

All other values are either grayed out or user selected

- **Photo Color:** This is the default configuration for color photographs. When this option is selected the following settings are used:
  - Mode is set to Color (24 bit)
  - Resolution is set to 400
  - Scan Speed is set to 4.00 Inches Per Second
  - Paper Eject is set to Front (Registration position)
  - Auto Detect Seed Values is selected

All other values are either grayed out or user selected

- **Sepia (High Quality):** This is the default configuration for high quality sepia scanning. When this option is selected the following settings are used:
  - Mode is set to Grayscale
  - Resolution is set to 400
  - Scan Speed is set to 4.00 Inches Per Second
  - Paper Eject is set to Front (Registration position)
  - Background Removal is set to Dynamic
  - Image (Dynamic) is set to Lineart
  - Contrast is set to 127
  - Auto Detect Seed Values is selected

All other values are either grayed out or user selected
• **Sepia (Low Quality):** This is the default configuration for low quality sepia scanning. When this option is selected the following settings are used:
  - Mode is set to Grayscale
  - Resolution is set to 100P
  - Scan Speed is set to 4.00 Inches Per Second
  - Paper Eject is set to Front (Registration position)
  - Background Removal is set to Dynamic
  - Image (Dynamic) is set to Lineart
  - Contrast is set to 127
  - Auto Detect Seed Values is selected

All other values are either grayed out or user selected

• **Sepia (Medium Quality):** This is the default configuration for medium quality sepia scanning. When this option is selected the following settings are used:
  - Mode is set to Grayscale
  - Resolution is set to 200
  - Scan Speed is set to 4.00 Inches Per Second
  - Paper Eject is set to Front (Registration position)
  - Background Removal is set to Dynamic
  - Image (Dynamic) is set to Lineart
  - Contrast is set to 127
  - Auto Detect Seed Values is selected

All other values are either grayed out or user selected

• **Scan:** When the Auto Scan button is not selected, the Synergix Scan System waits for you to click the Scan button before a loaded, registered document is scanned. The green Start button on the Synergix Scanner LCD control panel (DDS Hardware User Interface) provides the same functionality as the Scan button.

• **Auto Scan:** When the Auto Scan button is selected, the scanner automatically scans documents that are loaded and registered. The Auto Scan button stays selected until you deselect the button. It does not automatically become disabled as the Scan buttons does.

The Auto Scan button cannot be disabled if a document is inserted in the scanner. Remove the loaded document, and then deselect the button.
Clicking the Scan or Auto Scan buttons generates the Scan Progress dialog box, which illustrates the scan progress.

- **Stop**: The Stop button on the Scan Progress dialog box is used to stop the scanning process. The user then has to remove the document manually from the scanner. Before clicking on this button ensure that the progress bar is displayed and indicating that the scan process is started. If the Stop button is clicked before the progress bar starts, the application may freeze and it will be necessary to power down the computer and scanner.

The red Stop button on the Synergix Scanner LCD control panel (DDS Hardware User Interface) provides the same functionality as this Stop button.

**Synergix Scanner LCD control panel**

The Synergix Scanner LCD control panel (DDS Hardware User Interface) now provides the following functionality when the Synergix Scan System software is installed:

- **Start**: The green Start button starts the scan process just like the Scan button on the software user interface.

- **Stop**: The red Stop button stops the scan process just like the Stop button on the software scan progress dialog box.

- **Scanner status**: The scanner status is displayed on the both the scanner's user interface as well as on the software user interface. Both the DDS control panel and the smaller control panel display statuses. The following dynamic statuses are provided:
  - Powered by PlotWorks
  - Main Status
  - Document Status
  - Document Lever: The Document lever is used to determine how thick or thin the document being scanned is
  - Lever position

![Fig 9.25](image)

*Fig 9.25*

**Statuses displayed on the scanner's LCD screen**

<table>
<thead>
<tr>
<th>Powered by PlotWorks</th>
</tr>
</thead>
<tbody>
<tr>
<td>Main Status: Warmed up</td>
</tr>
<tr>
<td>Document Status: Registered</td>
</tr>
<tr>
<td>Document Lever: Lever OK</td>
</tr>
<tr>
<td>Lever Position: Thin Document</td>
</tr>
</tbody>
</table>

**Document Status lights**
Statues are displayed using red, yellow, and green document status lights and identifying text on the Synergix Scan System dialog box.

- A **red light** appears if a document is not inserted.
- A **yellow light** appears if a document is inserted but not registered.
- A **green light** appears if a document is inserted and registered. The Scan button is enabled only when the green Document Status light displays.

**Miscellaneous information regarding the Synergix Scanner**

**Image placement for Auto Standard Size or Auto Standard Width**

![Image placement for Auto Standard Size or Auto Standard Width](image)

When Auto Standard Size is selected the scanner automatically determines the size of the scanned image and calibrates the resulting scan such that the image is placed on the next largest standard media size, justified top and right.

When Auto Standard Width is selected the scanner automatically determines the width measurement of the scanned image and calibrates the resulting scan such that the image is placed centered on the next largest standard width size.

This placement is standard for all PlotWorks supported scanners.

**Retrieving scanned files from the AccXES controller**

To retrieve scanned files from the AccXES controller, refer to the topic "Adding Files from a Polled FTP Directory" on page 4-84.

**Synergix Scanner speed negotiation**

![Synergix Scanner speed negotiation](image)
The scanner may not always scan at the selected speed. This may be because the necessary speed key is not purchased or installed. Once the scanning process begins, the scanner may also slow down to meet a required quality and document size. If a slower speed is required, a Synergix Scan System DS dialog box may open, notifying the user that the scan speed will be automatically adjusted. In this case, click on the **OK** button to continue.

**Using the Synergix Scanner and Adobe PhotoShop simultaneously**

Occasionally if Adobe PhotoShop, the Synergix Scanner, and the Job Editor are all being used simultaneously the computer will freeze and will need to be rebooted. This is because Windows XP allocates both PhotoShop and the Synergix Scanner a large amount of memory regardless of whether it is available or not. Therefore for best results close Adobe PhotoShop before scanning.

**Trouble Shooting**

**Symptom: A document is jammed**

When a document becomes jammed in the scanner, press the red stop button on the scanner itself, or the Stop button on the Scan progress dialog box. The scanner will stop. Then lift the scanner lid, remove the document, wait for the scanner to reset, and then reload the document to scan.

If the error message "An error has occurred receiving scanner status" appears it is necessary to reboot the Scanner Interface, the Job Editor and the Synergix Scanner.

**Symptom: A Synergix Scan System DS warning dialog box appears**

- **Auto Standard Size is selected**

  When an Auto Standard Size is selected and the document being scanned is larger than the largest Auto Standard size available for the selected paper series, the document is not scanned and a Synergix Scan System DS dialog box appears.

  ![](Fig_9.28.png)

  *A Synergix Scan System DS dialog box*

  Click the **OK** button to continue. The dialog box will close. Then specify a size.

- **Document is loaded**

  If the Synergix Scan System DS (Data Source) warning dialog box appears,
remove the document that is physically loaded in the scanner, then click on the OK button

**Symptom: Memory errors occur when Auto Size is selected**

Because scanned images are kept in memory for transfer to the Job Editor, memory requirements for the Synergix Scanner are high. When Auto Size is selected, PlotWorks allocates enough memory to accommodate the largest document length available. This can create memory errors. To reduce the required memory amount, manually select the document size from the Size drop down list on the Synergix Scan System dialog box.

**Symptom: The Auto Scan button does not work and a document is loaded**

To place the scanner in Auto Scan mode, ensure a document is not currently loaded on the scanner. It is necessary to first remove any loaded document and then select the Auto Scan mode. This ensures that a document is not accidentally scanned.

**Symptom: The diagnostic test failed**

Lift and lower the top of the scanner then let it reset.

**Symptom: The scanner appears frozen**

This may be due to scanner recalibration. Occasionally before scanning a document the scanner may need to recalibrate. If a document is loaded in the scanner at that time, the computer may look like it has frozen. In this case simply remove the document from the scanner and reload it.

**Symptom: The scanner does not accept paper**

- **Scan light is on**
  
  If the scanner does not accept paper and the scan light is on, lift and lower the top of the scanner then let it reset.

- **Scan light is off**
  
  Remove the loaded document and wait for the scan to light to come back on.
Vidar Flash Scanner Interface

This section details only the features and settings specific to this scanner. Any features, options, or menus not mentioned are considered to be standard for all scanners. Their descriptions and instructions for use are found in Chapter 9 - The Scanner Interface.

When the Main Scanner dialog box or Scan Controls dialog box is active, you can press Enter to start the scanning process.

The Vidar Flash Scanner operates in the following modes:

- **Bilevel (Manual)**: This mode works best with line art that has a fairly constant background.

- **Bilevel (Adaptive Area)**: This mode works best with line art that uses text or other fine lines and has a varying background (such as a faded blueline). Adaptive thresholding allows the Scanner Interface to set different white point (background) values for different areas of the image as the document
gets scanned. The white point is set by determining the difference between the background and the data in a set area. The size of this area is specified in the Area Size setting. This mode does not work well with documents that contain large black areas.

- **Ordered Dither**: This mode works best with photographic images. Ordered dithering resolves lines very clearly, but it can produce a somewhat grainy image.

- **Error Diffusion Dither**: This mode works best with photographic images and produces very smooth gradients. However, this mode can diffuse the edges of lines, causing a “fuzzy” look. Error Diffusion Dither creates larger raster file sizes.

The following enhancements are available for the Flash scanner. The active buttons depend on the mode you have selected.

- **Area Size**: Lets you set the size of the area used for adaptive thresholding. Use the buttons for preset values (Small, Normal, or Large) or enter a value in the field. This value is a relative number, with 0 representing the minimum area allowed, and 100 representing the maximum area allowed. Set this option to scan past any dark or light leading edges on the image.

- **Background Removal**: Lets you remove unwanted specks and smears from the image background, allowing the image to compress more efficiently. Click **Light**, **Auto**, or **Heavy** for the amount of background removal you want, or enter a value in the field.

See also: "Remove Background Automatically" on page Chapter 9-24

- **Darkness**: Lets you set the brightness or darkness of the image.

- **Edge Sharpening**: Lets you sharpen the image.

  11. **Threshold**: Lets you set the point that divides black (0) and white (100) data. Any scanned data that is lighter than the threshold value will display as white. Any scanned data that is darker than the threshold data will display as black

**Vidar Flash+ Scanner Interface**

This section details only the features and settings specific to this scanner. Any features, options, or menus not mentioned are considered to be standard for all scanners. Their descriptions and instructions for use are found in *Chapter 9 - The Scanner Interface*. 
When the Main Scanner dialog box or Scan Controls dialog box is active, you can press Enter to start the scanning process.

The Flash+ scanner operates in the following modes:

- **Bilevel (Manual):** This mode works best with line art that has a fairly constant background.

- **Bilevel (Adaptive Area):** This mode works best with line art that uses text or other fine lines and has a varying background (such as a faded blueline). Adaptive thresholding allows the Scanner Interface to set different white point (background) values for different areas of the image. The white point is set by determining the difference between the background and the data in a set area. The size of this area is specified in the Area Size setting. This mode does not work well with documents containing large black areas.
• **Ordered Dither:** This mode works best with photographic images. Ordered dithering resolves lines very clearly, but it might produce a somewhat grainy image. Ordered Dither creates larger raster file sizes.

• **Error Diffusion Dither:** This mode works best with photographic images and produces very smooth gradients. However, this mode might diffuse the edges of lines, causing a “fuzzy” look. Error Diffusion Dither creates larger raster file sizes.

• **Darkness:** Lets you set the brightness or darkness of the image. Click the **Light**, **Medium**, or **Dark** button, or enter a value in the field.

• **Area size:** Lets you set the size of the area used for adaptive thresholding. This value is a relative number, with 0 representing the minimum area allowed, and 100 representing the maximum area allowed. Set this option to scan past any dark or light leading edges on the image. Click the **Small**, **Normal**, or **Large** button, or enter a value in the field.

• **Background removal:** Lets you remove unwanted specks and smears from the image background, allowing the image to compress more efficiently. Click the **Light**, **Auto**, or **Heavy** button, or enter a value in the field.

  • **Background bias:** If you clicked **Auto** under Background removal, you can set a strength here. The higher the strength, the more specks and smears will be removed from the background.

*Use Background removal with caution as it could remove light lines or images.*

• **Threshold:** Lets you set the point that divides black and white data. Any scanned data that is lighter than the threshold value will display as white. Any scanned data that is darker than the threshold value will display as black. Click the **Low**, **Medium**, or **High** button, or enter a value in the field.

• **Edge sharpening:** Lets you sharpen the image to make fine lines clearer. Click the **Soft**, **Normal**, or **Sharp** buttons, or enter a value in the field.
The Vidar Flash+ scanner also offers the following fields in the Scan Controls dialog box:

- **Black Point**: Sets the black point of the image. All data that is darker than the black point will appear as black in the image. Absolute black is 0.
- **White Point**: Sets the white point of the image. All data that is lighter than the white point value will appear as white in the image. Absolute white is 255.

**KIP 2035 and 7095 Scanner Interface**

This section details only the features and settings specific to these KIP scanners. Any features, options, or menus not mentioned are considered standard for all scanners. These are described in *Chapter 9 - The Scanner Interface*.

The following options are unique to the 2035 and 7095 scanners:

- **Modes**
  - **Line**: This mode works best with line art.
• **Photo1**: This mode works best with a combination of line and photographic images.

• **Photo2**: This mode works best with photographic images.

The following enhancement buttons are available for all modes:

• **Threshold**: Lets you set the point that divides black and white data. Any scanned data that is lighter than the threshold value will display as white. Any scanned data that is darker than the threshold value will display as black. Click the **Low**, **Medium**, or **High** button, or enter a value in the field.

• **Auto exposure**: When selected (down) lets the software automatically set the best darkness, white point, and sharpening values as each image is loaded.

**KIP 2020 and 2030 Scanner Interface**

This section details only the features and settings specific to these KIP scanners. Any features, options, or menus not mentioned are considered to be standard for all scanners. Their descriptions and instructions for use are found in *Chapter 9 - The Scanner Interface*.
The following modes are unique to the 2020 and 2030 scanners:

- **Line**: This mode works best with line art.
- **Photo1**: Use this mode when line and photographic images are combined.

The following enhancement buttons are available for all modes:

- **Threshold**: Is used to set the point that divides black (0) and white (100) data. Scanned data lighter than the threshold value displays as white. Scanned data darker than the value displays as black.
- **Auto exposure**: Select this button to automatically determine the amount of background removal, to compress the image more efficiently.

**KIP 2040 Scanner Interface**

This section details items specific to the KIP 2040 scanner. Items not mentioned here are considered standard and are described in *Chapter 9 - The Scanner Interface*.

![Fig 9.34 2040 Scan Controls](image)

The following modes are unique to the 2040 scanner:
• **Mode:** Lets you select the appropriate scanner mode:
  • **Line:** This mode works best with line art.
  • **Text/Photo:** This mode works best with less than perfect originals.
  • **Photo:** This mode works best with photographic images.

The following enhancement buttons are available for all modes:

• **Threshold:** Is used to set the point that divides black and white data. Scanned data lighter than the threshold value will display as white. Scanned data darker than this value displays as black. Click the **Low**, **Medium**, or **High** button, or enter a value in the field.

• **Auto exposure:** Selected this button to automatically determine the amount of background removal, to allow the image to compress efficiently.

**KIP 2950 Scanner Interface**

This section details only the features and settings specific to these KIP scanners. Any features, options, or menus not mentioned are considered to be standard for all scanners. Their descriptions and instructions for use are found in *Chapter 9 - The Scanner Interface*. 
The following modes are unique to the 2950 scanner:

- **Mode**: Lets you select the appropriate scanner mode:
  - **Line**: This mode works best with line art.
  - **Photo1**: This mode works best with photographic images.

The following enhancement buttons are available for all modes:

- **Threshold**: Is used to set the point that divides black and white data. Scanned data lighter than the threshold value displays as white. Scanned data darker than this value displays as black. Click the **Low**, **Medium**, or **High** button, or enter a value in the field.
- **Auto exposure**: Selected this button to automatically determine the amount of background removal, allowing the image to compress more efficiently.
Océ 9800 Scanner Interface

This section contains features and settings specific to the Oce. Features, options, or menus not mentioned are considered standard for all scanners and are described in Chapter 9 - The Scanner Interface.

9800 Scan Controls

The 9800 scanner Scan Controls dialog box is limited to only those features the scanner allows PlotWorks to influence (click the Scan Controls tab).

- **Configuration**: This feature is comprised of 7 choices - BluePrint (High Quality, Low Quality, Medium Quality), Default (previously configured), and Sepia (High Quality, Low Quality, Medium Quality).
- **Mode**: There are two modes, Standard and Custom.
- Select **AUTO LENGTH** to have the software automatically detect the closest (higher) standard length. PlotWorks detects the actual width of the document, even if it is not a standard size.

⚠️ **200 DPI Resolution is not currently supported.**
Contex FSS/FCS Scanners

This section details features and settings specific to the Contex FSS scanners. Options not mentioned are considered to be standard for all scanners. These are described in *Chapter 9 - The Scanner Interface*.

The following modes are unique to the FSS scanners:

- **Bilevel**: This mode works best with line art.
- **Dither/Halftone**: This mode works best with photo or grayscale images.

The following enhancement buttons are available for all modes:

- **Threshold**: Lets you set the point that divides black (0) and white (100) data. Any scanned data that is lighter than the threshold value will display as white. Any scanned data that is darker than the threshold value will display as black.
• **Auto thresholding** button: When selected (down), this option automatically determines the best threshold setting for the image being scanned.

• **Background Suppression**: Removes unwanted background specks and smears, allowing the image to compress more efficiently.

**Contex FSS Scanning Tips**

When scanning with the Contex scanners, always feed the image to be scanned from the left side of the scanner — not the center as indicated on the scanner.
Chapter 10

Advanced Reporting Utility (ARU)

Producing a Job Report

The PlotWorks Advanced Reporting Utility (ARU) function is used to generate job reports. The ARU is an ASCII text log, containing information about each file printed. The ARU records information like the time a job is printed, the media used, the name of the client, plus much more. The ARU can be imported into a spreadsheet or database program where the data can then be compiled to meet the organizations needs. For example a report can be generated to determine the average amount of each media used. Invoices can also be created for billing purposes.

ARU logs are generated by the Printer Interface, the Scanner Interface, and the Publisher. The Printer Interface records details on each job printed. The Scanner Interface records information on each job scanned and the Publisher records information on each job viewed or sent for print. An ARU report can also be created for the Output to File function that is available from the Job Editor or Job Queue. The ARU logs are not created till the first document is printed, scanned or viewed depending upon the type of log discussed.
Specifying what Data the ARU Log Collects

Data collected by the ARU is determined by data fields that are specified in the DEF file. The Printer Interface, Scanner Interface, and Publisher software each have a related DEF file. The DEF file always has a prefix of “rpt” and has the.def file extension. For example the DEF file for the XES 8180 printer is named, rptXES_8180_1.def. The “_1” indicates that it is the 8180 printer that is specified as Device 1 in the Printer Interface, General Configuration window.

The DEF file for Output to File is named rptPublisher.def.

When the PlotWorks software is first installed, the provided DEF files contain all applicable data fields. To limit or specify what data is collected in the ARU log you can edit the DEF files.

In Figure 10-1 the second data field is DATE. This data field records what date each file is printed. A list of data fields available, and how these can be used is provided later in this chapter.

Editing the DEF File

To edit the DEF file:
1. Open a text editor like Windows Notepad.
2. Click on the File menu.
3. Select the **Open** menu item. The Open dialog box appears.

4. Browse to the **PlotWorks** folder. This is usually located in **C:\Program Files\PLP\Plotworks**.

5. Select the DEF file you need to edit.

6. Click on the **Open** button. The DEF file opens in your text editor application.

7. The first line of the DEF file contains the data fields, **REPORT_DESTINATION**. This data fields is used either to specify a:
   - log file and path to use. In Figure 10-1 we specify the ARUdefault.log file. Edit the first line to use a different log file, or path. We recommend you specify a new log file if you intend to edit the data fields list as specified in step 8. The log file does not have to already exist. It is created the first time required. The syntax for this is
     \[ \text{REPORT\_DESTINATION}=<\text{filename and path}> \]
     For example, \[ \text{REPORT\_DESTINATION}=C:\Program Files\PLP\Plotworks \]
   - a printer port to print job details. The syntax for this is:
     \[ \text{REPORT\_DESTINATION}= <\text{printer port}> \]
     For example, \[ \text{REPORT\_DESTINATION}=LPT1 \]

8. The data fields list continues on the second line of the DEF file. Edit this list as needed. Keep in mind that each application (Printer Interface, Scanner Interface, and Publisher) can use only its specified DEF file. So this file must contain data fields for all the data you want to collect.

9. Save and close the text editor ensuring you did not change the DEF file name. The new log generated will only contain data for the specified data fields.

**ARU Data Fields**

Some data fields allow the user to limit the data size of values added to the log. This is done by adding a colon (:) after the data fields. For example:

\[ \text{JOB\_PATH}:255 \]

indicates that only the first 255 characters of the job path are added to the log file. This functionality is provided in case you need the ARU output to fit a specified form or a database field.

Most of the data fields are optional and the order in which they are listed in the DEF file is the order the data is listed in the log file.
Below are tables containing data fields that can be specified in the DEF files.

<table>
<thead>
<tr>
<th>Data field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>REPORT_DESTINATION</td>
<td>This data field is required. It is used to specify a full path and filename for the log file or to specify a printer port to print the job details.</td>
</tr>
</tbody>
</table>
This enters the date the job is printed to the log or print file. The default date format is Month/Day/Year (MM/DD/YYYY). You can specify a format for the date values using the following construct:

```
DATE= "your specifiers"
```

Replace the text “specifiers: with one or more of the format specifiers listed below. For example:

```
DATE= "m/d/y" gives 10/21/1999
DATE= "A/B d y" gives Thursday, October 21 1999
```

**Date Format Specifiers:**

- **d or D** provides the day as a number between 0-31
- **m or M** provides the month as a number between 1-12
- **y or Y** provides the year with the century
- **j** provides the day of year as a number between 1-366
- **a** provides the abbreviated weekday name
- **A** provides the full weekday name
- **b** provides the abbreviated month name
- **B** provides the full month name
- **x** provides the date customarily used in the current locale

These specifiers can be used in any order, with any character as a separator. Specifying multiple M’s, D’s or Y’s, or their lower case equivalents will produce the same format. For example, specifying mm, M, MM, m or Mm will provide the same output. Same for the D’s and Y’s.

<table>
<thead>
<tr>
<th>Data field</th>
<th>Description</th>
</tr>
</thead>
</table>
| DATE       | This enters the date the job is printed to the log or print file. The default date format is Month/Day/Year (MM/DD/YYYY). You can specify a format for the date values using the following construct: 

```
DATE= "your specifiers"
```

Replace the text “specifiers: with one or more of the format specifiers listed below. For example:

```
DATE= "m/d/y" gives 10/21/1999
DATE= "A/B d y" gives Thursday, October 21 1999
```

**Date Format Specifiers:**

- **d or D** provides the day as a number between 0-31
- **m or M** provides the month as a number between 1-12
- **y or Y** provides the year with the century
- **j** provides the day of year as a number between 1-366
- **a** provides the abbreviated weekday name
- **A** provides the full weekday name
- **b** provides the abbreviated month name
- **B** provides the full month name
- **x** provides the date customarily used in the current locale

These specifiers can be used in any order, with any character as a separator. Specifying multiple M’s, D’s or Y’s, or their lower case equivalents will produce the same format. For example, specifying mm, M, MM, m or Mm will provide the same output. Same for the D’s and Y’s. |
<table>
<thead>
<tr>
<th>Data field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>TIME</td>
<td>This records the time that the job was printed, in 24-hour format.</td>
</tr>
<tr>
<td>INF_TEXT</td>
<td>This records the text from the job information (.INF) file if one was sent with the job.</td>
</tr>
<tr>
<td>JOB_FILENAME</td>
<td>This records the name of the job ticket file.</td>
</tr>
<tr>
<td>JOB_PATH</td>
<td>This records the job ticket path file, if it is different from the Program/ PlotWorks directory. A maximum of 255 characters is recorded.</td>
</tr>
<tr>
<td>IMAGE_FILENAME</td>
<td>This records the name of the image file.</td>
</tr>
<tr>
<td>IMAGE_PATH</td>
<td>This records the image path at the time of printing if different from the PlotWorks Program directory. A maximum of 255 characters is recorded.</td>
</tr>
<tr>
<td>IMAGE_FILESIZE</td>
<td>This records the number of bytes in the image file.</td>
</tr>
<tr>
<td>IMAGE_QUANTITY</td>
<td>This records the number of copies requested.</td>
</tr>
<tr>
<td>IMAGE_NUMBER</td>
<td>This records the number of the current copy</td>
</tr>
<tr>
<td>FINAL_XSIZE</td>
<td>This is the Paper Sheet X size. This records the size along the X axis of the printed sheet of media.</td>
</tr>
<tr>
<td>FINAL_YSIZE</td>
<td>This is the Paper Sheet Y size. This records the size along the Y axis of the printed sheet of media.</td>
</tr>
<tr>
<td>ACTUAL_XSIZE</td>
<td>This records the size along the X axis of the main image. This is the original size of the main image without margins, overlays, or any Specified Size and Output Size manipulations.</td>
</tr>
<tr>
<td>Data field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ACTUAL_YSIZE</td>
<td>This records the size along the Y axis of the main image. This is the original size of the main image without margins, overlays, or any Specified Size and Output Size manipulations.</td>
</tr>
<tr>
<td>UNITS</td>
<td>This records the units of measure used. IN, CM, MM, or ML.</td>
</tr>
<tr>
<td>SET_QUANTITY</td>
<td>This records the number of sets requested.</td>
</tr>
<tr>
<td>SET_NUMBER</td>
<td>This records the number of the current set.</td>
</tr>
<tr>
<td>FORMAT</td>
<td>This records the original Image file format.</td>
</tr>
<tr>
<td>MEDIA</td>
<td>This records the Media type outputted.</td>
</tr>
<tr>
<td>COMPANY</td>
<td>This records the company name entered in the Company field of the PlotWorks Job Editor or PFS file preferences. A maximum of 64 characters is recorded.</td>
</tr>
<tr>
<td>PROJECT</td>
<td>This records the project name entered in the Project field of the PlotWorks Job Editor or in the PFS file preferences. A maximum of 64 characters is recorded.</td>
</tr>
<tr>
<td>CONTACT</td>
<td>This records the contact person entered in the Contact field of the PlotWorks Job Editor or in the PFS file preferences. A maximum of 64 characters is recorded.</td>
</tr>
<tr>
<td>PHONE</td>
<td>This records the contact phone number, entered in the Phone field of the PlotWorks Job Editor or in PFS file preferences. A maximum of 64 characters is recorded.</td>
</tr>
<tr>
<td>Data field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ADDRESS or ADDRESS1</td>
<td>This records the customer address entered in the Address field of the PlotWorks Job Editor or in the PFS file preferences. A maximum of 64 characters is recorded.</td>
</tr>
<tr>
<td>CITY or ADDRESS2</td>
<td>This records the customer city entered in the City field of the PlotWorks Job Editor or in the PFS file preferences. A maximum of 64 characters is recorded.</td>
</tr>
<tr>
<td>STATE or ADDRESS3</td>
<td>This records the customer state or province, entered in the State field of the PlotWorks Job Editor or in the PFS file preferences. A maximum of 64 characters is recorded.</td>
</tr>
<tr>
<td>ZIP, POSTCODE or ADDRESS4</td>
<td>This records the customer zip or postal code, entered in the Zip field of the PlotWorks Job Editor or in the PFS file preferences. A maximum of 64 characters is recorded.</td>
</tr>
<tr>
<td>COMMENT</td>
<td>This records the comments, entered in the comment field of the PlotWorks Job Editor or in the PFS file preferences. A maximum of 64 characters is recorded.</td>
</tr>
<tr>
<td>ACCOUNT</td>
<td>This records the account number, entered in the Account field of the PlotWorks Job Editor or in the PFS file preferences. A maximum of 64 characters is recorded.</td>
</tr>
</tbody>
</table>
### Data field | Description
--- | ---
**STATUS** | This records the status of the file. The following status values are recorded:
• `-`: The file was skipped
• `O`: The file was printed fine
• `P`: The file was processed without warnings
• `A`: The image was aborted during output, and did not complete successfully
• `M`: The image did not complete printing because the media ran out.
• `W`: Warnings were generated
• `E`: Error Free Printing.

**ERROR_TEXT** | This records any text that was generated due to an image file processing error. A maximum of 255 characters is recorded.

**SKIPPED** | A blank space is recorded when the file is printed successfully. An asterisk (*) is recorded when the file is skipped.

**OUTPUT_DEVICE** | This records the printer type.

**BILLABLE** | This records a “Yes” unless the image did not print successfully due to a media jam or if the job is aborted. Depending on the options selected in the Separator Page dialog box, Separator pages might be nonbillable.

**UNC_MACHINE_NAME_AND_LOGIN** | This records the UNC machine name and user login name. A maximum of 255 characters is recorded.
For many data fields, the prefix “PLOT” was changed to the prefix “IMAGE”. If you have older PLP files, the ARU is backward compatible and will recognize the PLOT data fields.

### Output to File Data Fields

The Output to File DEF file, rptPublisher.def, uses most of the data fields listed in the table above except for OUTPUT_DEVICE. The Output to File DEF file records the size selected for Output Setup for the FINAL_XSIZE and FINAL_YSIZE data fields.

### Scanner ARU Data Fields

Besides the data fields listed before, there are other key words used by the Scanner ARU. These are listed in the table below:

<table>
<thead>
<tr>
<th>Data field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>MODE</td>
<td>This records the appropriate scanner mode.</td>
</tr>
<tr>
<td>RESOLUTION</td>
<td>This records the scanning resolution.</td>
</tr>
<tr>
<td>RESCAN</td>
<td>This records any re-scans.</td>
</tr>
<tr>
<td>MIRROR</td>
<td>This records whether the image was printed mirrored (reversed).</td>
</tr>
<tr>
<td>INVERT</td>
<td>This records whether the image was printed inverted</td>
</tr>
<tr>
<td>IMAGE DENSITY</td>
<td>This records the image density used.</td>
</tr>
<tr>
<td>Data field</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>THRESHOLD</td>
<td>This records the point that black and white data is divided.</td>
</tr>
<tr>
<td>CONTRAST</td>
<td>This records the image contrast.</td>
</tr>
<tr>
<td>BACKGROUND REMOVAL</td>
<td>This records if the background removal option is used.</td>
</tr>
<tr>
<td>BACKGROUND BIAS</td>
<td>This records the level of background removal used.</td>
</tr>
<tr>
<td>EDGE SHARPENING</td>
<td>This records the level of edge sharpening used</td>
</tr>
<tr>
<td>DARKNESS</td>
<td>This records the image brightness or darkness.</td>
</tr>
<tr>
<td>COMPRESSION_IN_SCANNER</td>
<td>This records the scanner compression level.</td>
</tr>
<tr>
<td>AREA_SIZE</td>
<td>This records the size of the area used for adaptive thresholds.</td>
</tr>
<tr>
<td>BACKGROUND_SUPPRESSION LEVEL</td>
<td>This records the strength of the background suppression.</td>
</tr>
<tr>
<td>AUTO_THRESHOLDING</td>
<td>This records the automatic threshold value used</td>
</tr>
<tr>
<td>ADAPTIVE_LEVEL</td>
<td>This records the adaptive threshold value used</td>
</tr>
<tr>
<td>BACKGROUND_SUPPRESSION TYPE</td>
<td>This records the type of background suppression used.</td>
</tr>
<tr>
<td>BLACK_LEVEL</td>
<td>This records the black level selected.</td>
</tr>
<tr>
<td>RED_LEVEL</td>
<td>This records the red level selected.</td>
</tr>
<tr>
<td>BLUE_LEVEL</td>
<td>This records the blue level selected.</td>
</tr>
<tr>
<td>YELLOW_LEVEL</td>
<td>This records the yellow level selected.</td>
</tr>
<tr>
<td>Data field</td>
<td>Description</td>
</tr>
<tr>
<td>---------------------</td>
<td>-----------------------------------------------------------------------------</td>
</tr>
<tr>
<td>GREEN_LEVEL</td>
<td>This records the green level selected.</td>
</tr>
<tr>
<td>OTHER_LEVEL</td>
<td>This records any other levels selected.</td>
</tr>
<tr>
<td>AREA_SIZE</td>
<td>This records the area size used for adaptive thresholding.</td>
</tr>
<tr>
<td>SCANNER_SPEED</td>
<td>This records the scanner speed as a percentage of the scanners full speed.</td>
</tr>
<tr>
<td>AUTO_EXPOSURE</td>
<td>This records the auto exposure value used.</td>
</tr>
<tr>
<td>AUTO_SCAN</td>
<td>This records if the auto-scan feature is used.</td>
</tr>
<tr>
<td>RED_THRESHOLD</td>
<td>This records the red threshold level selected.</td>
</tr>
<tr>
<td>BLUE-THRESHOLD</td>
<td>This records the blue threshold level selected.</td>
</tr>
<tr>
<td>MASKING</td>
<td>This records if masking is used.</td>
</tr>
<tr>
<td>EJECT_TYPE</td>
<td>This records how scanned documents exit the scanner.</td>
</tr>
<tr>
<td>WHITE_POINT</td>
<td>This records the white point of the image. values lighter than the white point appear as white on the image.</td>
</tr>
<tr>
<td>BLACK_POINT</td>
<td>This records the black point of the image. values darker than the black point appear as black on the image.</td>
</tr>
<tr>
<td>AE_PRE_SCAN</td>
<td>This records AE_Pre_Scan data.</td>
</tr>
<tr>
<td>OUTPUT_FORMAT</td>
<td>This records the format selected for final document output, e.g., Bond, Vellum</td>
</tr>
<tr>
<td>ORIGINAL_SIZE</td>
<td>This records the size of the hard copy scanned.</td>
</tr>
</tbody>
</table>
Publisher ARU data fields

Besides the data fields listed before, there are other key words used by the Publisher ARU. These are listed in the table below.

<table>
<thead>
<tr>
<th>Data field</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>REQUESTED_PAGES</td>
<td>This records the pages viewed in a file</td>
</tr>
<tr>
<td>TOTAL_PAGES</td>
<td>This records the number of pages in the original file.</td>
</tr>
<tr>
<td>PIXELSIZE_X</td>
<td>This records the width, in pixels, of the output image.</td>
</tr>
<tr>
<td>PIXELSIZE_Y</td>
<td>This records the height in pixels of the output image.</td>
</tr>
<tr>
<td>OUTPUT_RESOLUTION</td>
<td>This records the resolution, in DPI, of the output image.</td>
</tr>
<tr>
<td>OUTPUT_FORMAT</td>
<td>This records the output file format</td>
</tr>
<tr>
<td>USERNAME</td>
<td>This records the login name</td>
</tr>
<tr>
<td>ORIGINATOR</td>
<td>This records the product that made the request. (Usually WEB).</td>
</tr>
<tr>
<td>METHOD</td>
<td>Records the function called</td>
</tr>
</tbody>
</table>
Disabling the Printer ARU

Every time a file is printed an entry is appended to the ARU log. Over time your ARU log will become very large. Therefore if your organization does not use the data collected in the log we recommend you disable the ARU log.

To disable the Printer Interface ARU:

1. Open the Printer Interface if it is not already open.
2. Click on the Setup menu.
3. Click on the General Configuration menu item.
4. Select the check box labeled Disable ARU logging.

When the Printer ARU is not disabled, two ARU logs are written:

- One in the Queue directory for that image (00000001\00000001.ARU).
- The second as specified for the data fields REPORT_DESTINATION in the DEF file.
LOG Files

Log files are comma delimited text files that are generated by the ARU. Data collected in LOG files is determined by the DEF files as explained above. LOG files can be viewed in any text editor like Notepad. These files are designed to be easily imported into most database or spreadsheet applications to generate reports.

Archiving a log file

Periodically you will want to archive or delete a log file. This can be accomplished efficiently by opening Windows Explorer and renaming or relocating the current file. We recommend you select a relevant name, like March2001_June2001.log.

ARU file size

When PlotWorks is first installed, a dialog box appears prompting the installer to select a maximum size for the ARU logs. The default maximum file size is 10MB. Every time a job is processed, entries are appended to the ARU log until the maximum allotted size is reached. If the maximum file size is exceeded you are warned. At that point we recommend you archive the old ARU log and start a new log. Once PlotWorks is installed the ARU maximum size value can only be changed in the registry.
Using the ARU Log to Generate Reports

The (ARU) is a tool to generate reports. You can use a third party report generating application, such as Crystal Reports, Microsoft Access, or Microsoft Excel, to create reports based on the ARU log.

Importing the ARU Log File into Microsoft EXCEL

1. Open Microsoft Excel
2. Click on the Open button. The Open dialog box appears.
3. Select All Files (*.*) from the Files of type drop down list.
4. Using the Look in drop down list, navigate to the directory containing the ARU log. This is usually C:\Program Files\PLP\Plotworks
5. Double click on the ARU log file. By default this file is named ARUdefault.log. The Text Import Wizard Step 1 of 3 dialog box opens.

6. Ensure that the Delimited radio button is selected.
7. Click on the Next button. The Text Import Wizard Step 2 of 3 dialog box opens.
8. Ensure that only the Comma check box is selected and that {none} is selected in the Text qualifier drop down list.

9. Click on the Next button. The Text Import Wizard Step 3 of 3 dialog box opens.

10. This dialog box enables you to select properties for each column in the EXCEL spread sheet. Depending on your organizations needs you may need to do this. When you have made your choices if necessary, click Finish. The ARU log now populates the spread sheet window.

You can now manipulate the information in EXCEL to generate the reports you desire.

**Importing the ARU log file into Microsoft Access**

1. Open Windows Explorer

2. Navigate to the ARU log file you want to base reports on. This file is usually in the C:\Program Files\PLP\Plotworks directory.

3. Rename the ARU log file with a .txt extension. For example if the file was called ARUdefault.log rename it ARUdefault.txt

4. Open the Microsoft Access application. The following dialog box appears:
5. Click on the **Blank Database** radio button

6. Click on the **OK** button. The File New Database dialog box appears.

7. Navigate to an appropriate directory and enter a name for the new database.

8. Click on the **Create** button. The following dialog box appears:
9. Click on the New button from the tool bar. The New Table dialog box opens.
10. Click on Import Table in the select box.
11. Click on the OK button. The Import dialog box opens.

12. In the drop down list labeled Files of Type, select Text Files.
13. Navigate and select the .txt file created in Step 3.
14. Click on the **Import** button. The Import text wizard dialog box opens.

![Import Text Wizard dialog box](image)

15. Select the radio button titled, **Delimited - Characters such as comma or tab separate each field**.

16. Click on the **Next** button. The following Import Text Wizard dialog box opens.
17. Ensure the **Comma** radio button is selected.
18. Check the **First Row Contains Field Names** check box.
19. In the **Text Qualifier** drop down list, select the double quotation marks (" ").
20. Click on the **Next** button. The next Import Text Wizard dialog box opens.
21. Select the radio button titled **In a New Table**.
22. Click the **Next** button. The next Import Text Wizard dialog box opens. This dialog box allows you to edit the fields. This is not necessary.
23. Click the **Next** button again. The next Import Text Wizard dialog box opens
24. Ensure that the **Let Access add Primary Key** radio button is selected and the **ID** field is highlighted.

25. Click the **Next** button again. The last Import Text Wizard dialog box opens

26. In the text box labeled **Import to Table**, enter a name for the table. For example MAX 200 Scanner Interface 12_2_2001

27. Click on the **Finish** button. The table is now displayed in the Database dialog box under **Table**.
The table you just created contains all the data originally contained in the ARU log. This table can be used to run different Queries and Reports as required.

**Create a Query**

Queries are Microsoft Access’s way of compiling useful data. The type of queries you can run are limitless. In the section we will create a very simple query to view all Bond media jobs in October. While this is not the most useful information to compile the purpose is to expose you to Microsoft Access’s functionality.

1. In the Database window click on **Queries**.
2. Double click on **Create query by using wizard**. The Simple Query Wizard dialog box opens.

3. Ensure the correct Table is listed in the **Table/Queries** drop down list. In our example this is the MAX 200 Scanner Interface 10_10_2000 table.

4. In the **Available Fields** select box select **Date**.
5. Then click on the button labeled “>”. Date appears in the **Selected Fields** group box.

6. In the **Available Fields** select box select Media.

7. Then click on the button labeled “>”. Media appears in the **Selected Fields** group box.

8. Click on the **Next** button. A dialog box appears prompting you to name your Query.

9. In the text box labeled, **What title do you want for your Query**, enter a title. For example, “Media used”.

10. Select the radio button labeled **Modify the query design**.

11. Click **Finish**. The Query opens in design view:

![Fig 10.15 Query in Design View](image)

12. In the column labeled Media, in the row labeled Criteria, Enter “**BOND**”.

13. In the column labeled Date, in the row labeled Criteria, Enter **Like“10/*/2002”**.

14. Click on the **Run** icon on the Access tool bar to run the query. All scans in October where Bond is used appear.

**Creating a report in Microsoft Access**

1. Select **Report** in the database window.

2. Double click **Create report using wizard**. The Report Wizard dialog box opens.
3. In the Tables Queries drop down list, Select your Query. for example the Media used query we used in our earlier example. The fields used in the Query are listed in the Available fields drop down list.

4. Select the fields contained in the Query from the Available Fields select box.
5. Click on the button labeled “>”
6. All the fields are moved to the Selected Fields select box.
7. Click on the **Finish** button.

To edit the final report you can open the report in design view and add fields and calculations as desired.
Chapter 11

Folder Information

This chapter is about using folding devices. It supplements information provided in Chapter 4, The Job Editor and Chapter 8, The Printer Interface.

Supported Folders

PlotWorks supports the following printer/folder combinations:

• GFI Folders. PlotWorks supports GFI Level 1 and Level 2 folders.
• KIP 3620 with the PrintFold 2150
• KIP 9010 with the PrintFold 3150
• Océ 9600 & 9800
• XEROX WIDE FORMAT 721p Printer with GFI folders using the AccXES or PlotWorks controller
• Xerox 8180
• Xerox 8845
• XES MAX 200 FX, EO & NACO with the Bay Hornet and PrintFold 2757
• XEROX WIDE FORMAT 510dp with GFI option using the AccXES or PlotWorks controller
• XEROX WIDE FORMAT 8825 with GFI option using the AccXES or PlotWorks controller
• XEROX WIDE FORMAT 8830 with the Bay 3, Gera, and PrintFold 2150 with GFI option using the AccXES or PlotWorks controller
• XEROX WIDE FORMAT 8850 with GFI option using the AccXES or PlotWorks controller
• XEROX WIDE FORMAT 8855 with the Bay 2 and 3, and PrintFold 3150 with GFI option using the AccXES or PlotWorks controller
Setting up the Folder

Depending upon what hardware you are using you use a different method to setup your folder. Before attempting to set up your folder it is useful to know:

- What type of folder you are using
- If your folder contains the GFI option.
- Whether the cable from the folder is connected to the printer or to a serial port on the computer
- If you are using the AccXES or PlotWorks Controller

Depending upon the answers to the questions above you may have to set up the Printer Interface to use your folder or create an FPF file. It may also be necessary to connect the PlotWorks Folder Cable. This is all done very easily and the instructions to do so are provided below.

Connecting the PlotWorks Folder Cable

721p with the PlotWorks or AccXES Controller

XEROX WIDE FORMAT 8830, 8850, or 510dp with the AccXES Controller

This set of instructions only apply if you are running the 721p or if running the XEROX WIDE FORMAT 8830, 8850, or 510dp with the AccXES Controller. If you are not running one of these printer/folder combinations, skip this section and move to the next subsection.

If you are running one of the printer/folder combinations listed in the previous paragraph, your PlotWorks shipment may include the PlotWorks Folder Cable. If included, follow the instructions below depending upon your hardware configuration.

721p with the PlotWorks Controller

This hardware configuration requires the PlotWorks Folder Cable so that PlotWorks can communicate with the folder. Connect one end of the PlotWorks Folder Cable to the folder and the other to the PlotWorks computer's COM 1 serial port.

721p, 8830, 8850, or 510dp with the AccXES Controller

It is necessary to use the PlotWorks Folder Cable to retrieve the Folder Program File (FPF file) with this configuration. Once the FPF file is retrieved the PlotWorks Folder Cable is disconnected.

To retrieve the FPF File, follow the instructions below:

1. Start the Printer Interface. Click on the Setup menu and then on Device
Specific Options.

2. Enter the AccXES controller's IP Address in the **IP Address** text box. Then click **OK**. The Printer Interface will close and reopen.

A dialog box should appear prompting you to connect the folder serial cable to COM 1 on the PlotWorks server. *Do not select an option from this dialog box till you have completed Steps 3 and 4*. If the dialog box does not appear, verify that the folder is correctly connected to the Printer or AccXES controller. When correctly connected, the AccXES WebPMT indicates that the GFI is ready.

3. Depending upon your printer, disconnect the cable from the printer/controller as follows:

   - **Xerox 721p**: Identify the cable currently connecting the folder to the AccXES controller. Disconnect the end connected to the AccXES controller.
   
   - **Xerox 8830, 8850 or 510dp**: Identify the cable currently connecting the folder to the printer. Disconnect the end connected to the printer.

4. Connect one end of the PlotWorks Folder Cable to the cable identified in Step 3. Connect the other end of the PlotWorks Folder Cable to the PlotWorks computer's COM 1 serial port.

5. Now click the **OK** button on the dialog box.

6. Once the FPF file is created, disconnect the PlotWorks Folder Cable and reconnect the cable from the folder manufacturer as before.

If any of the folder fold programs are changed, it is necessary to recreate the FPF file. In this case, delete the FPF file from the "\PLP\PlotWorks\FPFfolder" directory, restart the Printer Interface and follow the steps above to re-create the FPF file.

---

**The PlotWorks Folder Cable is not used or provided when running the Xerox 8830 or 8850 without AccXES.**

---

**If provided, store the PlotWorks Folder Cable in a safe place when it is not being used. You may need it in the future if your folder configuration changes or an FPF file needs to be recreated.**
Setting up GFI Folders

XEROX WIDE FORMAT 510dp, 8825, 8850, 8830, and 8855

This section only applies if you are running the XEROX WIDE FORMAT 510dp, 8830, 8825, 8850, or 8855 folder/printers with the GFI option. If you are not running this configuration, skip this section and move to the next subsection.

GFI (Generic Finisher Interface) is the proprietary communication protocol used with XEROX WIDE FORMAT printers and finishing devices. PlotWorks GFI support requires creating a Folder Description File (FPF file) for the attached folder. Depending upon your hardware configuration follow the instructions below to create the FPF file.

You may have created the FPF file while connecting the PlotWorks Folder Cable. In this case you do not have to recreate it unless your hardware configuration has changed.

XEROX WIDE FORMAT 8825 using the AccXES Controller

This section only applies if you are running the XEROX WIDE FORMAT 8825, folder/printer, with the GFI option, and are using the AccXES controller. If you are not running this configuration, skip this section and move to the next subsection.

1. Install the printer and folder as illustrated in the diagram below. Note that the PlotWorks Folder Cable, the serial cable provided by PLP is not used here.

2. Using the AccXES WebPMT or Configuration sheet verify that the AccXES Controller is successfully connected to the folder.

3. Open the PlotWorks Printer Interface for the printer that is connected to the GFI folder.
4. Click on the **Setup** menu and then on **Device Specific Options**. The Device Specific Options dialog box opens.

5. From the **Folder type** drop down list select **No folder/Auto detected folder**.

6. Enter the TCP/IP address of the AccXES controller in the **IP Address** text box.

7. Click on the **OK** button. The Printer Interface will close and reopen.

8. Once the connection is established, if a FPF file is not present in the directory "C:\Program Files\PLP\Plotworks\FPFFolder", the Printer Interface will prompt you to connect the folder to the computer to generate the FPF file. Refer to the diagram below and follow the provided instructions to create the file.

---

**Fig 11.2**

*Hardware connection for creating an FPF file*

1. Detach the folder serial cable from the Printer IOT. Do not disconnect it from the folder.

2. Connect the PlotWorks Folder Cable (previously unused), to the folder serial cable. This extends the folder serial cable.

3. Connect the available end of the Plot Works Folder Cable it to the COM1 Port on the PlotWorks computer.

4. Click **OK** when prompted to create the FPF file.

5. Once the FPF file is created, detach the PlotWorks Folder Cable and re-connect the folder to the AccXES controller or Printer IOT as before.

---

**GFI Folder Installation using the PlotWorks Direct Connection**

XEROX WIDE FORMAT 8850, 8830, and 8825
This section only applies if you are running the XEROX WIDE FORMAT 8850, 8830, or 8825 folder/printer, with the GFI option, and are using the PlotWorks connection. If you are not running this configuration, skip this section and move to the next one.

Follow the procedure below to set up the GFI folder using the PlotWorks Connection.

1. Install the printer and folder as illustrated in the diagram below. Note that the PlotWorks Folder Cable provided by PLP is not used here.

   ![Diagram of GFI folder installation using the PlotWorks direct connection](image)

2. Open the PlotWorks Printer Interface for the printer that is connected to the GFI folder.

3. Click on the Setup menu and then on Device Specific Options. The Device Specific Options dialog box opens.

4. From the Folder type drop down list, select No folder/Auto detected folder.

5. Click on the OK button. The Printer Interface will close and reopen.

6. Once the connection is reestablished, if a FPF file is not present in the directory "C:\Program Files\PLP\Plotworks\FPFFolder a FPF file is automatically created.

**Important installation notes for GFI Folders**

**XEROX WIDE FORMAT 8825, 8850, 8830, and 8855**

Do not use a FPF file downloaded from a different GFI folder, as this will cause the Printer Interface to crash when attempting to print a job with a fold request. If the PlotWorks Print Station was attached to a GFI folder, and then later attached to a different GFI folder, the Printer Interface would still use the FPF file from the original GFI folder. In either case follow the instructions below:
1. If the PlotWorks server is attached to the new folder, disconnect it.
2. Close the Printer Interface.
3. Delete the original FPF file from the folder C:\Program Files\PLP\Plotworks\FPFFolder
4. Reconnect the folder as described in the previous section titled "Installing the GFI folder".
5. Restart the Printer Interface.

**Setting up the PlotWorks Client to use GFI Folding options**
If you want to use the PlotWorks Client and you want to specify GFI Folding options in the job ticket, it is necessary to set up the PlotWorks Clients for GFI folding. To do so, copy the FPF file from the PlotWorks server to the “C:\Program Files\PLP\Plotworks\FPFFolder” directory of the PlotWorks Client computer.

**Media Requirements for Folding**
When using the certain hardware configurations, it is necessary to ensure specific media is loaded in the printer.

**Synergix Fold System 40**
When using the Synergix Fold System 40 (PrintFold) with the 721p printer, it is necessary to ensure specific media is loaded depending on the document size series selected. The following media is required for the Synergix Fold System 40:

<table>
<thead>
<tr>
<th>ISO Sizes:</th>
<th>ANSI Sizes:</th>
<th>Architectural Sizes</th>
</tr>
</thead>
<tbody>
<tr>
<td>297mm roll</td>
<td>11” roll</td>
<td>12” roll</td>
</tr>
<tr>
<td>420mm roll</td>
<td>17” roll</td>
<td>18” roll</td>
</tr>
<tr>
<td>594mm roll</td>
<td>22” roll</td>
<td>24” roll</td>
</tr>
<tr>
<td>841mm roll</td>
<td>34” roll</td>
<td>36” roll</td>
</tr>
</tbody>
</table>

**Gera Universal Folder**
When using the Gera Universal Folder, it is necessary to ensure specific media is loaded and the Rotation table is installed depending on the document size series selected. The following media is required for this folder:

ISO Sizes:          ANSI Sizes:          Architectural Sizes
• 297mm roll        • 11” roll           • 12” roll
• 420mm roll        • 17” roll           • 18” roll
• 594mm roll        • 22” roll           • 24” roll
• 841mm roll        • 34” roll           • 36” roll
Setting up the Printer Interface to use your Folder

All folders

It is necessary to set up the Printer Interface for folding. Before you can do so determine if you are using a GFI, Autodetected, or External folder.

Autodetected and External Folders

- **Autodetected folders**: Your folder is an Autodetected folder if the cable from the folder is connected to the printer. The PlotWorks Printer Interface automatically detects folders that are directly connected to the printer. Autodetected Folders include the:
  - Gera (XEROX WIDE FORMAT 8830)
  - Xerox 8845
  - XES 8180
  - XES MAX 200 FX
  - Océ 9600 & 9800

- **External folders**: Your folder is an External folder if the cable from the folder is connected to the computer’s serial port. External Folders include the:
  - Bay 2 (XEROX WIDE FORMAT 8855)
  - Bay 3 (XEROX WIDE FORMAT 8830, 8855)
  - PrintFold 2150 (XEROX WIDE FORMAT 8830, KIP 3620)
  - PrintFold 3150 (XEROX WIDE FORMAT 8855, KIP 9010)
  - PrintFold 2757 (XES MAX 200)
  - Bay Hornet (XES MAX 200)

Setting up the Printer Interface

All folders

1. Open the **Printer Interface** for the printer that will print the documents.
2. Click on the Setup menu and then click on **Device Specific Options**. The Device Specific Options dialog box opens.

3. From the **Folder type** drop down list select your folder. You may have to use the scroll bar on the drop down list to locate your folder. If your folder is an Autodetected folder select **No Folder/Auto detected**. If your folder contains the GFI option select **GFI Folder**.

4. If your folder is an External folder or a GFI Folder, enter the number of the serial port that the folder is connected to in the **Serial port** text box. If using a GFI folder, refer to the GFI Folder User Manual to determine the correct port number. Otherwise ignore this option.

5. If you are using the 8180 folder and you want to automatically rotate every other set 90 degrees when exiting the printer, select the **8180 automatic set rotation** check box. Otherwise ignore this option.
6. If your folder has a rotation table, select the Rotation feature check box to enable sheet rotation.

7. If your folder has the hole punching option, select the Punching check box.

8. If your folder has the reinforcement stripping option, select the Reinforcement check box.

9. Click OK. The Device Specific Options dialog box closes.

10. Close and then reopen the Printer Interface to effect the changes.

For more information on options available from the Printer Interface dialog box refer to “Configure Device Specific Options” on page 8-15.
Fold Types and Options

Depending upon your folder different folding types and options are available. Common folding types and options are described below.

Fold Types

Fan Folds

The document is folded in one direction and the finished fold resembles a fan. The different types of Fan Folds are illustrated below.

<table>
<thead>
<tr>
<th>Full Front, End Left</th>
<th>Full Back, End Left</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generally has a binding margin</td>
<td>Generally has a binding margin</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Full Front and Full Back, End Left</th>
<th>Ericsson Fold: Top panel binding</th>
</tr>
</thead>
<tbody>
<tr>
<td>Generally has a binding margin, may have compensation panels depending on size/fold</td>
<td>Binding margin on cover page.</td>
</tr>
</tbody>
</table>
Cross-fold

The document is folded in two directions. These include the C and Z Folds

**C-Fold:** The finished folded “package” resembles a “C”:

**Z-fold:** The document is fan-folded first, then turned 90 degrees and folded in a Z shape.

The different types of Cross-folds are illustrated below.
<table>
<thead>
<tr>
<th>Z Fold, Back from Top</th>
<th>Z Fold, Forward from Top</th>
</tr>
</thead>
<tbody>
<tr>
<td>Z-style crossfold, folded back from the top of the cover or title page. 3rd and 4th panels folded outside. May be orientated landscape or portrait.</td>
<td>Z-style crossfold, folded forward from top of cover (title) page. May be orientated landscape or portrait.</td>
</tr>
<tr>
<td>Z Fold, Forward from Top</td>
<td>Z Fold, Back from Bottom</td>
</tr>
<tr>
<td>Z-style crossfold, folded forward from top of the cover (title) page. May be orientated landscape or portrait.</td>
<td>Z-style crossfold, folded forward from top of the cover (title) page. May be oriented landscape or portrait.</td>
</tr>
<tr>
<td>C Fold, Back from Top</td>
<td>Wallet Fold</td>
</tr>
<tr>
<td>C-style crossfold, 3rd and 4th panels folded inside. May be orientated landscape or portrait.</td>
<td>Equal length fanfold and crossfold panels. C- or Z-style defined by finisher. Used mainly with Afnor Folds.</td>
</tr>
</tbody>
</table>
Folding Options

The following options may be available for your folder:

**Width**

This option is used to specify the final folded package width. If the desired final folded package size is 210mm, you would specify 210 as the fold width.

**Margin**

This option is used to specify a fold margin. Fold margins, often called “finishing” or “stripping” margins, are used when you want one folded area to be wider than the other areas. This is useful when you want to reinforce or punch the fold for storage in a binder or hanging file.

The amount specified for the Margin is included in the Width. For example, if you want a final piece width of 210mm but you want a 25mm finishing margin (for punching or reinforcing), specify a fold margin of \textbf{210} and a finishing margin of \textbf{25}. PlotWorks will subtract 25 from 210, leaving a 185mm width and a 25mm finishing margin (see Fig. 11.6).
**Fig 11.6**
This illustrates the fold margin and the final width between folds.

**Fold margin**
25 mm

**Fold lines**

finished piece with fold margin - total width is 210 mm

---

**Hanging Edge**
This is also referred to as a “hanging strip.” When selected, the margin is replaced with a pre-punched plastic-reinforced strip so that the document can be placed in a ringed binder.

**Fig 11.7**
Example of a folded document with a punched hanging strip.

finished piece with hanging strip attached
**Punch**
This option punches holes in the document margin for binding purposes. It is necessary to enable the **Margin** option when punching. This option is available with some Bay Folders. The Bay 2 folder does a 2-hole punch; and the Bay 3 does a 2 or 4-hole punch.

**Reinforcement**
This option is used to apply a plastic strip to reinforce the document for punching.
Folding and Image Orientation

Different manufacturer's devices may not orient images the same way. Depending upon your folder, it is necessary to orient your printed image so that the title block appears on top. For example, the Bay folder requires that the title block enter the folder last. Other folders require the title block enter the folder first.

The Bottom edge setting, Finishing Macros, and/or specifying the title block location are the various methods PlotWorks provides to orient printed documents. The Bottom Edge option is explained on page 4-23. Using Finishing Macros is explained on page 11-23. Specifying the title block location is explained next.

Specifying the Title Block Location

Specifying the location of the title block is usually the most efficient way to orient documents for folding. It is especially important to specify the location of the title block when using GFI folding options.

There are three ways to specify the location of the title block. You can use the Title Block Location dialog box if you need to view the document to locate the title block. If you already know where the title block is, select the location from the Title Block column in the job grid, or the Title Block drop down list from the Detailed Property Sheet.

⚠️ It is only necessary to specify a title block location when using GFI folding devices.

From the Detail Property Sheet Dialog Box

1. Click on the Properties button. The Detail Property Sheet dialog box opens displaying the Main tabbed dialog box.
2. Select the title block location from the Title Block drop down list. Select Don’t Care if the title block location is irrelevant.
The Job Grid contains a column named Title Block. Select the title block location from the drop down list in this column. Select **Don’t Care** if the title block location is irrelevant. Ensure you select the correct cells.
Using the Title Block Location Dialog Box

1. Click on the image in the Job Editor job grid.
2. Click on the View menu.
3. Select **Title Block Location Viewer**. The Title Block Location dialog box opens with the selected image displayed.

![Title Block Location dialog box](image)

4. Click on the corner of the image that contains the title block. A red X displays in that corner. If the title block location is irrelevant, click on the red X again. The red X will disappear and **Don’t Care** will appear in the Title Block Location text box.

5. Click on the **OK** button.
Specifying Folding Options in Job Tickets

Folding options are selected from either the Finishing Options tabbed dialog box or the Folding Options dialog box of the Job Editor or Client. Both dialog boxes offer the same folding options.

- The **Folding Options** dialog box is accessed by clicking on the **Output** button and then on the **Folding Options** button.
- The **Finishing Options** tabbed dialog box is accessed by clicking on the **Setup** menu, then **Preferences**, then on the **Finishing Options** tab.

How folding options are specified depends upon your folder. Instructions for specifying folding options for each folder follow.

Folding Options for All Folders

**Except the MAX 200 and GFI Folders**

This section explains how to select folding options for all folders except the **MAX 200 and GFI Folders**. If you are using the MAX 200 or GFI folding options ignore this section.

When selecting folding options for all folders except the **MAX 200 and GFI Folders** it is often necessary to use Finishing Macros. In this section we will first discuss Finishing Macros, then how to select general folding options, and then miscellaneous information about specific folders.

Finishing Macros

Finishing macros are not used with the MAX 200 or GFI Folders. Finishing macros are used with other folders to simplify the process of sending special commands to the printer and/or folder. Not all macros are supported for all folders. The following table provides information about each macro:

<table>
<thead>
<tr>
<th>Macro</th>
<th>Effect</th>
<th>Supported By</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Forces use of the 1st fold card</td>
<td>8845, Océ 9800</td>
</tr>
<tr>
<td></td>
<td>Forces use of belt 1</td>
<td></td>
</tr>
<tr>
<td>2</td>
<td>Forces use of 2nd fold card</td>
<td>8845, Océ 9800</td>
</tr>
<tr>
<td></td>
<td>Forces use of belt 2</td>
<td></td>
</tr>
<tr>
<td>A</td>
<td>Compensation fold first. You must enable Margins.</td>
<td>3150, 2150*</td>
</tr>
</tbody>
</table>
### Specifying Folding Options

To specify folding options for all folders except the MAX 200 and GFI Folders, follow the instructions below:

1. Open either the **Folding Options** dialog box or the **Finishing Options** tabbed dialog box as explained on page 11-20.

2. Select **Default** from the **Folding User Interface** drop-down list.

---

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Models</th>
</tr>
</thead>
<tbody>
<tr>
<td>A</td>
<td>Enables AFNOR fold. You must enable Margins</td>
<td>Océ 9800</td>
</tr>
<tr>
<td>B</td>
<td>Compensation fold is last. You must enable Margins.</td>
<td>3150, 2150*</td>
</tr>
<tr>
<td>B</td>
<td>Enables Din B fold.</td>
<td>8180 (European only)</td>
</tr>
<tr>
<td>C</td>
<td>Produces a ‘C’ fold (evenly folded panels). Requires that cross-fold is enabled.</td>
<td>3150, 2150, 8180</td>
</tr>
<tr>
<td>L</td>
<td>Forces landscape orientation</td>
<td>All</td>
</tr>
<tr>
<td>R</td>
<td>Same as “Bottom Edge = Top, Rotate Off”; rotates drawing 180 degrees</td>
<td>All</td>
</tr>
<tr>
<td>P</td>
<td>Forces portrait orientation</td>
<td>All</td>
</tr>
<tr>
<td>S</td>
<td>Sets a DIN A/C fold</td>
<td>8180 (European only)</td>
</tr>
<tr>
<td>Z</td>
<td>Produces a ‘Z’ fold (default). You must have cross-fold enabled.</td>
<td>3150, 2150, 8180</td>
</tr>
</tbody>
</table>
3. Select the **Enable Fold** check box.
4. Select the desired folding options from the following:
   - **Width**: Enter a fold width in this text box. The 8180 supports 20mm, 25mm, 30mm, and 50mm fold margins:
   - **Add fold margin**: Select this check box if you want to include a fold margin. Fold margins are explained on page 11-14. Then enter the desired margin width in the **Margin** text box.
   - **Margin**: Enter the desired margin width in this text box. This text box is only available when **Add Fold Margin** is selected.
   - **Cross-Fold**: Select this check box to enable a cross fold, if supported by your folder.
   - **Punch**: Select this check box to enable punching, if supported by your folder.
   - **Reinforce**: Select this check box to include a reinforcing strip, if supported by your folder.
   - **Finishing macro**: Finishing macros are entered in this text box.

If using the PrintFold, you can enter the fold number in the finishing macro field. The fold number corresponds to the number on the PrintFold’s Control Panel.

5. Click **OK**. Your folding options are applied to the print job.

**Miscellaneous Information about Specific Folders**

Miscellaneous information on certain folders follows.

**8830/8855 with the Bay Folder**

Bay Folders require customization to fold jobs correctly. This section details what options to select for desired folds.

- Regular Folds (no margin, punching, or reinforcement):
  1. Select **Enable fold** and **Cross-fold**
  2. Set the **Width** field between **180-189** or **201-210** (mm).

- Folds with Margins:
  1. Select **Enable Fold**, **Cross-Fold**, and **Add Fold Margin**.
  2. Set the **Width** field to **210**(mm).
  3. Set the **Margin** field between **20** to **30**(mm), as needed.
Folds with Hanging Edges (Strips):

1. Select Enable fold and Cross-fold.
2. Ensure the Margins check box is not selected.
3. Enter a fold width equal to or between 190 and 200. The Bay Folder automatically adds a hanging strip to the margin when a fold width between 190 and 200mm is entered.
4. Select the Punch and Reinforce options, if desired.

**Bay Hornet Folder**

The Bay Hornet folder supports fold widths from 180-240 mm, fold margins from 0-30 mm, hole punching and reinforcement strips. For AFNOR folds, type A in the Macro text box. For a CUSTOM fold, type C in the Macro text box.

**8830 (Gera) Folder**

There are three different models of the 8830 Gera Folder, ISO, ANSI, and ANSI/ARCH. Each supports different folding widths. The following widths are supported for each model:

<table>
<thead>
<tr>
<th>ISO</th>
<th>ANSI/</th>
<th>ANSI/ARCH</th>
</tr>
</thead>
<tbody>
<tr>
<td>190mm</td>
<td>7.5&quot;</td>
<td>8.5&quot;</td>
</tr>
<tr>
<td>190+20mm</td>
<td>7.5 + 1&quot;</td>
<td>9.0&quot;</td>
</tr>
<tr>
<td>210mm</td>
<td>8.5&quot;</td>
<td></td>
</tr>
</tbody>
</table>

If 190mm is selected for Width with the ISO model, you can add a 20mm margin. ISO only.

**8845 Folder**

PlotWorks automatically reverses the print orders for jobs that are folded using the 8845 folder.

The 8845 supports different fold types depending upon the fold card that is used. In the United States, the folder comes with the 11" and 12" cross and fan cards. In Europe, the folder comes with the DIN A/C, DIN B, European fan, European cross, and SD fold cards.

Enter the card number corresponding to the desired fold type in the Macro text box.
PrintFold 2150 and 3150 Folders

There are a few rules when using the PrintFold. These are detailed below.

- **All folds must first be set at the folder’s console**
  
  When using the PrintFold all folds must first be set at the folder’s console before they are output from PlotWorks. Please refer to the PrintFold operator manual for instructions on configuring fold types. If you send a job with a fold type that is not set at the folder’s console, your job is put on a Media Capabilities hold.

*After changing fold types on the PrintFold control panel, close and reopen the Printer Interface.*

- **Set the PrintFold Folder to Host Mode**
  
  The PrintFold Folder must be set to Host Mode at the console before it can be used. If jobs are not folding, ensure Host Mode is active.

- **PrintFold folds may require opposite rotation**
  
  Most PrintFold fold styles require the opposite rotation (180° vs. 0°; 270° vs. 90°) from most folders. The Printer Interface automatically uses the opposite rotation. However, if a fold style requires the opposite of the normal orientation for a particular folder you can put an ‘R’ (for reverse) in the **Finishing macro** field. This will flip the drawing 180 degrees (changing the **Bottom edge** field will also do this but then any references, labels, or watermarks will be the wrong orientation).

- **Each PrintFold folder supports different types of printers**
  
  - The 2150 is used with low to mid-speed 24-inch and 36-inch engineering printers
  - 3150 is used with high-speed 36-inch engineering printers.
  - The PrintFold 2150 supports XEROX WIDE FORMAT 8830 and the KIP 3620 printers.
  - The PrintFold 2750 supports Xerox 8825, 8830, 8855 and the MAX 200 printers.
  - The PrintFold 3150 supports XEROX WIDE FORMAT 8855 and the KIP 9010 printers.

- **Fold #1 must be set to Stack.**
• **Specifying Fold Types**
  
  - The PrintFold supports two first-fold styles. Type A is the default and Type B the alternate. Enter A or B in the macro text box to specify a fold style. For example to select Type B, enter ‘B’ in the Macro text box.
  
  - The PrintFold supports two second fold styles, Z-Fold (the default) and C-Fold. To select the C-Fold, place a ‘C’ in the Macro text box. To select the Z-Fold, place a ‘Z’ in the Macro text box.

• **Fold Sizes**

  Depending upon the folding Width specified, PlotWorks automatically assigns a packet height.

<table>
<thead>
<tr>
<th>Width in Job Editor</th>
<th>Folded Packet Size</th>
</tr>
</thead>
<tbody>
<tr>
<td>7.5 in</td>
<td>7.5 x 10 in</td>
</tr>
<tr>
<td>8.5 in</td>
<td>8.5 x 11 in</td>
</tr>
<tr>
<td>9 in</td>
<td>9 x 12 in</td>
</tr>
<tr>
<td>11 in</td>
<td>11 x 8.5 in</td>
</tr>
<tr>
<td>12 in</td>
<td>12 x 9 in</td>
</tr>
<tr>
<td>190mm</td>
<td>190 x 297mm</td>
</tr>
<tr>
<td>210mm</td>
<td>210 x 297mm</td>
</tr>
<tr>
<td>297mm</td>
<td>297 x 210mm</td>
</tr>
</tbody>
</table>

**Océ 9600 and 9800 Folder Options**

Depending upon the folding options specified in the Job Editor, The Océ 9600 and 9800 produces the following results:

<table>
<thead>
<tr>
<th>Option selected in the Job Editor</th>
<th>Resulting Fold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Fold only</td>
<td>Ericsson fold exiting from the default stacker.</td>
</tr>
<tr>
<td>Enable Fold with A macro</td>
<td>AFNOR fold</td>
</tr>
<tr>
<td>Enable Fold and Crossfold</td>
<td>DIN fold</td>
</tr>
</tbody>
</table>
The following folding options are also available if you have a high-capacity stacker attached to the Océ 9600 and 9800 folders.

<table>
<thead>
<tr>
<th>Option selected in the Job Editor</th>
<th>Resulting Fold</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Fold</td>
<td>Finished package exits from the default stacker.</td>
</tr>
<tr>
<td>Enable Fold with 1 macro</td>
<td>Finished package exits from belt 1 of the high-capacity stacker.</td>
</tr>
<tr>
<td>Enable Fold with 2 macro</td>
<td>Finished package exits from belt 2 of the high-capacity stacker.</td>
</tr>
</tbody>
</table>

**Folding Options for the MAX 200 NACO**

To access folding options for the MAX 200 NACO follow the instructions below:

1. Open either the **Folding Options** dialog box or the **Finishing Options** tabbed dialog box as explained on page 11-20.

2. Select **MAX 200 NACO** from the **Folding User Interface** drop-down list.

3. Select your folding options. These include:
   - **Fan Fold**: Click this button to specify a Fan Fold.
• **Cross Fold**: Click this button to specify a Cross Fold.
• **Special Fold**: Click this button to specify a Special Fold.

![Fig 11.14 Finishing Options tabbed dialog box when MAX 200 NACO & the Fan Fold button is selected](image)

The next three options will not display if the No Fold button is selected.

• **Punch/Tab/Reinforce**: Click this button to specify hole punching, folding margins or a reinforcing strip.
• **First Fold Only**: Clicking this button is the same as selecting the "Enable fold" check box in the default configuration.
• **Binding Margin**: Select the width of the binding margin from this drop-down list.
• **No Fold**: Select this button when you do not want to fold the printed document. When the No Fold button is selected, the folding options are replaced with options that enable you to choose how the printed document will exit the printer. The following document exiting options are available:
  • **Exit Top of Printer**: Click this button to exit the printed document from the top of the printer.
  • **Exit to Finisher**: Click this button to exit the printed document from the folder or finishing device.
• **Exit Set to Default:** Click this button to exit the printed document from the default location specified in the Printer Interface’s Device Specific Options dialog box.

---

**Fig 11.15**
Finishing Options tabbed dialog box when MAX 200 NACO & the No Fold button is selected

---

**Folding Options for the MAX 200 EO**

To specify folding options for the MAX 200 EO follow the instructions below:

1. Open either the **Folding Options** dialog box or the **Finishing Options** tabbed dialog box as explained above.

2. Select **MAX 200 EO** from the **Folding User Interface** drop-down list.

3. Select your folding options. These include:
   - **DIN AC:** Click this button to enable the DIN AC fold.
   - **DIN B:** Click this button to enable the DIN B fold.
   - **Special Fold:** Click this button to enable a Special fold.
The following options may not display if the No Fold button is selected.

- **Punch/Tab/Reinforce**: Click this button to specify hole punching, folding margins or a reinforcing strip.
• **First Fold Only**: Clicking this button is the same as selecting the "Enable fold" check box in the default configuration.

• **Binding Margin**: Select the width of the binding margin from this drop-down list.

• **No Fold**: Select this button when you do not want to fold the printed document. When the No Fold button is selected, the folding options are replaced with options that enable you to choose how the printed document will exit the printer.

The following document exiting options are available:

• **Exit Top of Printer**: Click this button to exit the printed document from the top of the printer.

• **Exit to Finisher**: Click this button to exit the printed document from the folder or finishing device.

• **Exit Set to Default**: Click this button to exit the printed document from the default location specified in the Printer Interface’s Device Specific Options dialog box.

---

**Folding Options for GFI Folders**

Before you can specify folding options for GFI Folders ensure you have set up PlotWorks for GFI Folding. See Page 11, Setting up GFI Folders for more information.

To access folding options for GFI Folders follow the instructions below:
1. Open either the **Folding Options** dialog box or the **Finishing Options** tabbed dialog box as explained on Page 11-20.

2. Select **GFI Folder** from the **Folding User Interface** drop-down list.
   
   If this is the first time that GFI Folding is selected, the folding dialog boxes will look like the ones below.

---

![Folding Options dialog box](image1)

---

![Finishing Options tabbed dialog box](image2)
3. Click on the **Advanced Options...** button. This opens the Folding Options Dialog box.

![Folding Options Dialog](image)

4. Ensure that your folder is listed in the **Select Folder** drop down list.

5. Select the desired fold type from the **Select Fold Style** list box. It may be necessary to use the scroll bar to locate the desired fold type.

6. Select the desired **Output Bin** from the provided drop down list.

7. Depending on your folder the **Cross Fold, Punch, Margin, and Tab/Reinforcement** check boxes may be available for selection. Select or deselect any of these options by clicking the appropriate check box.

8. Click on the **OK** button. The selected folding configuration is added to the Fold Program drop down list for future use.
9. Select the **OK** button if you are satisfied with the selected options.
PFS support for GFI Folding

PFS support is available for GFI Folding. It is necessary to specify values for the following PFS keywords when using GFI Folding:

- **FolderName**: This is the name of the GFI folder. Type in the name exactly as it appears in the FPF.
- **FoldProgram**: This is the fold program number. Specify the numeric value as assigned in the FPF.
- **OutputBin**: This is the output bin number. Specify the numeric value assigned in the FPF.
- **TitleBlockLocation**: Specify the title block location by entering one of the following values:
  - **DontCare**
  - **LowerLeft**
  - **LowerRight**
  - **UpperRight**
  - **UpperLeft**
- **FirstFold**: Select either a Yes or No value. Selecting Yes enables the fan fold
- **SecondFold**: Select either a Yes or No value. Selecting Yes enables the cross fold
- **FoldMarginEnable**: Select either a Yes or No value. Selecting Yes enables a Fold Margin
- **FoldMargin**: Specify a value for the fold margin depending on the size units selected.

More information on PFS support is available in Appendix D.
Print-to-Queue

Print-to-Queue is used to provide one or more users access to a PlotWorks printer. It can be installed on a local computer or on network servers.

You can customize Print-to-Queue using PFS files specified for specific print output such as media size, fold types, etc. For example, if there are two workgroups in the company that have different requirements for printed documents, the system administrator can configure a unique Print-to-Queue port for each group. This enables each group to print documents with their specific print specifications, without affecting other users print jobs or PFS files.

Just What is Print-to-Queue?

Print-to-Queue works like a port monitor. It controls the input/output (I/O) between the spooler and the printer. Basically, it monitors the flow of print data that goes through the physical parallel or serial ports installed in your computer.

Traditionally, when you print a file from an application, the Windows graphics device interface (GDI) directs the file to the application’s printer driver, which determines the actual output format of the printed job. The printer driver passes the print job data to the print spooler, where the Windows port monitor decides the output device to which the print job gets passed.

The PlotWorks Print-to-Queue redirects a local physical port to any number of virtual ports. A virtual port is a port that is not physically installed, plugged in, or otherwise attached to your local PC.

Print-to-Queue passes print data from a non-PlotWorks applications to a PlotWorks Job Queue, adding a predefined PFS file. From there the data is sent to the designated PlotWorks printer if Job Processing is enabled.
The PFS file can be edited from the Print-to-Queue configuration dialog box. You can easily create PlotWorks print jobs from any application whose driver output is supported by PlotWorks image processing (HP-GL/2 or PostScript). Use the HP DesignJet 600 printer driver for outputting HP-GL/2 format and the Apple LaserWriter II NTX printer driver for outputting PostScript format.

The following sections discuss installing, configuring, and using Print-to-Queue.

**Considerations before installing Print-to-Queue**

- To output PostScript files using Print-to-Queue, the PlotWorks PostScript processing option is necessary. Contact your PlotWorks sales representative if you need to purchase it.
- We recommend installing Print-to-Queue on a server for easier administration, especially if several users need access to a PlotWorks printer, or when printing to multiple PlotWorks printers.
- If each user or workgroup has specific output requirements, multiple monitors, using different PFS files, can be used to create a Print-to-Queue setup for each specific output size desired.

*If you edit a PFS file to customize it for specific output, set the final output size to 100% (\texttt{FinalSize=Percent,100}). If you enter a specific paper size, such as ‘E-size’, all images printed through that Print-to-Queue setup will be printed E-size.*

Print-to-Queue works in conjunction with the PlotWorks Job Processor and Printer Interface. If the Job Processor is not running and enabled, print data is not processed and passed to the Printer Interface.
Installing Print-to-Queue

1. Exit any open Windows applications.
2. Insert the PlotWorks CD-ROM in the CD-ROM drive. The Installation application will automatically open.
3. Click on Install Packages. The Install Packages window opens.
4. Click on Print To Queue. The installation wizard opens.
5. You may be prompted to select a language. If so, select the language you are most comfortable with from the list provided then click on the OK button. The default is English. The installation wizard begins the PlotWorks Print-to-Queue Setup program and a Welcome page appears.
6. Click Next. The PlotWorks Print-to-Queue license agreement displays.
7. Please read the license agreement and click Yes (if you agree with it). The Choose Destination Location dialog box appears. By default, PlotWorks Print-to-Queue is installed in C:\Program Files\PLP\Plotworks Print-to-Queue.
8. Click Next to accept the default destination or click on the Browse button to select a different Destination.

PlotWorks Print-to-Queue can not be installed in the same directory as PlotWorks.

9. When the Setup Complete dialog box prompts you to restart the computer, select the Yes, I want to restart my computer now radio button.
10. Click on the Finish button. The computer will shut down and restart.

Restart your computer to correctly initialize the Print-to-Queue port monitor service.

11. Once the computer restarts, associate (map) a printer with the Print-to-Queue port (labeled “PlotWorks Port”). Mapping instructions for Windows XP are available on page 20 of this chapter. Mapping instructions for Windows NT follow next.

Editing a PFS File

You can customize a Print-to-Queue setup by associating it with a PlotWorks PFS file containing specific output parameters. You can create a different Print-to-Queue setup for each type of print job you output and assign it to a copy of the Windows printer driver.
We recommend setting the final output size set to 100% (FinalSize=Percent,100) in the PFS file. This allows the printer to select the best size for the job. To restrict a PFS file to output a specific media size only, set the output size accordingly (FinalSize=D, for example).

Access a PFS file for editing

There are two ways to access a PFS file for editing:

- You can open it in Windows Notepad
- Open it directly from the PlotWorks Port Information dialog box. Accessing this dialog box is discussed on page 12-9 for Windows NT operating systems and on page 12-16 for XP.

To edit a PFS file:

1. Open the PFS file you want to edit.
2. Make the desired parameter changes. For detailed information on PFS file parameters, keywords, and their use, refer to Appendix D.
3. Save the file with a new name (i.e., SPECS.PFS) in the PlotWorks PARAM subdirectory (usually C:\Program Files\PLP\PlotWorks\Param).
4. Configure the PlotWorks Print-to-Queue setup, to use the PFS file.

Sample Custom PFS File

The following example shows a customized PFS file that will output two copies of the print job with an automatically determined output size, with a watermark, label, and fold parameters. For a description of each PFS keyword, see Appendix D.

Important note: When creating a PFS file for use with PlotWorks Print-to-Queue, do not use the FILE PFS section. Print-to-Queue uses the JOB parameters only.

;PFS file to generate 100% size drawings for delivery to construction sites.
;Generated on 9/25/98 8:19:32 AM

[JOB]

; ****** Job Control ******

SizeUnits=inches
Sets=2
PageRange=All
Media=Bond
Size=AUTO
FinalSize=Percent,100
OutputQualityLevel=Normal
Mirror=No
Format=Auto
ReversePrint=No

; ****** AutoCAD File Setup ******

ACADparms=1=1,extents,10.000

; ****** Pen Setup ******

PenUnits=mls
ScalePens=Yes

; ****** Folding Setup ******

FirstFold=Yes
SecondFold=No
FoldMarginEnable=Yes
FoldPunching=No
FoldReinforce=No

; ****** Watermark and Label Control ******

WatermarkFont=Times New Roman,Medium,Black,1,0
WatermarkText=Construction Print
WatermarkDirection=UpperRight
LabelRotation=0
LabelOffset=0.000,0.000
LabelFont=Times New Roman,Small,Black,0,0
LabelText=Sanders Architects,[DATE],[TIME],[FILENAME]

; ****** Justification and Margin Control ******
Selecting a Driver

The instructions on mapping a port and printer that follow next are going to ask you to select a printer driver. Select a driver at that time based upon the following guidelines:

- Use the **HP DesignJet 600** driver for outputting HP-GL/2 format files
- If running Windows NT and you experience problems printing HP-GL/2 files with PlotWorks, use the **PlotWorks Windows NT** driver. This driver is provided on the PlotWorks CD-ROM. The PlotWorks Windows NT driver creates larger plot files, so should only be used when other drivers fail.
- Use the **Apple LaserWriter II NTX** printer driver for outputting PostScript format files. This driver requires the PlotWorks PostScript processing option. If you have not already purchased it, please contact your PlotWorks sales representative.

Mapping a Local Printer to the PlotWorks Port on Windows NT

Follow these instructions to associate the Print-to-Queue port with a local printer on a Windows NT operating system. The instructions are for the initial Print-to-Queue port setup. It is not necessary to repeat these steps for subsequent Print-to-Queue setups.

1. From the Windows **Start** button, select **Settings** then **Printers**.
2. Double-click on the **Add Printer** icon. The Add Printer Wizard dialog box opens.
3. Make sure **My Computer** is selected then click **Next**.

4. A list of available ports displays. Click **Add Port** (first-time installations only). The Printer Ports dialog box displays:

5. Select the **PLP PlotWorks Port** and click the **New Port** button to display the PlotWorks Port Information dialog box, below.
6. Enter a descriptive name for your new port that users can easily identify in the **Port Name** dialog box. This is the name that will appear in the list of available ports.

7. In the **Print To** dialog space, select either Queue or File.
   - If Queue is selected, the option to specify a Queue file is addressed.
   - If File is selected, the option to specify a directory for the image files to be polled by Network Poling is addressed. The PFS File, Device Number, Priority and the Ignore Errors options are grayed out.

8. In the **Queue File** text box, enter the path and name for the Queue.que file (usually C:\Queue\Queue.que). Or you can click on the Browse (...) button to locate it.

9. In the **PFS File** text box, enter the path and name for the desired PFS file. Click on the Browse (...) button to locate it, if preferred.

This is where you can get creative with your port setup and its associated PFS file. You can create a PFS file (with a unique name) for each type of printer output (media size, labels, watermarks, etc.) you use, then associate it with its own Print-to-Queue port. Users or workgroups can then send their print jobs to the “printer” best suited to the type of output they create. See “Configuring LPD to Work with PlotWorks” on page 12-20 for more information.
10. If you wish to edit the PFS file for this port monitor, click the **Edit PFS** button, make the desired changes, **Save** the file, and close **Notepad**. (See “Configuring LPD to Work with PlotWorks” on page 12-20 for information on customizing a PFS file.)

11. Using the provided drop down lists, select a **Device Number** and **Priority** (the defaults are **Any** and **5**, respectively)

12. Select the **Ignore Errors** check box if you wish to ignore all processing errors.

13. Then click **OK** and then **Close**. Note that the device number corresponds to the device number set in the PlotWorks Printer Interface—this is what makes this association work.

**If you did not correctly enter the path and file name of the PFS file, a dialog box appears asking you to do so.**

**If you did not correctly enter the path and name of the Job Queue folder, a dialog box appears asking you to do so.**

14. The “Select Port” window displays again. Select the port you just configured then click **Next** to continue.

![Fig 12.6](image)

**Select the PlotWorks port**

15. A list of printer manufacturers and printer names displays.
16. Click **Next**. Use the guidelines under “Selecting a Driver” on page 12-6 to select a driver.

- If you have a manufacturer’s driver disk, click **Have Disk** and follow the prompts.
- If you are going to use the PlotWorks NT driver, click **Have Disk** and browse to where you copied your NT Driver folder from the CD-ROM. Open this folder and click the NTPrint.inf file.

17. If you are creating a “copy” of a driver that has already been installed, click **Keep existing driver** then click **Next**. If this is a first time installation, you will not see this prompt. Skip to step 15.
18. Type a descriptive name for the printer and click **Next** (you can also elect to make it the default printer if you want).

19. If you want this printer to be a shared device (so others on the network can access it), click **Shared**, enter a descriptive Share Name, and select the types of operating systems that might be using the printer.

![Share name dialog box](image)

20. Click **Next**.

![Test page request dialog box](image)

21. Select **No** (do not print a test page) and click **Finish**. You might be asked to insert the disk containing the printer driver. If so, insert the disk into the appropriate drive and click **Continue**.

22. The Printer folder redisplayes with your new “printer” highlighted (as seen below). You are finished!
Now you can print to the PlotWorks Job Queue from any Windows application by selecting the Print-to-Queue associated printer. You can associate any, local, supported Windows printer with a Print-to-Queue port any time. Simply right-click on the printer you wish to edit, select Properties, click the Ports tab, and follow steps 4 through 10, above.

**Using a Network Printer on Windows NT**

**Notice to Administrators:** Before users can attach to a network printer, you must create one and associate it with a Print-to-Queue port setup.

1. From the Windows **Start** button, select **Settings** then **Printers**.
2. Double-click the **Add Printer** icon. The Add Printer wizard begins:
3. Make sure **Network printer server** is checked and click **Next**.
4. A list of available network printers displays.
5. Select the printer associated with the PlotWorks Port and click **OK**. You can select this printer as your default Windows printer.

6. Make the desired selection and click **Next**. Click **Finish** to exit the wizard.

**Mapping a Local Printer to the Port (Windows XP)**

Follow these instructions to associate the Print-to-Queue port with a local printer on a Windows XP operating system. The instructions are for the initial Print-to-Queue port setup. It is not necessary to repeat these steps for subsequent Print-to-Queue setups.

1. From the Windows **Start** button, select **Printers and Faxes**. The Printers and Faxes dialog box opens.

2. Double-click on **Add a Printer**. The Add Printer Wizard dialog box opens.

3. Click on the **Next** button. You are prompted to select either a local or network printer.
4. Select the **Local printer attached to this computer** radio button.

5. Deselect the **Automatically detect and install my Plug and Play printer** option.

6. Click on the **Next** button. The next dialog box prompts you to select a port.

7. Select the **Create a new port** radio button only if this is a first-time installation.
8. Select **PLP PlotWorks Port** from the **Type of Port** drop down list.
9. Click on the **Next** button. The PlotWorks Port Information dialog box displays.
10. Enter a descriptive name for your new port, like “PlotWorks Queue” in the **Port Name** dialog box. This is the name that will appear in the list of available ports.

11. In the **Print To** dialog space, select either Queue or File.
   - If Queue is selected, the option to specify a Queue file is addressed.
   - If File is selected, the option to specify a directory for the image files to be polled by Network Poling is addressed. The PFS File, Device Number, Priority and the Ignore Errors options are grayed out.

12. Enter the path to the desired PlotWorks Queue directory and Queue.que file in the **Queue File** text box (usually C:\Queue\queue.que). Click the … button (Browse) to locate it, if necessary.

13. Enter the path to the PFS file that contains the desired parameters in the **PFS File** text box. Click the … button (Browse) to locate it, if necessary.

14. To edit or view the PFS file for this port monitor, click the **Edit PFS** button. The PFS file opens in **Windows Notepad**. Make the desired changes, **Save** the file, and close **Notepad**. (See “Configuring LPD to Work with PlotWorks” on page 12-20 for information on customizing a PFS file.)

15. Select a device number and priority. Note that the device number corresponds to the device number set in the PlotWorks Printer Interface. This is what makes this association work.

16. Select **Ignore Errors** if you wish to ignore all processing errors.

17. Click **OK** and then **Close**. The PlotWorks Port Information dialog box disappears.

---

Create a PFS file, with a unique name, for each type of printer output (media size, labels, watermarks, etc.) used, then associate it with its own Print-to-Queue port. Users or workgroups can then send their print jobs to the “printer” best suited to the type of output they create. See “Configuring LPD to Work with PlotWorks” on page 12-20 for more information.

---

If you did not correctly enter the path and file name of the PFS file, a dialog box appears asking you to do so.

If you did not correctly enter the path and name of the Job Queue folder, a dialog box appears asking you to do so.
18. Select the **Use the following port** radio button from the Add Printer Wizard dialog box.

19. Select the port you just configured from the **Use the following port** list box.

20. Click the **Next** button. A dialog box opens prompting you to select a printer manufacturer and printer.
The following steps associate the Print-to-Queue port to a Windows printer driver:

21. Use the guidelines under “Selecting a Driver” on page 12-6 to select a driver. Then:
   - If you have a manufacturer’s driver disk, click **Have Disk** and follow the prompts.
   - If you are going to use the PlotWorks NT driver, copy the contents of the NT Driver directory from your PlotWorks CD-ROM onto your hard drive. When prompted to select a driver, click **Have Disk** and browse to the directory where you copied the NT Driver folder. Open this folder and click the NTPrint.inf file.
   - Or, select your driver manufacturer from the manufacturer list and then select the printer name from the Printer list.

22. If you are creating a “copy” of a driver that has already been installed, click **Keep existing driver**. If this is a first time installation, this option will not be available. Then click **Next**. A dialog box appears prompting you to name the printer.

23. Enter a descriptive name for the printer in the text box labeled **Printer name**.

24. If you wish to make this your default printer, select the Yes radio button. Otherwise select the No radio button.
25. Click **Next**. A dialog box appears asking if you wish to share the printer.

![Add Printer Wizard](image)

26. Choose whether you want to share the printer.

- If you want to share this printer so that others on the network can access it, select the **Share name** radio button. Enter a share name if you wish
- Or select the **Do not share this printer** radio button. and select the types of operating systems that might be using the printer.

27. Click **Next**. A dialog box prompts you to enter a location and comment for the printer.

28. Click **Next**

29. Select **Yes** to print a test page. A dialog box appears listing all your selections.

30. Select **Finish** if this information is correct. Select **Back** if changes are necessary.

You successfully added the driver and printer if your Printer folder lists your new “printer” in the Printers window

Now you can print to the PlotWorks Job Queue from any Windows application by selecting the Print-to-Queue associated printer. You can associate any, local, supported Windows printer with a Print-to-Queue port any time. Simply right-click on the printer you wish to edit, select Properties, click the Ports tab, and follow the steps above.
Output a Job to the Print-to-Queue Printer

1. Open the PlotWorks Job Processor and select **Start Processing** from the **File** menu. Minimize (do not close) the Job Processor.
2. Make sure the appropriate PlotWorks Printer Interface is open and the medium has been configured for the printer.
3. From any Windows application, select **Print** and choose one of the “printer drivers” associated with a Print-to-Queue setup.
4. Complete the rest of the Print dialog box as normal and click **Print!**

**Leave the number of copies set to the default of 1. Microsoft limits copy count when sending jobs to a port monitor.**

Configuring LPD to Work with PlotWorks

The steps outlined below are to enable Linux or Unix systems to submit jobs to the PlotWorks Job Queue using Print-to-Queue. The procedure is broken up into three sections:

- Configuring PlotWorks with Print to Queue
- Configuring NT Workstation 4.0 to support LPD
- Configuring Linux to submit to Plotworks Job Queue

Configuring PlotWorks and Print-to-Queue

1. Install PlotWorks.
2. Configure Print-to-Queue with the desired print driver.
3. If not already done, *share* the printer that is configured with the Port Monitor.

Configuring NT Workstation 4.0 to support LPD

1. Install Simple TCP/IP services and Microsoft TCP/IP printing:
   - Right-click on **Network Neighborhood** and select **Properties**.
   - Click the **Services** tab.
   - Click the **Add** button.
   - Double-click on **Simple TCP/IP Services**.
   - Click the **Add** button.
   - Double-click on **Microsoft TCP/IP Printing**.
   - Click **OK** to exit.
2. Run your Service Pack (Use the same Service Pack version that has been previously applied to the system). When Service Pack is done, it reboots the computer.

3. Edit the Registry as follows:
   - Click the Windows **Start** button and select **Run**.
   - Type **Regedit** and press **Enter**.
   - Click the (+) (plus sign) next to the folder labeled **HKEY_LOCAL_MACHINE**.
   - Click the (+) (plus sign) next to the folder labeled **SYSTEM**.
   - Click the (+) (plus sign) to the folder labeled **CurrentControlSet**.
   - Click the (+) (plus sign) next to the folder labeled **Services**.
   - Click the (+) (plus sign) next to the folder labeled **LPDSVC**.
   - Click on the folder labeled **Parameters**.
   - On the right side of the screen are some set values. Right-click in the white background (not on an existing value) and select **DWORD value** from the **New** popup menu.

4. Start the TCP/IP Print Server:
   - Click on the Windows **Start** button. Select **Settings** then **Control Panel**.
   - Double-click on **Services**.
   - Select **TCP/IP Print Server** by clicking on it.
   - Click the **Startup...** button.
- Set the Startup Type to **Automatic**. Click **OK**. This makes the service start each time the computer is turned on.
- Click on the **Start** button. This starts the service now so that you do not have to reboot the computer.

### Setting Up a Line Printing Utility (LPR)-Compatible Printer

**LPR** is defined as **Line Printing Utility** and **LPD** is defined as **Line Printing Daemon**; both which are elements of **UNIX**.

The following are instructions for setting up a LPR-compatible printer. The computer where the configuration is created **must have** the TCP/IP protocol and the Microsoft TCP/IP Printing service installed.

The domain name system (DNS) name can be the name specified for the host in the HOSTS file.

**If the LPR port is not available, install the Microsoft TCP/IP Printing service.**

1. Click on the Windows **Start** button. Select **Settings** then **Printers** to start installing a printer.
2. Select the **Add Printer** icon (or select the command from the list).
3. Select the **My Computer** button, then click on the **Next** button.
4. Select **Add Port**.
5. Select **LPR Port** then select **OK**. (If there is no LPR Port choice, install the Microsoft TCP/IP Printing service.)
6. In the **Name or address of the server providing the LPD**, type in the DNS name or IP address of the host for the printer that is being added.
7. In the **Name of the printer or print queue on that server**, type in the name of the printer as it is identified by the host, which is the Print-to-Queue printer. Select **OK**.
8. **EXAMPLE:** In the case of PlotWorks server, specify the name of the PlotWorks Server PC (i.e, PLOTWORKS) or its IP address and the Print-to-Queue printer share name that was set up earlier.
9. Follow the instructions on the screen to finish installing the LPR-compatible printer.
Printing to PlotWorks using LPR

Test the LPR by sending a test file to the PlotWorks queue.

1. Open a command prompt.

2. Type in, `lpr -s plotworks_server_name -P Print_to_queue_printer_name -o l testfile.plt`

   EXAMPLE: To print test.plt from a UNIX system to the PlotWorks server that has PLOTWORKS as a DNS name and P2Q as the lpr printer the command line would be:
   `lpr -S PLOTWORKS -P P2Q -o l testfile.plt`

   `-S and -P must be entered in capital letters while -o and l must be entered lower case. This switch sets the data transfer to binary."

The following are the command line options:

Command Line Options

<table>
<thead>
<tr>
<th>Designation</th>
<th>Definition</th>
</tr>
</thead>
<tbody>
<tr>
<td>-S = Server</td>
<td>Name or IP address of the host providing lpd service</td>
</tr>
<tr>
<td>-P = Printer</td>
<td>Name of the print queue</td>
</tr>
<tr>
<td>-C = Class</td>
<td>Job classification for use on the burst page</td>
</tr>
<tr>
<td>-J = Job</td>
<td>Job name to print on the burst page</td>
</tr>
<tr>
<td>-o = option</td>
<td>Indicates type of the file (by default assumes a text file) Use “-o l” for binary (e.g., postscript) files</td>
</tr>
<tr>
<td>-x</td>
<td>Compatibility with Sun OS 4.1.x and prior</td>
</tr>
<tr>
<td>-d</td>
<td>Send data file first</td>
</tr>
</tbody>
</table>

The print file will pass through the Print-to-Queue driver transparently and will be added to the Job Queue as a new entry.
Configuring Linux to Submit to Plotworks Job Queue

This is a sample configuration. Your system might be slightly different, needing slightly different steps. This sample uses Linux 5.2 as the operating system submitting the job. The Unix setup uses similar steps.

1. Launch the Print System Manager (Printer Tool).
2. Click the Add button and select Remote Unix (lpd) Queue.
3. Configure the port:
   - **Name** – Will automatically be set to lp0, lp1, lp2, etc.
   - **Spool Director** – Leave the default
   - **File Limit** – Leave the default. Probably 0 (zero).
   - **Remote Host** – Set this value to the “IP address” or “Fully Qualified Domain” of the PC sharing the queue.
   - **Remote Queue** – Set this value to the “share name” of the printer that is configured with “PlotWorks Print-to-Queue”
   - **Input Filter** – This is the print driver that Linux is going to use to create the image file. The recommended driver is the generic “PostScript” driver, but other “PostScript” drivers might work as well.

The system is now ready to submit jobs from Linux (or Unix) to the PlotWorks Job Queue for printing.

Printing from AutoCAD or Microstation to the Job Queue

In Appendix H is a section, “Printing from AutoCAD Directly to PlotWorks Job Queue”, which contains screen and procedures for placing files from AutoCAD straight to the Job Queue.

In Appendix I, there is also a section, “Printing from Microstation SE Directly to Plotworks Job Queue”, which contains screens and procedures for placing files from Microstation SE straight to the Job Queue.

Troubleshooting

Q. I get an error message that the Print-to-Queue files cannot be installed. What should I do?

A. This usually means that the file **mfc42.dll**, found in your C:\WINNT\system32 folder, is outdated. Rename the original file to something like “mfc42.old” then copy the **mfc42.dll** found on the installation disk into the C:\WINNT\system32 folder.
Q. I did that and tried to reinstall, but I get the same message. Now what?
A. At times, Windows does not update the registry correctly. You might need to
do this manually. To do so, click on the Windows Start button and select Run.
Type regedit and click OK. When the Registry Editor displays, click on the
following items:
My Computer
HKEY_LOCAL_MACHINE
SYSTEM
CurrentControlSet
Control
Print
Monitors
Then select PlotWorks Port and delete it. Exit from the Registry Editor.
Go to an MS-DOS command prompt and type net stop spooler and press
Enter. You will receive the prompt: The Spooler service was stopped
successfully.
Now type net start spooler and press Enter. You will receive the prompt:
The Spooler service was started successfully. Exit from the DOS command
prompt. You can now try to set up Print-to-Queue.
Appendix A

Memory Requirements

When printing and scanning with multiple devices, adding more physical memory to your system may be necessary, and will increase performance. Ideally, each Printer Interface should have enough memory to image at least two (2) of the largest drawings you expect to print so that, one drawing can print while the other is processed (rasterized).

How to calculate the amount of RAM needed for each Computer:

1. Find out how many RAM slots and which type of RAM the computer motherboard can use.
   - Check the motherboard specifications for SIMM or DIMM sizes and compatibility.
   - Most systems require SIMMs to be installed in multiples of two while DIMMs can be installed singly.
   - Some systems will also not allow you to mix and match different size SIMMs from different manufactures.

2. Determine which scanning and printing devices will operate concurrently using the computer.

3. Determine the print and scan length requirements.

4. Use the Imaging Memory and the Data Buffer Size Guidelines on the following pages to decide how much memory will be needed to operate each device.

5. Calculate the memory required.

To calculate:

Do this for each printer:

1. Look up the amount of memory required for the largest size file that you print regularly. Enter that amount in the first blank in the equation that follows this list.
2. If printing red and black images on the Xerox 8180 or MAX 200, enter the value 4 in the second blank. If you are printing with a Windows or Generic Embedded Controller Color Printer enter the value 6; Otherwise, enter the value 2 in the second blank.

3. Now, multiply the two numbers and fill in the third blank with the result.

4. Memory needed for largest drawing generally being printed:

   \[ \text{number} \times \text{number} = \text{result} \]

   (use the resulting figure in the calculation below)

<table>
<thead>
<tr>
<th>NT OS and Apps.</th>
<th>PlotWorks Apps.</th>
<th>Printer1: #MB</th>
<th>Printer2: #MB</th>
<th>Scanner: #MB</th>
<th>Min. Total RAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>64 MB*</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>+ 56 (+/-)MB</td>
<td>+</td>
<td>+</td>
<td>+</td>
<td>=</td>
<td></td>
</tr>
</tbody>
</table>

This example assumes the use of only two printers, however PlotWorks can accommodate up to four printers, and so memory must be added accordingly if you are planning to use more than two printers.

*At least 64 MB should be allocated, and more might be needed depending on your system (which Service Pack you are running, which device drivers and services are being used, and any other applications that consume memory, such as antivirus programs, etc.)*

Do this if you are using a Scanner Interface:

Look up the memory required for the largest size file that you will generally be scanning. Use this figure in the calculation below.

**Example calculation:**

The example below assumes PC system driving an 8855 for long prints, an 8180 printer for one color printing, and an 8180 scanner.

<table>
<thead>
<tr>
<th>NT OS and Apps.</th>
<th>PlotWorks</th>
<th>8180 printer</th>
<th>8180 Scanner</th>
<th>Total RAM</th>
</tr>
</thead>
<tbody>
<tr>
<td>64 MB*</td>
<td>+ 56</td>
<td>+ 66</td>
<td>+ 8</td>
<td>= 194</td>
</tr>
</tbody>
</table>

194 MB minimum required divided by 128 (DIMM size) = 1.5. Thus, two 128MB DIMMs (256 MB total), are required for the PC.
The Printer and The Scanner Interfaces

The Printer Interface uses only a minimal amount of memory when not actively printing. When a print job starts, the Printer Interface will image (rasterize) as many drawings as it can into physical memory while sending them to the printer. This continues until it reaches the limit you set with Maximum Imaging Memory, or your operating system tells it that there is insufficient physical memory available.

You can set the Maximum Imaging Memory as high as 1 MB less than your physical memory, but keep in mind that the operating system will not allow the Printer Interface(s) and Scanner Interface to have all of that memory. The actual physical memory available on your system will depend on the applications, device drivers, services, etc. using the memory and the operating system on your computer.

Keep in mind, too, that the more memory the Printer Interface gets from the operating system, the less memory is available to other applications running on the system, such as the Job Editor, Network Polling, the Job Queue, and any other applications you are using. When your computer reaches the limits of physical memory, the operating system will start moving some or all of the Printer Interface and other applications out to the hard drive. Since the hard drive is much slower than physical memory, you might start noticing that these applications become less responsive and slower, and you might encounter problems using them. Therefore, it makes sense to limit the amount of memory that the Printer Interface is set to request.

For optimum PlotWorks performance, do not allocate more than is necessary for general day-to-day use. Increase the Maximum Imaging Memory (Printer Interface) and Data Buffer Size (Scanner Interface) only when needed for specific long print or long scan jobs.

Imaging Memory Setting Guidelines for the Printer Interface

Maximum print lengths are approximate and are dependent on the other applications in use at the time of printing. The above calculations were made without nonprinting or nonscanning applications running.

Note: Long prints can affect processing and printing speeds. Output speed will degrade with longer prints.
Xerox MAX 200 and 8180 Users: Dual color printing requires double the memory amount shown on the chart. Also, please note that the 8180 has a maximum output size of 24" x 12’ (or approximately 594mm x 3.7m) for single color prints.

Windows and Generic Embedded Controller Printers

Windows and Generic Embedded Controller color printers require approximately four times as much imaging memory as other printers to process color prints and long jobs. Be aware of this when determining the amount of RAM required for imaging.

Approximate Maximum Lengths

<table>
<thead>
<tr>
<th>Detected Media Width</th>
<th>in</th>
<th>in</th>
<th>in</th>
<th>in</th>
<th>in</th>
<th>in</th>
<th>in</th>
<th>in</th>
</tr>
</thead>
<tbody>
<tr>
<td>11 in.</td>
<td>309</td>
<td>451</td>
<td>755</td>
<td>1059</td>
<td>1363</td>
<td>1667</td>
<td>1971</td>
<td>2275</td>
</tr>
<tr>
<td>12 in.</td>
<td>284</td>
<td>415</td>
<td>695</td>
<td>974</td>
<td>1254</td>
<td>1534</td>
<td>1813</td>
<td>2093</td>
</tr>
<tr>
<td>17 in.</td>
<td>199</td>
<td>291</td>
<td>487</td>
<td>683</td>
<td>879</td>
<td>1075</td>
<td>1271</td>
<td>1467</td>
</tr>
<tr>
<td>18 in.</td>
<td>188</td>
<td>275</td>
<td>461</td>
<td>647</td>
<td>832</td>
<td>1018</td>
<td>1203</td>
<td>1389</td>
</tr>
<tr>
<td>22 in.</td>
<td>154</td>
<td>226</td>
<td>378</td>
<td>530</td>
<td>681</td>
<td>833</td>
<td>985</td>
<td>1137</td>
</tr>
<tr>
<td>24 in.</td>
<td>142</td>
<td>208</td>
<td>347</td>
<td>487</td>
<td>627</td>
<td>767</td>
<td>907</td>
<td>1046</td>
</tr>
<tr>
<td>30 in.</td>
<td>113</td>
<td>166</td>
<td>277</td>
<td>389</td>
<td>500</td>
<td>612</td>
<td>723</td>
<td>835</td>
</tr>
<tr>
<td>34 in.</td>
<td>100</td>
<td>146</td>
<td>245</td>
<td>343</td>
<td>442</td>
<td>540</td>
<td>638</td>
<td>737</td>
</tr>
<tr>
<td>36 in.</td>
<td>95</td>
<td>138</td>
<td>232</td>
<td>325</td>
<td>418</td>
<td>511</td>
<td>604</td>
<td>698</td>
</tr>
</tbody>
</table>

Imaging Memory (in megabytes) Needed for the Printer Interface *

<table>
<thead>
<tr>
<th>Media Width</th>
<th>210 mm</th>
<th>297 mm</th>
<th>420 mm</th>
<th>594 mm</th>
<th>841 mm</th>
<th>257 mm</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>10404</td>
<td>7311</td>
<td>5202</td>
<td>3680</td>
<td>2614</td>
<td>8587</td>
</tr>
<tr>
<td></td>
<td>15206</td>
<td>10685</td>
<td>7603</td>
<td>5379</td>
<td>3820</td>
<td>12551</td>
</tr>
<tr>
<td></td>
<td>25449</td>
<td>17883</td>
<td>12725</td>
<td>9003</td>
<td>6393</td>
<td>21006</td>
</tr>
<tr>
<td></td>
<td>35693</td>
<td>25082</td>
<td>17847</td>
<td>12626</td>
<td>8966</td>
<td>29461</td>
</tr>
<tr>
<td></td>
<td>45937</td>
<td>32280</td>
<td>22968</td>
<td>16250</td>
<td>11540</td>
<td>37916</td>
</tr>
<tr>
<td></td>
<td>56181</td>
<td>39473</td>
<td>28090</td>
<td>19873</td>
<td>14113</td>
<td>46371</td>
</tr>
<tr>
<td></td>
<td>66425</td>
<td>46677</td>
<td>33212</td>
<td>23497</td>
<td>16686</td>
<td>54827</td>
</tr>
<tr>
<td></td>
<td>76668</td>
<td>53875</td>
<td>38334</td>
<td>27121</td>
<td>19260</td>
<td>63282</td>
</tr>
</tbody>
</table>
Image Data Buffer Size Guidelines for the Scanner Interface

Use figures below as the minimum settings for the Data Buffer Size in the Scanner Interface.

<table>
<thead>
<tr>
<th>Scanner</th>
<th>MB</th>
</tr>
</thead>
<tbody>
<tr>
<td>7336</td>
<td>33</td>
</tr>
<tr>
<td>7396</td>
<td>33</td>
</tr>
<tr>
<td>7399</td>
<td>33</td>
</tr>
<tr>
<td>7356</td>
<td>8</td>
</tr>
<tr>
<td>8180</td>
<td>8</td>
</tr>
<tr>
<td>MAX 200</td>
<td>8</td>
</tr>
</tbody>
</table>

The 7336 and 7396 will need more memory if the scans are longer than standard E or A0 lengths. The other scanners will automatically slow down if the scans are longer, so no additional memory will be needed. The guidelines below will assist you in calculating extra Data Buffer Size allocations needed for long scans on the 7336 and 7396.

With an extra 33 MB of memory allocated in the Data Buffer Size, you will gain the following scan length for each media width.

<table>
<thead>
<tr>
<th>Media Width</th>
<th>33MB will give extra length of:</th>
</tr>
</thead>
<tbody>
<tr>
<td>155 in</td>
<td>502 mm for 11 in</td>
</tr>
<tr>
<td>142 in</td>
<td>365 mm for 12 in</td>
</tr>
<tr>
<td>100 in</td>
<td>260 mm for 18 in</td>
</tr>
<tr>
<td>94 in</td>
<td>184 mm for 22 in</td>
</tr>
<tr>
<td>71 in</td>
<td>130 mm for 24 in</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Media Width</th>
<th>33MB will give extra length of:</th>
</tr>
</thead>
<tbody>
<tr>
<td>520 mm</td>
<td>210 mm for 11 in</td>
</tr>
<tr>
<td>366 mm</td>
<td>297 mm for 12 in</td>
</tr>
<tr>
<td>260 mm</td>
<td>420 mm for 18 in</td>
</tr>
<tr>
<td>184 mm</td>
<td>594 mm for 22 in</td>
</tr>
<tr>
<td>130 mm</td>
<td>814 mm for 24 in</td>
</tr>
</tbody>
</table>
Maximum scan lengths are approximate and are dependent on the physical memory available, and the applications, device drivers, services, etc., using the memory and operating system on your computer at the time of scanning. Users might see a slight difference in lengths during actual operation.

<table>
<thead>
<tr>
<th>In</th>
<th>For</th>
<th>Mm</th>
<th>For</th>
</tr>
</thead>
<tbody>
<tr>
<td>57</td>
<td>30</td>
<td>4294</td>
<td>257</td>
</tr>
<tr>
<td>50</td>
<td>34</td>
<td>3006</td>
<td>364</td>
</tr>
<tr>
<td>48</td>
<td>36</td>
<td>2130</td>
<td>515</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1503</td>
<td>728</td>
</tr>
<tr>
<td></td>
<td></td>
<td>1202</td>
<td>914</td>
</tr>
</tbody>
</table>
Appendix B

Error Messages and Common Problems

The Job Queue

Job Queue warning and error messages are listed numerically then alphabetically below.

- **Error 4001:** The language DLL that you are using is not current. See your administrator for more information.

- **Error 4002:** You must specify a priority for job(s).

- **Error 4003:** No items are currently selected for this option.
  The operation you are attempting requires you to select one or more jobs. Highlight a job in the Queue window and try again.

- **Error 4004:** Unable to register Q*Works as a drag/drop target.

- **Error 4005:** Unable to open or create queue file.
  You might not have enough memory to open another Job Queue, or the Job Queue you are trying to open could be damaged. Try freeing up RAM by quitting other open applications.
  This error can also indicate that your Job Queue might be damaged.

- **Error 4006:** Unable to create directory [directory name].
  You might be trying to use a noncompliant file name for your directory. Be sure that the file name you have chosen is accepted by your computer and/or network.
  You also might not have create privileges for the location in which you are trying to create a directory. See your network administrator for information on your access privileges.

- **Error 4007:** Unable to create the report.

- **Error 4008:** Unable to copy [file name].
  First, check to see that you have sufficient disk space to copy the file(s).
  If you are copying a job that uses a job ticket (.PLP file) or PFS file, the Job
Queue might have failed to find all of the files listed in the job ticket and aborted copying as a result. In this case, resend the job, making sure all of the images are included.

- **Error 4009: Unable to rebuild the queue file.**
  The Rebuild Queue command failed. If your Job Queue is damaged, delete your Queue directory, create a new Job Queue, and have your clients resubmit their jobs.

- **Error 4010: Operation Aborted.**

- **Error 4011: Unable to create report.**

- **Error 4012: No more than one item can be selected at a time for this operation.**

- **Error 4013: No log exists. The job has not been preprocessed yet.**
  There is no Processing log because the job has not been processed. Wait until the job has been processed to view the log.

- **Error 4014: Job information does not exist.**
  The creator of the job did not include a TEMPLATE.INF file with the job.

- **Error 4015: Unable to find the Media log.**
  There is no Media log because no media errors have occurred.

- **Error 4016: Unable to find the Printing log.**
  There is no Printing log because the job has not been printed.

- **Error 4017: Unable to lock the Queue.**
  Another person or application might be making changes to the Job Queue. While the Queue is being updated, it is locked against input from other sources. You must wait until the current changes are completed.

- **Error 4018: Unable to find XXX**

- **Error 4019: You must either abort or finish the current import/rebuild task before you can close the Job Queue.**

- **Error 4020: Unable to import the job.**

- **Error 4021: Cannot write the current job to the queue.**

- **Error 4022: Unable to delete job directory.**

- **Error 4023: Security code invalid.**
• Error 4024: Error finding help file viewer.
• Error 4025: Error executing help file viewer.
• Error 4026: Help file viewer path is invalid.
• Error 4027: Help file viewer specified is invalid or is not an executable file.
• Error 4028: Insufficient memory to load help file viewer.
• Error 4029: Unable to launch the help file viewer.
• Error 4030: Help file cannot be found.
• The following jobs could not be deleted because...
  • Job [name] is already in use: The job is being processed, printed, copied, or edited. You must wait until the job is idle to perform your command.
  • Job [name] could not be locked: Another person or application could be making changes to the Job Queue. While the Queue is being updated, it is locked against further input from other sources. You must wait until the current changes are completed.
  • Job [name] no longer exists: The job has been deleted or moved from the job directory.
  • Job [name] is currently printing: The job is in use. You must wait until the job is idle to complete your command.
• The following jobs could not be selected to print from the selected location because...
  See the reasons listed above “The following jobs could not be deleted because...”
• The following jobs could not be selected to print next because...
  See the reasons listed above “The following jobs could not be deleted because...”
• The following jobs could not have their destination changed because...
  See the reasons listed above “The following jobs could not be deleted because...”
• The following jobs were not aborted because...
  See the reasons listed above “The following jobs could not be deleted
because...”

- **The following jobs were not resumed because...**
  See the reasons listed above “The following jobs could not be deleted because...”

- **The following jobs were not held because...**
  See the reasons listed above “The following jobs could not be deleted because...”

- **The following jobs were not selected for reprint because...**
  See the reasons listed above “The following jobs could not be deleted because...”

- **The printer number could not be changed because...**
  See the reasons listed above “The following jobs could not be deleted because...”

- **The priority on the following jobs were not changed because...**
  See the reasons listed above “The following jobs could not be deleted because...”

- **The selected job cannot be printed immediately because...**
  See the reasons listed above “The following jobs could not be deleted because...”

- **The selected jobs could not be dragged because...**
  See the reasons listed above “The following jobs could not be deleted because...”

- **This job cannot be edited because...**
  See the reasons listed above “The following jobs could not be deleted because...”

- **Unable to allocate enough memory for this operation.**
  The Job Queue does not have enough RAM to perform the requested operation. Try freeing up memory by quitting other open applications.

- **Unable to register Queue as a drag/drop target.**
  The Job Queue could not be registered as a drag-and-drop target. You will not be able to drag-and-drop items into the Job Queue.
  You might be experiencing memory problems that prevent the operating
system from registering the Job Queue. Try freeing up RAM by quitting other open applications.

- **Unable to start monitor thread for [job]. Job will be left in indeterminate state.**
  
The number of job tickets that you can open from the Job Queue at one time is limited. Try closing other open job tickets. If this does not work, try freeing up RAM by quitting other open applications.

**Network Polling**

Network Polling warnings and error messages are listed numerically then alphabetically below.

- **Error 1000: The language DLL that you are using is not current. See your administrator for more information.**
- **Error 1001: (The) Configuration file is invalid or corrupt.**
  
When you set up options and target directories in the Network Polling program, the information is stored in a configuration file called NETPOLL.CNF. If this configuration file is damaged or deleted, your setup information will be lost.

**Solution:**

1. Delete the NETPOLL.CNF file.
2. If you have a backup of the original configuration file, copy it into your Program directory. Otherwise, you will need to open Network Polling, reset your Polling Options and add your target directories again.

---

**Back up the program directory on a regular basis. If your configuration file becomes damaged, you can replace it with the backed-up version.**

- **Error 1002: You are using an older file format that is not compatible with this program.**
  
The Polling configuration file (NETPOLL.CNF) is outdated. Set your Polling Options and add your target directories again to create a new.CNF file.

- **Error 1003: You are using a newer version of this program.**

- **Error 1004: Unable to delete this directory.**
  
The directory is in use. Network Polling might be querying the directory or moving jobs from it. Wait a few seconds and try again.

- **Error 1005: Unable to write to the registry.**
• **Error 1006: Invalid Password.**

• **Error 1007: Your new password does not match the confirmed password.**

• **Error 1008: You must specify a queue database filename.**

• **Error 1009: One or more directories or files have been either deleted or moved.**

  One or more of the target directories have been removed from the specified location. Network Polling cannot search them for incoming files. Select Yes to recreate the directory(s) in the correct location.

• **Error 1010: You must specify a queue filename for this directory.**

  You must tell Network Polling where your destination Job Queue resides. In the Modify Directory dialog box, enter the path and name of the Queue directory in the Queue Directory field.

• **Error 1011: You must enter a filespec to search on.**

  If you are using Network Polling Mode 1, you must tell the Network Polling program what type of files to look for. In the Add Directory or Modify Directory dialog box, fill in the Search Filename field with one or more filename extensions (example: *.cc, *.dwg). Or, enter *.* to search for all files.  

  If you use *.* as your search filename, be sure that all incoming files are supported file formats. If an unsupported file comes in (e.g., a .TXT or .CGN file), it will not be processed.

• **Error 1012: Unable to copy XXX**

• **Error 1013: Unable to remove XXX**

• **Error 1014: Unable to create the parameter file directory. Aborting.**

  When you run the Network Polling program, it looks for a PARAM subdirectory in your program directory. If Network Polling can’t find the PARAM directory, it will try to create it. In this case, Network Polling was unable to create this directory.

  **Solution:**

  1. Manually create a directory called **PARAM**.

  2. Place the PARAM directory inside the Network Polling program directory.
• **Error 1015:** No PFS editor selected.

• **Error 1016:** Unable to open or create queue file.
The Job Queue you have selected might not exist or could be damaged.

**Solution:**
1. Check your Queue selection to make sure that you have entered the correct path.
2. Check to be sure that you have access privileges to the selected Queue location.
3. If the first two options do not work, your Job Queue might be damaged.
   Try rebuilding the Queue from within the Job Queue window.

• **Error 1017:** Unable to open or create queue file for job submission.
The Job Queue you have selected might not exist or could be damaged.

**Solution:**
1. Check your Queue selection to make sure that you have entered the correct path.
2. Check to be sure that you have access privileges to the selected Queue location.
3. If the first two options do not work, your Job Queue might be damaged.
   Try rebuilding the Queue from within the Job Queue window.

• **Error 1018:** Unable to create the subdirectory. Check to make sure that the path is correct. If the target drive does not support long filenames then try using a shorter directory name.

• **Error 1019:** Unable to lock queue.
Only one person or application can update or change the Job Queue at one time. When someone accesses the Queue, it is locked to prevent anyone else from changing it.

If another person or application is updating the Queue, Network Polling will not be able to submit files until the activity is finished. Polling will keep trying to access the Queue until it is successful.

• **Error 1020:** Cannot find file.
The Network Polling program cannot find Notepad.

**Solution:**
Be sure that NOTEPAD.EXE is in the Windows directory.

• **Error 1021:** Unable to locate job ticket (.PLP file).
• Error 1022: Garbled data.
• Error 1023: Error finding help file viewer.
• Error 1024: Error executing help file viewer.
• Error 1025: Help file viewer path is invalid.
• Error 1026: Help file viewer specified is invalid or is not an executable file.
• Error 1027: Insufficient memory to load help file viewer.
• Error 1028: Unable to launch the help file viewer.
• Error 1029: Help file cannot be found.
• One or more polling directories has been deleted. Shall I recreate them?
  One or more of the target directories have been removed from the specified location. Network Polling cannot search them for incoming files.

  Solution:
  Select Yes to recreate the directory(s) in the correct location.

• You must specify a queue directory.
  You must tell Network Polling where your destination Job Queue resides.

  Solution:
  In the Modify Directory dialog box, enter the path and name of the Queue directory in the Queue Directory field.

The Printer Interface

Common Printing Problems

Fonts on PDF files are printing thin

This problem occurs when the font specified in the PDF file is not listed in the Fontmap.gs file. PlotWorks then substitutes a different font.

PlotWorks uses Ghostscript to process PDF files. All fonts known to Ghostscript are cataloged in a file called Fontmap.gs.

To resolve this problem the best solution is to edit the PDF file to use a font that is listed in the Fontmap.gs file. Otherwise acquire the desired font and modify the Fontmap.gs file. Information on editing this file is provided at the beginning of the Fontmap.gs file.
To view or edit the Fontmap.gs file:
1. Click on the Windows Start button.
2. Click on Programs.
3. Click on Accessories.
4. Click on Notepad. Windows Notepad opens.
5. Click on the File menu.
6. Select Open. The Open dialog box appears.
7. In the Files of type drop down list select All Files.
8. Then navigate to the file C:\Program Files\PLP\PlotWorks\ontmap.GS.
9. Click on the Open button. The file opens in Notepad.

Error Messages

• Activation codes are about to expire
  This dialog box appears to remind you that the PlotWorks Activation codes are about to expire. Clicking on the OK button causes the dialog box to disappear. The message will reappear every eight hours, until the activation codes are renewed or replaced.

• Error: Add Media
  This error occurs when the printer does not contain the medium type or size specified in the job ticket. The software halts printing and requests the correct medium. You can take one of the following actions to resolve the problem:
  • Load the specified medium into the printer, or
  • Use the Override Media command to force printing on an available roll (see below).

To override the requested media:
1. Click Override Media.
2. Select the available medium you wish to use. The software prints the job on this medium, regardless of the specifications in the job ticket.

You can also set up the software to put jobs on hold when the correct medium is not available. The printer skips these jobs and continues printing the remaining jobs in the Queue. The above error messages do not appear when you have selected this option.

To put jobs on hold when media is out:
1. Open the Setup menu and select **Printing Configuration**.
2. Select **Hold Job When Media Out**.
3. Click **OK**.

- **Fatal Error**
  Solution: Refer to the displayed dialog box to identify and resolve the error. Then close and reopen the Printer Interface.

- **HPGL conversion code has expired**
  The Activation Codes have expired. Please contact PLP for new Activation Codes.

- **Multiple Match**
  The medium detected by the printer matches more than one of the items on the inventory list. When you have a multiple match, the media roll on your printer diagram turns red.

  **Solution:**
  1. Click **Media Change**.
  2. Find the roll that has a multiple match and select the correct medium type in the **Selected Media** field.
  3. Click **OK**.

- **No Match**
  The medium detected by the printer does not match anything in the inventory list. When you have a No Match error, the media roll on your printer diagram turns red.

  **Solution:**
  Add the detected medium to the inventory list. See “Adding Media to Inventory” on page 8-21.

- **Error: Invalid “XXXX” Option Code**
  This occurs when a feature’s activation code is missing or invalid. Contact Technical Support to find out the status of the code.

- **Error: “XXXX” Security Code to Expire in “X” Days**
  A temporary activation code is about to expire. Contact Technical Support to find out the status of the code.

- **Error 1: The language DLL that you are using is not current. See your administrator for more information.**
• Error 2: Unable to read the stock inventory file.
• Error 3: Unable to write to stock inventory file.
• Error 4: You must select an item to complete the transaction.
• Error 5: Unable to open or create queue file.
• Error 6: Unable to create directory: XXX
• Error 7: A parameter file is already in process!
• Error 8: Cannot open device driver
  The 8850 printer using the embedded controller displays this error when
  Enable LMHOSTS Lookup is not enabled. Refer to Appendix E page 26 for
  how to enable LMHOSTS Lookup.
• Error 9: 7396 scanner communication error
  Ensure the Smart Switch option is set to Automatic. This problem sometimes
  occurs when the Smart Switch scanner, printer or loop cables need replacing.
  If this does not resolve the problem, remove the Smart Switch and connect
  directly to the printer and scanner and then change the Smart Switch option
  to None. If communication is established then check the Smart Switch
  connection and replace it if necessary.
• Error 10: Printer has no power or is not connected
  This error sometimes occurs if a connection is lost while trying to
  communicate with the printer, any job currently printing is deleted from the
  Printer Interface. The job is then set to processing in the Job Queue and is
  resubmitted once the connection is reestablished.
• Error 11: Call Service (fuser low temperature)
• Error 12: Call Service (fuser over temperature)
• Error 13: Call Service (main motor error)
• Error 14: Call Service (developing motor error-black)
• Error 15: Call Service (process motor error)
• Error 16: Call Service (counter error)
• Error 17: Call Service (cutter error)
• Error 18: Call Service (web feeding error)
• Error 19: Call Service (out of web error)
• Error 20: Call Service (X cutter 0 error)
- Error 21: Call Service (X cutter 1 error)
- Error 22: Call Service (X cutter 2 error)
- Error 23: Call Service (paper feeding motor error)
- Error 24: Call Service (fuser motor error)
- Error 25: Call Service (original motor error)
- Error 26: Call Service (wire cleaning motor error)
- Error 27: Call Service (exposure lamp error)
- Error 28: Call Service (quantity counter error)
- Error 29: Call Service (key counter error)
- Error 30: Call Service (developer motor error-red)
- Error 31: Call Service (fuser thermostat error)
- Error 32: Call Service (tray error)
- Error 33: Call Service
- Error 34: Folder communication error
- Error 34: Folder communication error or Host Mode disabled
- Error 35: Folder is not set for external control
- Error 36: Paper jam
- Error 37: Paper jam in folder
- Error 38: Waste toner full
- Error 39: Folder is over temperature
- Error 40: Out of toner
- Error 41: Remove manual feed
- Error 42: Need manual feed: XXX
- Error 43: Transport open
- Error 44: Door open
- Error 46: Folder is off
- Error 47: Not enough memory to print image: XXXMB
- Error 48: Printer claimed by SCSI class driver

"Error: 48" occurs if Scsiprint and Scsiscan are not disabled in the WinNT Devices applet or if another program is claiming the SCSI driver. The problem is in the Control Panel WinNT Devices applet. Open the Devices dialog box and verify that Scsiprint and Scsiscan are set to Disabled. If the
device is set to Automatic in Devices it will claim the SCSI card. Then reboot the PC.

- **Error 49: Large SCSI transfer failed**
- **Error 49: Printer Claimed by SCSI class device**
  Disable SCSIPrint from the Windows Devices window.
  The option SCSIPrint is found under Start\Settings\Control Panel\Devices. When Windows NT is first installed SCSIPrint is enabled by default. Once it is disabled, reboot the PC. Then when Windows NT restarts SCSIPrint is disabled and the error should not display.

- **Error 50: Cover open**
- **Error 51: Printer must have version 1.03 firmware or later**
- **Error 52: J2-02 toner cartridge can't find home**
- **Error 53: LL-05 end of oil web**
- **Error 54: LL-06 no oil web encoder pulses**
- **Error 55: LL-10 module wrap-around**
- **Error 56: LL-11 servo controller SCB comm fault**
- **Error 57: LL-12 photoreceptor motor stall fault**
- **Error 58: LL-21 charge HVPS fault**
- **Error 59: LL-22 transfer/dtack HVPS fault**
- **Error 60: LL-30 cutter cannot leave/find home**
- **Error 61: LL-41 fuser not to 110F in one minute**
- **Error 62: LL-42 fuser temperature exceeds maximum**
- **Error 63: LL-43 fuser open signal**
- **Error 64: LL-44 scorch signal active**
- **Error 65: LL-45 fuser zap too long**
- **Error 66: LL-4F fuser logic fault**
- **Error 67: LL-50 24V power supply off**
- **Error 68: LL-90 overtoned**
- **Error 69: LL-91 undertoned**
- **Error 70: LX.FF fault requiring power cycling**
- **Error 71: U1-01 copy counter disconnected**
- **Error 72: Front door open**
• Error 73: Cut sheet feed shelf open
• Error 74: Upper rear cover open
• Error 75: Cutter drawer open
• Error 76: Media drawer 1 open
• Error 77: Media drawer 2 open
• Error 78: Media drawer 3 open
• Error 79: Need manual feed: XXX
• Error 80: Media roll 1 not ready
• Error 81: Media roll 2 not ready
• Error 82: Media roll 3 not ready
• Error 83: Printer front panel being accessed
• Error 84: Not enough memory for raster fill pattern
• Error 85: Invalid XXX option code
• Error 86: Folding specified but no folder attached
• Error 87: Folds without margin must be between 180 and 200mm
• Error 88: Folds with margin must be 210mm
• Error 89: Fold margin must be between 20 and 30mm
• Error 90: Cannot punch without a margin and crossfold
• Error 91: Cannot reinforce without a margin and crossfold
• Error 92: Punching specified but folder has no punching option
• Error 93: Reinforcement strip specified but folder has no reinforcement option
• Error 94: 7396 control requires Rev 2 Scorpion board or later
• Error 95: Printer error
• Error 96: Drawer shelf 1 open
• Error 97: Drawer shelf 2 open
• Error 98: Drawer shelf 3 open
• Error 99: Clam shell open
• Error 100: Rear cover open
• Error 101: Drum cover open - Call Service
• Error 102: Power is off
• Notice 103: Printer is in Power Save mode
• Error 104: Incorrect driver (SCORPION.SYS) version
• Notice 105: Manual bypass tray open
• Error 106: Close manual bypass shelf
• Notice 107: Printer is in warm power save mode
• Notice 108: Printer is in cold power save mode
• Error 109: XXX option code expired
• Error 110: XXX option code (Can’t find hardware key)
• Error 111: Printer error
• Error 112: Door or panel open
• Error 113: Not ready to print
• Error 114: Plot mode disabled
• Error 115: You must enter a detected width.
• Error 116: You must enter a detected medium.
• Notice 117: Receiving Scan Data
• Error 118: Folder Error
• Error 119: Remove Prints From Folder Bridge and Reset Folder
• Error 120: Close long plot folder tray.
• Error 121: Error executing viewer.
• Error 122: Viewer file or path is not valid
• Error 123: Viewer specified is invalid or not an executable file.
• Error 124: Insufficient memory to load viewer.
• Error 125: Unable to launch viewer.
• Error 126: Too many command-line arguments for viewer.
• Error 127: Folding cannot be selected for mylar or vellum media.
• Error 128: Error finding help file viewer.
• Error 129: Error executing help file viewer.
• Error 130: Help file viewer path is invalid.
• Error 131: Help file viewer specified is invalid or is not an executable file.
• Error 132: Insufficient memory to load help file viewer.
• Error 133: Unable to launch the help file viewer.
• Error 134: Help file cannot be found.
• Error 135: Multiple invalid or missing activation codes.
• Error 136: Patterns must be aligned
• Error 137: Print Failed
• Error 138: "Clear all media holds" - Bad record or record unavailable. Restarting scan of queue.
  This message indicates a corrupt Queue. Rebuild the Queue to resolve the problem. This often occurs when jobs are kept for several days and not deleted often.
• Error 139: "Find next print job" - Bad record or record unavailable. Restarting scan of queue.
• Error 140: Unable to retrieve job information from the queue.
• Error 141: Could not allocate page memory.
• Error 141: Cannot allocate page memory when running NT SP4
  Run Windows NT SP6A, remove unwanted items from the hard drives and increase the page file size
• Error 142: Entry count too high.
• Error 145: System has run out of memory.
  Close all unnecessary applications. If this does not solve the problem, add more memory to the computer.
• Error 146: System has no hard drive space available
  Delete all unwanted applications and files from your hard drive and from the Windows Recycle Bin.
• Error 147: Failed to create space to store unencoded image.
  This error occurs when the system fails to create a memory mapped file to store the uncompressed raster image. Check the debug log for the last error encountered.
• Error 149: Communication error with the printer's controller
  This is a fatal error caused by the OCE API
  Solution: Shut down and restart the OCE controller and Printer Interface computers.
• Error 150: Printer could not be opened
Printer communication failed when the job was started. Ensure that the correct printer is selected in the Device Specific Options dialog box. If this does not solve the problem, consult the debug log to see what the last error encountered was.

- **Error 151: Folder has no power**
  This error occurs when a print folder is detected but not powered. Ensure that the folder is powered and connected to the printer properly.

- **Error 152: To many open sessions to the printer's controller**
  This is an issue that Oce is resolving. This error occurs when the OCE TDS controller cannot handle another session or when old sessions are not released. Ensure that no one else is connected to the controller. If no one else is connect to the controller then restart the computer containing the OCE controller.

- **Error 153: A job has been put on hold by the controller**
  Check the computer containing the controller for a message explaining why the job was put on hold.

- **Error 154: The delivery tray is full**
  Remove all papers from the delivery tray.

- **Error 155: The printer needs paper to finish printing the job see display panel for details**
  Check the display panel and add the media requested.

- **Error 157: The detachable cover is open**
  Close the detachable cover.

- **Error 158: The original cover is open**
  Close the original cover.

- **Error 159: The toner cover is open**
  Solution: Close the toner cover.

- **Error 160: The output cover is open**
  Close the output cover.

- **Error 161: The waste toner cover is open**
  Close the waste toner cover.

- **Error 162: Bypass misfeed**
  Clear the paper jam in the bypass section of the printer.
- **Error 163: Misfeed in roll #**
  Clear the paper jam in the indicated roll.

- **Error 164: Misfeed in the paper conveying section**
  Clear the paper jam in the paper conveying section.

- **Error 165: Misfeed in the paper exiting section**
  Clear the paper jam in the paper exiting section of the printer.

- **Error 166: Misfeed in the leading edge cut request**
  Clear the paper jam in the leading edge cut section of the printer.

- **Error 167: Misfeed in the original conveying section**
  Clear the paper jam in the original conveying section of the printer.

- **Error 168: Call Service (controller hardware error)**
  The printer display should provide an error code indicating what the problem is. Look up this code in the printer service manual. If necessary, call the printer service technician to fix the problem.

- **Error 169: Call Service (controller memory error)**
  The printer display should provide an error code indicating what the problem is. Look up this code in the printer service manual. If necessary, call the printer service technician to fix the problem.

- **Error 170: Call Service (controller error)**
  The printer display should provide an error code indicating what the problem is. Look up this code in the printer service manual. If necessary, call the printer service technician to fix the problem.

- **Error 171: The printer requires paper in roll # to finish printing**
  The printer has run out of paper in the specified roll. Replace the depleted roll with the same size media previously loaded.

- **Error 172: Controller Communication has not been established**
  Failed to connect with the controller. Confirm the IP address is correct. Ensure that 'Enable LMHOSTS lookup' is enabled for that controllers network connection.

**Job Editor**

Job Editor warning and error messages are listed numerically then alphabetically below.
- Error 2001: The language DLL that you are using is not current. See your administrator for more information.
- Error 2002: Unable to write to the system registry.
- Error 2003: Unable to open files for compression.
- Error 2004: An error occurred while imploding - XXX
- Error 2005: An error occurred while exploding - XXX
- Error 2006: Error uncompressing file: XXX
- Error 2008: Invalid file format.
- Error 2010: There is an error in the CRC of XXX
- Error 2011: File Error
- Error 2012: Unable to create temporary INF file for transmission.
- Error 2013: No valid files are currently selected.
- Error 2014: No job to submit. All files were skipped.
- Error 2015: The specified path to HyperACCESS/5 is invalid.
- Error 2016: Unable to find the file XXX. It will be skipped.
- Error 2017: Unable to find preprocessing files for XXX. They will be skipped.
- Error 2018: Unable to find the PGS file XXX. It will be skipped.
- Error 2018-1: Unable to find the intermediate PostScript/PDF file XXX. It will be skipped.
- Error 2019: Unable to find the message file XXX. It will be skipped.
- Error 2020: Security code invalid

The activation codes may have expired or are incorrect. Confirm that you are running the correct activation codes for your PlotWorks key and the correct driver for your PlotWorks card. Then run the PlotWorks smart update ensuring you are using the correct activation code diskette.

Install Internet Explorer 6.0 and then reinstall the latest version of PlotWorks.
• Error 2021: The job file (.PLP) just saved exceeds the maximum size allowed by PlotWorks for DOS.
• Error 2022: The file is not a valid job ticket (.PLP file).
• Error 2023: Cannot read this version of job ticket (.PLP file).
• Error 2024: Invalid or corrupt job ticket (.PLP file).
• Error 2025: Unable to create the configuration file XXX.
• Error 2026: Unable to create the necessary preprocessing subdirectory.
• Error 2027: The necessary preprocessing subdirectory does not exist.
• Error 2028: This file has not been processed.
• Error 2029: Specified directory for preprocessing does not exist or cannot be created. In the Processing Options dialog box, Processing tab, either specify a valid directory or select to automatically create a directory.
• Error 2030: Unable to create processing dialog box.
• Error 2031: An unknown error occurred while accessing the diskette (XXX).
• Error 2032: Diskette not ready or unformatted. Please insert a diskette.
• Error 2033: This diskette is full. Please insert another empty diskette.
• Error 2034: No valid files are currently selected.
• Error 2035: Destination directory not found.
  This could be because the FTP Destination directory was not found. Verify that the destination path and directory exist. To set up a destination directory:
  1. Open the Job Editor or Job Client if it is not already open
  2. Click on the Setup menu
  3. Click on Configure Destinations to open the Configure Destinations dialog box
  4. Click on the Add button to open the Add Destinations dialog box
  5. Enter a name of your choice in the text box labeled Destination name
  6. Select the radio button labeled FTP site
  7. If you are not using a proxy enter either username:password@host name or your IP (/subdirectory) in the text box labeled Destination path If you are using a proxy enter either username@host name or your IP (/
subdirectory) in the text box labeled Destination path
8. Click OK

- **Error 2036**: Unable to access the next Q*Works job number.
- **Error 2037**: Unable to create the next Q*Works job directory.
- **Error 2038**: Unable to connect to the output queue. Job has not been submitted.

Rebuild the Job Queue:
1. Open the Job Queue if it is not already open
2. Click on the File menu
3. Select Rebuild Queue to open the Rebuild Queue dialog box
4. Click Yes

- **Error 2039**: Unable to create a new job queue subdirectory or entry.
- **Error 2040**: Unable to create the next NetQuery job directory. Extended Error %lu.
- **Error 2041**: Exhausted all possible NetQuery job directories.
- **Error 2042**: Exception XXX was encountered during transfer of file XXX. Continuing with the next file.
- **Error 2043**: Unable to lock the output queue. Job XXX has been removed.
- **Error 2044**: User aborted transmission
- **Error 2045**: Unable to dial remote system. RAS extended error #XXX.
- **Error 2046**: The Image Viewer application cannot be found. Make sure the application is properly installed, and that it has not been deleted, or moved, or renamed.
- **Error 2047**: Unable to load GridWiz resources. Make sure grid.rc is included in your projects resource file.
- **Error 2048**: Unknown data type.
- **Error 2049**: No file was selected!
- **Error 2050**: Current File is not empty!
- **Error 2051**: No Document
- **Error 2052**: Unknown Value XXX for XXX
- **Error 2053**: The Scanning Interface application cannot be found. Make sure the application is properly installed, and that it has not been deleted, or moved, or renamed.

- **Error 2054**: Unable to find TEMPLATE.INF file in current directory or the install path.

- **Error 2055**: Unable to find Template.inf
  Deselect the "Send additional information from TEMPLATE.INF file". option from the Job Editor or Client Configure Destination dialog box. To access this dialog box click on Setup then Configure Destination.

- **Error 2055**: Unknown value type.

- **Error 2056**: Unable to find the specified Windows temporary directory. This path is found in the system ‘TMP’ environmental variable.

- **Error 2057**: Unable to match Specified Size.

- **Error 2058**: Unable to match Output Size.

- **Error 2059**: Not enough memory for reading file.

- **Error 2060**: Unable to open Postscript/PDF file for reading.

- **Error 2061**: Internal selection error.

- **Error 2056**: You must enter a filename in this field.

- **Error 2063**: Unable to get the short filename of XXX. The drive that it is on does not support short name aliases. You might have to shorten the name down or move it to a local drive and re-add it to the job.

- **Error 2064**: Unable to erase the disk. The disk could be write-protected or one of its files might be in use.

- **Error 2065**: Unable to save viewer configuration to registry.

- **Error 2066**: Unable to save viewer configuration to registry.

- **Error 2067**: Error executing viewer. Please recheck viewer path.

- **Error 2068**: Error executing viewer.

- **Error 2069**: Viewer file or path is invalid.

- **Error 2070**: Viewer specified is invalid or not an executable file.

- **Error 2071**: Insufficient memory to load viewer.
• Error 2072: Unable to launch viewer.
• Error 2073: Too many command-line arguments for viewer.
• Error 2074: The last directory you specified is no longer valid. Defaulting to program directory.
• Error 2075: Unable to register PlotWorks for Drag-and-Drop capability.
• Error 2076: Unable to open PLPJTDAT file.
• Error 2077: Error executing DMSDBADD. Please recheck path in environment.
• Error 2078: Error executing DMSDBADD.
• Error 2079: DMSDBADD file or path is invalid in environment.
• Error 2080: DMSDBADD specified in environment is invalid or not an executable file.
• Error 2081: Insufficient memory to load DMSDBADD.
• Error 2082: Unable to launch DMSDBADD.
• Error 2083: Missing DMS_DB_ADD path in environment.
• Error 2084: Unable to create temp file for DMSDBADD.
• Error 2086: Cannot copy file(s) to itself.
• Error 2087: Please choose only one job ticket (.PLP file) or PFS file.
• Error 2088: Error finding help file viewer.
• Error 2089: Error executing help file viewer.
  Acrobat Reader is not installed. Acrobat Reader is provided on the PlotWorks Job Client and Server CD.
• Error 2090: Help file viewer path is invalid.
• Error 2091: Help file viewer specified is invalid or not an executable file.
• Error 2092: Insufficient memory to load help file viewer.
• Error 2093: Unable to launch help file viewer.
• Error 2094: Help file cannot be found.
• Error 2095: Unable to rename file.
• Error 2096: File <filename.ext> already exists in this job. Duplicate
filenames not allowed.

- **Error 2097**: No viewer has been defined for this data format.
- **Error 2098**: PlotWorks viewer not available in basic client mode.
- **Error 2099**: Unable to write to the destination directory. System Error:
  - **Error 2100**: Encountered an unknown property tag.
- **Error 2101**: The template.inf file is empty.

Error numbers 2106 through 2110 are generated by the FTP Polling function,

- **Error 2106**: *xxx (nnn)* and other error numbers in the 10000 or 20000 range
  
  This error indicates that the FTP module sent us an error message (*xxx*) with an error number (*nnn*).

- **Error 2107**: Unspecified error occurred while FTP polling
  
  An error occurred that is not recognized as an FTP polling error. This could be due to an incomplete installation of a Service Pack, Windows OLE dlls, or an OS corruption.

- **Error 2108**: Unable to request list of files in remote directory *xxx (nnn)*
  
  Failed to obtain a directory listing for the polled directory from the remote FTP server.

- **Error 2109**: Unable to create temporary filename.
  
  This error indicates that the Windows function CoCreateGUID failed. This is due to a missing network card or a network card failure on a Windows NT 4.0, 95, or 98 operating system.

- **Error 2110**: Unable to create local file *yyy from temporary file*.
  
  Failed to move the temporary file downloaded from the FTP site to the destination directory for the polled files. This is caused by anything that prevents you from writing to the destination directory - usually access permissions or a bad network connection.

- **The destination directory does not exist.**
  
  This error occurs if the destination directory for the FTP polled files does not exist, or you don't have access rights to it.

- **An error occurred attempting to delete the file *%s from the ftp server.***
  
  *xxx (nnn)*
An error occurred while attempting to delete the file on the remote FTP server after the file was copied and placed in the destination directory. This could be because the FTP server or network connection is down, or you do not have the correct access permissions on the remote FTP server to delete files in the polled directory.

- **An error occurred downloading the file yyy. xxx (nnn)**
  An error occurred during the FTP download, such as the failure of the network connection or the FTP server.

- **Error while logging in. Please check the surname and password. xxx (nnn)**
  This error occurs when we use the FTP module to log into the FTP server, and the login fails. This could be due to a bad user name or password, or the network connection or FTP server is down.

- **The file %s can not be overwritten because of insufficient file permissions or some other reason. Polling will be aborted.**
  If the user chooses to replace the file already in the destination directory, and PlotWorks is not able to remove the read-only attribute for that file, this error occurs. This is usually a problem with access permissions, such as the current user not having rights to remove the read-only flag from that file.

- **The file yyy already exists in the destination directory. Would you like to overwrite the existing file?**
  This means that the name we are going to use for the file that was just downloaded is already in use in the destination directory.

- **Operation interrupted (connection with server was lost)**
  This error occurs when using the FTP Polling function. When the FTP module encounters an error while processing a request to the remote FTP server. This could be due to a power failure at the remote FTP server, or a bad network connection.

- **The specified FTP server could not be found or an error occurred. xxx (nnn)**
  This error occurs when the IP address or URL cannot be looked up by the FTP module. The DNS may not be working preventing the IP look up, or the IP address doesn't exist on this network or on the Internet, or there is a downed network connection.
• Warning: A file of an unsupported file format was downloaded from the remote directory. It will not be added to the job ticket. Please check the remote directory to ensure that it is correct.

PlotWorks doesn't recognize the file format of the downloaded file.

Job Processor:

• Error 3001: The language DLL that you are using is not current. See your administrator for more information.
• Error 3002: Security code invalid
• Error 3003: Unable to connect to specified queue.
• Error 3004: Unable to find specified queue.
• Error 3005: Unable to access the queue to scan for the next job to preprocess.
• Error 3006: The job XXX could not be found in the proper directory.
• Error 3007: Unable to lock the queue to update the status after preprocessing a job.
• Error 3008: Job XXX had errors during processing.
• Error 3009: Unable to create processing dialog box.
• Error 3010: Unable to create the necessary preprocessing subdirectory.
• Error 3011: The necessary preprocessing subdirectory does not exist.
• Error 3012: Job Processor cannot close while a job is being processed.
• Error 3013: Unable to write job entry to the queue.
• Error 3014: Error finding help file viewer.
• Error 3015: Error executing help file viewer.
• Error 3016: Help file viewer path is invalid.
• Error 3017: Help file viewer specified is invalid or is not an executable file.
• Error 3018: Insufficient memory to load help file viewer.
• Error 3019: Unable to launch the help file viewer.
• Error 3020: Help file cannot be found.
• Error 3021: Remote queues are not supported without proper activation codes.

• Error 3022: Cannot process client jobs without proper activation codes.

**Image Viewer**

• **Error 5001**: Invalid HPGL\_RTL sequence
  This error occasionally occurs when using the HP 650C driver, supplied by a different company, then HP or AutoCAD. Use the optimized systems driver from the AutoCAD 2000 CD.

• **Error 5001**: The language DLL that you are using is not current. See your administrator for more information.

• Error 5002: A fatal error occurred while reading the image file.

• **Error 5003**: Unknown Object type

• **Error 5004**: File: XXX has an invalid plot format!

• **Error 5005**: This application can only be run under NT or WIN95!

• **Error 5006**: Fail to Create Font

• **Error 5007**: Fail to TextOut

• **Error 5008**: Fail to Set Data into Pen List Box

• **Error 5009**: Error finding help file viewer.

• **Error 5010**: Error executing help file viewer.

• **Error 5011**: Help file viewer path is invalid.

• **Error 5012**: Help file viewer specified is invalid or is not an executable file.

• **Error 5013**: Insufficient memory to load help file viewer.

• **Error 5014**: Unable to launch the help file viewer.

• **Error 5015**: Help file cannot be found.

**Scanner Interface:**

• **Error 7001**: The language DLL that you are using is not current. See your administrator for more information.
• Error 7002: Failed to Autodetect document Size!
• Error 7003: Working Directory does not exist!
• Error 7004: Strength must be between -100 and 100!
• Error 7005: Document Width must be greater than 0!
• Error 7006: Document Height must be greater than 0!
• Fatal Error 7007: Failed to get image data from scanner!
• Fatal Error 7008: Paper Jam!
• Fatal Error 7009: Scanner Hardware Error. Please reset the scanner.
• Fatal Error 7010: Image buffer overflow. Please decrease scanner speed or increase image data buffer size, and try again.
• Fatal Error 7011: Aborted command!
• Error 7012: Failed to print. Current file is Empty!
• Error 7013: Black point must be between 0 and 255!
• Error 7014: White point must be between 0 and 255!
• Error 7015: White point must be greater than or equal to black point.
• Error 7016: Scale is out of range. Scale must between XXX and YYY.
• Fatal Error 7017: Image buffer overflow. Please increase image data buffer size, and try again.
• Error 7018: Failed to Autodetect document Size!
• Error 7019: Too many command-line arguments for viewer
• Error 7020: Error executing viewer. Please recheck viewer path.
• Error 7021: Error executing viewer.
• Error 7022: Viewer path is invalid.
• Error 7023: Viewer specified is invalid or is not an executable file.
• Error 7024: Insufficient memory to load viewer.
• Error 7025: Error finding help file viewer.
• Error 7026: Error executing help file viewer.
• Error 7027: Help file viewer path is invalid.
• Error 7028: Help file viewer specified is invalid or is not an executable file.
• Error 7029: Insufficient memory to load help file viewer.
• Error 7030: Unable to launch the help file viewer.
• Error 7031: Help file cannot be found.
• Error 7032: An unspecified file error occurred.
• Error 7033: The file could not be located.
• Error 7034: All or part of the path is invalid.
  If running an older version of PlotWorks, ensure there are no hyphens, spaces or parenthesis in the file name. PlotWorks 5.5 and newer does support hyphens; spaces and parenthesis in filenames but previous PlotWorks versions do not.
• Error 7035: The permitted number of open files was exceeded.
• Error 7036: The file could not be accessed.
• Error 7037: There was an attempt to use an invalid file handle.
• Error 7038: The current working directory cannot be removed.
• Error 7039: There are no more directory entries.
• Error 7040: There was an error trying to set the file pointer.
• Error 7041: There was a hardware error.
• Error 7042: Share.exe was not loaded, or a shared region was locked.
• Error 7043: The disk is full.
• Error 7044: The end of file was reached.
• Error 7045: There was an attempt to lock a region that was already locked.
Appendix C

Image File Requirements

PlotWorks supports a variety of popular image file formats. When you add files to a job, the software automatically detects the file formats. You can combine any supported file formats in a single job to produce digitally collated sets.

The following file formats are supported:

- AutoCAD files (DWG, DXF) (AutoCAD 2000 must be installed to process AutoCAD 2000 plot files)
- BMP
- CalComp plot files (906/907)
- CALS (Type 1)
- CGM, DGN (MicroStation must be installed for either format)
- DWF
- DCX
- HP-GL, HP-GL/2
- JOB files from Repro Desk/Apprentice
- JPG
- PCX
- PDF
- PostScript (Level 1, 2 and 3)
- TIFF and TIFF 5.5.1 (Subset of TIFF is supported)
- VIC (The AutoCAD VIC 24 Driver is not currently supported)
- VRF (vector format only)
- XIF

Support for some of these formats is optional and must be purchased separately. If you receive an Unrecognized File Format error, confirm that your PlotWorks system supports the format being used.

Plot Files

The software autodetects HP-GL, HP-GL/2, HP-RTL and CalComp 906/907 formats. We recommend that you choose the following drivers when creating plot files in the source application:

- For HP-GL, select model 7585B
- For HP-GL/2, select HP-DesignJet 750 driver
- For HP-RTL, select HP-DesignJet 750 driver (Windows system)
• For CalComp, select model 1043 or 1044
CalComp Commands

PlotWorks does not support every CalComp command. The unsupported commands are listed below along with error numbers and any additional text. A complete list of all CalComp commands is in the CalComp manual.

<table>
<thead>
<tr>
<th>Number</th>
<th>Warning</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>1007</td>
<td>'0E-06' (Operator Message)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>1008</td>
<td>'0E-06' (Operator Message With Pause)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>1009</td>
<td>'0E-OD' (User-Defined Symbol)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>1010</td>
<td>'0E-OE' (Erase User-Defined Symbol Set)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>1011</td>
<td>'OE-11' (Negate Image)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>1012</td>
<td>'0E-12' (Set Pen)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>1013</td>
<td>'0E-13' (Paper Cutter)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>1014</td>
<td>'0E-14' (ASYNC)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>1015</td>
<td>'0E-15' (HATCH)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>1016</td>
<td>'0E-16' (Set Pattern)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>1017</td>
<td>'0E-18' (Start Plot)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>1018</td>
<td>'0E-19' (Force Plot)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>1019</td>
<td>'0E-1A' (Plotter Select)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>1020</td>
<td>'0E-1 B' (Plot Copies)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>1048</td>
<td>'0E-21' (PATTERN FILL)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>1049</td>
<td>'0E-22' (SETPAT)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>1022</td>
<td>'0E-23' (COLOR MODIFY)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>1023</td>
<td>'0E-26' (NEW LEVEL)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>1024</td>
<td>'0E-28' (XSETPEN)</td>
<td>Not Supported</td>
</tr>
<tr>
<td>1025</td>
<td>'OE-29' (SETLEVEL)</td>
<td>Not Supported</td>
</tr>
</tbody>
</table>
### CalComp Error Codes

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Not Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>1004</td>
<td>Too Many Segments in 'OD-xx' (Define Dash)</td>
<td></td>
</tr>
<tr>
<td>1005</td>
<td>Invalid Length In 'OD-xx' (Define Dash)</td>
<td></td>
</tr>
<tr>
<td>1006</td>
<td>Illegal Escape Sequence '08-??' (Escape Sequence)</td>
<td></td>
</tr>
<tr>
<td>1027</td>
<td>'0E-??' (Extended Character) Unknown</td>
<td></td>
</tr>
<tr>
<td>1040</td>
<td>'0B-00-??' (Pass Through To Plotter) Unknown</td>
<td></td>
</tr>
<tr>
<td>1041</td>
<td>'0B-05-??' (Symbol Characteristics) Unknown</td>
<td></td>
</tr>
<tr>
<td>1042</td>
<td>'0B-05-??' Rotate Angle too big</td>
<td></td>
</tr>
<tr>
<td>1043</td>
<td>'0B-08-??' (Dash Bypass) Unknown</td>
<td></td>
</tr>
<tr>
<td>1044</td>
<td>'0B-%02x' (Pass Through to Plotter) Unknown</td>
<td></td>
</tr>
<tr>
<td>1045</td>
<td>'??' Unknown Instruction</td>
<td></td>
</tr>
<tr>
<td>1046</td>
<td>Illegal Delta Data</td>
<td></td>
</tr>
</tbody>
</table>
## HP-GL Supported Command List

### Configuration Group

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>DF</td>
<td>Default</td>
<td>Supported</td>
</tr>
<tr>
<td>IN</td>
<td>Initialize</td>
<td>Supported</td>
</tr>
<tr>
<td>IP</td>
<td>Input P1 and P2</td>
<td>Supported</td>
</tr>
<tr>
<td>SC</td>
<td>Scale</td>
<td>Supported</td>
</tr>
</tbody>
</table>

### Lines and Rectangles

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>EA</td>
<td>Edge Rectangle Absolute</td>
<td>Supported</td>
</tr>
<tr>
<td>ER</td>
<td>Edge Rectangle Relative</td>
<td>Supported</td>
</tr>
<tr>
<td>PA</td>
<td>Plot Absolute</td>
<td>Supported</td>
</tr>
<tr>
<td>PD</td>
<td>Pen Down</td>
<td>Supported</td>
</tr>
<tr>
<td>PR</td>
<td>Plot Relative</td>
<td>Supported</td>
</tr>
<tr>
<td>PU</td>
<td>Pen Up</td>
<td>Supported</td>
</tr>
<tr>
<td>SP</td>
<td>Select Pen</td>
<td>Supported - Enhanced to support pens 1 to 255</td>
</tr>
</tbody>
</table>

### Enhancing Plots

<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>FT</td>
<td>Fill Type</td>
<td>Supported</td>
</tr>
<tr>
<td>LT</td>
<td>Line Type</td>
<td>Supported</td>
</tr>
<tr>
<td>PT</td>
<td>Pen Spacing</td>
<td>Supported</td>
</tr>
<tr>
<td>RA</td>
<td>Fill Rectangle Absolute</td>
<td>Supported</td>
</tr>
<tr>
<td>SM</td>
<td>Symbol Mode</td>
<td>Not supported</td>
</tr>
<tr>
<td>TL</td>
<td>Tick Length</td>
<td>Not supported</td>
</tr>
<tr>
<td>UF</td>
<td>User-Defined Fill Type</td>
<td>Supported</td>
</tr>
<tr>
<td>XT</td>
<td>X-Tick</td>
<td>Not supported</td>
</tr>
<tr>
<td>Code</td>
<td>Description</td>
<td>Supported</td>
</tr>
<tr>
<td>------</td>
<td>------------------------------</td>
<td>---------------</td>
</tr>
<tr>
<td>YT</td>
<td>Y-Tick</td>
<td>Not supported</td>
</tr>
<tr>
<td>CI</td>
<td>Circle</td>
<td>Supported</td>
</tr>
<tr>
<td>CT</td>
<td>Chord Tolerance</td>
<td>Supported</td>
</tr>
<tr>
<td>EW</td>
<td>Edge Wedge</td>
<td>Supported</td>
</tr>
<tr>
<td>WG</td>
<td>Fill Wedge</td>
<td>Supported</td>
</tr>
</tbody>
</table>

### Circles, Arcs and Wedges

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>AA</td>
<td>Arc Absolute</td>
<td>Supported</td>
</tr>
<tr>
<td>AR</td>
<td>Arc Relative</td>
<td>Supported</td>
</tr>
<tr>
<td>CI</td>
<td>Circle</td>
<td>Supported</td>
</tr>
<tr>
<td>CT</td>
<td>Chord Tolerance</td>
<td>Supported</td>
</tr>
<tr>
<td>EW</td>
<td>Edge Wedge</td>
<td>Supported</td>
</tr>
<tr>
<td>WG</td>
<td>Fill Wedge</td>
<td>Supported</td>
</tr>
</tbody>
</table>

### Labelling Plots

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>BL</td>
<td>Buffer Label</td>
<td>Not supported</td>
</tr>
<tr>
<td>CP</td>
<td>Character Plot</td>
<td>Supported</td>
</tr>
<tr>
<td>DI</td>
<td>Absolute Direction</td>
<td>Supported</td>
</tr>
<tr>
<td>DR</td>
<td>Direction Relative</td>
<td>Not supported</td>
</tr>
<tr>
<td>DT</td>
<td>Define Label Terminator</td>
<td>Supported</td>
</tr>
<tr>
<td>DV</td>
<td>Direction Vertical</td>
<td>Not supported</td>
</tr>
<tr>
<td>ES</td>
<td>Extra Space</td>
<td>Supported</td>
</tr>
<tr>
<td>LB</td>
<td>Label</td>
<td>Partially Supported - Only printable characters are supported - backspace, half-backspace, line-feed, inverse-line-feed, carriage-return, shift-in and shift-out are not.</td>
</tr>
<tr>
<td>LO</td>
<td>Label Origin</td>
<td>Supported</td>
</tr>
<tr>
<td>----------</td>
<td>-------------------</td>
<td>-----------</td>
</tr>
<tr>
<td>PB</td>
<td>Print Buffer Label</td>
<td>Not supported</td>
</tr>
<tr>
<td>SI</td>
<td>Absolute Character Size</td>
<td>Supported</td>
</tr>
<tr>
<td>SL</td>
<td>Character Slant</td>
<td>Supported</td>
</tr>
<tr>
<td>SR</td>
<td>Relative Character Size</td>
<td>Supported</td>
</tr>
</tbody>
</table>

### Polygons

<table>
<thead>
<tr>
<th>EP</th>
<th>Edge Polygon</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>FP</td>
<td>Fill Polygon</td>
<td>Supported</td>
</tr>
<tr>
<td>GM</td>
<td>Graphics Memory</td>
<td>Not relevant</td>
</tr>
<tr>
<td>PM</td>
<td>Polygon Mode</td>
<td>Supported</td>
</tr>
</tbody>
</table>

### Picture Area and Orientation

<table>
<thead>
<tr>
<th>IW</th>
<th>Input Window</th>
<th>Supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>OH</td>
<td>Output Hard Clip Limits</td>
<td>Not relevant</td>
</tr>
<tr>
<td>OP</td>
<td>Output P1 and P2</td>
<td>Not relevant</td>
</tr>
<tr>
<td>OW</td>
<td>Output Window</td>
<td>Not relevant</td>
</tr>
<tr>
<td>RO</td>
<td>Rotate Coordinate System</td>
<td>Supported</td>
</tr>
</tbody>
</table>

### Advanced Pen Control and Front-Panel Interaction

<table>
<thead>
<tr>
<th>AP</th>
<th>Automatic Pen Operations</th>
<th>Not relevant</th>
</tr>
</thead>
<tbody>
<tr>
<td>AS</td>
<td>Acceleration Select</td>
<td>Not relevant</td>
</tr>
<tr>
<td>CV</td>
<td>Curved Line Generator</td>
<td>Not relevant</td>
</tr>
<tr>
<td>FS</td>
<td>Force Select</td>
<td>Not relevant</td>
</tr>
<tr>
<td>GP</td>
<td>Group Pen</td>
<td>Not relevant</td>
</tr>
<tr>
<td>KY</td>
<td>Define Key</td>
<td>Not relevant</td>
</tr>
<tr>
<td>NR</td>
<td>Not ready</td>
<td>Not relevant</td>
</tr>
<tr>
<td>----</td>
<td>-----------</td>
<td>--------------</td>
</tr>
<tr>
<td>OK</td>
<td>Output Key</td>
<td>Not relevant</td>
</tr>
<tr>
<td>SG</td>
<td>Select Group</td>
<td>Not relevant</td>
</tr>
<tr>
<td>VS</td>
<td>Velocity Select</td>
<td>Not relevant</td>
</tr>
<tr>
<td>WD</td>
<td>Write to Display</td>
<td>Not relevant</td>
</tr>
</tbody>
</table>

**Digitizing**

<table>
<thead>
<tr>
<th>DP</th>
<th>Digitize Point</th>
<th>Not relevant</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC</td>
<td>Digitize Clear</td>
<td>Not relevant</td>
</tr>
<tr>
<td>OD</td>
<td>Output Digitize Point</td>
<td>Not relevant</td>
</tr>
</tbody>
</table>

**Roll Feed and Long-Axis Plotting**

<table>
<thead>
<tr>
<th>AF</th>
<th>Advance Full Page</th>
<th>Not supported</th>
</tr>
</thead>
<tbody>
<tr>
<td>AH</td>
<td>Advance Half Page</td>
<td>Not supported</td>
</tr>
<tr>
<td>EC</td>
<td>Enable Cut Line</td>
<td>Not supported</td>
</tr>
<tr>
<td>PG</td>
<td>Advance Full Page</td>
<td>Supported</td>
</tr>
<tr>
<td>PS</td>
<td>Page Size</td>
<td>Partially Supported - Used only to set P1 and P2</td>
</tr>
</tbody>
</table>

**Alternate Character Sets and User-Designated Characters**

<table>
<thead>
<tr>
<th>CA</th>
<th>Designate Alt Char Set</th>
<th>Partially Supported - Only sets 0-9, 30-39, and 99 in HP-GL (not supported in HP-GL/2)</th>
</tr>
</thead>
<tbody>
<tr>
<td>CC</td>
<td>Character Chord Angle</td>
<td>Not supported</td>
</tr>
<tr>
<td>CM</td>
<td>Character Selection Mode</td>
<td>Not supported</td>
</tr>
<tr>
<td>CS</td>
<td>Designate Std Char Set</td>
<td>Partially Supported - Only sets 0-9, 30-39, and 99 in HP-GL (not supported in HP-GL/2)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>---</td>
<td>---</td>
<td>---</td>
</tr>
<tr>
<td>DL</td>
<td>Def. Downloadable Char</td>
<td>Not supported</td>
</tr>
<tr>
<td>DS</td>
<td>Desig. Char Set into Slot</td>
<td>Not supported</td>
</tr>
<tr>
<td>IV</td>
<td>Invoke Character Slot</td>
<td>Not supported</td>
</tr>
<tr>
<td>SA</td>
<td>Select Alternate Char Set</td>
<td>Supported (only in HP-GL)</td>
</tr>
<tr>
<td>SS</td>
<td>Select Standard Char Set</td>
<td>Supported (only in HP-GL)</td>
</tr>
<tr>
<td>UC</td>
<td>User-Defined Character</td>
<td>Not supported</td>
</tr>
</tbody>
</table>

**Obtaining Information from the Plotter**

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>GC</td>
<td>Group Count</td>
<td>Not relevant</td>
</tr>
<tr>
<td>IM</td>
<td>Image Mask</td>
<td>Not relevant</td>
</tr>
<tr>
<td>OA</td>
<td>Output Actual Pen Status</td>
<td>Not relevant</td>
</tr>
<tr>
<td>OC</td>
<td>O/P Command Pen Status</td>
<td>Not relevant</td>
</tr>
<tr>
<td>OE</td>
<td>Output Error</td>
<td>Not relevant</td>
</tr>
<tr>
<td>OF</td>
<td>Output Factors</td>
<td>Not relevant</td>
</tr>
<tr>
<td>OG</td>
<td>Output Group Count</td>
<td>Not relevant</td>
</tr>
<tr>
<td>OI</td>
<td>Output Identification</td>
<td>Not relevant</td>
</tr>
<tr>
<td>OL</td>
<td>Output Label Length</td>
<td>Not relevant</td>
</tr>
<tr>
<td>OO</td>
<td>Output Options</td>
<td>Not relevant</td>
</tr>
<tr>
<td>OS</td>
<td>Output Status</td>
<td>Not relevant</td>
</tr>
<tr>
<td>OT</td>
<td>Output Carousel Type</td>
<td>Not relevant</td>
</tr>
</tbody>
</table>

**Device Control Instructions**

<p>| | | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Esc A</td>
<td>Output Identification</td>
<td>Not relevant</td>
</tr>
<tr>
<td>Esc B</td>
<td>Output Buffer Space</td>
<td>Not relevant</td>
</tr>
<tr>
<td>Esc E</td>
<td>Output Extended Error</td>
<td>Not relevant</td>
</tr>
<tr>
<td>Esc J</td>
<td>Abort Device Control</td>
<td>Not relevant</td>
</tr>
</tbody>
</table>
### Interfacing and Handshaking

<table>
<thead>
<tr>
<th>Key</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Esc H</td>
<td>Set Handshake Mode 1</td>
<td>Not relevant</td>
</tr>
<tr>
<td>Esc I</td>
<td>Set Handshake Mode 2</td>
<td>Not relevant</td>
</tr>
<tr>
<td>Esc M</td>
<td>Set Output Mode</td>
<td>Not relevant</td>
</tr>
<tr>
<td>Esc N</td>
<td>Set Ext. O/P &amp; Handshake</td>
<td>Not relevant</td>
</tr>
<tr>
<td>Esc P</td>
<td>Define Handshake</td>
<td>Not relevant</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Key</th>
<th>Command</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Esc K</td>
<td>Abort Graphics</td>
<td>Not relevant</td>
</tr>
<tr>
<td>Esc L</td>
<td>O/P BuffSize When Empty</td>
<td>Not relevant</td>
</tr>
<tr>
<td>Esc O</td>
<td>Output Extended Status</td>
<td>Not relevant</td>
</tr>
<tr>
<td>Esc Q</td>
<td>Set Monitor Mode</td>
<td>Not relevant</td>
</tr>
<tr>
<td>Esc R</td>
<td>Reset</td>
<td>Not relevant</td>
</tr>
<tr>
<td>Esc S</td>
<td>O/P Configurable MemSize</td>
<td>Not relevant</td>
</tr>
<tr>
<td>Esc T</td>
<td>Alloc. Configurable Mem.</td>
<td>Not relevant</td>
</tr>
<tr>
<td>Esc U</td>
<td>End Flush Mode</td>
<td>Not relevant</td>
</tr>
<tr>
<td>Esc U</td>
<td>Plotter On</td>
<td>Not relevant</td>
</tr>
<tr>
<td>Esc (</td>
<td>Plotter On</td>
<td>Not relevant</td>
</tr>
<tr>
<td>Esc Z</td>
<td>Plotter Off</td>
<td>Not relevant</td>
</tr>
<tr>
<td>Esc )</td>
<td>Plotter Off</td>
<td>Not relevant</td>
</tr>
<tr>
<td>Esc@</td>
<td>Set Plotter Configuration</td>
<td>Not relevant</td>
</tr>
</tbody>
</table>
## HP-GL/2

### Configuration and Status Group

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>DF</td>
<td>Default</td>
<td>Supported</td>
</tr>
<tr>
<td>IN</td>
<td>Initialize</td>
<td>Supported</td>
</tr>
<tr>
<td>IP</td>
<td>Input P1 and P2</td>
<td>Supported</td>
</tr>
<tr>
<td>IR</td>
<td>Input Relative P1 and P2</td>
<td>Supported</td>
</tr>
<tr>
<td>IW</td>
<td>Input Window</td>
<td>Supported</td>
</tr>
<tr>
<td>PG</td>
<td>Advance Full Page</td>
<td>Supported</td>
</tr>
<tr>
<td>RO</td>
<td>Rotate Coord System</td>
<td>Supported</td>
</tr>
<tr>
<td>RP</td>
<td>Replot</td>
<td>Not Relevant</td>
</tr>
<tr>
<td>SC</td>
<td>Scale</td>
<td>Supported</td>
</tr>
</tbody>
</table>

### Vector Group

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>AA</td>
<td>Arc Absolute</td>
<td>Supported</td>
</tr>
<tr>
<td>AR</td>
<td>Arc Relative</td>
<td>Supported</td>
</tr>
<tr>
<td>AT</td>
<td>Absolute Three Point Arc</td>
<td>Not Supported</td>
</tr>
<tr>
<td>CI</td>
<td>Circle</td>
<td>Supported</td>
</tr>
<tr>
<td>PA</td>
<td>Plot Absolute</td>
<td>Supported</td>
</tr>
<tr>
<td>PD</td>
<td>Pen Down</td>
<td>Supported</td>
</tr>
<tr>
<td>PE</td>
<td>Polyline Encoded</td>
<td>Partially Supported - Does not support fractional data</td>
</tr>
<tr>
<td>PR</td>
<td>Plot Relative</td>
<td>Supported</td>
</tr>
<tr>
<td>PU</td>
<td>Pen Up</td>
<td>Supported</td>
</tr>
<tr>
<td>RT</td>
<td>Relative Three Point Arc</td>
<td>Not Supported</td>
</tr>
</tbody>
</table>
### Polygon Group

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>EA</td>
<td>Edge Rectangle Absolute</td>
<td>Supported</td>
</tr>
<tr>
<td>ER</td>
<td>Edge Rectangle Relative</td>
<td>Supported</td>
</tr>
<tr>
<td>EW</td>
<td>Edge Wedge</td>
<td>Supported</td>
</tr>
<tr>
<td>EP</td>
<td>Edge Polygon</td>
<td>Supported</td>
</tr>
<tr>
<td>FP</td>
<td>Fill Polygon</td>
<td>Supported</td>
</tr>
<tr>
<td>PM</td>
<td>Polygon Mode</td>
<td>Supported</td>
</tr>
<tr>
<td>RA</td>
<td>Fill Rectangle Absolute</td>
<td>Supported</td>
</tr>
<tr>
<td>RA</td>
<td>Fill Rectangle Relative</td>
<td>Supported</td>
</tr>
<tr>
<td>WG</td>
<td>Fill Wedge</td>
<td>Supported</td>
</tr>
</tbody>
</table>

### Line and Fill Attributes Group

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>AC</td>
<td>Anchor Corner</td>
<td>Partially Supported - No raster pattern support currently</td>
</tr>
<tr>
<td>FT</td>
<td>Fill Type</td>
<td>Supported</td>
</tr>
<tr>
<td>LA</td>
<td>Line Attributes</td>
<td>Partially Supported - Specify W in the Pen Macro field to use; Does not support joins or miter limits currently</td>
</tr>
<tr>
<td>LT</td>
<td>Line Type</td>
<td>Supported</td>
</tr>
<tr>
<td>PW</td>
<td>Pen Width</td>
<td>Supported</td>
</tr>
<tr>
<td>RF</td>
<td>Raster Fill Definition</td>
<td>Partially Supported - 64 bit patterns not supported</td>
</tr>
<tr>
<td>SM</td>
<td>Symbol Mode</td>
<td>Not supported</td>
</tr>
<tr>
<td>SP</td>
<td>Select Pen</td>
<td>Partially Supported - No pen 0, supports pens 1 to 255</td>
</tr>
<tr>
<td>UL</td>
<td>User-Defined Line Type</td>
<td>Supported</td>
</tr>
<tr>
<td>WU</td>
<td>Pen Width Unit Selection</td>
<td>Supported</td>
</tr>
</tbody>
</table>
## Character Group

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>AD</td>
<td>Alternate Font Definition</td>
<td>Not supported</td>
</tr>
<tr>
<td>CF</td>
<td>Character Fill Mode</td>
<td>Not supported</td>
</tr>
<tr>
<td>CP</td>
<td>Character Plot</td>
<td>Supported</td>
</tr>
<tr>
<td>DI</td>
<td>Absolute Direction</td>
<td>Supported</td>
</tr>
<tr>
<td>DR</td>
<td>Direction Relative</td>
<td>Not supported</td>
</tr>
<tr>
<td>DT</td>
<td>Define Label Terminator</td>
<td>Supported</td>
</tr>
<tr>
<td>DV</td>
<td>Define Variable Text Path</td>
<td>Not supported</td>
</tr>
<tr>
<td>ES</td>
<td>Extra Space</td>
<td>Supported</td>
</tr>
<tr>
<td>LB</td>
<td>Label</td>
<td>Partially Supported - Only printable characters are supported - backspace, half-backspace, line-feed, inverse-line-feed, carriage-return, shift-in and shift-out are not.</td>
</tr>
<tr>
<td>LO</td>
<td>Label Origin</td>
<td>Supported</td>
</tr>
<tr>
<td>SA</td>
<td>Select Alternate Char Set</td>
<td>Not supported (only in HP-GL)</td>
</tr>
<tr>
<td>SD</td>
<td>Standard Font Definition</td>
<td>Not supported</td>
</tr>
<tr>
<td>SI</td>
<td>Absolute Character Size</td>
<td>Supported</td>
</tr>
<tr>
<td>SL</td>
<td>Character Slant</td>
<td>Supported</td>
</tr>
<tr>
<td>SR</td>
<td>Relative Character Size</td>
<td>Supported</td>
</tr>
<tr>
<td>SS</td>
<td>Select Standard Font</td>
<td>Not supported (only in HP-GL)</td>
</tr>
<tr>
<td>TD</td>
<td>Transparent Data</td>
<td>Not supported</td>
</tr>
</tbody>
</table>

## Technical Graphics Extension

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>BP</td>
<td>Begin Plot</td>
<td>Supported</td>
</tr>
<tr>
<td>CT</td>
<td>Chord Tolerance Mode</td>
<td>Supported</td>
</tr>
<tr>
<td>DL</td>
<td>Downloadable Character</td>
<td>Not supported</td>
</tr>
</tbody>
</table>
### Palette Extension

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>CR</td>
<td>Set Clr Rnge, Rel Clr Data</td>
<td>Supported</td>
</tr>
<tr>
<td>NP</td>
<td>Number of Pens</td>
<td>Supported</td>
</tr>
<tr>
<td>PC</td>
<td>Pen Color Assignments</td>
<td>Supported</td>
</tr>
<tr>
<td>SV</td>
<td>Screened Vectors</td>
<td>Supported</td>
</tr>
<tr>
<td>TR</td>
<td>Transparency Mode</td>
<td>Supported</td>
</tr>
</tbody>
</table>

---

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Support</th>
</tr>
</thead>
<tbody>
<tr>
<td>EC</td>
<td>Enable Cutter</td>
<td>Not supported</td>
</tr>
<tr>
<td>FR</td>
<td>Frame Advance</td>
<td>Not supported</td>
</tr>
<tr>
<td>MC</td>
<td>Merge Control</td>
<td>Partially Supported - programmable extensions ignored</td>
</tr>
<tr>
<td>MG</td>
<td>Message</td>
<td>Not supported</td>
</tr>
<tr>
<td>MT</td>
<td>Media Type</td>
<td>Not supported</td>
</tr>
<tr>
<td>NR</td>
<td>Not Ready</td>
<td>Not supported</td>
</tr>
<tr>
<td>OE</td>
<td>Output Error</td>
<td>Not relevant</td>
</tr>
<tr>
<td>OH</td>
<td>O/P Hard Clip Limits</td>
<td>Not relevant</td>
</tr>
<tr>
<td>OI</td>
<td>Output Identification</td>
<td>Not relevant</td>
</tr>
<tr>
<td>OP</td>
<td>Output P1 and P2</td>
<td>Not relevant</td>
</tr>
<tr>
<td>OS</td>
<td>Output Status</td>
<td>Not relevant</td>
</tr>
<tr>
<td>PS</td>
<td>Plot Size</td>
<td>Partially Supported - used only for setting P1 and P2</td>
</tr>
<tr>
<td>QL</td>
<td>Quality Level</td>
<td>Not supported</td>
</tr>
<tr>
<td>ST</td>
<td>Sort</td>
<td>Not relevant</td>
</tr>
<tr>
<td>VS</td>
<td>Velocity Select</td>
<td>Not relevant</td>
</tr>
</tbody>
</table>
### Dual Context Extension

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>Esc % # A</td>
<td>Enter PCL Mode</td>
<td>Not supported</td>
</tr>
<tr>
<td>Esc E</td>
<td>Reset</td>
<td>Supported -- Used in raster mode only</td>
</tr>
<tr>
<td>FI</td>
<td>Primary Font Select by ID</td>
<td>Not supported</td>
</tr>
<tr>
<td>FN</td>
<td>Sec. Font Selection by ID</td>
<td>Not supported</td>
</tr>
<tr>
<td>SB</td>
<td>Scalable or Bitmap Fonts</td>
<td>Not supported</td>
</tr>
</tbody>
</table>

### Digitizing Extensions

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>DC</td>
<td>Digitize Clear</td>
<td>Not supported</td>
</tr>
<tr>
<td>DP</td>
<td>Digitize Point</td>
<td>Not Supported</td>
</tr>
<tr>
<td>OD</td>
<td>Output Digitized point and pen status — Not Supported</td>
<td></td>
</tr>
</tbody>
</table>

### Advanced Drawing Extensions

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>BR</td>
<td>Bezier Relative</td>
<td>Supported</td>
</tr>
<tr>
<td>BZ</td>
<td>Bezier Absolute</td>
<td>Supported</td>
</tr>
<tr>
<td>MC</td>
<td>Merge Control</td>
<td>Partially Supported -- Programmable extensions ignored</td>
</tr>
<tr>
<td>PP</td>
<td>Pixel Placement</td>
<td>Not supported</td>
</tr>
</tbody>
</table>

### Advanced Text Extensions

<table>
<thead>
<tr>
<th>Code</th>
<th>Description</th>
<th>Status</th>
</tr>
</thead>
<tbody>
<tr>
<td>LM</td>
<td>Label Mode</td>
<td>Not supported</td>
</tr>
<tr>
<td>SB</td>
<td>Scalable or Bitmap Fonts</td>
<td>Not supported</td>
</tr>
</tbody>
</table>
Appendix D

PFS Files

Understanding PFS Files

PlotWorks Flexible Submission (PFS) files are ASCII text files used as order forms (electronic job tickets) for print jobs. PFS files use a set of keywords to specify PlotWorks printing parameters. PFS files can be created using any program that can produce ASCII text. You can use an existing program, such as a spreadsheet or word processor, or you can create your own custom interface. See “Sample User Interfaces” on page D-44.

When PlotWorks is installed, a DEFAULT.PFS file is placed in the PlotWorks/Param directory. Open this file in Windows Notepad to view it. It can be used as a template for creating custom PFS files.

PlotWorks Network Polling

PlotWorks accepts PFS files through Mode 3 of its Network Polling program. Network Polling also uses PFS files for setting directory-level default parameters in Modes 1 and 3.

The Network Polling program is used to create a set of directories to receive jobs submitted over local or wide area networks (LANs or WANs). These directories, called “target directories,” can reside on the PlotWorks Print Server (Hub) or on any network drive.

Network Polling polls target directories in four different modes. The following two modes use PFS files:

- **Mode 1** polls directories for individual image files. The images are printed according to the parameters contained in a directory-level PFS file.

- **Mode 3** polls directories for PFS files. These PFS files can contain all of the information needed to print a job. However, default PFS files can be used to fill in any information that is omitted from the incoming job, or to lock parameters against changes from the remote user (See “Locking Parameters” on page D-39). The software also copies the original PFS file into the Job Queue as “Submitted.PFS”.
• **Mode 5** polls directories for JOB files. These files can contain all of the information needed to print a job. However, default PFS files can be used to fill in any information that is omitted from the incoming job, or to lock parameters against changes from the remote user (See “Locking Parameters” on page D-39). The software also copies the original PFS file into the Job Queue as “Submitted.PFS”.

---

For more information on the Network Polling modes, refer to the Network Polling Help file included with your software.

---

When the Network Polling program finds jobs in a target directory, it sends them to a Job Queue for automatic processing and printing. PlotWorks processes print jobs based on the parameters set in the PFS files.
PFS File Types

There are three types of PFS files used. They are:

- **Site Level**
  Site level PFS files are optional files that provide defaults for all target directories in your site. These are the lowest level of PFS file and will be overridden by the other PFS files unless locked. See “Locking Parameters” on page D-39.

- **Directory Level**
  Directory level (parameter) PFS files are directory-specific. The directory PFS file is used to fill in parameters omitted from incoming PFS files, and to lock certain parameters so that they cannot be changed by the end user. See “Locking Parameters” on page D-39. Directory level PFS files override site level PFS files. PlotWorks copies the original PFS file into the Job Queue as “Submitted.PFS”. The converted PFS file created from the directory-level PFS is saved as [Queue Name].PFS.

- **Incoming PFS**
Incoming PFS files are created by end users and contain parameters for a single print job. Incoming PFS files will override directory-level default PFS files and site-level PFS files, except for locked parameters. “Locking Parameters” on page D-39.

**Directory-level Defaults**

Each Mode 1 and Mode 3 target directory uses a directory-specific PFS file to set default printing parameters. In Mode 3, the directory PFS file serves two purposes: to fill in parameters that are omitted from incoming PFS files, and to lock certain parameters so that they cannot be changed by the end user. See “Locking Parameters” on page D-39.

When you run Network Polling for the first time, PlotWorks creates a PARAM subdirectory inside the program directory. This subdirectory contains a file called DEFAULT.PFS. The DEFAULT.PFS file is your master PFS file.

Whenever you create a target directory, PlotWorks makes a copy of the DEFAULT.PFS to use as the directory PFS file. You can make changes to the directory PFS file without changing the original master file.

**To access a directory parameter (PFS) file:**

1. In the Network Polling window, select the directory that you want to modify.
2. Click on the **Params** button. The PFS file will open in Notepad.

To access the master PFS file from the Network Polling program, open the **Setup** menu and select **Edit Default PFS File**.

If you change the default PFS file, all target directories that you create in the future will reflect the changes.

Incoming PFS files will overwrite the parameters in the directory parameter file, unless the parameters are locked. If any parameters are omitted from the incoming PFS file, they will be filled in with the values specified in the directory-level default.

**Site-level Defaults**

You can create an optional site-level PFS file in addition to the directory-level defaults. This file will provide defaults for all target directories. The directory-level defaults will overwrite the site-level defaults, unless the site-level parameters are locked. See “Locking Parameters” on page D-39.

**To create a site-level PFS file:**

1. Using Notepad, create a PFS file with the desired default parameters.
2. Save the file as **PW-SITE.PFS** in the PARAM subdirectory.
PFS File Layout

Each section of a PFS file begins with the section type enclosed in square brackets. For example: [JOB]. Most PFS files (except for Mode 1) contain a JOB section and one or more FILE sections. These sections contain the keywords and values that define your printing parameters.

JOB section

The JOB section is the first section of the PFS file. PFS keywords specified in the JOB section are used to specify printing parameters that are applied to every file in the print job.

FILE section

The second type of section is the FILE section. You must create a separate FILE section for each file being printed. FILE sections within a job are differentiated by numbers (FILE.1, FILE.2, FILE.3, etc.) that represent individual files. Parameters defined in the FILE section apply only to that image.

When the same keyword appears in both a FILE section and the JOB section, the FILE values will override the JOB values for that particular file.

Keywords and Values

In PFS files, printing parameters are specified using a keyword followed by an equal sign (=) and a value or set of values. For example:

Quantity=2

The keyword “Quantity” signals that you are defining the quantity of copies to print. The value “2” tells PlotWorks to print two copies.

A small PFS file might look like this:

[JOB]
Contact=Joe Soap
Quantity=3
[FILE.1]
FileName=HOUSE.PLT
FinalSize=D
[FILE.2]
FileName=SHOP.PLT

This PFS file tells PlotWorks to print three D-size copies of HOUSE.PLT and three E-size copies of SHOP.PLT.
FinalSize=E

Text in a PFS file is not case-sensitive (i.e., pen is the same as PEN). PlotWorks ignores space and tab characters in PFS files as well as empty lines. Any text following a semi-colon (;) up until the end of a line is considered a comment and is also ignored by PlotWorks.

When you finish entering a keyword and its values, you must enter a carriage return before starting the next keyword. Do not use spaces or the arrow keys to get to the next line.
Defining Parameters

The table on the following pages describes the acceptable PFS file keywords and values, organized by the types of information they provide.

How to Use this Section

As you go through this guide, information that you should type appears in Courier type. Plain text describes the kind of information to enter. This guide describes acceptable values in several ways:

- Sometimes you can choose from a list of values to enter. For example:
  
  **SizeUnits=**inches, cm or mm
  
  For this field, you can set the units to *any one* of the values listed. For example, you might type: SizeUnits=mm

- Sometimes you will see a description of the information you should enter. For example:
  
  **Filename=**Name of an individual image file
  
  For this field you might type:
  
  Filename=HOUSE.DWG

- Some keywords require you to enter more than one value. For example:
  
  **Pen=**Number range, width, end style, pattern number, type, color
  
  For this field, you should enter all of the values requested, separated by commas. *If you skip one of these values, you must mark the field by entering a set of commas. Otherwise all subsequent parameters will be offset.* For example, you might type:
  
  Pen=all,5,RO,OP,140
  
  to skip the pattern number. If no commas are entered, PlotWorks will read OP (the pen type) as the pattern setting, which is invalid.

- Unless otherwise specified, any mentions of X,Y are referring to width and height.
Parameter Setting Requirements

You must specify your units of measure before entering measurement values (such as final size or pen width). If you use a measurement value without specifying a unit of measure, the default is used.

**Pens Data**

You must specify your Pen Units before entering any Pen Width values. If you do not specify a Pen Unit value, the width will default to 10 mils. Include the *PenUnit=* parameter in the PFS before entering the *Pen=* parameter.

**Example:**

```
[JOB]
PenUnits=mm
Pen=all,25,RO,OP,140
```

**Size Data**

You must specify your measurement units before entering “User-specified” size and offset values. If you enter a size without specifying a unit of measure, the value will default to inches.

**Example:**

```
[JOB]
SizeUnits=mm
```
### Keywords by Category

*Alias keywords can be used interchangeably with regular keywords.*

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Alias</th>
<th>Section</th>
<th>Description/Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Administrative Information</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Account=</td>
<td>JOB</td>
<td>JOB</td>
<td>Account number/name</td>
</tr>
<tr>
<td>Project=</td>
<td>JOB</td>
<td>JOB</td>
<td>Project name</td>
</tr>
<tr>
<td>Contact=</td>
<td>JOB</td>
<td>JOB</td>
<td>Contact person</td>
</tr>
<tr>
<td>Phone=</td>
<td>JOB</td>
<td>JOB</td>
<td>Contact person’s phone number</td>
</tr>
<tr>
<td>Comment=</td>
<td>JOB</td>
<td>JOB</td>
<td>Comments</td>
</tr>
<tr>
<td>Company=</td>
<td>JOB</td>
<td>JOB</td>
<td>Company name</td>
</tr>
<tr>
<td>Address1=</td>
<td>Address=</td>
<td>JOB</td>
<td>Street address</td>
</tr>
<tr>
<td>Address2=</td>
<td>City=</td>
<td>JOB</td>
<td>City</td>
</tr>
<tr>
<td>Address3=</td>
<td>State=</td>
<td>JOB</td>
<td>State or province</td>
</tr>
<tr>
<td>Address4=</td>
<td>Zip=</td>
<td>JOB</td>
<td>Zip or postal code</td>
</tr>
<tr>
<td>Address5=</td>
<td>Country=</td>
<td>JOB</td>
<td>Country name</td>
</tr>
<tr>
<td>ReceiptEmail=</td>
<td>JOB</td>
<td>JOB</td>
<td>This email address is to notify remote job submitters an acknowledgment that their job is received. This email address will display in the Job Queue, “Submitted By” column.</td>
</tr>
<tr>
<td>Keyword</td>
<td>Alias</td>
<td>Section</td>
<td>Description/Parameters</td>
</tr>
<tr>
<td>------------------</td>
<td>-------</td>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>ErrorEmail=</td>
<td></td>
<td>JOB</td>
<td>This email address is used to notify remote job submitters that a printing or processing error occurred. PLP recommends that long e-mail, or multiple e-mails not be used. Long e-mails will over write the contact information in the Job Queue.</td>
</tr>
<tr>
<td>PrintedEmail=</td>
<td></td>
<td>JOB</td>
<td>This email address is used to notify remote job submitters that their job has completed printing. PLP recommends that long e-mail, or multiple e-mails not be used. Long e-mails will over write the contact information in the Job Queue.</td>
</tr>
<tr>
<td><strong>Job Control</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Filename=</td>
<td>Name=</td>
<td>FILE</td>
<td>Enter the name of the image file</td>
</tr>
<tr>
<td>Directory=</td>
<td></td>
<td>JOB/FILE</td>
<td>Defines the default directory for all files in this job. Specifying directory does not cause the file to be deleted from the specified directory. Only those files placed in the Mode 3 target polling directory are deleted when the job is created.</td>
</tr>
<tr>
<td>SizeUnits=</td>
<td></td>
<td>JOB</td>
<td>Sets the units of measure. Use <strong>Inches</strong> (default), <strong>cm</strong> or <strong>mm</strong>.</td>
</tr>
<tr>
<td>Keyword</td>
<td>Alias</td>
<td>Section</td>
<td>Description/Parameters</td>
</tr>
<tr>
<td>-----------</td>
<td>-------</td>
<td>---------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Sets=</td>
<td></td>
<td>JOB</td>
<td>Number of sets to print (default = 1), up to 9999 (do not use a comma in large numbers). Example: Sets=1250.</td>
</tr>
<tr>
<td>Quantity=</td>
<td></td>
<td>JOB/FILE</td>
<td>Number of copies to print, up to 99 (default = 1). Enter X or 0 for overlay files or to skip files.</td>
</tr>
<tr>
<td>PageRange=</td>
<td>range</td>
<td>JOB/FILE</td>
<td>Selects the range of pages (in a multipage document) to print. Use All (default) or n-n. Example: PageRange=5-7</td>
</tr>
<tr>
<td>Media=</td>
<td></td>
<td>JOB/FILE</td>
<td>None, Bond (default), Vellum (or Vllm), Translucent (or Tbnd), and Film</td>
</tr>
<tr>
<td>Size=</td>
<td></td>
<td>JOB/FILE</td>
<td>* Calls for extra parameters: Size=User Specified, width, height, X offset, Y offset (using specified SizeUnits)</td>
</tr>
<tr>
<td>Keyword</td>
<td>Alias</td>
<td>Section</td>
<td>Description/Parameters</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------</td>
<td>---------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
*FinalSize=Percent*, percent to scale by  
**FinalSize=User Specified*, width, height (using specified SizeUnits) |
<p>| EnableMediaSize=      |       | JOB/FILE| If FinalSize is set to Percent, enables specification of a final media size. Enter <strong>Yes</strong> or <strong>No</strong> (default)                                        |</p>
<table>
<thead>
<tr>
<th>Keyword</th>
<th>Alias</th>
<th>Section</th>
<th>Description/Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Job Control (continued)</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>MediaSize=X,Y</td>
<td></td>
<td>JOB/FILE</td>
<td>If EnableMediaSize equals Yes, this specifies the final media size (in current SizeUnits).</td>
</tr>
<tr>
<td><strong>Format</strong></td>
<td></td>
<td>JOB/FILE</td>
<td>Print data format; choose one:</td>
</tr>
<tr>
<td>Auto-detected</td>
<td></td>
<td></td>
<td>For automatic detection</td>
</tr>
<tr>
<td>ACAD, units, removehidden-lines, reverse-zorder</td>
<td></td>
<td></td>
<td>Imperial (inches) or metric (cm, mm), removes lines (behind another plane) from a 3-D rendering (Yes or No), prints XREF files first (Yes or No)</td>
</tr>
<tr>
<td>DXF, units, removehidden-lines, reverse-zorder</td>
<td></td>
<td></td>
<td>Imperial (inches) or metric (cm, mm), removes lines (behind another plane) from a 3-D rendering (Yes or No), prints XREF files first (Yes or No)</td>
</tr>
<tr>
<td>DWF, dwf_resolution, dwf_auto_resolution, dwf_minimum_pen_width, dwf_password</td>
<td></td>
<td></td>
<td>For dwf_auto_resolution, select Yes or No.</td>
</tr>
<tr>
<td>HPGL, origin, resolution</td>
<td></td>
<td></td>
<td>Passwords for DWF files are entered as part of the FORMAT keyword.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Select lower-left or center origin, enter a plot coordinate resolution</td>
</tr>
<tr>
<td>Keyword</td>
<td>Alias</td>
<td>Section</td>
<td>Description/Parameters</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------</td>
<td>---------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Job Control (continued)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>HPGL/2, resolution</strong></td>
<td></td>
<td></td>
<td>Enter a plot coordinate resolution</td>
</tr>
<tr>
<td><strong>CCMP, step size, sync code, num syncs, eom, checksum</strong></td>
<td></td>
<td></td>
<td>(for CalComp 90x) Enter step size, sync code, num syncs (single or double), eom (end of message), checksum (Yes or No)</td>
</tr>
<tr>
<td><strong>CALS</strong></td>
<td></td>
<td></td>
<td>For CCITT Group 4 raster with CALS-type 1 header</td>
</tr>
<tr>
<td><strong>BMP</strong></td>
<td></td>
<td></td>
<td>For BMP Files</td>
</tr>
<tr>
<td><strong>DCX</strong></td>
<td></td>
<td></td>
<td>For DCX Files</td>
</tr>
<tr>
<td><strong>JPG</strong></td>
<td></td>
<td></td>
<td>For JPG Files</td>
</tr>
<tr>
<td><strong>XIF</strong></td>
<td></td>
<td></td>
<td>For XIF Files</td>
</tr>
<tr>
<td><strong>PCX</strong></td>
<td></td>
<td></td>
<td>For PCX Files</td>
</tr>
<tr>
<td><strong>VIC</strong></td>
<td></td>
<td></td>
<td>For VIC Files</td>
</tr>
<tr>
<td><strong>TIFF</strong></td>
<td></td>
<td></td>
<td>For TIFF Files</td>
</tr>
<tr>
<td><strong>CGM</strong></td>
<td></td>
<td></td>
<td>Computer Graphics Metafile format</td>
</tr>
<tr>
<td><strong>VRF</strong></td>
<td></td>
<td></td>
<td>For Versatec random format (Note: PenMacro= defaults to ‘PW’ with this format)</td>
</tr>
<tr>
<td>Keyword</td>
<td>Alias</td>
<td>Section</td>
<td>Description/Parameters</td>
</tr>
<tr>
<td>---------</td>
<td>-------</td>
<td>---------</td>
<td>------------------------</td>
</tr>
<tr>
<td><strong>Job Control (continued)</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>Format</strong></td>
<td></td>
<td>JOB/FILE</td>
<td>Enter a rasterization resolution or enter <strong>Yes</strong> to automatically determine a rasterization resolution of the file. Format=PDF,200,No</td>
</tr>
<tr>
<td><strong>Postscript</strong>, resolution, auto resolution yes/no</td>
<td></td>
<td></td>
<td>Enter a rasterization resolution or <strong>Yes</strong> to automatically determine a rasterization resolution of the file. Enter <strong>Yes</strong> or <strong>No</strong> to enable or disable automatically adding a Postscript “show page” if it seems to be missing. Sample: Postscript,200,No,Yes</td>
</tr>
<tr>
<td><strong>DGN</strong>, resolution</td>
<td></td>
<td></td>
<td>For MicroStation file format. Enter a plot coordinate resolution. Enter one of three values: <strong>On</strong>, <strong>Off</strong> or <strong>As-Is</strong> (default)</td>
</tr>
<tr>
<td><strong>DGN processing options</strong> (listed below):</td>
<td></td>
<td></td>
<td>Example: <strong>DGNCamera=As-Is</strong></td>
</tr>
<tr>
<td><strong>DGNCamera</strong>=</td>
<td></td>
<td></td>
<td>Enable or disable processing of DGN camera settings.</td>
</tr>
<tr>
<td><strong>DGN processing options</strong>, cont.</td>
<td></td>
<td>JOB/FILE</td>
<td>Enable or disable processing of DGN constructions.</td>
</tr>
<tr>
<td><strong>DGNConstructions</strong>=</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keyword</td>
<td>Alias</td>
<td>Section</td>
<td>Description/Parameters</td>
</tr>
<tr>
<td>---------------------</td>
<td>-------</td>
<td>---------</td>
<td>----------------------------------------</td>
</tr>
<tr>
<td>DGN-DataFields=</td>
<td></td>
<td></td>
<td>Enable or disable processing of DGN text placeholders.</td>
</tr>
<tr>
<td>DGNDimensions=</td>
<td></td>
<td></td>
<td>Enable or disable processing of DGN dimension labels.</td>
</tr>
<tr>
<td>DGNFastCells=</td>
<td></td>
<td></td>
<td>Enable or disable processing of DGN Fast Cells.</td>
</tr>
<tr>
<td>DGNFastCurves=</td>
<td></td>
<td></td>
<td>Enable or disable processing of DGN Fast Curves.</td>
</tr>
<tr>
<td>DGNFastFont=</td>
<td></td>
<td></td>
<td>Enable or disable processing of DGN Fast Fonts.</td>
</tr>
<tr>
<td>DGNFastRefClipping=</td>
<td></td>
<td></td>
<td>Enable or disable processing of DGN Fast RefClipping.</td>
</tr>
<tr>
<td>DGNFenceBoundary=</td>
<td></td>
<td></td>
<td>Enable or disable processing of DGN Fences.</td>
</tr>
<tr>
<td>DGNFill=</td>
<td></td>
<td></td>
<td>Enable or disable processing of DGN Fills.</td>
</tr>
<tr>
<td>DGNLevelSymbolology=</td>
<td></td>
<td></td>
<td>Enable or disable processing of DGN symbology.</td>
</tr>
<tr>
<td>DGNLineStyles=</td>
<td></td>
<td></td>
<td>Enable or disable processing of DGN line styles.</td>
</tr>
<tr>
<td>DGNLineWeights=</td>
<td></td>
<td></td>
<td>Enable or disable processing of DGN line weights.</td>
</tr>
<tr>
<td>DGNPatterns=</td>
<td></td>
<td></td>
<td>Enable or disable processing of DGN patterns.</td>
</tr>
<tr>
<td>DGNPlotBorder=</td>
<td></td>
<td></td>
<td>Enable or disable processing of DGN plot borders.</td>
</tr>
<tr>
<td>Keyword</td>
<td>Alias</td>
<td>Section</td>
<td>Description/Parameters</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Job Control (continued)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>DGNRef-Boundaries=</td>
<td></td>
<td></td>
<td>Enable or disable processing boundaries of a displayed reference file.</td>
</tr>
<tr>
<td>DGNTags=</td>
<td></td>
<td></td>
<td>Enable or disable processing of DGN tags.</td>
</tr>
<tr>
<td>DGNText=</td>
<td></td>
<td></td>
<td>Enable or disable processing of DGN text elements</td>
</tr>
<tr>
<td>DGNText-Nodes=</td>
<td></td>
<td></td>
<td>Enable or disable processing of DGN multiline text elements.</td>
</tr>
<tr>
<td>OutputQualityLevel=</td>
<td>JOB/FILE</td>
<td></td>
<td>Defines the output quality for some printers: <strong>Best, Normal</strong> (default), <strong>Draft</strong>. For Postscript and PDF, this keyword factors into determining a rasterization resolution when auto resolution is set to yes.</td>
</tr>
<tr>
<td>Mirror=</td>
<td>JOB/FILE</td>
<td></td>
<td>Mirror the image? Enter <strong>Yes</strong> or <strong>No</strong> (default).</td>
</tr>
<tr>
<td>ReversePrint=</td>
<td>JOB/FILE</td>
<td></td>
<td>Reverse the print order? <strong>Yes</strong> or <strong>No</strong> (default). This is desirable for printers which eject printed pages facedown.</td>
</tr>
<tr>
<td>BottomEdge=</td>
<td>JOB/FILE</td>
<td></td>
<td>Tells PlotWorks which edge of the image (as seen from the Viewer) will be used as the bottom. Can be <strong>Left, Right, Bottom</strong> (default), <strong>Top</strong>.</td>
</tr>
<tr>
<td>Keyword</td>
<td>Alias</td>
<td>Section</td>
<td>Description/Parameters</td>
</tr>
<tr>
<td>----------------------</td>
<td>-------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>RemoveBorders=</td>
<td>JOB</td>
<td>JOB</td>
<td>Remove trim line borders from prints? <strong>Yes</strong> or <strong>No</strong> (default).</td>
</tr>
<tr>
<td>OperatorHold=</td>
<td>JOB</td>
<td>JOB</td>
<td>Allows users to submit jobs to the queue on hold. Set this value to either <strong>Yes</strong> or <strong>No</strong></td>
</tr>
<tr>
<td>AutoCAD, DWG &amp; DXF File Setup</td>
<td></td>
<td>JOB/FILE</td>
<td>AutoCAD parameters where:</td>
</tr>
<tr>
<td>ACADparms=</td>
<td>JOB/FILE</td>
<td>JOB/FILE</td>
<td>Scale, plot by, view name, fill space</td>
</tr>
<tr>
<td>Scale</td>
<td></td>
<td>JOB/FILE</td>
<td>Scale is a valid AutoCAD scale, printed units = drawing units.</td>
</tr>
<tr>
<td>Plot By</td>
<td></td>
<td>JOB/FILE</td>
<td><strong>Plot By</strong> defines the boundaries of the drawing, and can be <strong>extents</strong> (default), <strong>display</strong>, <strong>limits</strong>, <strong>view</strong>, or <strong>layout</strong>.</td>
</tr>
<tr>
<td>View name</td>
<td></td>
<td>JOB/FILE</td>
<td><strong>View name</strong> is the name under which the view is saved. This value is used only when <strong>Plot By=View</strong> or <strong>Plot By=Layout</strong>.</td>
</tr>
<tr>
<td>Fill space (used with DWG Direct processing only)</td>
<td>FILE</td>
<td>FILE</td>
<td>Sets the space between vectors in a fill on AutoCAD drawings. (In current pen units)</td>
</tr>
</tbody>
</table>
### Pen Control

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Alias</th>
<th>Section</th>
<th>Description/Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>PenUnits=</td>
<td></td>
<td>JOB</td>
<td>mils (default), mm, 400-dpi, 300-dpi, or 200-dpi</td>
</tr>
<tr>
<td>Pen=</td>
<td></td>
<td>JOB/FILE</td>
<td>Pen definitions:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Pen number (e.g., 1), range (e.g., 1-5), or All</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>The width of the line, using the specified PenUnits</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>RO or round, SQ or square, BU or butt, EB or extended butt</td>
</tr>
<tr>
<td>Pattern</td>
<td></td>
<td></td>
<td>Enter a valid pattern number from the sample pattern sheets for your specific output device. Can be a percentage (from 1-100%) which results in a diffused dot pattern (on some printers) or an actual pattern number which results in an ordered dot dither pattern.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>OP or opaque, TR or transparent</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Enter a valid color number between 0 and 255 (this also works to change shades on grayscale printers)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Sample pen definition: Pen=all,5,RO,15,OP,140</td>
</tr>
</tbody>
</table>

**Type**

- **OP** or opaque
- **TR** or transparent

**Color**

Enter a valid color number between 0 and 255 (this also works to change shades on grayscale printers).
<table>
<thead>
<tr>
<th>Keyword</th>
<th>Alias</th>
<th>Section</th>
<th>Description/Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pen Control (continued)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keyword</td>
<td>Alias</td>
<td>Section</td>
<td>Description/Parameters</td>
</tr>
<tr>
<td>--------------</td>
<td>-------</td>
<td>---------</td>
<td>------------------------</td>
</tr>
<tr>
<td>PenMacro=</td>
<td></td>
<td>JOB/FILE</td>
<td>B forces a bilevel representation of colors (black &amp; white)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>G prints the grayscale representation of colors in HP-GL/2 files</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>H Prints the entire image using the highlight color, if available (red on the Xerox MAX 200 and 8180)</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>P Enables printing using embedded pen description. When printing HPGL/2 files with embedded pen colors, to extract the color data.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>W enable printing using embedded pen widths</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>WP (default) enable both</td>
</tr>
<tr>
<td></td>
<td>*</td>
<td></td>
<td>~ Reapplies patterns when scaling</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>A Flattens all color pixels to solid black</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>C Use color definitions from the HP-GL/2 file instead of the pen set.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>E Fill pen strokes with patterns defined in the HP-GL/2 file instead of the pen set.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>F Use fill screens and patterns defined in the HP-GL/2 file instead of the pen set.</td>
</tr>
<tr>
<td>Keyword</td>
<td>Alias</td>
<td>Section</td>
<td>Description/Parameters</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------</td>
<td>---------</td>
<td>------------------------</td>
</tr>
<tr>
<td>Pen Control (continued)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Keyword</td>
<td>Alias</td>
<td>Section</td>
<td>Description/Parameters</td>
</tr>
<tr>
<td>-------------</td>
<td>-------</td>
<td>---------</td>
<td>------------------------</td>
</tr>
<tr>
<td>ScalePens=</td>
<td></td>
<td>JOB/FILE</td>
<td>Scale pens with image? No (default) or Yes</td>
</tr>
</tbody>
</table>

- **I** Invert the entire output sheet including overlays, watermarks etc.
- **J** Use the HP-GL/2 Plot Size((PS) Command) instead of the drawings extents.
- **K** Emulate output from Repro Desk.
- **M** Enables multiple color planes (Xerox MAX 200, 8180, Color Windows, and Color RTL printers only). If you want to print red components of colors used in files on the red plane then the “M” macro (multiple planes) must be used.

Example: If you want the Xerox MAX 200 or 8180 to print a red and black representation of the colors in a file, use **PenMacro=WPM**

Example: If you want the 8180 to print a red and black representation of the colors in an HP-GL/2 file, use **PenMacro=WPM**
<table>
<thead>
<tr>
<th>Keyword</th>
<th>Alias</th>
<th>Section</th>
<th>Description/Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Pen Control (continued)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>N Ensures RTL raster data is not scaled.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>O Forces dot patterns to ordered dither</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>D Forces dot patterns to diffused dither</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>U Forces dot patterns to reduced-coverage ordered dither</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>R Forces diffused dithering for raster images.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Z Forces progressive pattern-dithering for raster images.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Q Use pen 0 &amp; 1 in the RTL palette to determine the color of 0 &amp; 1 pixels for monochrome raster blocks.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>T Use merge control &amp; transparency data from the HP-GL/2 files not the pen set.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>V Use line end data from the HP-GL/2 files not the pen set.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>X Flattens all vector pens to a solid color on each color plane.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Y Use alternate (even/odd) fills instead of the fill type specified in the HP-GL/2 file.</td>
</tr>
</tbody>
</table>
## Pen Control (continued)

Print the short edge first.  
Print the long edge first.

### Folding (DOS Aliases)

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Alias</th>
<th>Section</th>
<th>Description/Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FoldEnable</strong></td>
<td></td>
<td>JOB</td>
<td>Enable folding? <strong>Yes</strong> or <strong>No</strong> (default).</td>
</tr>
<tr>
<td><strong>FirstFold</strong></td>
<td>BayFoldEnable=</td>
<td>JOB</td>
<td>Set equal to <strong>Yes</strong> or <strong>No</strong>. Yes enables the first fold. The default value is No. Check the folder specifications to see whether the first fold is the crossfold or fanfold.</td>
</tr>
<tr>
<td><strong>SecondFold</strong></td>
<td>BayCrossfold=</td>
<td>JOB</td>
<td>Set equal to <strong>Yes</strong> or <strong>No</strong>. Yes enables the second fold. The default value is No. Check the folder specifications to see whether the second fold is the crossfold or fanfold.</td>
</tr>
<tr>
<td><strong>FoldMarginEnable</strong></td>
<td></td>
<td>JOB</td>
<td>Set equal to <strong>Yes</strong> or <strong>No</strong>. Yes enables the folder’s margins? The default value is No.</td>
</tr>
<tr>
<td><strong>FoldMargin</strong></td>
<td>BayMargin=</td>
<td>JOB</td>
<td>Specify a value for the fold margin depending on the size units selected.</td>
</tr>
<tr>
<td><strong>FoldPunching</strong></td>
<td>BayPunching=</td>
<td>JOB</td>
<td>Enable hole punching for folder? (Not available with all folders) <strong>Yes</strong> or <strong>No</strong> (default)</td>
</tr>
</tbody>
</table>
### Folding
(Continued)

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Alias</th>
<th>Section</th>
<th>Description/Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>FoldWidth</strong></td>
<td></td>
<td>JOB</td>
<td>Enter the width of the folded area (using the selected units of measure).</td>
</tr>
<tr>
<td><strong>FoldReinforce</strong></td>
<td>BayStripping=</td>
<td>JOB</td>
<td>Enable reinforcement strip? (Not available with all folders) <strong>Yes</strong> or <strong>No</strong> (default)</td>
</tr>
</tbody>
</table>
| **FinishingMacro** |                  | JOB     | Selects the desired fold type or folding card. Available values are:  
  *Xerox MAX 200 and 8180 folders:*  
  *American and Far Eastern Hardware:*  
  Blank = Fanfold  
  C = Crossfold  
  S = Special fold  
  *European Hardware Options:*  
  C= Crossfold  
  B = Din B fold |
<table>
<thead>
<tr>
<th>Keyword</th>
<th>Alias</th>
<th>Section</th>
<th>Description/Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Folding (Continued)</td>
<td>(DOS Aliases)</td>
<td></td>
<td>8845 folder&lt;br&gt;1 = Forces use of 1st folding card&lt;br&gt;2 = Forces use of 2nd folding card</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>All folders&lt;br&gt;L = Forces landscape output from printer for proper folding&lt;br&gt;(except sizes E, E1, E2, and A0)&lt;br&gt;P = Forces portrait output from printer for proper folding</td>
</tr>
<tr>
<td>FolderName=</td>
<td></td>
<td></td>
<td>GFI folder setting&lt;br&gt;The name of the GFI folder exactly as it appears in the FPF file.</td>
</tr>
<tr>
<td>FoldProgram =</td>
<td></td>
<td></td>
<td>GFI folder setting&lt;br&gt;The numeric value of the folding program exactly as it appears in the FPF file.</td>
</tr>
<tr>
<td>OutputBin=</td>
<td></td>
<td></td>
<td>GFI folder setting&lt;br&gt;The numeric value of the output bin exactly as it appears in the FPF file.</td>
</tr>
<tr>
<td>Keyword</td>
<td>Alias</td>
<td>Section</td>
<td>Description/Parameters</td>
</tr>
<tr>
<td>-----------------------</td>
<td>-------</td>
<td>---------</td>
<td>----------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>TitleBlockLocation=</td>
<td></td>
<td></td>
<td><em>GFI folder setting</em> Specify either Don'tCare, LowerLeft, LowerRight, UpperRight, or UpperLeft as the title block location.</td>
</tr>
<tr>
<td>Keyword</td>
<td>Alias</td>
<td>Section</td>
<td>Description/Parameters</td>
</tr>
<tr>
<td>------------------</td>
<td>-------</td>
<td>-----------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Overlay Control</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Overlay=overlay number,filename,x offset, y offset</td>
<td>Ref=</td>
<td>JOB/FILE</td>
<td>Specifies the location and origin of an overlay file. This file will overlay the main file. If defined in the JOB section, it will overlay every file within the job. If defined in the FILE section, it will only overlay the current file. Definitions in the FILE section will take precedence over entries in the JOB section for the current file only (i.e., the next file again defaults to the entries in the Job section).</td>
</tr>
<tr>
<td>Where:</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Number</td>
<td></td>
<td>JOB/FILE</td>
<td>Enter the number of the overlay image (1 to 10 images)</td>
</tr>
<tr>
<td>Filename</td>
<td></td>
<td>JOB/FILE</td>
<td>Enter the name of overlay image (do not include a path)</td>
</tr>
<tr>
<td>X origin</td>
<td></td>
<td>JOB/FILE</td>
<td>Enter the X origin of overlay image</td>
</tr>
<tr>
<td>Y origin</td>
<td></td>
<td>JOB/FILE</td>
<td>Enter the Y origin of overlay image</td>
</tr>
</tbody>
</table>

Overlay Control (continued)
<table>
<thead>
<tr>
<th>Keyword</th>
<th>Alias</th>
<th>Section</th>
<th>Description/Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>OverlaysRelative=</td>
<td></td>
<td>JOB</td>
<td>Scale, size, clip, and offset overlay images relative to the main image. Enter Yes (default) or No</td>
</tr>
<tr>
<td>Nesting Controls</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Nesting=</td>
<td></td>
<td>JOB</td>
<td>Enables you to nest (combine) images on one sheet of medium to save media. Enter Yes (to enable) or No (default)</td>
</tr>
<tr>
<td>NestingBorder= border</td>
<td>NestingSize=</td>
<td>JOB</td>
<td>Defines the space between the borders of each nesting image. Defaults to 0.5 inches. Note: Default maximum nest length is 36 inches.</td>
</tr>
<tr>
<td>MaxFiles=count</td>
<td></td>
<td>JOB</td>
<td>Define the maximum number of images to nest at once (up to 100). Default is 1.</td>
</tr>
<tr>
<td>Margins</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Margin=left, top, right, bottom</td>
<td></td>
<td>JOB/FILE</td>
<td>Enter the margin width(s) using specified SizeUnits). Default is 0.5.</td>
</tr>
<tr>
<td>EnableFinishing-Margin= yes or no</td>
<td>EnableMargin-Striping=</td>
<td>JOB/FILE</td>
<td>Enables or disables the finishing margin. Enter Yes or No (default)</td>
</tr>
<tr>
<td>FinishingMargin=value</td>
<td></td>
<td>JOB/FILE</td>
<td>Enter the width of the finishing margin (using specified Size-Units). Default is 0.0 inches.</td>
</tr>
<tr>
<td>Keyword</td>
<td>Alias</td>
<td>Section</td>
<td>Description/Parameters</td>
</tr>
<tr>
<td>--------------</td>
<td>-------</td>
<td>----------</td>
<td>-------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Justification</strong>= orientation</td>
<td></td>
<td>JOB/FILE</td>
<td>Specifies where the leading edge of the image is to be justified. Default is center. Values: lower left, lower right, upper left, upper right, center, top, bottom, left, right</td>
</tr>
<tr>
<td><strong>Watermarks</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WatermarkText= text</td>
<td></td>
<td>JOB/FILE</td>
<td>Enter the text to be used as the watermark, up to 80 characters.</td>
</tr>
<tr>
<td>WatermarkDirection=direction</td>
<td></td>
<td>JOB/FILE</td>
<td>Enter the desired watermark placement: UpperRight (default): angle from lower left to upper right. LowerRight: angle from upper left to lower right. Down: read from top to bottom Right: read from left to right</td>
</tr>
</tbody>
</table>
### WatermarkFont

- **FontName**: Name of font (i.e. Times New Roman (default), etc.).
- **Size**: Size of the font: **Small**, **Medium** (default), or **Large**.

**Keyword** | **Section** | **Description/Parameters**
--- | --- | ---
**Watermarks (continued)** |  |  
**WatermarkFont** = FontName, Size, PenColor, PenPattern, Style, CharacterSet, FontMappingLevel, FontPitch, FontFamily | JOB/FILE | Defines the watermark font attributes. 

*Where:*
- FontName:
- Size:
<table>
<thead>
<tr>
<th>Keyword</th>
<th>Alias</th>
<th>Section</th>
<th>Description/Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>Watermarks (Continued)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>WatermarkFont (continued)</td>
<td></td>
<td>JOB/FILE</td>
<td>Enter desired pen color (default = black) from available Windows colors.</td>
</tr>
<tr>
<td>PenColor:</td>
<td></td>
<td></td>
<td>Enter a pen pattern. Can be a number (default = 1) or a percentage (0% - 100%).</td>
</tr>
<tr>
<td>PenPattern:</td>
<td></td>
<td></td>
<td>Sets the style of the font: (0 = \text{regular}) (default) (1 = \text{bold}) (2 = \text{italics}) These values can be added together for different effects, i.e., bold/italics = 3 (1+2).</td>
</tr>
<tr>
<td>Style:</td>
<td></td>
<td></td>
<td>Defines the character set of the font: \text{Ansi, Default, Baltic, ChineseBig5, EastEurope, GB2312, Greek, Hangul, Mac, OEM, Russian, ShiftJIS, Symbol, Turkish, Johab, Hebrew, Arabic, or Thai.}</td>
</tr>
<tr>
<td>CharSet:</td>
<td></td>
<td></td>
<td>Sets the level of font matching desired: \text{Any} (will substitute any font), \text{Normal} (default - substitutes a font close to the font used), or \text{Strict} (which looks for the font that most closely resembles the font used).</td>
</tr>
<tr>
<td>Keyword</td>
<td>Alias</td>
<td>Section</td>
<td>Description/Parameters</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Watermarks (continued)</td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

| WatermarkFont (continued)     |       | JOB/FILE| Specifies the pitch: **Fixed-Pitch**, **VariablePitch**, or **DefaultPitch**.            |
| FontPitch:                    |       |         |                                                                                       |

| FontFamily:                   |       |         | Specifies the font family: **DecorativeFamily**, **DontCareFamily**, **ModernFamily**, *RomanFamily*, **ScriptFamily**, or **SwissFamily** |
### Label Control

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Alias</th>
<th>Section</th>
<th>Description/Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>LabelFont</strong> = FontName, Size, PenColor, PenPattern, Style, CharacterSet, FontMappingLevel, FontPitch, FontFamily</td>
<td></td>
<td>Defines the label font attributes.</td>
<td></td>
</tr>
</tbody>
</table>

**Where:**
- **FontName:** Name of font (i.e., Times New Roman (default), etc.).
- **Size:** Size of the font: **Small**, **Medium** (default), or **Large**.
- **PenColor:** Enter desired pen color (default = black) from available Windows colors.
<table>
<thead>
<tr>
<th>Keyword</th>
<th>Alias</th>
<th>Section</th>
<th>Description/Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Label Control (continued)</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td><strong>LabelFont (cont.)</strong></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>PenPattern:</td>
<td></td>
<td></td>
<td>Enter a pen pattern. Can be a number (default = 1) or a percentage (0% - 100%).</td>
</tr>
<tr>
<td>Style:</td>
<td></td>
<td></td>
<td>Sets the style of the font: 0 = regular (default) 1 = bold 2 = italics These values can be added together for different effects, i.e., bold/italics = 3 (1+2).</td>
</tr>
<tr>
<td>CharSet:</td>
<td></td>
<td></td>
<td>Defines the character set of the font: Ansi, Default, Baltic, ChineseBig5, EastEurope, GB2312, Greek, Hangul, Mac, OEM, Russian, ShiftJIS, Symbol, Turkish, Johab, Hebrew, Arabic, or Thai. Sets the level of font matching desired: Any (will substitute any font), Normal (default - substitutes a font close to the font used), or Strict (which looks for the font that most closely resembles the font used).</td>
</tr>
<tr>
<td>Keyword</td>
<td>Alias</td>
<td>Section</td>
<td>Description/Parameters</td>
</tr>
<tr>
<td>-------------------------</td>
<td>-------</td>
<td>---------</td>
<td>---------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Label Control (continued)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>LabelFont (cont.)</td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>FontPitch:</td>
<td></td>
<td></td>
<td>Specifies the pitch: Fixed-Pitch, VariablePitch, or DefaultPitch.</td>
</tr>
<tr>
<td>FontFamily:</td>
<td></td>
<td></td>
<td>Specifies the font family: DecorativeFamily, DontCareFamily, ModernFamily, RomanFamily, ScriptFamily, or SwissFamily</td>
</tr>
<tr>
<td>LabelRotation = value</td>
<td>JOB/FILE</td>
<td></td>
<td>Defines the rotation of the label block.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>Valid values are 0 (default), 90, 180, and 270.</td>
</tr>
<tr>
<td>LabelOffset = X, Y</td>
<td>JOB/FILE</td>
<td></td>
<td>Specifies where to place the label relative to the origin of the image (in SizeUnits).</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>All values are floating point and go by units of measure.</td>
</tr>
</tbody>
</table>
### Label Control (continued)

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Alias</th>
<th>Section</th>
<th>Description/Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>LabelText = text</td>
<td></td>
<td>JOB/FILE</td>
<td>Enter the wording of the label (on a single line), up to 255 characters. Text can include the macros: [DATE], [TIME], [JOB], [SET], [FILENAME], [PATH], [COPY], [IMAGE], [COMPANY], [PROJECT], [CONTACT], [CR], [LF], [FF], [ESC]</td>
</tr>
</tbody>
</table>

### Log File Data

<table>
<thead>
<tr>
<th>Keyword</th>
<th>Alias</th>
<th>Section</th>
<th>Description/Parameters</th>
</tr>
</thead>
<tbody>
<tr>
<td>LogFile=</td>
<td></td>
<td>JOB</td>
<td>Path and name of the log file. If this file does not exist, PlotWorks creates it.</td>
</tr>
<tr>
<td>WriteLog=text</td>
<td></td>
<td>JOB</td>
<td>Enter the text to insert in the log file.*</td>
</tr>
</tbody>
</table>
If you do not want a default value changed, type `Lock.` before the keyword.

For example:
`Lock.Media=Bond` sets the media type to Bond.
Advanced Features

PFS files can include a variety of special keywords and values for customizing your jobs and performing advanced functions. The following sections explain how to insert dynamic data into PFS files, automatically open and write to text files, and add comments that can be parsed out for later use.

Special Fields

You can insert special fields within your values to signal that data should be substituted before output. These fields are particularly useful in WriteLog= or WriteFile= statements.

For example, a line containing the following...

WriteLog=ACME Repro: [DATE] at [TIME]

... might show up in the log file as...

ACME Repro: 10/30/97 at 10:53

The following are acceptable as special fields:

[DATE] translates to the current date as it is formatted in Windows Control Panel: Regional Settings on the PlotWorks server. In the U.S., MM/DD/YY is the default form. However, in Europe the format is DD/MM/YY. The date format can be changed by adding an optional string after the word DATE, separated by a colon (:). The following substitutions are valid:

YY= Year (e.g., 97)
YYYY= Year (e.g., 1997)

If you want to ensure that your PFS files are “year 2000 compliant,” use the four-digit year format: YYYY.

MM= Numeric Month (e.g., 02)
MMM = Month, 3-letter abbreviation (e.g., Feb)
DD= Day (e.g., 24)
WWW= Weekday, 3-letter abbreviation (e.g., Sat)

For example, [DATE: WWW: DD-MMM-YYYY] would become:

Sat: 30-Oct-1997

[TIME] translates to the current time in hours:minutes form. All time settings are based on local time as specified in the Windows Control Panel: Regional Settings on the PlotWorks server.

[FF] translates to the “Form Feed” ASCII character (WriteLog and WriteFile fields only).
[CR][LF] translates to the “Carriage Return” ASCII character.

[ESC] translates to the “Escape” ASCII character.

The following fields can only be used in the [FILE] section (Mode 3 only):

[PFSFILE] translates to the path and filename of the directory-level PFS file.

[FILENAME] translates to the last image filename processed by PFS on a
Filename= statement.

[FILESIZE] translates to the size, in bytes, of the [FILENAME] file.

Open and Write to a File

The WriteFile option lets you create up to four text files for each print job. The files can contain any text you wish to include, as well as any of the special fields described on page D-40. The WriteFile appears as soon as a job has been submitted from Network Polling to the Job Queue. Therefore, it could be used to signal a networked CAD user that the job has been submitted for printing. The WriteFile option uses three keywords:

OpenFile=I.D. number, filename, mode

Where...

I.D. number is the number of the file being opened. It can be 1, 2, 3, or 4. You can open up to four files at once.

Filename represents the name of the text file. If this file does not exist, PlotWorks creates it.

Mode is used when the specified text file already exists. The mode can be New (to overwrite the existing file) or Append (to append the text to the end of the existing file).

All OpenFile commands must be entered in the [JOB] section of your PFS file.

WriteFile=I.D. number (same as in OpenFile), text (the text that you want to log.)

You can enter this field in the JOB section, or in one or more of the [FILE] sections. You can also include special fields within the text. (See “Special Fields” on page D-26.)

CloseFile=I.D. number (same as in OpenFile).
Printing a Job (Network Polling Mode 3)

Once you have created a PFS file, you can send your job to a Network Polling target directory for automatic processing and printing.

Sending Jobs to a Target Directory

To submit a job:
1. Once you have defined your printing parameters, save the ASCII text file using the .PFS filename extension.

Copy your image files to the target directory first. Otherwise, Network Polling might send your job to the Queue before you have transferred all of the files. If you have specified the path to your images by using the Directory= keyword, and they can be accessed from the computer that Network Polling is running on, you can skip this step.

2. Copy your PFS file to the target directory. The Network Polling program will transfer your job to the Job Queue.

The Polling Log File

When a job is sent to any Polling directory, an entry is added to the Polling log file. This file records all of the jobs sent to the Network Polling program. The location of this log file is specified in the Polling Options dialog box under the Setup menu within the Network Polling program.

To view the Polling Log:
1. Open the Network Polling program.
2. Open the Setup menu and select View Log. The log file opens into Notepad.

Sample PFS Files

There is a sample PFS file provided in your PlotWorks Samples folder. You can make edits to the file and save it as a directory or site PFS file or use it as a template for creating incoming PFS files. To view the sample file, open it in Windows Notepad. If you make any changes to it, please remember to save it with a new name.
Incoming PFS File

The following file is an example of a job submitted to a target directory from a remote user.

[JOB]
;:ACME: Job from the ACME CAD output processor
Company=ACME CAD
Account=165AC
Sets=3

[FILE.1]
FileName=DRG01222.PLT
Quantity=2
FinalSize=A4

[FILE.2]
FileName=DRG01223.PLT
Quantity=2
FinalSize=A3

[FILE.3]
FileName=DRG01224.PLT
Quantity=3
FinalSize=A3
Sample User Interfaces

You can use VisualBasic, Microsoft Access, etc., to create a graphical user interface for creating and submitting PFS files to PlotWorks. This interface can be customized for your particular computing platform and can contain any fields you wish to include. Remote users can easily submit their print jobs by filling out this “job ticket.”

The following pages show examples of possible interface designs. After each example is a copy of the PFS file generated by that particular template.

Sample Windows Interface

The following screen is a sample order form created as a standard Windows interface.

PFS File Created from Windows Interface

[JOB]
:-PFS job generated by PW-WIN program
:-PFS file: c:\demo\plots\scan4\JOB-0014.PFS
Contact=John B. Smith
Company=XYZ Systems
Account=1234546
Project=entry for project 2
Comment=Deliver by 4 p.m. Thursday
WriteLog=[FF] JOB: JOB-001
WriteLog=SUBMITTED BY
WriteLog=John B. Smith, XYZ Systems
WriteLog=NOTE INSTRUCTIONS:-
WriteLog=Deliver by 4 p.m. Thursday
WriteLog=**THIS JOB IS BILLABLE**
WriteLog=DISTRIBUTION:-
WriteLog=* 1 set to: engineering supervisor
WriteLog=* 1 set to: management
WriteLog=* 3 sets to: distrib list 4
Sets=5
ReversePrint=Yes
Mirror=No
FinalSize=A0-P
Media=Bond
[FILE.1]
Quantity=1
FileName=JOB-0014.F01
;File: JOB-0014.F01 was originally C:\DEMOPLP\SAMPLES\SAMPLE1.CC
[FILE.2]
Quantity=1
FileName=JOB-0014.F02
;File: JOB-0014.F02 was originally C:\DEMOPLP\SAMPLES\SAMPLE2.HP

**Sample Excel Interface**

This interface contains several worksheets that you can access by clicking on tabs along the bottom of the window. The program opens into the main menu worksheet shown below (Fig. 6.2).

The screen shown in Fig. 6.3 shows the Files sheet, which lets users add files to a print job and specify basic printing parameters.
**PFS File Created from Excel Interface**

```
[JOB]
:-Created by XYZ Excel example
:-4/15/96 4:12:17 PM
:-Start of JOB data -
RemoveBorders=No
Quantity=1
```
Account=ACC123
Project=PRJ001
Contact=XYZ Excel test
Company=XYZ Systems
Address1=2300 Clarendon Blvd.
Address2=Arlington
Address3=Virginia
Address5=USA
Directory=c:\demo\plots\scan4

;Start of FILES data -

[FILE.1]
FileName=SAMPLE.G4
Quantity=1
Mirror=Yes
FinalSize=a4

[FILE.2]
FileName=SAMPLE.CC
Quantity=2
FinalSize=a4

[FILE.3]
FileName=SAMPLE2.HP
Quantity=3
FinalSize=a3
Appendix E

Configuring RAS to Output PlotWorks Job Files

This appendix provides step-by-step instructions on configuring your workstation to output files using Remote Access Services (RAS) and Dial-Up Networking (DUN). The first section, Install & Configure a Remote Access Server (Hub), details the installation and setup of the Print Server at the service bureau. The next two sections detail configuring RAS for Windows NT clients and DUN for Windows 95 clients.

PlotWorks Client users: These instructions use NetBEUI as the network protocol. However, your service bureau might require a different protocol. If so, instructions for installing other network protocols are given in Installing Network Protocols (Windows NT) and Installing Network Protocols (Windows 95). Please check with your service bureau before beginning.

You must have Administrator permission to install or configure some of the necessary options.

Service Bureaus: These instructions use NetBEUI as the network protocol. If you prefer to use a different protocol, such as IPX/SPX or TCP/IP, for your RAS service please refer to Installing Network Protocols (Windows NT) and Installing Network Protocols (Windows 95). Please provide the following information to the clients who will be submitting files by RAS or DUN to your Print Server:

• The print server’s phone number
• The network protocol(s) installed on the print server
• The full UNC path to the network polling directory on the print server
• The RAS user account and password they are to use for dialing in to the print server

If the user account you are creating belongs to a Windows 95 client, the username must be the same as the user’s Windows/Networking name.
Install & Configure a Remote Access Server (Hub)

This section provides you, the service bureau, with step-by-step instructions on how to configure the print hub, or server, to use RAS for receiving PlotWorks job files (.PLP) from your clients. Make notes as you go along so that you can provide your clients:

- The name and phone number of the print hub
- The network protocol used by the hub
- Dial in user name
- A password

The steps required in the installation and configuration of a RAS server are:

- Install/configure Remote Access Service
- Set up RAS user accounts
- Set up sharing on a local print queue directory

These instructions assume you have a working knowledge of Windows NT navigation and program installation. The steps below take you through installing and configuring Remote Access Service (RAS) using the NetBEUI network protocol. If you wish to use a different protocol, please refer to Installing Network Protocols (Windows NT) at the back of this appendix.

Verify Current Configuration

The first thing you should do is to make sure the required options are installed. All options can be verified within the Network dialog box, shown below.
To see if Remote Access Service, a modem, NetBEUI (or other) protocol, and the Loopback Adapter are installed:

1. Click the Windows **Start** button, click **Settings**, click **Control Panel**, and double-click **Network**. The Network dialog box displays.

2. Click the **Protocols** tab. Look to see if **NetBEUI** (or other protocol) is listed. The network protocol must be installed first. If there is not a network protocol installed, go to See “Installing Network Protocols (Windows NT)” on page G-18. and follow the instructions to install the appropriate network protocol.

3. Click the **Services** tab. Look to see if **Remote Access Service** is listed.

   If so, click **Remote Access Service** and click the **Properties** button to display the RAS Setup dialog box. If a modem is listed, click **Network** to verify what protocol is selected for the **Server Settings**. Click **Cancel** to close the Server Settings and click **Configure**. Verify that **Port Usage** is set to **Receive calls only** then click **Cancel** twice.

If RAS is not installed, go to **Install RAS** below. The RAS installation process will automatically install the MS Loopback Adapter. You will then need to install NetBEUI, if it is not already installed. Go to “Installing Network Protocols (Windows NT)” on page G-18 for more information.
4. Click the **Adapters** tab. Look to see if **MS Loopback Adapter** is listed.

*If it is not listed, please go to “Installing the MS Loopback Adapter” on page G-24 and follow the installation instructions.*

**Install RAS**

At different times during installation you might be asked to insert the Windows NT Installation disk(s) in your computer. Please have the Windows NT CD or Installation Disks ready.

*If you are currently on a Local Area Network (LAN), please contact your Network Administrator before proceeding. If an available option is not mentioned here, please accept the default setting.*

**To install Remote Access Service on your Windows NT 4.0-based computer:**

1. If not already viewing the Network dialog box, click the Windows **Start** button, click **Settings**, click **Control Panel**, and double-click **Network**. The Network dialog box displays (previous page).

2. Click the **Services** tab.

3. Click **Add** to and select **Remote Access Service** from the list of displayed services.

4. Click **OK** and follow the screen prompts. You might also be prompted to insert the Windows NT 4.0 installation disk (CD or diskette).

   The Remote Access Setup program copies some files and then prompts you to select a modem to be used for the RAS Device.

5. In the list of RAS-capable devices, click the modem you have installed, and then click **OK**.
6. Click **Configure** to display the Configure Port Usage dialog box.

7. In the Port Usage box, click **Receive calls only**, and click **OK** to return to the Remote Access Setup dialog box.

8. Click **Network** to display the Network Configuration dialog box.

*Any protocols that are currently installed will be selected by default. If you select a protocol that is not currently installed, it will automatically be installed with RAS.*
If you select TCP/IP you might have to configure a Static Address Pool. See your network administrator or the Microsoft Windows documentation for assistance.

9. Click NetBEUI in the Server Settings box, and then click Configure. The RAS Server NetBEUI Configuration dialog box displays:

10. Click This computer only and click OK.

11. Click Continue. You might be prompted again for the Installation Disk. If using IPX/SPX, you might also be asked if you want to enable NetBIOS Broadcast Propagation. Click Yes to continue.

12. You might be asked to install the MS Loopback Adapter. If so, accept and go to “Installing the MS Loopback Adapter” on page G-24 for more information.

13. Click Restart when prompted to restart your computer and finish the installation.
IMPORTANT NOTE: If you have installed a Service Pack on your Windows NT-based computer, you must reapply the Service Pack after restarting your computer and before using RAS.

Create User Accounts for Remote Access Service

The next step in setting up your RAS host (server) is to create a user account for each client that will be submitting files to your Print Hub.

To create a user account:

1. Click the Windows Start button, click Programs, click Administrative Tools, and then click User Manager.
2. Select New User from the User menu. The New User setup dialog box displays:

   ![New User setup dialog box](Fig. E.6)

3. Enter a Username, Password and Password confirmation. Full Name and Description are optional.

   ![New User setup dialog box](Fig. E.6)

   If the user account you are creating belongs to a Windows 95 client, the username must be the same as the user's Windows/Networking name.

4. Deselect the box next to User Must Change Password at Next Logon, then select the check boxes next to User Cannot Change Password and Password Never Expires to select them.
5. Click the Dialin button on the bottom of the dialog box. The Dialin Information dialog box displays.
6. Click **Grant dialin permission to user** then click OK.
7. Click **OK** again.
8. Continue adding new user accounts or exit from the User Manager window.

**Create Shared Folders**

It is very important to set up a folder into which your clients will submit their .PLP print jobs. You can share your default Job Queue folder, or create a separate folder for each client and set Network Polling to watch the different folders.

---

*This section assumes that you know how to create new folders using Windows NT Explorer.*

1. Open Windows NT Explorer, navigate to the local drive and create a New Folder (directory) called **Incoming**.
2. Create a subfolder (subdirectory) under Incoming and call it **Queue**.
3. Right-click on the **Incoming** folder and select **Properties** from the pop-up menu.
4. Click the **Sharing** tab and click **Shared As** to give sharing permissions to Incoming.
5. Click **OK** to save and exit.
Start the Remote Access Administrator

To start the Remote Access Server service:
1. Click Start, Programs, Remote Access, and click Remote Access Admin.
2. Click the Server menu and click Start Remote Access Service.
3. Click OK. The Remote Access Administrator displays the current RAS server and shows it Running.

That’s all there is to setting up a RAS server to receive PlotWorks files from your clients. If you wish to install additional network protocols at this time, go to Installing Network Protocols (Windows NT).

Making Remote Access Service Start Automatically

It is a good idea to configure the Remote Access Administrator to start automatically each time the computer is restarted.

To do so:
1. Click the Windows Start button, select Settings and select Control Panel.
2. Double-click the Services icon to display the Services dialog box.
3. Click Remote Access Administrator then click the Startup button.
4. Under Startup Type, click Automatic then click OK.
5. Click Close.

Now, whenever the server is restarted, RAS starts automatically and is ready to receive incoming files without any further user intervention.

Stopping the Remote Access Admin

To stop the RAS service:

*The RAS server will not receive incoming jobs if the RAS Admin is turned off.*

1. From the Admin screen (shown above), click the Server menu and click Stop Remote Access Service. The Remote Access Administrator displays the current condition as Stopped.
2. Select Exit from the Server menu to close the Admin window.
Set Up the Client’s Dial-Up Networking Connection

This section provides you with step-by-step instructions on how to configure your Windows NT workstation to use RAS for sending PlotWorks job files (.PLP) to your service bureau.

The steps required in the setting up a RAS connection are:

• Install and configure Dial-Up Networking/Remote Access Service
• Install and configure a network protocol

These instructions assume you have a working knowledge of Windows NT navigation and program installation. The steps below take you through installing and configuring Remote Access Service (RAS) using the NetBEUI network protocol. If your service bureau uses a different protocol, please refer to Installing Network Protocols (Windows NT) for installation instructions.

Be Prepared

Before you can create a Dial-Up Networking connection to a remote server, you must get the following information from your service bureau:

• The remote server’s phone number
• The network protocol(s) installed on the remote server (dial out protocol)
• The full UNC path to the network polling directory on the print server
• The RAS user account and password they have configured for you.

Verify Current Configuration

The first thing you should do is to verify that the required options are installed.

First, check to see if Dial-Up Networking is installed: Double-click the My Computer icon on your Windows NT desktop. Double-click Dial-Up Networking. If it has been installed you will see either a prompt that “The phone book is empty, press OK to add an entry,” or you will see the Dial-Up Networking dialog box.

If it has not been installed, select Install to launch the DUN installation “wizard.” See step 5 of RAS Installation below for more information.

All other required options can be verified by viewing the Network dialog box, shown below.
You must have Administrator permission to install or configure some of the necessary options.

To see if Remote Access Service is installed:

1. Click the Windows Start button, click Settings, click Control Panel, and double-click Network. The Network dialog box displays.
2. Click the Services tab. Look to see if Remote Access Service is listed. If it is not installed, see RAS Installation below.
3. Click the Protocols tab. Look to see if NetBEUI is listed.

If NetBEUI is not listed, you will need to install it. Go to “Installing Network Protocols (Windows NT)” on page G-18 for more information.

If all required options are present, continue with Add a Dial-Up Networking Connection, below.
Add a Dial-Up Networking Connection

To create a new Dial-Up Networking connection:

1. Double-click **My Computer** and double-click **Dial-Up Networking**.

   *If you receive a notice that Dial-Up Networking is not installed, click **Install** and follow the prompts. When you are asked to create a new connection, proceed with Step 3.*

2. Click **New**.

   *If you have not created a connection previously, the Make New Connection Wizard starts automatically. Follow the prompts.*

   *If you have not installed a modem in Windows NT, the Install New Modem Wizard starts. Follow the prompts to install your modem.*

3. Name the **Phonebook Entry** (Printing Service, for example) and click **Next**.

4. Click **I am calling the Internet** and click **Next**.

5. Enter the area code and telephone number for the connection, and select the appropriate country code for the remote server you are dialing.

6. Click **Use Telephony dialing properties**, and then click **Next**. You might need to get this information from the service bureau.

7. Click **Finish** to add the entry to the **Phonebook entry to dial** list.

8. Click **More** and select **Edit entry and modem properties**. Click the **Server** tab to display the Dial-up Server properties. Make sure your settings are as shown below (if you are using NetBEUI). Refer to *Installing Network Protocols (Windows NT)* if you are using a different protocol.
9. Click **OK**. This connection is ready to test. Go to step 2 of *Make the Connection*, below.

**Make the Connection**

*The following section assumes that you have installed and configured Dial-Up Networking and all other required options (protocol and RAS).*

**To connect to the RAS host (service bureau):**

1. Double-click **Dial-Up Networking** in **My Computer**.
2. Select the Service Bureau phonebook entry and click **Dial**.
3. Enter the correct **password** (and domain, if required) and click **OK**.

*If using TCP/IP, you will need an LMHOSTS file. See “Create an LMHOSTS File” on page **G-25** before proceeding.*

4. When the connection is made, click the Windows **Start** button, select **Run**, enter the UNC path to the shared folder on the host NT computer and click **OK**.
   
   For example: `\RASHOST\INCOMING\QUEUE` (where RASHOST will be the actual remote computer name).

5. If the connection has been made successfully, the host’s `\Incoming\Queue` folder displays on your screen. You might be asked for your **Contact As** (username) and **Password**. If so, fill in the information and click **OK**.
6. Right-click on the **Dial-Up Monitor** icon (located near the clock on the Windows NT task bar) and select **Hang Up**, click on the name of the connection that is running, then click **Yes**.

The connection is ready to transfer .PLP files. For more information on using the Job Editor to send job files, see “Output Job Tickets” on page G-28, or refer to the PlotWorks Client guide.

### RAS Installation

**To install Remote Access Service on your Windows NT workstation:**

1. Click the Windows **Start** button, click **Settings**, click **Control Panel**, and double-click **Network** to display the Network dialog box.
2. Click the **Services** tab and click **Add**. A list of available services displays.
3. Click **Remote Access Service**.
4. Click **OK** and follow the prompts.
5. When prompted, select the modem to be used as a **RAS Device**, then click **OK**. The Remote Access Setup dialog box displays:

![Remote Access Setup dialog box](Fig.E.11)

6. Click the **Configure** button. The Configure Port Usage dialog box displays:

![Configure Port Usage dialog box](Fig.E.12)

7. Select **Dial out only** and click **OK**.
8. Back at the Remote Access Setup dialog box, click the **Network** button.

9. Select the correct **Dial out protocol** (get this from your service bureau) and click **OK**.

10. Click **Continue** and follow the screen prompts.

11. If the Network dialog box is still open, click **Close** and follow the screen prompts.

**Set up the Client Dial-Up Networking Connection (Win95)**

These instructions assume you have working knowledge of Windows 95 navigation and program installation. The steps below take you through installing and configuring Dial-Up Networking using the NetBEUI network protocol. If your Service Bureau uses a different protocol, please refer to “Installing Network Protocols (Win95)” on page G-24.

---

*If the user account you are creating belongs to a Windows 95 client, the username must be the same as the user’s Windows/Network logon username.*

---

**Verify Current Configuration**

To check your current **Network configuration**:

1. Click the Windows **Start** button, click **Settings**, click **Control Panel**, and double-click **Network**. The Network dialog box displays.

2. The following items should be listed in the Installed Components window:
   - Client for Microsoft Networks
   - Dial-Up Adapter
• A network protocol -- NetBEUI, for example

3. Double-click the **My Computer** icon on your Windows desktop to see if Dial-Up Networking is installed. The 1.3 upgrade is required for Windows 95-OSR2/OEM -- you can download this from Microsoft’s web site at: www.microsoft.com/windows/getisdn/dload.htm.

    If any of these options is missing, click *Add* and follow the prompts. Go to “Installing Network Protocols (Win95)” on page G-24 for more information.

4. If all required options are present, continue with *Add a Dial-Up Networking Connection*, below.

**Add a Dial-Up Networking Connection**

Before you can create a Dial-Up Networking connection to a remote server, you must get the following information from your service bureau:

• The remote server’s phone number
• The network protocol(s) installed on the remote server
• The full UNC path to the network polling directory on the print server
• The RAS user account and password they have configured for you
To add a new connection:

1. Double-click **My Computer** (on your Windows desktop), then double-click **Dial-Up Networking**. If you have not created a connection previously, the **Make New Connection Wizard** starts automatically. Follow the prompts. If it has been used, go to step 2 to create a connection for your service bureau.

2. Double-click **Make New Connection**.

3. Enter a name for the computer to which you will be connecting (such as Printing Service).

4. Select a **modem** and click **Next**.

5. Enter the area code and telephone number for the connection, and select the appropriate country code for the remote server you are dialing and click **Next**.

6. Click **Finish** to add an icon for this connection to the Dial-Up Networking folder.

7. Right-click on the new Dial-Up connection and select **Properties** from the menu that pops up. Click the **Server Types** tab to display the Dial-up Server properties. Make sure your settings are as shown below. Refer to “Installing Network Protocols (Win95)” on page G-24 if you are using a different protocol.

   - **Dial-Up Server Type:** **PPP: Windows 95, Windows NT 3.5, Internet**
   - **Advanced Options:** Click **Log on to Network** and **Enable software compression**
   - **Allowed Network Protocols:** Click **NetBEUI** (for this example)

8. Click **OK**. This connection is ready to use. Go to step 2 below.

Make the Connection

The following instructions assume that you have installed and configured **Dial-Up Networking** and all required protocol(s).
To connect to the RAS host (service bureau):

1. Double-click **Dial-Up Networking** in **My Computer**.
2. Double-click your new Dial-up connection entry.

---

*If using TCP/IP, you will need an LMHOSTS file. See “Create an LMHOSTS File” on page G-25 before proceeding.*

3. When the connection is made, click the Windows **Start** button, select **Run**, enter the UNC path to the shared folder on the host NT computer and click **OK**.
   For example: `\RASHOST\INCOMING\QUEUE` (where `RASHOST` will be the actual host computer name)

4. If the connection has been made successfully, the host’s `\Incoming\Queue` folder displays on your screen. You might be asked for your password again. If so, enter your password and click **OK**.

5. Right-click on the **Dial-Up Monitor** icon (located near the clock on the Windows 95 task bar) and select **Disconnect**.

The connection is ready to transfer job tickets. For more information on using the Job Editor to send job files, see “Output Job Tickets” on page G-28 or refer to the PlotWorks Client guide.

**Installing Network Protocols (Windows NT)**

This section provides the basic steps required to install a network protocol on a Windows NT Server or Workstation.

**Install TCP/IP**

*If you are currently on a Local Area Network (LAN), contact your Network Administrator before proceeding. Administrative Privileges are required to install a network protocol on an NT server or workstation.*

1. Open the **Control Panel** and double-click **Network**. The Network dialog box displays.
2. Click the **Protocols** tab and click **Add**. The Select Network Protocol dialog box displays.
3. Select **TCP/IP** and click **OK**. A dialog box displays, asking if a DHCP server is present on the network (so it can dynamically assign the computer an IP address).

4. Do one of the following procedures to configure the IP address:
   - To have the DHCP server assign the IP address, click **Yes**. The Windows NT Setup dialog box displays. Follow the prompts to enter the following information:
     1. Type the path to the location of the Setup files on the Windows NT Server 4.0 CD-ROM. The Setup files are typically located at \x:\i386, where ‘x’ is the letter of the CD-ROM drive.
     2. Click **Continue**. The Setup program copies the required files, and the TCP/IP Protocol appears in the Network Protocols list box.
     3. Click **Close**. Windows NT Server 4.0 updates the network bindings, and you are prompted to restart the computer.
   - If the network does not have an existing DHCP server, or if the computer is to be used as a DHCP server, click **No** to manually configure the IP address. The Windows NT Setup dialog box appears. Follow the prompts to enter the following information:

---

**CAUTION:** To prevent data loss, save any open files and exit all open applications before proceeding.

4. Click **Yes** to restart the computer and enable the new settings.

   - If the network does not have an existing DHCP server, or if the computer is to be used as a DHCP server, click **No** to manually configure the IP address. The Windows NT Setup dialog box appears. Follow the prompts to enter the following information:
1. Type the path to the location of the Setup files on the Windows NT Server 4.0 CD-ROM.

The Setup files are typically located at \x:\i386, where ‘x’ is the letter of the CD-ROM drive.

2. Click Continue. The Setup program copies the required files and the TCP/IP Protocol appears in the Network Protocols list box.

3. Click Close. Windows NT Server 4.0 updates the network bindings, and the TCP/IP Properties dialog box appears.

4. Select the desired network adapter from the Adapter drop-down list box (usually MS Loopback Adapter).

5. Click Specify an IP address, type the IP address for your computer, the subnet mask, and the default gateway in the appropriate boxes.

6. Click OK. Windows NT Server 4.0 updates the network bindings, and a dialog box prompts you to restart the computer to enable the new settings.

To prevent data loss, save any open files and exit all applications before proceeding.

7. Click Yes to restart the computer and enable the new settings.
Create an LMHOSTS File

If you are using TCP/IP to connect to a remote host (service bureau) that is not using a DHCP server, you must also create and use a text file called LMHOSTS. The LMHOSTS file contains the mappings of IP addresses to NT computer names (in this case, the service bureau's print server). If you will be sending to different print servers, each entry should be kept on a separate line. The IP address should be placed in the first column followed by the corresponding [computer name]. A tab should separate the address and the [computer name]. These are then followed by #PRE, which causes the entry to be preloaded into the name cache.

Contact the service bureau for the correct IP address and NT computer name. For more information, you can also refer to the LMHOSTS.SAV file located in the C:\WINNT\SYSTEM32\DRIVERS\ETC folder.

To create an LMHOSTS file:

1. Open the Windows Notepad accessory: Click the Start button, select Programs, then Accessories, then click Notepad.
2. Type the IP address of the remote computer.
3. Press Tab and type the remote computer’s name (use upper-case).
4. Press Tab and type #PRE (use upper-case). The Notepad screen should resemble:
   
   192.168.1.253  RASHOST  #PRE

5. Click File and Save to save the file as LMHOSTS (no extension) in the C:\Winnt\System32\Drivers\Etc folder. You might have to go to Windows Explorer to remove the .TXT extension from the file before using it.
6. Click File and Exit.
7. When you establish a dial-up connection to the host, go to an MS-DOS prompt (there is usually one on the Windows Program list).
8. At the DOS prompt, type NBTSTAT -R and press Enter. You must use an upper-case R.
9. Type NBTSTAT -c and press Enter. You must use a lower-case c.
10. Type Exit to return to Windows. You can now continue from G-13, step 4 in Make the Connection.
If `NBTSTAT` fails, check to see if the LMHOSTS file has an extension (like `.TXT`). If so, rename the file (from LMHOSTS.TXT to LMHOSTS, for example) and try again.

### Install NWLink IPX/SPX Compatible Transport

If you are currently on a Local Area Network (LAN), contact your Network Administrator before proceeding. Administrative Privileges are required to install a network protocol on an NT server or workstation.

1. Open the Network dialog box from the Windows Control Panel.
2. Select the Protocols tab and click Add.
3. Select NWLink IPX/SPX Compatible Transport from the Network Protocols list box and click OK. A Windows NT Setup dialog box appears, prompting for the location of Windows NT setup files.
4. Enter the path to the location of the Setup files on the Windows NT Server 4.0 CD-ROM, if necessary.

The Setup files are typically located at `{x:i386}`, where `{x}` is the letter of the CD-ROM drive.

5. Click OK. NWLink IPX/SPX Compatible Transport and NWLink NetBIOS appear in the Network Protocols list box.
6. To complete NWLink IPX/SPX Compatible Transport installation, do one of the following:
   1. Accept the default configuration:
      - Click Close. The Bindings process starts and finishes, and the Network Settings Change dialog box appears.
   2. Manually configure NWLink IPX/SPX Compatible Transport:
      - Click Yes to restart the computer and enable the new settings.
      - Manually configure NWLink IPX/SPX Compatible Transport:
• Double-click **NWLink IPX/SPX Compatible Transport** in the **Network Protocols** list box. The NWLink IPX/SPX Properties dialog box appears.

• Select the **General** tab. From the **Adapter** drop-down list, select the name of the network adapter card to which you want to bind the transport.

• Specify the appropriate frame type and network number in the **Frame Type** and **Network Number** drop-down list boxes.

• (Optional) Select the **Routing** tab and select **Enable RIP Routing**.

---

To enable RIP routing you must have more than one network adapter card running IPX/SPX and Routing Information Protocol (RIP) for NWLink must be installed under Network Services.

• Click **OK** then click **Close**. The binding process starts and finishes, and the Network Settings Change dialog box appears.

---

**CAUTION:** Make sure to save all work and close all applications before proceeding to prevent data loss.

• Click **Yes** to restart the computer and enable the new settings.

---

**Installing NetBEUI Protocol**

*If you are currently on a Local Area Network (LAN), contact your Network Administrator before proceeding. Administrative Privileges are required to install a network protocol on an NT server or workstation.*

1. Open the **Network** dialog box.
2. Click the **Protocols** tab and click **Add**. The Select Network Protocol dialog box appears.
3. Select **NetBEUI Protocol** from the Network Protocols list box and click **OK**. The Windows NT Setup dialog box displays. Follow the prompts.

*The Setup files are typically located at x:\i386, where ‘x’ is the letter of the CD-ROM drive.*

**CAUTION:** To prevent data loss, save all open files, and exit applications before proceeding.

5. Click Yes to restart the computer and enable the new settings.

**Installing the MS Loopback Adapter**

The Microsoft Loopback Adapter is usually installed when you install certain network protocols. However, should you need to install it separately, this section details the installation.

1. Open the Network dialog box from the Windows **Control Panel**.
2. Select the **Adapters** tab and click **Add**.
3. Click **MS Loopback Adapter** and click **OK**.
4. Select **Frame Type** as **802.3**, click **OK** and follow the instructions on the screen.
5. If you are using TCP/IP, you might be prompted to enter the TCP/IP Properties for the MS Loopback Adapter. For example:
   - Select the **MS Loopback Adapter**.
   - Click **Specify an IP address**.
   - For the IP Address type **192.168.1.253**.
   - For the Subnet Mask type **255.255.255.0**.
   - Click **OK**.
6. Click **Close** and follow the instructions on the screen.

**Installing Network Protocols (Win95)**

This section provides the basic steps required to install a network protocol on a Windows 95 workstation.

**Installing TCP/IP**

If you are currently on a Local Area Network (LAN), contact your Network Administrator before proceeding.

1. Open the **Control Panel** and double-click **Network**. The Network dialog box
2. From the **Configuration** tab, click **Add**.

3. Click **Protocol** and click **Add**.

4. Click the appropriate **Manufacturer** and **Network protocol** and click **OK**. In this case, you would select Microsoft as the manufacturer and TCP/IP as the network protocol. Click **OK**.

5. Click **OK**. You might be asked to insert the Windows 95 Installation CD (or diskette).

6. Click **Yes** when prompted to restart the computer and enable the new settings.

### Installing IPX/SPX Compatible Protocol (Win95)

*If you are currently on a Local Area Network (LAN), contact your Network Administrator before proceeding.*

1. Open the **Control Panel** and double-click **Network**. The Network dialog box displays.
2. From the **Configuration** tab, click **Add**.

3. Click **Protocol** and click **Add**.

4. Select **Microsoft** as the **Manufacturer** and **IPX/SPX Compatible Protocol** as the **Network protocol** and click **OK**.

5. Click **OK**. You might be asked to insert the Windows 95 Installation CD (or diskette).

6. Click **Yes**, when prompted, to restart the computer and enable the new settings.

**Installing NetBEUI Protocol**

---

If you are currently on a Local Area Network (LAN), contact your Network Administrator before proceeding. Administrative Privileges are required to install a network protocol on a server or workstation.

1. Open the **Control Panel** and double-click **Network**. The Network dialog box displays.

2. From the **Configuration** tab, click **Add**.

3. Click **Protocol** and click **Add**.
4. Select Microsoft as the Manufacturer and NetBEUI as the Network protocol and click OK.

5. Click OK. You might be asked to insert the Windows 95 Installation CD (or diskette).

6. Click Yes, when prompted, to restart the computer and enable the new settings.

**Installing Client for Microsoft Networks**

1. Open the Control Panel and double-click Network. The Network dialog box displays.

2. Click Add and click Client.

3. Click the Add button, click Microsoft, select Client for Microsoft Networks, and then click OK.

4. Click Client for Microsoft Networks to select it, click the Properties button, click Logon and restore network connections, and then click OK.

5. Click the Identification tab, fill out the Computer name, Workgroup, and Computer Description.

6. Click the Access Control tab and select Share-Level access control.

7. Click the Configuration tab and select Client for Microsoft Networks as the Primary Network Logon.

8. Click OK and follow the instructions on the screen.

**Installing Dial-Up Networking on Win95**

**To install the Dial-Up Networking component:**

1. Double-click My Computer.
   If there is a Dial-Up Networking folder in My Computer, Dial-Up Networking is already installed. If there is no Dial-Up Networking folder, continue with these steps.

2. In Control Panel, double-click the Add/Remove Programs icon.

3. On the Windows Setup tab, click Communications in the Components box, and then click Details.

4. Select the Dial-Up Networking check box, and then click OK.
5. Click OK again.

**Output Job Tickets**

This section assumes that the PlotWorks Client is installed and that you can create and output job ticket.

1. Open the PlotWorks Client and create or open a job ticket.
2. Under the **Setup** menu, choose **Configure Destinations**. The following dialog box appears:

![Configure Destination dialog box]

3. Enter the name of the service bureau connection in the **Destination Name** field. This creates an entry under the Output menu.
4. In the **Destination Path** field, enter the UNC path of the shared folder to which the files will be sent.
5. Under **Options**, select **Use Dial-up Networking to Connect to Destination**.
6. In the **Dial-up Configuration** box, select the **Phonebook Entry** of the Service Bureau, enter your **User Account** (username) and **Password**, if required. The service bureau can provide this information.

   *Your user account name must be the same as your Windows/Network logon username if you are using Windows 95.*

7. Under **Destination Type**, select **Network Polling** (unless the service bureau specifies **Job Queue**).
8. Click **OK**.
9. Send the job by clicking **Output Job** and selecting the destination name entered in step 3.
10. Follow any on-screen prompts that appear. Your job is sent to the `\[RASHOST]\INCOMING\QUEUE` folder on the host computer (where [RASHOST] is the actual host computer name).

## Installing FTP

FTP has gained in popularity as a faster, more efficient means of file transfer than e-mail. It can handle larger files and uses the Internet as its means of connection between clients and hosts. FTP uses the connection-oriented services of TCP to transfer text and/or binary files between a local host running TCP/IP and a host configured with an FTP server program.

This section tells you how to install FTP on a Windows NT 4.0 server and on a Windows 95, 98, or NT client (workstation).

### System Requirements:

In order to receive FTP files the Host Server must be configured with:

- Windows NT 4.0 or higher
- Remote Access Service
- TCP/IP
- FTP server daemon (included on the Windows NT diskettes/CD)
- A user account for the remote user

The client computer must be configured with:

- Windows NT 4.0, Windows 5 or WIndows 98
- Dial-Up Networking
- TCP/IP
- FTP client software (included on your Windows NT, 95 or 98 CD/diskettes)
- A user account on the FTP server

### To verify if FTP is already installed:

1. From the command prompt (C:\) type `FTP` and press Enter.
2. An FTP prompt appears (shown below). If you receive any other message, FTP is not yet installed. Proceed to “Installing Internet Information Server on an NT Server” on page G-30.

---

*Unless otherwise changed, when Windows 95 is installed on your system TCP/IP is installed as your default Internet protocol. FTP is also installed as part of the TCP/IP service.*
For a list of FTP commands, type **help** and press **Enter** at the FTP prompt. For further information type **help** and then the name of the command. This applies for both WIN95 and NT-based systems.

### Installing Internet Information Server on an NT Server

You will need your Windows NT installation diskettes/CD.

1. Log on as Administrator
2. Check to see if TCP\IP is installed on your system
3. From the **Start** menu, go to **Settings** and then click on the **Control Panel**. The **Control Panel** window displays.
4. Double-click on the **Network** icon.
5. Click on the **Protocols** tab. Look to see if TCP\IP is installed. If it is not, see “Installing Network Protocols (Windows NT)” on page G-18.
6. Click **Cancel** to close the **Network** dialog box.
7. Insert the Windows NT 4.0 Server CD/diskette.
8. From the desktop, double-click the **Install Internet Information Server**. If **Install Internet Information Server** is not found on your desktop:
   - Click on the Windows **Start** menu, point to **Settings** and then click **Control Panel**.
   - Double-click the **Network** icon.
   - Click on the **Services** tab.
   - Click **Add**. The **Select Network Service** dialog box displays.
   - From the Select **Network Protocol** dialog box, select **Internet Information Server**. The Windows NT Setup box appears, requesting the full path of the desired file. For most systems this will be **D:\I386**.
Click Continue. The Install Internet Information Server displays.

9. From the Install from dialog box, type D:\I386, in most cases, or type the appropriate path for the Windows NT 4.0 Server disk.

10. The Microsoft Internet Information Server 2.0 Setup dialog box appears. The Microsoft Internet Information Server 2.0 Setup contains the following information:
   - Internet Service Manager
   - World Wide Web Service
   - WWW Service Samples
   - Internet Service Manager (HTML)
   - Gopher Service
   - FTP Service
   - ODBC Drivers and Administration

11. Make sure that only Internet Server Manager (HTML) and FTP Service options are selected and click OK.

12. When prompted to create the C:\Winnt\System32\Inetsrv directory, click on Yes. The Publishing Directories dialog box appears, listing the default directory:
   FTP Publishing Directory  C:\Inetpub\ftproot

13. Click OK to accept the default directory or create your own.

14. When prompted to create the default directory, click Yes. Setup installs the Internet Information Server software.

15. When setup is complete, click OK.

16. Follow the prompts to restart your computer.

When your computer has rebooted a new program will have been added to your Start menu.

17. From your Start menu, click Programs and then Microsoft Internet Server (Common). The options available from within the application are: Internet Information Server Setup, Internet Service Manager, Internet Service Manager (HTML), Key Manager, and Product Documentation.

18. If the Network dialog box is open, click Close.
Configuring Windows NT 4.0 Workstation for FTP

You will need a Windows NT 4.0 Workstation CD/diskette to accomplish the following.

1. Log on as Administrator.

2. Check to see if TCP\IP is installed on your system:
   - From the Start menu, go to Settings and then click Control Panel. The Control Panel window displays.
   - Double-click the Network icon.
   - Click on the Protocols tab. Look to see if TCP\IP is installed. If it is not, see “Installing Network Protocols (Windows NT)” on page G-18.
   - Close the Network dialog box by clicking Cancel.

3. Insert the Windows NT 4.0 Workstation CD/diskette.

4. From within the Network dialog box, select the Services tab. Click the Add button. From within the Select Network Service window, find and highlight Microsoft Peer Web Server.

5. The Internet Information Server Installation dialog box displays, prompting you for the path to additional files. These files are found on the Windows NT 4.0 Workstation CD. The default path for the files is usually D:\i386. Click OK. The desired files are loaded and the Microsoft Peer Web Services Setup box appears.

   The Microsoft Peer Web Services Setup dialog box contains the following information:
   - Internet Service Manager
   - World Wide Web Service
   - WWW Service Samples
   - Internet Service Manager (HTML)
   - Gopher Service
   - FTP Service
   - ODBC Drivers and Administration

6. Select Internet Service Manager (HTML) and FTP Service options, and click OK.
7. You are asked to create the install directory for the desired files. The default directory is C:\Winnt\System32\Inetsrv (or change this directory by selecting the Change Directory button and create your own).

8. Click OK to create the directory. The Publishing Directories dialog box appears, listing the default directory:
   FTP Publishing Directory C:\Inetpub\ftproot

9. Click OK to accept the default directory or create your own.

10. When prompted to create the default directory, click Yes.

11. Setup installs the Microsoft Peer Web Services software.

12. When setup is complete, click OK. The new application is added to your Start menu.

13. From your Start menu, click Programs and then Microsoft Peer Web Services (Common). From this program your choices are Internet Service Manager, Key Manager, Peer Web Services Setup and Product Documentation.

   Internet Service Manager is used in the administration of FTP and other Internet Services.

14. If the Network dialog box is open, click Close.

To verify that FTP is now installed, refer to page G-29.

For instructions on configuring PlotWorks to output jobs using FTP, see “Output to FTP” on page 4-125.
Appendix F

Processing AutoCAD Jobs

PlotWorks can process plot files and AutoCAD’s native format files (.DWG). However, additional reference files, fonts and print scales must be provided with DWG files as these are not incorporated in the .DWG file.

**DWG Direct* File Processing**

PlotWorks processes native AutoCAD files using DWG Direct. This is a processing tool used to process AutoCAD R14 or earlier files for printing without installing AutoCAD on your PlotWorks Server. DWG Direct does not support AutoCAD 2000 and 2002 files, PostScript and TrueType fonts, 3D perspective views, or files with more than 47 viewports. Prints produced with DWG Direct can be slightly different from the original drawings.

**AutoCAD File Processing**

AutoCAD can be used to process native AutoCAD files if this option is selected during installation, or by selecting this option from the **AutoCAD/DWG Direct Setup** tabbed dialog box located in the Job Editor Setup menu under Preferences. For more information on this option please refer to page 4-76 of the PlotWorks User Guide.

PlotWorks cannot process DWG files using AutoCAD processing if AutoCAD Version 14.01 or earlier is used. Only AutoCAD Version 14.01 or newer can process DWG files.

DWG files should not be processed using AutoCAD processing if more than one version of AutoCAD is running on the processing station. This is because if two versions of AutoCAD are running, the original .dwg files are deleted by PlotWorks after processing.

---

*AutoCAD must be maximized or the AutoCAD menu bar must be visible during AutoCAD processing. If AutoCAD is minimized during processing, the pens settings assigned can change every time a file is processed.*

---

**How AutoCAD Files are Processed**

PlotWorks processes AutoCAD files in three stages: prechecking, preprocessing and interaction.
Prechecking
Before vectorizing AutoCAD files, PlotWorks prechecks for parameter inconsistencies or other possible problems. Prechecking includes calculations to see if the specified AutoCAD Scale will produce a print that fits the specified natural paper size — within an allowable deviation range as established in the Job Editor, Setup Processing options. When discrepancies between Size and Scale parameters fall within the allowable range, processing proceeds without interruption. If an automatic adjustment is made, the software notifies the operator before printing. For inconsistencies that exceed the allowable range, PlotWorks alerts the operator and provides options.

Preprocessing and Interaction
After prechecking, the software vectorizes AutoCAD files and converts them to a high-speed internal plotting format. If inconsistencies or other problems are detected during preprocessing, PlotWorks notifies the operator during the interaction stage, and provides options.

AutoCAD Printing Boundaries
When printing AutoCAD drawings, it is necessary to specify print boundaries. Select print boundaries in the Plot By field of the Job Editor or Client. The following options are available:

- **Extents**: Selecting this option will print the rectangular area containing drawn entities. It may include electronic traces of entities that have been moved or deleted. To print by extents, the drawing should be zoomed to Extents and then saved and closed in AutoCAD first. If the Zoom-Extents option is not used, the resulting print may be clipped or undersized.

- **View**: Selecting this option will print an area defined in AutoCAD under a specified view name. It is then necessary to enter the view name in the View Name field of the Job Editor or Client.

- **Limits**: Selecting this option will print the entire drawing area defined by the drawing limits specified in AutoCAD.

- **Display**: Selecting this option will print the area displayed on the screen when the.DWG file was saved.

- **Layout**: Selecting this option will print a saved and named layout defined in AutoCAD 2000 or 2002.
PlotWorks Parameters and AutoCAD

The formulas shown below are the key to understanding AutoCAD and PlotWorks.

<table>
<thead>
<tr>
<th>Formula 1:</th>
</tr>
</thead>
<tbody>
<tr>
<td>AutoCAD Image x AutoCAD Scale = Size</td>
</tr>
<tr>
<td></td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Formula 2:</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size x Printing Scale = Output size</td>
</tr>
<tr>
<td>Example: (36 x 24) x (1=2) = 18 x 12</td>
</tr>
</tbody>
</table>

The image creator designs an image in AutoCAD in a nonspecific set of units called drawing units. The creator then designates an AutoCAD scale which translates the image into a specific paper size. If the scale and size specified by the creator are incorrect, the resulting size in AutoCAD is wrong.

PlotWorks addresses this issue by allowing the user to independently scale to a printed image size. The user only has to designate the scale or a final size in PlotWorks.

For example: If in AutoCAD a Scale is specified and the size is wrong, PlotWorks will detect the error during pre-checking. PlotWorks will then display the resulting nonstandard natural image dimensions (for example: 33" x 22" or 42" x 28") and the respective nonstandard scales so that the error can be corrected.

In the example on the next page, it is likely that the user intended to produce a D1-size plot (36x24), but the Scale was specified incorrectly at 1=48 instead of 1=12.
**Fig. F.1**

**AUTO Size**

(Plot-to-Scale)

With **AUTO Size**, PlotWorks relies solely on **Scale** & drawing unit dimensions to establish natural image dimensions.

---

**NATURAL IMAGE**

9" x 6"

- **Scale**: 1:48
- **Size**: AUTO
- **Final Size**: 100%

---

At **AutoCAD Scale** 1:48

---

**MODIFIED**

- **Scale**: 1:48
- **Size**: AUTO
- **Final Size**: 200%

---

200% of Natural Image (9" x 6") = 18" x 12"

**NOTE:** Enlargement causes loss of resolution
In the example below it is likely that the user intended to produce a D1-size plot (36"x24") at a Scale of 1=12, but the Size was specified incorrectly as D or E.

**Fig. F.2**
*Scale Down to Fit Automatically*

**Fig. F.3**
*Scale Up to Fit Automatically*
Configuring AutoCAD For Use with PlotWorks

PlotWorks supports AutoCAD R14, 2000 and 2002 DWG file processing. Uninstall AutoCAD R14 if AutoCAD 2000 or 2002 processing is going to be used. PlotWorks will not be able to process .dwg files using AutoCAD processing if AutoCAD version 14 or earlier is used. Only AutoCAD Version 14.01 or later can process .dwg files.

The following steps take you through the basic configuration required for both PlotWorks and AutoCAD.

Configuring AutoCAD R14

If the “Use AutoCAD” option was not selected during PlotWorks installation and AutoCAD was installed after installing PlotWorks, a full PlotWorks install is necessary. During the PlotWorks full install select “Use AutoCAD”. PlotWorks will then install the necessary files and registry accordingly.

If “Use AutoCAD” was selected during the original PlotWorks installation and AutoCAD is being upgraded from a previous install, only the PlotWorks Smart Update is required.

Configuring AutoCAD R14 for use with PlotWorks

1. Ensure AutoCAD is installed and PlotWorks is not.
2. Install PlotWorks (refer to Chapter 2 for more instructions). When prompted select Use AutoCAD.
3. After the PlotWorks installation is complete and you have restarted the PC, run AutoCAD.
4. On the Start Up dialog box disable the Show this dialog at start up check box.
5. At the AutoCAD command line, type config and press Enter.
6. Go to the Printer tab of the Preferences dialog box.
7. Configure a new printer and select Hewlett-Packard HP-GL/2 devices, ADI 4.3 - for Autodesk by HP. Click OK.
8. Press Enter, type 3 (for the HP DesignJet 750c) and press Enter twice.
9. Press Enter to select Parallel Port <P>.
10. Press the period ( . ) key, then press Enter.
11. Press Y (Yes) and press Enter to make changes to the defaults.
12. Select N (No) and press Enter for each selection until you get to the prompt “Write plot to file?”. Select Yes.
13. Enter the desired size units (or leave the default) and press Enter.
14. Select Y (Yes) and Enter to keep the default plot origin (0,0).

15. At the “Enter the Size or Width, Height” prompt, type 64,600 and press Enter.

---

Due to the way AutoCAD processes plot files, you need to set the maximum plot size to prevent image rotation. A standard HP-GL file has a resolution of 1016 (steps per inch) and AutoCAD can plot widths from 0 to 65,535 steps. Therefore, to determine the actual number of inches required, divide 65,535 by 1016 to get approximately 64 inches. Anything larger than 64 reduces the resolution of the plot file. Most plotters have a default resolution (plotter units) of 1016.

---

16. Accept the defaults for the rest of the settings by pressing Enter at each prompt.

17. Set the HP DesignJet 750c as Current, then select OK to complete configuration.

You also need to make the following change to AutoCAD to prevent a notification dialog box about Proxy objects:

18. Select Preferences from the AutoCAD Tools menu.

19. Click the Compatibility tab and remove the check mark (click it) from Show Proxy Information Dialog Box. This stops the dialog box from appearing for drawings that have proxy entities, such as zombie entities. The install script takes care of the proxy setting at install time if AutoCAD is already installed.

20. Close AutoCAD.

**Configuring AutoCAD 2000 or 2002**

If the “Use AutoCAD” option was not selected during PlotWorks installation and AutoCAD was installed after installing PlotWorks, a full PlotWorks install is necessary. During the PlotWorks full install select “Use AutoCAD”. PlotWorks will then install the necessary files and registry accordingly.

If “Use AutoCAD” was selected during the original PlotWorks installation and AutoCAD is being upgraded from a previous install, only the PlotWorks Smart Update is required.

For AutoCAD 2000, PlotWorks will automatically install a plotter configuration file for AutoCAD processing called PLPPLOT.PC3, which includes the driver it will use. PlotWorks also installs a color table called PlotWorks.ctb. To configure AutoCAD 2000 or 2002, perform the procedures below depending upon whether PlotWorks is already installed.
When PlotWorks has not yet been installed and AutoCAD is installed
1. Run AutoCAD 2000.
2. Proceed to the **Tools** menu and select **Options**.
3. Select the “**Open and Save**” tab.
4. In the ‘**ObjectARX Applications**’ section, uncheck the ‘**Show Proxy information dialog box**’ option.
5. Select the “**Plotting**” tab.
6. In the ‘**Default plot settings**’ section, select PLPPLOT.PC3 under ‘**Use as default output device**’.
7. In the ‘**Default plot style behavior**’ section, select ‘PlotWorks.ctb’ color table.
8. Close the dialog box by selecting the ‘**OK**’ button.

**NOTE:** the PLPPLOT.PC3 file is a preconfiguration of an AutoCAD 2000 HDI driver. It is a standard AutoCAD HP-GL/2 plotter driver, with the vector graphics color depth set at ‘255 Virtual Pens’. The configuration has a 36” roll selected as the ‘loaded’ medium and a number of custom paper sizes.

When PlotWorks is already installed
1. Log on to the computer with Administrator rights.
2. Close all PlotWorks applications
3. Close all the AutoCAD windows
4. Open Windows Explorer by right clicking on the Windows **Start** button and selecting **Explore**
5. Navigate to the PlotWorks folder usually **C:\Program Files\PLP\PlotWorks**
6. Right click on the file named **Plotworks.ctb**
7. Select **Copy** from the right click menu
8. Paste this file into the AutoCAD\Plot Styles folder.
9. Similarly copy the file **PlpPlot.pc3** from the PlotWorks folder and paste it into the AutoCAD\Plotters folder.
10. Copy the file **PlpPlot.pmp pc3** from the PlotWorks folder and paste it into the AutoCAD\drv folder.
11. Open the Job Editor
12. Click on the **Setup** menu
13. Click on **Processing Options**.
14. Click on the **AutoCAD/DWG Direct Setup** tab

15. Select the **Use AutoCAD** radio button.

16. Enter the path to your AutoCAD application in the **AutoCAD path** text box. For Example, If your AutoCAD program was installed on the C drive, in a folder named AutoCAD, then enter: \ACAD2002\acad.exe

17. Enter the path to the font files in the text box titled **Font search path**. For example, \ACAD2002\Fonts;\ACAD2002\Support

18. Enter the path for default substitute font to use in the text box titled **Substitute font**. For example, \ACAD2002\Fonts\simplex.shx

19. Open the AutoCAD application

20. Select **Tools** and then **Options**.

21. Select the **Plotting** tab

22. Select the Default plot settings for new drawings section radio button for **Use as default output device**

23. Select the **PlpPlot.pc3** from the drop-down menu

24. Click on the **Use color dependent plot styles** radio button next to ":"

25. Select the **Plotworks.ctb** from the drop-down menu.

26. Click **Apply** and **OK**.

27. Close AutoCAD.

28. Open the Job Editor, load a dwg file, and view the image.

**AutoCAD 2000 or 2002 DWG files with PlotWorks AutoCAD Processing**

To ensure AutoCAD 2000 and 2002 DWG files are printed correctly using PlotWorks AutoCAD processing select the following options before saving and submitting the DWG file for printing.

- In the Plot dialog box, under the Plot device tab set “Plotter Configuration Name” to “None” and “Plotstyle table (open assignments) Name” to “None”.
- In the Plot dialog box under the Plot Settings tab select the “Plot with plot styles” options so there is a checkmark in the check box.

**Configuring AutoCAD or DWG Direct* in PlotWorks**

1. Start the PlotWorks Job Editor.

2. Select **Processing Options** from the **Setup** menu.

3. Select the **AutoCAD/DWG Direct Setup** tab.
4. Click the radio button for **Use DWG Direct** or **Use AutoCAD** at the bottom of the dialog box.

5. Make sure the AutoCAD path is properly configured with the full path and filename of ACAD.EXE.

6. In the font path (using D:\ACAD as an example install path), ensure the following string is entered (without spaces):
   
   D:\ACAD\FONTS

7. Make sure the font referred to in the substitute font entry exists, and is correct.

8. Select **OK** to close the dialog box.

*DWG Direct does not support AutoCAD 2000 or 2002 files.*

---

**AutoCAD and “Error Free Printing™”**

**Scale and Size Fields**

During the prechecking pass, the software determines if there is a scale inconsistency between the data, the PlotWorks-specified AutoCAD scale, and the PlotWorks-specified size. The software will suggest a scale that will print the data to the specified size.

There are three other methods for designating the scale of the drawing:

1. Specifying “FIT” as a valid AutoCAD scale. In order to do this, you must specify a Size value (not Auto Detected).
2. Specifying “Auto Detected” as a valid Size. In order to do this, you must specify an AutoCAD scale value (not FIT).
3. Specifying “DIMSCALE” as a valid AutoCAD scale. The software will use the scale of the dimension entities within the DWG for the drawing scale.

Please note that choosing any one of these options, in effect, disables the software’s ability to check on the compatibility of your specified scale with your specified size. The formula on page H-3 demonstrates this.

**Over and Under Size Errors**

The Over/Under Size Error fields let you define an allowable range of error for your AutoCAD drawings. Any size errors that fall within the range will be printed accordingly. If the errors exceed the allowable range, the software generates an error message and requires one of the following operator actions:

1. Print Anyway  
2. Skip Image  
4. Halt Processing  
5. Ignore All
3. View Image

![Warning Image](image1)

To access the AutoCAD Setup box and define a range of error in the Job Editor,

1. Select **Processing Options** from the **Setup** menu.

![Processing Options](image2)

2. Choose the **AUTOCAD/DWG Direct Setup** property sheet.

3. Then set the desired percentages in the **Drawing is over-sized by:** and **Drawing is under-sized by:** fields. The default values are 10% for Over-sized errors and 20% for Under-sized errors.

**Examples of parameter settings**

**Parameter Settings**

1. To produce final output that is scaled to match other prints and engineering
documents, use the following PlotWorks settings:

<table>
<thead>
<tr>
<th>Scale</th>
<th>Explicit AutoCAD scale string, such as 1=1, 1=12, or Dimscale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified Size</td>
<td>Industry-standard size, or specific width and height</td>
</tr>
<tr>
<td>Output Size</td>
<td>100% (unless you are producing check prints or enlargements)</td>
</tr>
</tbody>
</table>

2. To produce final output of a specific media size, you can use the following PlotWorks settings:

<table>
<thead>
<tr>
<th>Scale</th>
<th>FIT</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified Size</td>
<td>Industry-standard size, or specific width and height</td>
</tr>
<tr>
<td>Output Size</td>
<td>100%</td>
</tr>
</tbody>
</table>

3. To produce full-size prints, check prints or other variations of a specific paper size (that is, an industry standard size, or an explicit width and height), use the following PlotWorks settings:

<table>
<thead>
<tr>
<th>Scale</th>
<th>Explicit AutoCAD scale string, such as 1=1, 1=12, or Dimscale</th>
</tr>
</thead>
<tbody>
<tr>
<td>Specified Size</td>
<td>Industry-standard size, or a specific width and height</td>
</tr>
<tr>
<td>Output Size</td>
<td>A percentage (100%, 25%, 200%, etc.)</td>
</tr>
</tbody>
</table>

**Prechecking Messages**

When the software detects inconsistent parameters, which ordinarily would result in an incorrect print, a Critical Error message or Warning displays — along with the options available to the printer attendant. Also, when appropriate, PlotWorks computes and/or displays detailed parameter-related information to help the attendant make an informed decision and produce a valid print without delay.
Critical Error Options
The attendant is offered options to **Halt** and modify the parameters, or **Skip** the file for later attention. In either case, the file will not be printed until a modification is made.

Warning Options
Warning options can include: Print Anyway; Skip the file for later attention; Halt and modify the parameters; View the image on-screen, or Ignore all the warnings in this image and all other images currently being processed with identical errors.

Messages
A prechecking message can include some or all of the following information: the presumed image dimensions; the dimensions of the specified paper Size; an alternative Scale string that shows the relationship between the specified paper Size and the presumed AutoCAD image dimensions.

Using Prechecking Messages to Identify Errors
If the software issues a warning during prechecking, one of the following errors exists:
- The specified AutoCAD Scale is incorrect,
- The wrong paper size is specified in the Size field
- The presumed AutoCAD drawing dimensions are not the actual dimensions
- The image was not zoomed to Extents

Usually, with the detailed information PlotWorks provides, you can spot an incorrect parameter immediately, because it stands out as an obvious deviation from (1) standard industry parameters and/or (2) the parameters specified for other images in the project.

Identifying Errors
**Example 1: Invalid Size**
The specified Scale is 1=12, and the specified paper Size is 34" x 22" (D-size). Along with the specified paper Size, the software displays the following:
- Presumed image dimensions: 36" x 24" (industry standard D1-size)
- Alternate scale string: 1=13.09 (nonstandard)

Because the presumed image dimensions reflect an industry standard, but the alternate scale string does not, it is likely that the specified Scale is correct and the specified paper Size should be changed to D1-size to match the presumed image dimensions. This is further confirmed if D1 is the specified paper Size for other images in the project.
Example 2: Invalid Scale

The specified Scale is 1=48, and the specified paper Size is 36" x 24" (D1-size). Along with the specified paper Size, the software displays:

- Presumed image dimensions: 9" x 6" (nonstandard)
- Alternate scale string: 1=12 (standard AutoCAD scale)

Because the alternate scale string reflects an industry standard, but the presumed image dimensions do not, it is likely that the specified natural paper Size is correct and the specified Scale should be changed to 1=12 to match the alternate scale string. This is further confirmed if 1=12 is the specified Scale for other images in the project.

Example 3: Inaccurate Image Dimensions

The specified Scale is 1=12, and the specified natural paper Size is 36" x 24" (D1). Along with the specified paper Size, the software displays:

- Presumed image dimensions: 36" x 39" (nonstandard)
- Alternate scale string: 1=19.5 (nonstandard)

In this example, neither the alternate scale string or the presumed image dimensions reflect an industry standard, so it is likely that both the specified Scale and paper Size are correct. (This is further confirmed if the specified Scale and Size match the parameters for other images in the project.) With this information, the attendant can logically assume that the presumed image dimensions are not the actual image dimensions. Since PlotWorks determines the actual dimensions when the file is vectorized, and the parameters appear to be correct, the attendant can choose the option to Print Anyway.

If the parameters match after vectorization, a valid print is produced. If the actual image dimensions do not fit the specified natural paper Size, the software will issue a Warning and provide options. Changes made in the Viewer during processing are not saved.

Printing with AutoCAD using Network Polling Mode 1

The processing of AutoCAD drawing files (DWGs) is unique because of the need to specify an AutoCAD scale. Since both AutoCAD scale and paper size (SIZE) are specified in PlotWorks, they must be consistent or an error will occur, producing either a clipped or undersized print.

Since Network Polling Mode 1 is a noninteractive submission mode, the creator cannot easily communicate the desired scale to the printer operator. Network Polling Mode 1 entails the copying of image files to a specified directory and subsequent printing of files according to the parameters of that directory.
Given this scenario, the user would have to create a different subdirectory for each possible AutoCAD scale. When coupled with other required printing parameters, the need for subdirectories quickly exceeds the limits of practicality.

Fortunately, PlotWorks provides two very practical methods to work around this impasse:

**Method 1**

Set up the parameters to accept any scale under the assumption that the customer has properly specified the size (paper size).

1. In the JOB section of the default PFS file for the directory, type `ACADPARMS=FIT`.
2. On the next line, type `SIZE=(desired size)`. For example, `SIZE=D`.
3. On the next line, type `FinalSize=(desired output size)`. For example, `FinalSize=100%`.
4. Save the PFS file.

Network Polling takes the AutoCAD drawing dimensions and processes the data such that the print will end up as the specified size.

The risk is simple: If the user made a mistake in specification of size, the ensuing print will not scale as expected. For example: let us say that the user had a 1/8 inch = 1 foot AutoCAD scale and, using this scale, an E-size drawing would have been printed. By specifying a D-size print, and an AutoCAD scale of FIT, you would get an inaccurate print.

**Method 2**

Embed a scale in AutoCAD using one of the five user parameters (USERR1 through USERR5) and allow the software to read that embedded scale or use `DIMSCALE` as the scale value for the drawing.

1. Within AutoCAD, embed the scale of the print into the DWG file:
   - At the AutoCAD command line, type `setvar` and press `Enter`.
   - AutoCAD prompts you to enter the variable name. Type `USERR1` (or the desired user variable (USERR1 through USERR5) and press `Enter`.
   - AutoCAD now prompts you to enter the new value for USERR1 (or the variable you entered).
   - Enter the desired drawing scale and press `Enter`. For example, `1=48` or `48`. Or use the same scale value for the dimension entities as for the entire image file.
Be sure to normalize the scale relationship such that the relationship is "1=xxxx"; enter the “xxxx” value. In other words, 1/8 inch = 1 foot should be written as 1=96 (1/8 inch = 12 inches or 1 inch equals 96 inches or 1 plotting unit equals 96 drawing units); enter 96 as the value for the variable.

2. In the Network Polling directory default PFS file, use the chosen AutoCAD variable, i.e., R1 for USERR1, R2 for USERR2, etc., or DIMSCALE (if defined in AutoCAD) for the scale value.

If there is no embedded value for the specified user variable, the program assumes a value of 1 and tries to print it.

3. In the default PFS file, set SIZE=AUTO and FinalSize=(desired size, normally 100%).

The embedded scale will be used to generate a print and, with SIZE set to AUTO, you will get a print as specified. Please note that setting SIZE=AUTO removes the ability of PlotWorks to compare specified size with the actual data.

In this scenario, we are again in a situation where the software cannot determine if an inconsistency occurred between the final size and specified size, as determined by the AutoCAD scale.
Repro Desk Support

Supported Repro Desk Files

PlotWorks supports Repro Desk and Apprentice JOB, VIC, PEN and SET files. Print jobs from Repro Desk containing PostScript, PDF, Calcomp, HPGL, HPGL/2, CALS, AutoCAD, DWG, and TIFF file formats are also supported.

Additional information regarding file formats follows:

- **JOB Files:** JOB files contain information, including printing parameters, about the entire Repro Desk or Apprentice job. PlotWorks supports Versions 4.21, 4.25, 4.30 and 4.30.2 JOB files.

- **VIC Files:** This is the file format that Repro Desk uses for pre-processed files. VIC files created with both the Apprentice and Buzzsaw.com® VIC Driver for AutoCAD, are supported. PlotWorks supports VIC files created with AutoCAD 14, AutoCAD 2000, AutoCAD 2000i, AutoCAD 2002, and AutoCAD 2004. PlotWorks supports:
  - Pen tables:
    - Pen numbers
    - Pen colors
    - Pen patterns
    - Pen widths
  - Embedded raster information
    - CALS MIL-R-28002A Type 1 (CCITT G4 2D Compression)
    - Independent JPEG Group JFIF (JPEG Compression)
    - MS-Windows BMP (Uncompressed DIB)
    - Portable Network Graphics PNG (LZH Compression)
    - TIFF Version 6 (CCITT G4 2D Compression)
    - TIFF Version 6 (Uncompressed)
    - TrueVision TGA Version 2 (Uncompressed)
    - ZSoft PC Paintbrush PCX (ZSOFT PACKBITS Compression)
• Black and white, gray scale and color VIC files.
• Embedded Fonts: SHX and TrueType fonts.
• Embedded OLE Objects.
• **PEN Files:** This is the file format that Repro Desk uses for PEN settings. The Repro Desk pen set is only imported when opening a JOB file.
• **SET Files:** This is the file format Repro Desk uses for pattern sets.

⚠️ *Word, Text, Stamp, and LDF file formats from Repro Desk are not supported by PlotWorks. However, you can print these to file using an HPGL2 or PostScript print driver and then import them into PlotWorks.*
Printing Repro Desk Jobs with PlotWorks

For PlotWorks to print a Repro Desk job, the job must be exported out of Repro Desk and then imported into PlotWorks. There are a few simple methods to accomplish this depending on how your organization is set up. This section describes some of these methods.

To export jobs from Repro Desk, you can set up the Repro Desk Client to send jobs via modem, drive letter, or to a specified Network Polling directory. You can also send jobs from the Repro Desk Queue directly to a PlotWorks Network Polling directory.

To import the job into PlotWorks, you can open the job in the PlotWorks Job Editor just as you would open a PlotWorks print job, or you can use Network Polling and poll a specified directory for Repro Desk jobs.

Many jobs can be sent directly to PlotWorks without any problems. However it is necessary to process some files in Repro Desk before PlotWorks can use them.

Processing Files before Outputting from Repro Desk

The following types of files need to be processed in Repro Desk before they are sent to PlotWorks:

- **DWG files**: DWG files must be processed in Repro Desk before they are sent to PlotWorks unless AutoCAD is used at the print location for file processing.

- **Files named the same**: If the Repro Desk job contains files that are different but have the same name, the files must be processed in Repro Desk before the job is submitted. Processing the job in Repro Desk generates VIC files with different names that PlotWorks can use.

- **Offset images**: If the original image is offset from the origin, the file needs to be processed in Repro Desk to determine the offset value.

Using PlotWorks Network Polling for Repro Desk Jobs

One common method of printing Repro Desk jobs using PlotWorks is by using the PlotWorks Network Polling application. To use this method you set up Repro Desk to send jobs to a specific directory or Repro Desk Queue. Then you set up Network Polling to send jobs from the Network Polling Directory to PlotWorks.
for printing. This directory or Repro Desk Queue is also referred to as the Network Polling Directory.

### Setting up PlotWorks Network Polling for Repro Desk Jobs

To set up a Network Polling directory for JOB files follow the instructions below:


22. Open the Network Polling window if it is not already open.

23. Click on the **Add Directory** button from the Network Polling tool bar. The Add Directory dialog box opens.

24. Click on the **Polling path Browse** button. The Open dialog box appears.
25. From the **Drives** drop down list, select the drive that contains the directory you wish to use as the Network Polling Directory (refer to Step 1).

26. Using the **Directories** select box, select the directory you wish to use as the Network Polling Directory.

27. Click on the **OK** button. The Open dialog box disappears and your directory is listed in the **Polling path** text box.

28. Select your other Network Polling options. For more information on these consult “Add a Target Directory” on page 6-6 of your PlotWorks User Guide.

29. Select the **Mode 5 Polling** radio button. Mode 5 polling is for Repro Desk JOB files.

30. Click on the **OK** button. The Add Directory dialog box disappears and your directory is listed in the Network Polling window.

If submitting ZIP files to a designated Network Polling directory, it is necessary to create a subdirectory. Placing a ZIP file in the root of a Network Polling directory is not permitted. If using a registered copy of WinZip, zipped files added to the Network Polling directory are automatically unzipped and sent to the Job Queue.

**Polling for Repro Desk VIC Files**

To set up a directory to poll for VIC files follow the instructions above but in Step 9 select **Mode 1** and for **Files of type** enter *.VIC
Sending Files from Repro Desk to PlotWorks

Jobs are sent out of Repro Desk from either the Repro Desk Client or from the Repro Desk Queue.

Outputting Jobs from the Repro Desk Client

1. Open the Repro Desk Client and create your Repro Desk job as desired.
2. Click on the Send Job button. The Send Job To… dialog box opens.
3. Depending on how you wish to send the job, select one of the options from the Send Job To… dialog box.

- To a Network Drive:
  1. Select the Drive radio button
  2. Select the Drive Letter using the drop down list.
  3. Click on the OK button. A Job Information window opens displaying a form.
  4. Fill in the form. Items labeled in bold are required.
  5. Click on the Submit button. Another Job Information window opens displaying your job information.
  6. Verify the information displayed is correct and then click on the Send Job button. The Job is compressed into a ZIP file named Job.zip and placed in the root of the selected drive. This ZIP file will contain the job instruction file, PEN file as well as VIC files, if
the job was processed before sending.

- **Via Modem to a preconfigured destination:**
  1. Select the **Modem** radio button and follow the instructions provided by your network administrator.
  2. Ensure that compression is selected.

- **To a Network Polling Directory:**
  1. Select the **Queue** radio button.
  2. Select the Network Polling Mode 5 directory.

  If you are sending jobs to a Network Polling Directory, it is necessary to set up the directory as a Network Polling Directory first. See “Using PlotWorks Network Polling for Repro Desk Jobs” on page Appendix G-3 for more information.

The following pages provide detailed instructions on submitting jobs from Repro Desk to PlotWorks.

**Outputting VIC files from the Repro Desk Client**

To submit VIC files from Repro Desk the original image files must be processed first. To process an image file either click the **Process** button on the Repro Desk toolbar or view the image file in Repro Desk. Then click on the Repro Desk **Send Job** button to send the VIC files to PlotWorks.

*If you view files in Repro Desk using their built-in viewer but do not select Send Job, the VIC files are deleted by Repro Desk and are not named in the Job files, nor are they then accessible to PlotWorks.*

**Outputting Jobs from the Repro Desk Queue**

You can send jobs from the Repro Desk Queue to a Network Polling Mode 5 Directory. To do so, designate the Network Polling Directory as your new Repro Desk Queue. Then open the original Repro Desk Job Queue, and send the job to the new “Network Polling Queue”.

**To designate the Network Polling Directory as the new Queue:**
  1. Open the Repro Desk Client and click on the Repro Desk **Queue** button.
2. Select Create New Queue. The Queue Creation Wizard dialog box appears. Follow the prompts and select the Network Polling Mode 5 directory you wish to designate as the new Queue. Name this Queue appropriately for example “Network Polling Queue”.

**Sending the Job from the Repro Desk Queue to the Network Polling Queue**

1. Open your Repro Desk Job Queue. By default this is named “Incoming”.
2. Right click on the job you wish to send to the Network Polling Queue.
3. Select Move Job To Queue if you wish to move the job deleting it from the original Queue. Select Send Entire Job To Queue if you want to send the job to the Network Polling Queue without deleting the job.

Once the job arrives in the Network Polling Mode 5 Directory it is sent to PlotWorks for printing.

**Importing Repro Desk Job files**

There are two ways to bring a Repro Desk job into PlotWorks. You can open Repro Desk jobs in the Job Editor or you can use Network Polling.

**Opening Repro Desk JOB Files in the Job Editor**

The PlotWorks Job Editor can be used to open, edit, and submit Repro Desk jobs to the PlotWorks Job Queue for printing. If the Repro Desk job file is received as a ZIP file it is necessary to extract it first.
Extracting the zipped files

If the Apprentice job is received as a ZIP file it is necessary to have a file extraction utility, like Power Archiver or WinZip, installed on your computer. It is necessary to extract the files before you can open the job in the Job Editor. To extract the files, follow the instructions below. Please note that instructions provided are generic. Your extraction utility may work differently.

1. Right click on the Windows **Start** button.
2. Select **Explorer** from the right click menu. The Windows Explorer window opens.
3. Navigate to the directory containing the zipped file.
4. Right click on the zip file. The right click menu displays.
5. Select **Extract to ...** The Extract dialog box opens.

![Extract Dialog Box](image)

6. From the **Folders/drivers** select box, select a directory to extract the files into.
7. Click on the **Extract** button. Your image and job files are extracted and placed in the selected directory.

Opening and outputting a JOB file using the Job Editor

To open a JOB file, follow the instructions below.

1. Open the **Job Editor** if it is not already open.
2. Click on the **Open Job** button. The Open dialog box displays.
3. Select **Job Files (*.job)** from the **Files of type** drop down list.

4. Click in the **Look in** drop down list and select the directory containing the Apprentice JOB file. The JOB file is displayed in the select box.

5. Double click on the desired JOB file. The job is opened in the Job Editor Job Grid. PlotWorks settings that are not defined in the Repro Desk JOB file are auto-detected or are assigned the parameters assigned to the prototype line. A Warning dialog box also opens displaying warning messages that pertain to the JOB file import process.

6. Select PlotWorks print parameters as desired. Specifically address the print parameters mentioned in the Warning dialog box. For more information on how to set print parameters in the Job Editor, click on the Job Editor Help menu or refer to the PlotWorks User Guide.

7. Click on the **Output** button. The Output Job dialog box opens.
8. Select your output options.

9. Click on the OK button to send the job to the selected output destination. This is usually the Job Queue so that the job can be printed.

Adding and outputting VIC Files using the Job Editor

1. Open the Job Editor if it is not already open.
2. Click on the Add Files button. The Add Files dialog box opens.
3. Use the **Look in** drop down list to select the directory containing the VIC files.

4. Select the desired VIC files.

5. Click on the **Open** button. The Add Files dialog box disappears and the selected VIC files are added to the Job Editor Job Grid.

| **Warning** Pen files are not included when adding VIC files. to the Job Editor. Therefore, when VIC files are added to the Job Editor using the **Add Files** option, all pen parameters and macros must be manually set in PlotWorks.

6. Select your printing parameters and output the job as you would any other PlotWorks job.
Repro Desk Pens and Patterns

Repro Desk Pen Properties and the PlotWorks Equivalent

The Repro Desk Client offers options for Pen Sets in their Pens tabbed dialog box. In PlotWorks these options are specified using Pen Macros. The following table lists the PlotWorks Pen Macros and their Repro Desk equivalent.

<table>
<thead>
<tr>
<th>PlotWorks Pen Macro</th>
<th>Option from the Controls tab of the Repro Desk Pen dialog box</th>
</tr>
</thead>
<tbody>
<tr>
<td>B</td>
<td><strong>Pen Colors</strong> is not selected. (Pen colors are not mapped to a shaded halftone.)</td>
</tr>
<tr>
<td>C</td>
<td><strong>Pen Colors</strong> is selected. (Pen colors can be manipulated and are acquired from the plot file.)</td>
</tr>
<tr>
<td>E</td>
<td><strong>Pen Screens &amp; Patterns</strong> is selected. (Pen screens and patterns can be manipulated and are acquired from the plot file.)</td>
</tr>
<tr>
<td>F</td>
<td><strong>Fill Screens &amp; Patterns</strong> is selected. (Fill screens and patterns can be manipulated and are acquired from the plot file.)</td>
</tr>
<tr>
<td>G</td>
<td><strong>Pen Colors</strong> is not selected and <strong>Map Pen Colors to a Shaded Half tone</strong> is selected. (Pen colors are mapped to a shaded half tone.)</td>
</tr>
<tr>
<td>M</td>
<td><strong>Pen Colors</strong> is selected.</td>
</tr>
<tr>
<td>R</td>
<td><strong>Use Error Diffusion for Gray or Color RTL images</strong> is selected.</td>
</tr>
<tr>
<td>T</td>
<td><strong>Pen Effect (Transparency)</strong> is selected. (Pen types and effects can be manipulated and are acquired from the plot file.)</td>
</tr>
<tr>
<td>W</td>
<td><strong>Pen Widths</strong> is selected. (Pen widths are acquired from the plot file.)</td>
</tr>
<tr>
<td>X</td>
<td><strong>Pen Colors</strong> is selected and <strong>Map Pen Colors to a Shaded Half tone</strong> is not selected. (Pen colors are not mapped to a shaded half tone.)</td>
</tr>
</tbody>
</table>
PlotWorks Pen Macros not supported by Repro Desk

The following PlotWorks Pen Macros do not have a Repro Desk equivalent:

<table>
<thead>
<tr>
<th>PlotWorks Pen Macro</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>N</td>
<td>Do not scale RTL raster data</td>
</tr>
<tr>
<td>Y</td>
<td>Use alternate fill instead of winding fills for polygons</td>
</tr>
</tbody>
</table>

Importing Repro Desk Pattern Files

Repro Desk is installed with 127 default pattern files. Repro Desk users can modify these default patterns and assign them numbers from 128-255. This custom set of patterns is saved as a *.SET file. If a Repro Desk job uses these modified patterns, the SET file should be imported into PlotWorks to ensure the job prints correctly.

Once these pattern files are imported into PlotWorks, all subsequent print jobs will use this imported pattern set until you revert to the default pattern set. Imported patterns can create undesired effects on print jobs that do not use the imported pattern set. Therefore, revert to the standard patterns after printing jobs that required the custom pattern set.

Pattern files are not automatically submitted with a Repro Desk job. Pattern files must be imported manually.

Importing a User Defined Repro Desk pattern

1. Open the Printer Interface if it is not already open.
2. Pause or Stop the Printer Interface ensuring no print jobs are pending.
3. Click on the File menu.
4. Select **Import Pattern File**. The Open Pattern File dialog box opens.

5. Using the **Look in** drop down list, select the folder containing the pattern file.

6. From the **Files of Type** drop down list, select **Pattern Set Files (*.set)**.

7. Double click on the pattern file. The file is imported.

Repro Desk pen patterns are assigned pattern numbers from 250 through 505 in PlotWorks. So if you select pattern number 254 in PlotWorks you are actually selecting Repro Desk pattern number 4.

**Reverting to the Default Standard Patterns**

1. Click on the **File** menu.

8. Select **Revert to Standard Patterns**

Now the standard set of patterns included with PlotWorks is used.
Warnings and Other Print Parameter Issues

Warnings

The various warnings generated by PlotWorks are documented alphabetically below.

100% Normal, 50% Reduction, and 200% enlargement may not be fully supported

If 100% Normal, 50% Reduction, or 200% enlargement is specified, the resulting print size may not be exactly what was expected.

Address was truncated to 40 characters

The Delivery Address field is limited to 40 characters

AutoCAD option to use saved extents is not currently supported

The Repro Desk option "use saved extents" is not currently supported.

City was truncated to 25 characters

The Delivery City field is limited to 25 characters

Color is not available on some file types

Some file types cannot be printed in color with PlotWorks unless a color RTL printer is used.

Different folds for each document in the job ticket is not supported. The first document's folding parameters will be used for all documents in the job ticket

PlotWorks does not currently support more than one fold type for documents contained in a job ticket. The fold settings specified for the first file is used for all the files in the job.

File could not be found at the original path nor the JOB directory

This message displays if the file does not exist, or isn't found in the original directory specified by the Repro Desk job ticket, nor can it be found in the same directory as the job file.

Folding packet height is not currently supported and will be defaulted

PlotWorks does not yet support a packet height size.

Invalid pen set file

The pen set file contains an incorrect signature therefore it cannot be used.
Inversion not currently supported for all data formats
PlotWorks currently only supports inversion for some file formats.

Job Instructions were truncated to 80 characters
The Instruction field is limited to 80 characters.

Job Instructions will be truncated in order to add the PO Number and not exceed 80 characters
The Job Instruction field is limited to 80 characters. However, if a value is also provided for PO Number, PlotWorks further truncates the Job Instructions and appends the PO Number. Combined, the PO Number and Job Instructions cannot exceed 80 characters.

Number of sets is out of range (1-9999) and will be set to 1
If the number of sets specified in Repro Desk is larger than 9999 it is reset to 1 in PlotWorks. PlotWorks has a 9999 set limit.

Only error diffusion is currently supported for RTL images
The "Use error diffusion" checkbox in Repro Desk was deselected in the pen set for this image. PlotWorks only uses error diffusion for RTL images.

Only ten overlays per file are currently supported. The rest will be skipped"
Ten is the maximum number of overlays that can be applied on one file.

Only the first entry of the overlay file with the same name will be used. The others will be ignored"
If an overlay with the same name is applied to multiple files in a job ticket, only the first overlay file listed in the job ticket, including any alignment, rotation, or other specified parameters will be used.

Pen effect XOR is not currently supported and will be defaulted.
The pen effect "XOR" is not currently supported in PlotWorks.

Pen number [ ] was expected but number [ ] was gotten instead. Pen set file may be corrupt
An error occurred while attempting to read an entry in the pen set file. Check for network or storage problems, or recreate the pen set file.

Pen set file appears corrupt since entry number [ ] could not be read
An error occurred while attempting to read an entry in the pen set file. Check for network or storage problems, or recreate the pen set file.
Pen set file appears to be truncated and corrupt
   The pen set file is not usable.

Quantity is too large and will be truncated to 9999
   If the quantity (copy count) for a file is higher than 9999, then PlotWorks resets it to 9999.

Rotation, alignment and left margin may not work correctly if file has not been processed and specified size has different orientation than the image file"
   To ensure that the file is printed correctly process the drawing in Repro Desk first. Otherwise the alignment, rotation and left margin may be affected.

Stamp files are not currently supported, but can be manually added using a watermark or label
   Currently PlotWorks does not support LBL Files. These are the Apprentice Stamp files. However, you can add a similar stamp using the Job Editor’s Watermark, Label, and Overlay property sheets.

State/Country was truncated to 25 characters
   The Delivery State and Delivery Country fields are combined and limited to 25 characters.

Unable to correctly position the image because file has not yet been processed
   The original image size is not yet known, as the file has not yet been processed, therefore the alignment may not be applied correctly.

Unable to correctly scale this alignment because file has not yet been processed
   The original image size is not yet known, as the file has not yet been processed, therefore the alignment may not be scaled correctly.

Unable to find a matching pen color. Black will be used
   A matching color is not found in the PlotWorks pen set color palette therefore black will be used.

Unable to find a matching pen color. The closest color found will be used
   PlotWorks does not support the full pen set RGB colors. Pen color will be matched to the closest color in the PlotWorks pen set color palette.
Unable to open pen set file to read in the pen set. Using default pen set
The specified pen set file cannot be opened or read. Ensure the file is not in use or corrupted.

Unable to read *.Job file entry
An error occurred while reading the job file.

Unable to remove borders because file has not yet been processed
To remove borders, the file needs to be processed in Repro Desk first to create a VIC file.

Unable to do title block alignment because file has not yet been processed. Using centered instead
The original image size is not yet known, as the file has not yet been processed, therefore the title block alignment may not be scaled correctly. The file needs to be processed in Repro Desk.

Unknown AutoCAD plot by option. Using extents
A plot by option is not recognized and plot by extents will be used instead.

Unknown media type [] being translated to Bond
The media type selected in Repro Desk is not known and Bond will be used instead.

Unknown orientation - assuming normal orientation
The specified orientation is not recognized so the default orientation will be applied.

Unknown pen effect will be mapped to default
An unknown pen effect type is detected and set to default (transparent) in PlotWorks.

Unknown special alignment option was used. Using centered instead
The specified alignment option is not recognized therefore centered alignment will be used.

Unrecognized folding option. No folding will be set
The specified fold option is unrecognized and no folding parameters have been applied.

Unsupported *.Job file version
Only Repro Desk versions 103 and 104 job files are supported. Also only
Repro Desk software versions 4.25, and 4.30 are currently supported.

**Unsupported media type (Bond 110g, *Bond, or *Bond 110g) is translated to Bond**

The media type selected in Repro Desk is not currently supported and Bond will be used instead.

**Unsupported media type (Trans. 110g) being translated to T-Bond**

The media type selected in Repro Desk is not currently supported and T-Bond will be used instead.

**Unsupported media type (Film 4.5mil) being translated to Mylar**

The media type selected in Repro Desk is not currently supported and Mylar will be used instead.

**Unsupported pen set file version**

The pen set file version is not version 100. This is currently the only supported pen file version.

**User-defined patterns require manual importing of the pattern file before printing the job**

User-defined patterns (numbers 128-255) are used in the pen set. These patterns need to be imported into the Printer Interface via the pattern set file before printing.

**Zip files are not currently supported. Please unzip the files and add them manually**

Unzip the zip file and then add it to either the Repro Desk or PlotWorks job ticket.

**Zip was truncated to 25 characters**

The Delivery Zip field is limited to 25 characters

**Zoom percentage was too large and has been truncated to 10,000%**

If a zoom percentage greater than 10000% is selected, PlotWorks reduces it to 10000%.

**Print Parameter Issues**

**AutoCAD DWG files**

The Repro Desk AutoCAD default font, font path and Xref settings are ignored and PlotWorks settings are used instead.
**View name** is transferred to the PlotWorks View name, only if Plot by View is selected.

**Folding parameters**

Fold Enable, Binding Edge, Folding Width, Cross fold, Punch, and Reinforcement options from Repro Desk are supported regardless of the folding program used. PlotWorks will automatically add the following macros to support folding options set in Repro Desk.

- The "E" fold macro is applied for the Ericsson folds.
- The "A" fold macro is applied for the AFNOR folds.
- The "S" pen macro is applied for Portrait fold orientations.

Ericsson and Afnor folding options are not supported for older folders.

Landscape orientation or free-fit settings have no effect if Portrait orientation is set in folding options as Portrait orientation overrides these settings.

Fold program number has no equivalent in a PLP file and is ignored.

If a Repro Desk Fold Option is not understood, the user is warned and folding is deselected in PlotWorks.

**Overlays**

If the same overlay is applied on more than one file of a Repro Desk Job Ticket and the job is then opened in the PlotWorks Job Editor, the overlay is listed multiple times. However, only the first overlay listed in the job ticket, and its specified print parameters, is applied to all the files.

**PEN files**

Pen settings for JOB files are stored in a .PEN file. PlotWorks supports the Repro Desk PEN files with the following limitations:

- Pen files cannot be opened in PlotWorks.
- If Pen Colors, Pen Screens and Patterns, Fill screens and Patterns, or Pen Effects is selected in Repro Desk, the "C" macro is applied for Pen Colors settings, "E" macro for Pen Screen and Patterns, "F" macro for Fill screens and Patterns, and the "T" macro for Pen Type or effect.
- The "K" pen macro is added when HPGL2 files are output from Repro Desk.
• To print highlight red from PlotWorks, define the desired pen color as red in your plot file.

• PlotWorks uses transparent for XOR pen effects.

• Using Alternate Fill instead of Winding Fill for Polygons option in the pen set is not currently supported since PlotWorks derives this information from the HPGL2 file.

• PlotWorks does not support Full RGB Pens in a pen set. If the pen is in an HPGL2 file it is supported.

Pen patterns
Pattern files are not transmitted with the job submission and must be copied manually for pattern changes to take effect.

Pen pattern names are discarded, since PlotWorks does not support pattern names for pattern numbers.

RTL images
PlotWorks only supports Error diffusion for grayscale and color RTL images. Therefore when the Error diffusion check box is deselected, PlotWorks ignores it and notifies you with a warning.

The Repro Desk option, "Do not scale RTL raster data" is not supported by PlotWorks currently.

Specified Size
When a combination of rotation and alignment is applied, the Specified Size is increased so that PlotWorks can produce the desired output. This may generate processing warnings in the Job Queue.

Title Block Orientation
Title block orientation is supported, but requires the drawing be preprocessed. If the drawing is not preprocessed, a warning message is recorded and centered orientation is used.

Use Saved Extents
The option to "Use saved extents" is not currently supported. If selected in Repro Desk, a warning message is recorded.
User Information

- Contact Name, Company, Account Number, Project, Phone Number, PO Number, Delivery Address, Delivery City, Delivery State, Delivery Country, Delivery Zip, Comment, and Additional Number of Sets are supported. However, PlotWorks does not currently support the full possible size of these entries.

- The Contact Name is limited to 63 characters
- The Company Name is limited to 40 characters
- The Account Number is limited to 25 characters
- The Project Name is limited to 25 characters
- The Phone Number is limited to 25 characters
- The Comment (Job Instructions) and the P.O Number are combined and limited to 80 characters. The comment is truncated to allow spaces for the P.O Number.

If entered user information exceed its allocated character limit, additional characters are truncated and a warning is displayed.

Zoom options

Zoom options are supported up to a maximum 10,000% value.
PlotWorks Settings Not Supported by Repro Desk

There are a number of PlotWorks settings that are not supported by Repro Desk Job files. These include: Output Quality, Fill Space, Overlay Offsets, Watermarks, Labels, Top, Bottom, and Right Margins, Finishing Margin, and many data format specific options such as for Calcomp files, HPGL2 resolution, etc. PlotWorks will either auto-detect these settings or default them to values from the Prototype line.

Printing differences between Repro Desk and PlotWorks

Alignment

If an image is left aligned in Repro Desk and rotation is set at 90 or 270 degrees, the image becomes right aligned.

If left margin is selected and alignment is set as centered at 0 or 180 degree rotation, Repro Desk shifts the image off the page by a variable amount. This does not occur with Repro Desk when 90 or 270-degree rotation is selected. PlotWorks does not shift the image regardless of the rotation selected.

Image density

Compensate for differences in image density by adjusting the gamma correction settings in the Printer Interface. The amount of correction necessary is dependent on the printer used and customer preferences. For more information refer to page 8-34.

Map Pen Colors to a Shaded Halftone

Test cases using the sample SuCasa files, showed that when "Map Pen Colors to a Shaded Halftone" was selected, Repro Desk did not print certain sections of the drawings. Also 0.06mm line weights caused fills to disappear in some areas. In these cases PlotWorks output was superior and consistent.

Pen Lines

If pen lines are printing too thin, deselect Reduce pen widths from the Printer Interface, Device Specific Options dialog box. For more information see page 8-17.

Postscript/PDF prints

Postscript/PDF prints often look better when printed with PlotWorks. This is because in PlotWorks, Postscript/PDF resolution can be manually set to any number, individually, per drawing. This reduces or eliminates undesirable patterns...
when scaling by a fractional pixel replication. Postscript/PDF resolution can also be automatically set based on how much the drawing is being enlarged or reduced for output. Job files do not contain dynamic resolution values, therefore the prototype's setting is used to determine whether to automatically set the resolution or set it to a user-defined value.
PlotWorks End-User Licence Agreement

IMPORTANT-READ CAREFULLY: This End-User License Agreement ("EULA") is a legal agreement between you (either an individual or a single entity) and PLP Digital Systems, Inc. ("PLP") for the PLP software product identified above, which includes computer software and may include associated media, printed materials, and "online" or electronic documentation ("Product"). An amendment or addendum to this EULA may accompany the Product. YOU AGREE TO BE BOUNDED BY THE TERMS OF THIS EULA BY INSTALLING, COPYING OR OTHERWISE USING THE PRODUCT. IF YOU DO NOT AGREE, DO NOT INSTALL OR USE THE PRODUCT.

1. LICENSE:
You have the non-exclusive right to use the enclosed programs. These programs can only be used on a single computer. You may physically transfer the programs from one computer to another provided the programs reside on only one computer at a time. You may make one back-up copy of the programs solely for backup purposes. You must reproduce and include the copyright notice on the backup copy. You may not electronically transfer the programs from one computer to another over a network. You may not rent, lease or distribute copies of the programs or documentation to others. You may not modify or translate the programs or related documentation without the prior written consent of PLP. You may not reverse assemble or reverse compile the programs without PLP's consent. These programs may include clients designed to submit jobs from remote locations. You may distribute copies of the client programs solely for the preparation and submission of jobs to a PlotWorks print server or scan server. YOU MAY NOT USE, COPY, MODIFY OR TRANSFER THE PROGRAMS, OR DOCUMENTATION, OR ANY COPY, EXCEPT AS EXPRESSLY PROVIDED IN THIS AGREEMENT.

2. OWNERSHIP:
You shall own only the magnetic or other physical media on which the programs and its related documentation are recorded or fixed. PLP shall at all times retain ownership of the programs recorded on the original media and all subsequent copies of the programs, regardless of the form or media in or on which the original and other copies may subsequently exist.

3. SECURITY:
Your programs contain embedded codes that will cause the programs to cease operating within 30 days unless the codes are replaced by PLP. Upon your acceptance of this license agreement, and full payment of the fees due hereunder, PLP will provide you with codes allowing for perpetual operation.

4. TERM:
This license is effective until terminated. You may terminate it by destroying the programs and documentation and all copies thereof. This license will also terminate if you fail to comply with any term or condition of this Agreement. You agree, upon such termination, to destroy all copies of the programs and documentation. All rights to use the programs granted herein are contingent upon timely payment of any fees due to PLP.

5. LIMITED WARRANTY AND DISCLAIMER OF WARRANTY:
PLP warrants the programs will perform as described in the technical documentation. This warranty is void if the programs are altered or modified in any way by anyone other than PLP. PLP AND SUPPLIERS OF THIRD PARTY SOFTWARE HEREUNDER DISCLAIM ALL OTHER WARRANTIES, EXPRESS OR IMPLIED, INCLUDING, BUT NOT LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE.

PLP is not responsible for problems caused by changes made after the publication of the programs in the operating characteristics of computer hardware, test instruments or operating systems, nor for problems in the interaction of the programs with non-PLP software components.

PLP assumes no responsibility for interruption of access to the programs through the Internet or as a result of network failures, nor is PLP responsible for breaches in security, including any damages resulting therefrom. PLP does not warrant that access to the programs through the Internet will be error-free or that files available for downloading from or through the PLP web site will be free from viruses or similar contamination or destructive devices.

6. THIRD PARTY BENEFICIARIES
PlotWorks contains software licensed by PLP from Autodesk, Inc. ("Autodesk"). You are hereby granted a non-exclusive, transferable license to this third party software. Autodesk is a third party beneficiary of this agreement, and assumes no responsibility for any damages, whether di-
rect, indirect, incidental or consequential, in connection with the use of this software. You are expressly prohibited from modifying the included Autodesk software, and you are expressly prohibited from using the included Autodesk software with any product other than PlotWorks.

The PlotWorks interface for the Xerox Wide Format Scan System contains software licensed by PLP from Xerox Corporation ("Xerox"). If you have purchased the PlotWorks interface for the Xerox Wide Format Scan System you are hereby granted a non-exclusive, non-transferable license to this third party software for exclusive use with a Xerox Wide Format Scan System. Xerox is a third party beneficiary of this agreement, and assumes no responsibility for any damages, whether direct, indirect, incidental or consequential, in connection with the use of the PlotWorks interface for the Xerox Wide Format Scan System.

7. LIMITATION OF REMEDIES:
PLP's entire liability and your exclusive remedy shall be refund of the purchase price, regardless of any defect in the programs, or negligence of PLP, and regardless of the claim or form of action. In no event will PLP be liable to you for any lost profits, lost savings, or other incidental or consequential damages arising out of the use of, or inability to use, any programs, even if PLP, or a PLP authorized representative, has been advised of the possibility of such damages, or for any other claim by any other party. You agree that PLP's liability hereunder for damages regardless of the form of action will not exceed the license fee paid to PLP for use of the programs during the prior twelve-month period.

8. NO REPRESENTATIONS:
This license defines PLP's entire responsibility to you concerning the programs. If you believe that any representative of PLP has made any representations or commitments to you or reached any understandings or agreements with you relating to the programs, you acknowledge that this License Agreement specifically supersedes them. All of your rights and remedies are as set forth herein.

9. AUTHORITY:
By accepting these terms, you represent that you have the authority from your employer or principal to do so.

10. TRANSFER:
PLP will authorize you to transfer its rights under this Agreement, except as explicitly forbidden in Section 6, to another bona-fide end user of the programs (including a new or related entity), but only if: (A) You cease use of the programs and waive any future rights hereunder, (B) the transferee signs a license agreement in PLP's then current form, (C) the transfer would not be, in PLP's reasonable business judgment, deleterious to PLP's interests; And (D) you or the transferee pay a transfer fee equal to eighteen percent (18%) of the current software price for the configuration being transferred, which will entitle the transferee to a one year support and software maintenance contract with PLP containing PLP's standard terms. Notification of the proposed transfer should be sent to the attention of Sales Coordinator at PLP for proper authorization.

11. SERVICES:

In connection with the license of the programs, PLP may provide certain services, including integration, installation and consulting, upon payment of an additional fee to PLP. PLP may also assist you in integrating the programs into your network and accessing the programs through the Internet. PLP makes no warranty, express or implied, regarding its services or the results to be obtained therefrom. You are solely responsible for establishing and maintaining the network structure, administering the network and Internet access, and network and Internet security.

12. MISCELLANEOUS:

Virginia law shall govern the validity and performance of this license, except as to copyright and trademark matters, which are covered by United States laws and international treaties. All disputes will be resolved by arbitration. In the United States this will be under the auspices of the American Arbitration Association in Richmond, Virginia. In Europe arbitration will be conducted according to the Rules of Arbitration of the International Chamber of Commerce in London, England. In Asia, arbitration will be conducted according to the Rules of Arbitration of the International Chamber of Commerce in Honolulu, Hawaii. This Agreement constitutes the entire agreement between you and PLP and supersedes all previous communications either written or oral regarding the subject matter of this Agreement.

NOTICE TO USERS: THIS IS A CONTRACT. BY INSTALLING THIS SOFTWARE YOU ACCEPT ALL THE TERMS AND CONDITIONS OF THIS AGREEMENT.

This Adobe Systems Incorporated ("Adobe") End User License Agreement accompanies the Adobe® Acrobat® Reader product and related explanatory materials ("Software"). The term "Software" also shall include any upgrades, modified versions or updates of the Software licensed to you by Adobe. Please read this Agreement carefully. At the end, you will be asked to accept this agreement and continue to install or, if you do not wish to accept this Agreement, to decline this agreement, in which case you will not be able to use the Software.

Upon your acceptance of this Agreement, Adobe grants to you a nonexclusive license to use the Software, provided that you agree to the following:

1. Use of the Software.
   • You may install the Software on a hard disk or other storage device; install and use the Software on a file server for use on a network for the purposes of (i) permanent installation onto hard disks or other storage devices or (ii) use of the Software over such network; and make backup copies of the Software.
   • You may make and distribute unlimited copies of the Software, including copies for commercial distribution, as long as each copy that you make and distribute contains this Agreement, the Acrobat Reader installer, and the same copyright and other proprietary notices pertaining to this Software that appear in the Software. If you download the Software from the Internet or similar on-line source, you must include the Adobe copyright notice for the Software with any on-line distribution and on any media you distribute that includes the Software.

2. Copyright and Trademark Rights. The Software is owned by Adobe and its suppliers, and its structure, organization and code are the valuable trade secrets of Adobe and its suppliers. The Software also is protected by United States Copyright Law and International Treaty provisions. You may use trademarks only insofar as required to comply with Section 1 of this Agreement and to identify printed output produced by the Software, in accordance with accepted trademark practice, including identification of trademark owner’s name. Such use of any trademark does not give you any rights of ownership in that trademark. Except as stated above, this Agreement does not grant you any intellectual property rights in the Software.

3. Restrictions. You agree not to modify, adapt, translate, reverse engineer, decompile, disassemble or otherwise attempt to discover the source code of the Software. Although you may customize the installer for the Software as documented on the Adobe Acrobat Reader CD-ROM (e.g., installation of additional plug-in and help files), you may not otherwise alter or modify the installer program or create a new installer for the Software. The Software is licensed and distributed by Adobe for viewing, distributing and sharing PDF files. Any plug-in or enhancement that permits you to save modifications to a PDF file is authorized only for use with Acrobat Exchange™ program and may not be used with the Software.

4. No Warranty. The Software is being delivered to you AS IS and Adobe makes no warranty as to its use or performance. ADOBE AND ITS SUPPLIERS DO NOT AND CANNOT WARRANT THE PERFORMANCE OR RESULTS YOU MAY OBTAIN BY USING THE SOFTWARE OR DOCUMENTATION.
TION. ADOBE AND ITS SUPPLIERS MAKE NO WARRANTIES, EXPRESS OR IMPLIED, AS TO
NONINFRINGEMENT OF THIRD PARTY RIGHTS, MERCHANTABILITY, OR FITNESS FOR
ANY PARTICULAR PURPOSE. IN NO EVENT WILL ADOBE OR ITS SUPPLIERS BE LIABLE TO
YOU FOR ANY CONSEQUENTIAL, INCIDENTAL OR SPECIAL DAMAGES, INCLUDING ANY
LOST PROFITS OR LOST SAVINGS, EVEN IF AN ADOBE REPRESENTATIVE HAS BEEN ADVI-
SEd OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY ANY THIRD PAR-
TY. Some states or jurisdictions do not allow the exclusion or limitation of incidental, consequential or
special damages, or the exclusion of implied warranties or limitations on how long an implied warranty
may last, so the above limitations may not apply to you.

5. Governing Law and General Provisions. This Agreement will be governed by the laws of the State
of California, U.S.A., excluding the application of its conflicts of law rules. This Agreement will not be
governed by the United Nations Convention on Contracts for the International Sale of Goods, the applica-
tion of which is expressly excluded. If any part of this Agreement is found void and unenforceable, it will
not affect the validity of the balance of the Agreement, which shall remain valid and enforceable according
to its terms. You agree that the Software will not be shipped, transferred or exported into any country or
used in any manner prohibited by the United States Export Administration Act or any other export laws,
restrictions or regulations. This Agreement shall automatically terminate upon failure by you to comply
with its terms. This Agreement may only be modified in writing signed by an authorized officer of Adobe.

6. Notice to Government End Users. If this product is acquired under the terms of a: GSA contract-
Use, reproduction or disclosure is subject to the restrictions set forth in the applicable ADP Schedule con-
tract; U.S. DoD contract- Use, duplication or disclosure by the Government is subject to restrictions as set
forth in subparagraph (c) (1) (ii) of 252.227-7013; Civilian agency contract- Use, reproduction, or disclo-
sure is subject to 52.227-19 (a) through (d) and restrictions set forth in the accompanying end user agree-
ment.

Unpublished-rights reserved under the copyright laws of the United States.
Adobe Systems Incorporated, 345 Park Avenue, San Jose, CA 95110.

Adobe, Acrobat, and Acrobat Exchange are trademarks of Adobe Systems Incorporated.

YOUR ACCEPTANCE OF THE FOREGOING AGREEMENT WAS INDICATED DURING
INSTALLATION OF THE ACROBAT READER.
Symbols

# of sets 4-123
^ macro 4-42

Numerics

8180 8-46, 8-49
8180 automatic set rotation 8-16, 11-9
8180 Folder 11-32, 11-33
8180 Printer
dual color printing Appendix A-4
8830 8-71
8830 Folder 11-24
8845 Folder 11-24
8845 pen widths 8-55
8850 8-71
8855 8-71

A

A macro 4-46
abort a job 3-17
Abort Job 3-5
about folding 11-11
about nesting 4-71
AccXES 8-10, 8-67, 8-74
Acquire 4-92, 4-93
Acquiring images from a TWAIN scanner 4-93
Activation codes are about to expire Appendix B-9
Actual Length 8-22
Actual Type 8-23
Actual Width 8-22
add an entry to the media inventory 2-11
Add crop marks when needed 8-12
Add Files 4-7
Add fold margin 4-69
add images to a job ticket 2-14
Add lead/trailing edge 8-17
Add Printer 8-69
add showpage (PostScript files) 4-29
Add/Edit Media Inventory 2-11, 8-21
adding media 8-21
Additions Setup 4-102
Advanced Media Options 8-23
Advanced Options 8-33
Advanced Options... 11-33
Age Timeout 6-8
All Color Models Option 8-35
Allow Color if Available 4-44
Alternate VIC Merge Control 4-42
Always Use PlotWorks Viewer 4-10
An error occurred attempting to delete the file %s from the ftp server. xxx (nnn) Appendix B-24
An error occurred downloading the file yyy. xxx (nnn) Appendix B-25
archive 3-20
Archiving a log file 10-15
Area size 9-7
ARU
job report 10-1
ARU file size 10-15
ARU Keywords 10-3
ARU log 10-2
associate the Print-to-Queue setup (Windows NT) 12-18
Auto Detect Seed Values 9-61
Auto Detected 4-19, 4-21
Auto exposure 9-7
Auto length 9-8
Auto naming 9-10
Auto naming options 4-90
Auto preview compared file 4-106
Auto scan 9-8, 9-43
Auto thresholding 9-7
Auto view 9-8
AutoCAD 12-24
   Error Free Printing Appendix F-10
   printing boundaries Appendix F-2
   printing using Network Polling Mode 1 Appendix F-14
AutoCAD files
   special options 4-29
      English or metric 4-30
      plot by 4-30
      remove hidden lines 4-30
      reverse Z order 4-30
      scale 4-30
      view name 4-30
AutoCAD Processing Appendix F-9
AutoCAD scale 4-13
AutoCAD/DWG Direct Setup sheet 4-76
auto-detected folders 11-8
Auto-generate a filename (dont prompt after each file) 4-82, 4-86
automatic file naming 9-17
automatic printing 3-16

C

C macro 4-41
CalComp Commands Appendix C-3
CalComp commands Appendix C-3
CalComp error codes Appendix C-4
CALS 8-49, 9-11
Cancel 4-107
Center output on media 8-13
change from a color to monochrome printer 8-66,
   8-77
change image filenames 4-16
change media type 8-25
choose an image file format 9-20
Close 4-107
Color (24 Bit) 9-56
Color Feature Key 9-49, 9-56
Color Model and Rendering Options 4-43
Color Sensitivity 9-7
Command
   HP-GL & HP-GL/2 Appendix C-5
Command line switches 6-11
Command Prompt 8-68
Commands
   CalComp Appendix C-3
Compare 4-106
Compare Configuratins 4-101
Compare Configuration 4-99
Compare file and both revs 4-105
Compare File and old rev 4-105
Compare File only 4-105
Compare Files 4-101
Comparison file 4-99
Compress all files into single file 4-114
Compress all files into single file prior to submission 4-114
Compress in scanner 9-9
Configuration 9-3, 9-5
Configure 7-3, 7-5
configure an output destination 4-109
Configure Destinations 4-112
Configure Error Notification
   7-3, 7-5

B

B Pen Macro 4-44
background
   automatic removal 9-24
Background bias 9-6
Background Removal 9-25
Background removal 9-6
background suppression 9-7
Batch scanning 9-60
Beep on new queue entries 3-12
Binding Margin 11-28, 11-31
Bi-Tonal 9-60
Black point 9-8
Bottom Edge 9-13
Browse button 9-3
button 9-10
Buzzaw.com® VIC Driver for AutoCAD Appendix G-1
configure PlotWorks applications 2-7
configure the printer 2-9
configuring a Print-to-Queue port (Windows 95/98) 12-20
configuring a Print-to-Queue port (Windows NT) 12-6
configuring AutoCAD 14 for use with PlotWorks Appendix F-6
configuring hardware 1-6
configuring Linux to submit to Plotworks Job Queue 12-24
configuring LPD to work with PlotWorks 12-20
configuring NT Workstation 4.0 to support LPD 12-20
configuring RAS to output PlotWorks job files Appendix E-1
configuring Windows NT 4.0 Workstation for FTP Appendix E-32
Confirm file replacement 4-89, 9-10
Connect to Queue 8-4, 8-39
connect to the RAS host Appendix E-18
Contex 8300 FSS/FCS Scanner Interface 9-80
Continue processing 4-109
Contrast 9-7
Convert PFS keywords to INF file 6-9
Copy Field 4-9, 4-16
Copy Field Down 4-9
Copy Field Up 4-9
Copy mode timeout 8-17
Copy Row 4-9
Copy Row to Prototype 4-9
copying 9-26, 9-27
could not be locked Appendix B-3
create a new Job Queue 3-10
Create a Query 10-23
Create Multipage Document 4-95
Create multipage document 4-97
Creating a report in Microsoft Access 10-25
creating PFS files Appendix D-1
Cross Fold 11-28, 11-33
Cross-fold 4-69
Current Directory 9-30
Cut Row 4-8

D

Darkness 9-7
Data Format property sheet 4-27
data type 4-29, 4-31
DEF file 10-2
Default Dithering Type 8-35
  Diffused 8-36
  Ordered 8-36
  Reduced Coverage Ordered 8-36
Default Dithering Types 8-35
Default file paths 4-65
Default number of sets to request 4-65
Default PFS file 6-8
default PFS files Appendix D-3
DEFAULT.PFS 6-13
Delete 9-9
delete 3-19
Delete an existing Output Destination 4-119
Delete Row 4-9
Deleted 8-13, 8-14
Deleted after 8-13, 8-14
Deleting Media from Inventory 8-24
Delimited 10-16
Demo System 2-19
Destination Device 6-8
Destination Directory 4-85
Destination name 4-113
Destination Path 4-113
Destination Type 4-113
destination types 4-114
determining fold width 11-23
Device # 6-8
Device number 8-11
Device Specific Options 8-5, 8-15, 8-74
Devices Online 3-12
device-specific options 2-11
DGN files
  advanced options 4-31
  special options
    view name 4-30
Dial-Up Networking Appendix E-15
  add a connection Appendix E-16
setup the client Appendix E-15
DIN AC 11-29
DIN B 11-29
Directory PFS file 6-8
directory-level defaults Appendix D-3
Disable ARU logging 8-13
Display 4-14
Display Images When Printing 8-29
Dither/Halftone 9-6
DNS 12-22
Do not show splash screens 4-10, 8-5
Document offsets 9-13
document size 9-21
documentation
   additional 1-22
domain name system 12-22
Don’t generate File name 4-81, 4-86, 4-90
Don’t save 4-103
dongle 1-10
DontCare 11-35
Driver
   printer 12-6
duplicate filenames 4-16
Duplicating file names while polling a
directory 4-83
DWF file options
   4-31
DWF Files 4-4
DWG Direct Appendix F-1
DWG files Appendix F-9, Appendix G-3
DXF Appendix D-13

E
E 8-14
E macro 4-41
Edge sharpening 9-6
edit a PFS file 12-4
Edit an existing Output Destination 4-118
Edit Default PFS File 6-13
Edit Parameter File 6-8
Edit PFS 12-9
edit the master PFS file 6-13
Eject 9-9
ejection 9-20
E-Mail Remote Submitter on Error 8-13
E-mail Sender 7-6, 8-14
E-mail Server 7-6, 8-14
Embedded Controller Options 8-18
embedded patterns 4-36
Enable fold 4-69
Enable LMHOSTS Lookup 8-67
Enable Polling 6-9
Enable processing application 6-10
End number 4-82, 4-86
End suffix 4-91
enhancing images 9-24
enlarge an image 9-21
Error
   Add Media Appendix B-9
   Invalid “XXXX” Option Code Appendix B-10
Error 10
   Printer has no power or is not connected Appendix B-11
Error 1000 Appendix B-5
Error 1001 Appendix B-5
Error 1002 Appendix B-5
Error 1003 Appendix B-5
Error 1004 Appendix B-5
Error 1005 Appendix B-5
Error 1006 Appendix B-6
Error 1007 Appendix B-6
Error 1008 Appendix B-6
Error 1009 Appendix B-6
Error 1010 Appendix B-6
Error 1011 Appendix B-6
Error 1012 Appendix B-6
Error 1013 Appendix B-6
Error 1014 Appendix B-6
Error 1015 Appendix B-7
Error 1016 Appendix B-7
Error 1017 Appendix B-7
Error 1018 Appendix B-7
Error 1019 Appendix B-7
Error 1020 Appendix B-7
Error 1021 Appendix B-7
Error 1022 Appendix B-8
Error 1023 Appendix B-8
Error 1024 Appendix B-8
Error 1025 Appendix B-8
Error 1026 Appendix B-8
Error 1027 Appendix B-8
Error 1028 Appendix B-8
Error 1029 Appendix B-8
Error 11
Call Service (fuser low temperature) Appendix B-11
Error 12
Call Service (fuser over temperature) Appendix B-11
Error 13
Call Service (main motor error) Appendix B-11
Error 14
Call Service (developing motor error-black) Appendix B-11
Error 145 Appendix B-16
Error 146 Appendix B-16
Error 147 Appendix B-16
Error 149 Appendix B-16
Error 15
Call Service (process motor error) Appendix B-11
Error 150 Appendix B-16
Error 151 Appendix B-17
Error 152 Appendix B-17
Error 153 Appendix B-17
Error 154 Appendix B-17
Error 155 Appendix B-17
Error 157
The detachable cover is open Appendix B-17
Error 158
The original cover is open Appendix B-17
Error 159
The toner cover is open Appendix B-17
Error 16
Call Service (counter error) Appendix B-11
Error 160
The output cover is open Appendix B-17
Error 161
The waste toner cover is open Appendix B-17
Error 162
Bypass misfeed Appendix B-17
Error 163
Misfeed in roll # Appendix B-18
Error 164
Misfeed in the paper conveying section Appendix B-18
Error 165
Misfeed in the paper exiting section Appendix B-18
Error 166
Misfeed in the leading edge cut request Appendix B-18
Error 167
Misfeed in the original conveying section Appendix B-18
Error 168
Call Service (controller hardware error) Appendix B-18
Error 169
Call Service (controller memory error) Appendix B-18
Error 17
Call Service (cutter error) Appendix B-11
Error 170
Call Service (controller error) Appendix B-18
Error 171
The printer requires paper in roll # to finish printing Appendix B-18
Error 172 Appendix B-18
Error 18
Call Service (web feeding error) Appendix B-11
Error 19
Call Service (out of web error) Appendix B-17
Error 2
Unable to read the stock inventory file Appendix B-11

Error 20
Call Service (X cutter 0 error) Appendix B-11

Error 21
Call Service (X cutter 1 error) Appendix B-12

Error 206
xxx (nnn) and other error numbers in the 10000 or 20000 range Appendix B-24

Error 2107
Unspecified error occurred while FTP polling Appendix B-24

Error 2108
Unable to request list of files in remote directory xxx (nnn) Appendix B-24

Error 2109
Unable to create temporary filename. Appendix B-24

Error 2110
Unable to create local file yyy from temporary file Appendix B-24

Error 22
Call Service (X cutter 2 error) Appendix B-12

Error 23
Call Service (paper feeding motor error) Appendix B-12

Error 24
Call Service (fuser motor error) Appendix B-12

Error 25
Call Service (original motor error) Appendix B-12

Error 26
Call Service (wire cleaning motor error) Appendix B-12

Error 27
Call Service (exposure lamp error) Appendix B-12

Error 28
Call Service (quantity counter error) Appendix B-12

Error 29
Call Service (key counter error) Appendix B-12

Error 3
Unable to write to stock inventory file Appendix B-11

Error 30
Call Service (developer motor error-red) Appendix B-12

Error 31
Call Service (fuser thermostat error) Appendix B-12

Error 32
Call Service (tray error) Appendix B-12

Error 33
Call Service Appendix B-12

Error 34
Folder communication error Appendix B-12

Folder communication error or Host Mode disabled Appendix B-12

Error 35
Folder is not set for external control Appendix B-12

Error 36
Paper jam Appendix B-12

Error 37
Paper jam in folder Appendix B-12

Error 38
Waste toner full Appendix B-12

Error 39
Folder is over temperature Appendix B-12

Error 4
You must select an item to complete the transaction Appendix B-11

Error 40
Out of toner Appendix B-12

Error 4001 Appendix B-1
Error 4002 Appendix B-1
Error 4003 Appendix B-1
Error 4004 Appendix B-1
Error 4005 Appendix B-1
Error 4006 Appendix B-1
Error 4007 Appendix B-1
Error 4008 Appendix B-1
Error 4009 Appendix B-2
Error 4010 Appendix B-2
Error 4011 Appendix B-2
Error 4012 Appendix B-2
Error 4013 Appendix B-2
Error 4014 Appendix B-2
Error 4015 Appendix B-2
Error 4016 Appendix B-2
Error 4017 Appendix B-2
Error 4018 Appendix B-2
Error 4019 Appendix B-2
Error 4020 Appendix B-2
Error 4021 Appendix B-2
Error 4022 Appendix B-2
Error 4023 Appendix B-2
Error 4024 Appendix B-3
Error 4025 Appendix B-3
Error 4026 Appendix B-3
Error 4027 Appendix B-3
Error 4028 Appendix B-3
Error 4029 Appendix B-3
Error 4030 Appendix B-3
Error 41
   Remove manual feed Appendix B-12
Error 42
   Need manual feed
      XXX Appendix B-12
Error 43
   Transport open Appendix B-12
Error 44
   Door open Appendix B-12
Error 46
   Folder is off Appendix B-12
Error 47
   Not enough memory to print image
      XXXMB Appendix B-12
Error 48
   Printer claimed by SCSI class
   driver Appendix B-12
Error 49
   Large SCSI transfer failed Appendix B-13
   Printer Claimed by SCSI class
device Appendix B-13
Error 5
   Unable to open or create queue
      file Appendix B-11
Error 6
   Unable to create directory
      XXX Appendix B-11
Error 7
   A parameter file is already in
      process! Appendix B-11
Error 8
   Cannot open device driver Appendix B-11
Error 9
   7396 scanner communication
error Appendix B-11
Error beep 9-9
error codes
   CalComp Appendix C-4
   Image Viewer Appendix B-27
   Job Editor Appendix B-18
   Job Processor Appendix B-26
   Network Polling Appendix B-18
   Printer Interface Appendix B-10
   Scanner Interface Appendix B-27
Error Diffusion Dither 9-6
Error Free Printing
   AutoCAD
      identifying errors Appendix F-13
   AutoCAD scale and size fields Appendix F-10
critical error options Appendix F-13
   messages Appendix F-13
   over and under size errors Appendix F-10
   pre-checking messages Appendix F-12
   using pre-checking messages to identify
      errors Appendix F-13
   warning options Appendix F-13
Error Free Printing (EFP) 4-75
error messages Appendix B-1
Error while logging in. Please check the username and password. xxx (nnn) Appendix B-25
Error-Free Plotting 4-43
Exclude 4-102, 4-103
Exit Set to Default 11-29, 11-31
Exit to Finisher 11-28, 11-31
Exit Top of Printer 11-28, 11-31
Extension 4-91
Extents 4-14, 4-42
external dongle 1-10
external folders supported 11-11

F
F macro 4-41
Fan Fold 11-27
Fan Folds 11-11
Fatal Error Appendix B-10
File Configurations 4-103
File Filter 4-85
File format options 4-91
File menu 3-3
File Naming Options 4-89
File Naming/Viewing 9-2
File Naming/Viewing tab window 9-9
file processing status 4-12
Filename prefix 9-10
Filepath 4-19
Files named the same Appendix G-3
Files of type 6-7
FINAL_XSIZE 10-10
FINAL_YSIZE 10-10
finishing macro 4-69
Finishing Options sheet 4-68
First Fold Only 11-28, 11-31
FirstFold 11-35
FIT 4-13
Fixed Threshold 9-60
Flatten Red 8-37
fold margin 4-69
fold width 4-69
folder specific options 11-23
8180 Folder 11-32, 11-33
8830 Folder 11-24
8845 Folder 11-24
MAX 200 Folder 11-32, 11-33
MAX200 Folder 11-32, 11-33
Printfold 2150 11-25
Printfold 3150 11-25
Folder type 8-16, 11-9
FolderName 11-35, Appendix D-27
folders
auto-detected 11-8
configure the Printer Interface for 11-25
folding logic 11-11
Folding Options 4-124
Folding options for the MAX200 EO 11-29
Folding options for the MAX200 NACO 11-27
Folding User Interface 4-69
FoldMargin 11-35
FoldMarginEnable 11-35
FoldProgram 11-35, Appendix D-27
Font dialog box 4-51
Fontmap.gs Appendix B-8
Fonts on PDF files are printing thin Appendix B-8
Foot pedal COM port 9-14
Force Even/Odd Polygon Fill 4-46
Force Pens Solid on all Planes 4-46
Format 4-13
from last path used to open/save jobs 4-65
from the current working directory 4-65
from the last path used to add files 4-65
from the specified job path 4-65
FTP
configuring Windows NT 4.0 Workstation Appendix E-32
setting as a destination 4-116
FTP Directory 4-84
FTP Polling Directory 4-84
FTP Server 4-84
Full Print Recovery 11-1
G

G Pen Macro 4-43
Gamma Correction 8-35
Gamma correction 8-34
Gecko Interface Card 1-7
General Configuration 8-5, 8-10, 9-2
General Preferences sheet 4-65
Generic 8-18
Generic Embedded Controller Options 8-6
Gera Folder 11-24
Gera Universal Folder 11-7
going help 1-21
GFI Folder 4-69, 11-19
GFI Folding 11-31
GFI Level 1 11-1
Ghostscript Appendix B-8
Graphic Sample 4-103
Grayscale 4-43
Grayscale (8Bit) 9-56
Greater than 8-12
Grey 4-102
grid 4-12
change the width of columns 4-14
move through 4-12

H

Halftoning 9-60
Halt Processing 4-110
Hanging Edge 11-15
hanging strip 11-15
hardware
configuration 1-6
interface cards 1-7
Hardware port number 8-18
Header 8-18
Held 8-13, 8-14
Help 4-107
Help menu 3-5
High Resolution Patterns 8-36
Highlight Color 4-102
Highlight Color Printing 8-47
hold 3-17
hold a job 3-17
Hold Job When Media Out Appendix B-10
Host Mode 11-25
How is This Media Loaded 8-23
HP-GL & HP-GL/2 supported command list Appendix C-5
HP-GL & HP-GL/2 Supported Commands Appendix C-5
HPGL conversion code has expired Appendix B-10
HP-GL supported command list
advanced pen control and front-panel interaction Appendix C-7
alternate character sets and user-designated characters Appendix C-8
circles, arcs and wedges Appendix C-6
configuration group Appendix C-5
device control instructions Appendix C-9
digitizing Appendix C-8
enhancing plots Appendix C-5
interfacing and handshaking Appendix C-10
lines and rectangles Appendix C-5
obtaining information from the plotter Appendix C-9
picture area and orientation Appendix C-7
polygons Appendix C-7
roll feed and long-axis plotting Appendix C-8
HP-GL/2 printing 12-6
HP-GL/2 supported command list
advanced drawing extensions Appendix C-15
advanced text extensions Appendix C-15
character group Appendix C-13
configuration and status group Appendix C-11
digitizing extensions Appendix C-15
dual context extension Appendix C-15
line and fill attributes group Appendix C-12
palette extension Appendix C-14
polygon group Appendix C-12
   technical graphics extension Appendix C-13
   vector group Appendix C-11
HPGL2 Plot Size 4-42

I
Icons 2-17
Ignore all 4-110
Ignore Warnings 3-5, 6-9
Image 8-9
Image Controls tab 8-33
Image data buffer size 9-14
image data buffer size 9-23, Appendix A-5
   for the Scanner Interface Appendix A-5
Image Density 9-7
image file requirements Appendix C-1
   plot files Appendix C-1
image files 4-109
   processing 4-109
   viewing 5-1
Image Intensity 8-35
Image Rendering Defaults 8-35
Image Viewer 5-1
   adjust print area edges 5-8
   adjust print origin 5-7
   adjust print size 5-7
black paper 5-9
Edit menu 5-4
File menu 5-4
Help menu 5-6
hide pens 5-8
identify pens 5-8
Image menu 5-5
show pens 5-8
View menu 5-4
viewing area 5-6
zooming 5-7
images
   enhancing 9-24
   enlarging 9-24
   reducing 9-24
imaging memory setting guidelines
   for Printer Interface Appendix A-3
   for RTL printers Appendix A-4
   for Windows printers Appendix A-4
import a job from disk 3-15
Import DOS Job 3-3
Import Job 3-3
Import Pattern File 8-4, Appendix G-15
Importing the log file into Microsoft Access 10-17
Index 6-4
install & configure a Remote Access Server (Hub)
   for Windows NT 4.0 Appendix E-2
install Client for Microsoft Networks Appendix E-27
install Dial-Up Networking on Windows 95 Appendix E-27
installation 2-1, 10-1
installing FTP Appendix E-29
installing network protocols (Windows NT) Appendix E-24
   create an LMHOSTS file Appendix E-21
NetBEUI Appendix E-23
NWLink IPX/SPX compatible transport Appendix E-22
TCP/IP Appendix E-24
installing network protocols (Windows 95) Appendix E-24
Client for Microsoft Networks Appendix E-27
   create an LMHOSTS file Appendix E-25
IPX/SPX compatible Appendix E-25
NetBEUI Appendix E-26
TCP/IP Appendix E-24
installing Print-to-Queue (Windows NT) 12-3
interrupt a job 3-18
Inventory 2-11
Invert 4-46
invert 9-21
Invert image 9-8
IP Address 8-67, 8-72, 8-74, 8-75
ipconfig 8-68
is already in use Appendix B-3
is currently printing Appendix B-3
Is this media available for automatic media selection? 8-22

**J**

J macro 4-42
Unable to start monitor thread for Appendix B-5
Job # 8-9
JOB and FILE sections Appendix D-5
Job Editor 1-16, 4-1
   Edit menu 4-8
   File menu 4-7
   Help menu 4-11
   property sheets 4-19
   Setup menu 4-10
   toolbar buttons 4-5
   View menu 4-9
JOB Files Appendix G-1
Job goes on hold when media out 8-13
Job Information 3-23
job information 4-122
Job menu 3-4
job nesting 4-70
Job of at least 8-31
Job Order 3-23
Job Processor 1-16, 7-1
   File menu 7-2
   Help menu 7-4
   setting up 7-5
   window 7-1
Job Queue 1-16, 3-1
   columns 3-6
   File menu 3-3
   Help menu 3-5
   icons 3-6
   Job menu 3-4
   setting up 3-10
   Setup menu 3-4
   structure 3-9
   toolbar buttons 3-2
   troubleshooting Appendix B-1
   View 3-5
   View menu 3-3
   window 3-2
job recovery 8-40
job report
   producing 10-1
job ticket
   output 4-123
   processing 4-109
   save 4-16
   save under new name 4-16
Jobs Printed Successfully Should Be 8-13
Jobs Printed with Errors Should Be 8-14
Justification 4-14
justification 4-53

**K**

K macro 4-42
keywords and values Appendix D-5
KIP 1230 options 8-60
KIP 2020 Scanner Interface 9-75
KIP 2030 Scanner Interface 9-75
KIP 2950 9-77
KIP 3620 8-58
KIP 7095 options 8-61
KIP 7095 Scanner Interface 9-74
KIP 8000 8-56
KIP 9010 options 8-62
Kyocera Mita 4850w 8-67
Kyocera-Mita Controller 8-74

**L**

L macro 4-43
Label 4-14
label macros 4-59
Label Rotation 4-59
labels
   create 4-59
Labels property sheet 4-57
Last Scan Size 9-3
Layout 4-14
Leading 8-17
Less or equal 8-12
Limits 4-14
Line 9-6
Line Ends 4-41
Line Printing Daemon 12-22
Line Printing Utility 12-22
Linux 12-20
LOG Files 10-15
logs 3-22
Long Edge 4-43
long filenames 4-16
LowerLeft 11-35
LowerRight 11-35
LPD 12-22
configuring for use with PlotWorks 12-20
configuring Linux/Unix 12-24
configuring NT Workstation 12-20
configuring PlotWorks and Print-to-Queue 12-20
LPR 12-22

M

M macro 4-43
macros
  color 4-32
diffused dot dither 4-37
finishing 4-69, 11-20
label 4-59
pen 4-32
Main tab window 9-3
Make overlays relative to main image 4-47, 4-70
Make Raster Pixels Solid Black 4-46
Manual Feed 8-23, 8-26
manual feed 8-78
Manual Feed Continue 8-26
Map pen colors to a shaded halftone 4-46
mapping a printer to a port (Windows 95/98) 12-20
mapping a printer to a port (Windows NT) 12-6
Margin 4-69, 11-33
margins 4-53
Master PFS File 6-13
Master PFS file 6-8
MAX 200 8-46, 8-49
MAX 200 Billing Meter 8-37
MAX 200 EO 4-69
MAX 200 Folder 11-32, 11-33
MAX 200 NACO 4-69
Max nest length 8-23
MAX200
  manual feed 8-78
MAX200 Folder 11-32, 11-33
MAX200 Interface 8-46, 8-50
color or patterns in CALS and TIFF files 8-49
color performance limitations 8-48
color planes 8-48
patterns used 8-48
MAX200 Printer
dual color printing Appendix A-4
MAX200 Scanner Interface 9-42
options 9-44
Maximum Files 6-8
Maximum Imaging memory 8-11
Media Change 8-6, 8-25
Media Inventory 8-6
media inventory
  list 8-24
  setting up
    media inventory 8-21
Media Inventory dialog box 2-11
Media length 8-32
media log 3-22
Media Size and Type 8-22
Media type 8-31
Media Type Unknown Error 8-41
Media width 8-32
memory requirements Appendix A-1
Mesquite Interface Card 1-9
Microsoft Excel 10-16
Microsoft TCP/IP Printing service 12-22
Microstation 12-24
Microstation scale 4-13
Minimum Paper Length 8-18
Minimum Pen Width (Pixels) 4-32
Minimum Pen Width (pixels) 8-17
Mirror 4-14, 9-60
Mirror image 9-8
mirror image 9-21
mirroring 4-64
Missing or Invalid Password dialog box 4-4
Mode 9-3, 9-5
Mode 2
  Parameter Files 6-9
Mode 3
  PFS Polling 6-10
Mode 4
  OVR Polling 6-10
modem 6-14
Monochrome (1Bit) 9-56
Move Down 4-10
Move Up 4-10
MS Loopback Adapter Appendix E-24
multi-page documents 4-29
Multiple Match Appendix B-10
Multiple Match error 8-3, 8-6
Multiple sheet DWG file 4-4
multiple sheet DWG file 4-4

N
Job Appendix B-3
ob Appendix B-3
name files manually 9-19
nest jobs 4-68, 4-70
  about nesting 4-71
  color jobs 4-72
  media override 4-72
Nesting Options sheet 4-70
Network Polling 1-16, 6-1
  About Network Polling 6-4
  Add Directory 6-3
  columns 6-4
  Delete 6-12
  Delete Directory 6-3
  Delete Network Polling Entry 6-12
  Delete Network Polling Entry and Polling Directory 6-12
  Edit Default PFS File 6-4
  Edit Parameter File 6-3, 6-13
  File menu 6-3
  Help menu 6-4
  Mode 5 JOB Polling (Repro Desk) 6-10
  Modify Directory 6-3, 6-11
  Online Manual 6-3
Polling Options 6-4
  setting up 6-6
  Setup menu 6-3
  Start Polling 6-3
  Status Bar 6-3
  Stop Polling 6-3
  Toolbar 6-3
troubleshooting Appendix B-5
  View Log 6-4

network polling Appendix D-1
New Job 4-7
New Media 8-25
New Queue Directory 3-3
New Revision 4-100, 4-101
Next Document 8-26
Next file 9-3
Next filename 4-82, 4-86
Next suffix at 9-10
No Fold 11-28, 11-31
No Folder/Auto detected 11-9
No Folder/Auto Detected Folder 8-16
no longer exists Appendix B-3
No Match Appendix B-10
Notify 7-2
Notify remote sender of processing error 7-5
Notify Remote Submitter on Error 8-13
Number of Copies 9-3

O
Océ 9600 11-26
Océ 9800 11-27
Océ 9800 Folder
  specifying folds 11-26
  Ocė 9800 Scanner Interface 9-79
  scan controls 9-79
Océ OCI Controller 8-10, 8-67
Oce Power Logic 4-78
Océ Power Logic Controller 8-73
Offset images Appendix G-3
Old Revision 4-100, 4-101
Online Help 1-21
open an existing Job Queue 3-10
Open Job 4-7
Open Label 4-63
Open Margin 4-63
Open Pen Set 4-7
Open Queue 3-3
open the Job Editor 2-13
Open Watermark 4-63
Operation interrupted (connection with server was lost) Appendix B-25
Optional components 1-17
Ordered Dither 9-6
ordered dot dither 4-37
Ordered Pattern Set 4-45
Original height 9-13
Original size 9-12
Original width 9-12
output quality levels 4-27
Output Bin 11-33
output destination 4-112
Output Job 4-8
output job 4-123
output job tickets Appendix E-28
Output quality 8-18
output quality 2230/2240 Inkjets 8-18
Output Size Property Sheet 4-24
Output Size property sheet 4-24
output the job 2-15
Output To File 4-94
Compress files into ZIP file 4-96, 4-97
Compression 4-96
GROUP 3 4-96
GROUP 4 4-96
HIGH 4-96
LOW 4-96
MEDIUM 4-96
PACKBITS 4-96
RLG 4-96
Destination Path 4-95
Disable ARU log 4-96
Format 4-95
Resolution 4-96
Selected Files Only 4-95
TIFF 4-95
Use Original Filenames 4-95
Output to File 4-8, 4-94, 10-1
3-5
Create PLP Job File 4-95
Error during processing dialog box 4-98
Process Cancelled 4-97
Output to File Data Fields 10-10
OutputBin 11-35, Appendix D-27
Overlays 4-14, 4-46
Overlays property sheet 4-39
Overlays tab 4-48
Override Media 8-6, 8-24, 8-42, Appendix B-9
override the requested media Appendix B-9
P
Paper sizes 9-14
paper sizes supported by Windows printers 8-77
PARAM Appendix B-6
Paste Row 4-9
Pattern Set Files (*.set) Appendix G-15
Pause Printer 8-4
PDF 9-11
pen color 4-39
patterns 4-39
type 4-39
pen color 4-39
Pen Colors 4-41
Pen Configurations 4-41
PEN Files Appendix G-2
pen macro 4-32
pen macros 4-34
pen patterns used with the Xerox 8855 printer 8-56
pen set 4-61
apply to image 4-61
create & save 4-61
open existing 4-61
Pen Strokes 4-41
Pen Widths 4-41
Pen/Print Options 4-39
Pens 4-13, 4-65
Pens property sheet 4-31
PFS File 12-8
PFS file 6-12
  sample custom file 12-4
PFS file hierarchy Appendix D-3
PFS file layout Appendix D-5
PFS files
  advanced features Appendix D-40
  defining parameters Appendix D-7
  keywords by category Appendix D-9
  administrative
    information Appendix D-9, Appendix D-18, Appendix D-19
  AutoCAD file setup Appendix D-18
  folding Appendix D-25
  job control Appendix D-10,
    Appendix D-11, Appendix D-13, Appendix D-14,
    Appendix D-15, Appendix D-16, Appendix D-17,
    Appendix D-18
  justification Appendix D-31
  labels Appendix D-35, Appendix D-36, Appendix D-37,
    Appendix D-38
  log file data Appendix D-38
  margins Appendix D-30
  nesting controls Appendix D-30
  pen control Appendix D-19,
    Appendix D-20
  watermarks Appendix D-31,
    Appendix D-32, Appendix D-34
  open and write to a file Appendix D-41
  parameter setting requirements Appendix D-8
  pens data Appendix D-8
  size data Appendix D-8
  polling log file Appendix D-42
  sending jobs to a target directory Appendix D-42
special fields Appendix D-40
PGS file 1-16, 4-73, 4-74, 4-109, 4-124, 7-1
Photo 9-6
Photo1 9-6
Photo2 9-6
ping 8-69
Plot by 4-13
PlotWorks
  installation 2-1, 10-1
  PlotWorks parameters and AutoCAD Appendix F-3
PLP files
  view images in 5-1
PLP Internet Support 1-22
Poll Directory 4-79, 4-84
Poll queue every 3-12
poll target directories 6-15
Polled Directory 4-78, 4-84
Polling 1-16
polling 6-14
polling directories has been deleted Appendix B-8
Polling Directory 4-79
Polling for Repro Desk VIC Files Appendix G-5
Polling Modes 6-9
Polling Options 6-15
Polling Path 6-7
Polygon Fills 4-41
Port 4-84
Port Name 12-8
Power save timeout 8-17
preferences sheets
  Finishing 4-68
  General 4-65
  Nesting 4-70
  User information 4-67
Prefix 4-81, 4-86, 4-90
Prefix and suffix with auto-increment 4-81, 4-86, 4-91
Prefix only 4-81, 4-86, 4-90
Prefix with auto-increment 4-81, 4-86, 4-90
print 3-18
Print Anyway 4-110
print darker 8-35
Print density 8-17
Print Image in Highlight Color 4-44
Print Orientation 4-43
print page range
   PDF files 4-29
   PostScript files 4-29, 4-31
   TIF files 4-29
print red 8-49
print red and black 4-36
print status box 8-8
Print To 12-8
printer diagram 8-7
printer information box 8-8
Printer Interface 1-16, 8-1
   File menu 8-4
   Help menu 8-6
   setting up 8-10
   Setup menu 8-5
   toolbar buttons 8-3
   troubleshooting Appendix B-8
   View menu 8-5
   window 8-3
Printer Name 8-18
Printer type 8-11
Printer-Specific Options 8-46
Printfold 2150 and 3150 Folders 11-25
PrintFold Folders
   viewing available fold types 11-26
Printfold Folders
   supported printers 11-25
Printing
   HP-GL/2 12-6
   NT driver 12-6
Printing from AutoCAD 14 Directly to PlotWorks
   Job Queue Appendix F-16
printing mode 8-28
printing parameters 4-12
Printing Postscript 8-49
Print-to-Queue 1-17, 12-1
   associate to a Windows printer (Windows NT) 12-18
considerations 12-2
installing on Windows NT 12-3
map a local printer (Windows NT) 12-6
map a local printer (Windows XP) 12-13
troubleshooting 12-24
using a network printer 12-12
what is it 12-1
prioritize 3-16
Priority
   6-9
problems printing HP-GL/2 files 12-6
process 3-18
Process All 4-8
Process Files on Hold 7-3
Process PS/PDF/DWF files in Color 4-43
Process Selected 4-8
Process selected files 4-109
Processing application 6-11
processing AutoCAD 14 jobs Appendix F-1,
   Appendix G-1
processing log 3-22, 7-7
processing options 4-72
   AutoCAD/DWG Direct setup 4-76
processing 4-73
   Size tolerances 4-75
Processing Options sheet 4-73
Prompt for manual entry of filename after each
   file 4-91
   4-82, 4-86
Prompt for user information on submission 4-113
property sheets 4-18
   Data Format 4-27
   Margins 4-52, 4-63
   view 4-18
Proto row 4-12
Punch 4-69, 11-33
Punch/Tab/Reinforce 11-28, 11-30
Punching 8-16, 11-10
put jobs on hold when media is out
   Appendix B-9
PWC 4-114
PWJ 6-10
PWJ file 4-114
Q

Q macro 4-43
Quantity 4-19
Queue 7-1
Queue Directory 6-8
Queue File 12-8

R

R macro 4-44, 4-45
Raster Imaging 8-33, 8-34
Raster Rendering 4-45
Rebuild Queue 3-3
rebuild the queue 3-24
Red 8-37
Red and Black Printing Options 8-49
Red Threshold 8-37
Red Threshold value 8-37
reduce an image 9-21
Reduce or Enlarge 9-4
Reduce pen widths 8-17
refresh the Viewer window 5-9
Refresh Viewer 4-10
Reinforce 4-69
Reinforcement 8-16, 11-10
Release Notes 6-4
Remember Password 4-85
Remote Directory to Poll 4-85
Remove borders from prints 4-69
Rendering Options 4-43
Replace 9-30
report file keywords 10-10
report generating 10-16
reports 3-22
Reprint 3-19
reprint 3-19
Repro Desk
  Use Error Diffusion for Gray or Color RTL images 8-36
Repro Desk Emulation 4-42
Repro Desk Pen Macros Appendix G-13
Repro Desk pen patterns Appendix G-14
Required Inventory for ISO folds 11-25

Resample All Monochrome TIFF 4-46
ReScan 9-4
rescan 9-27
reset 3-25
Reset Job 3-5
reset the Activity Field for a job 3-25
Resolution 9-8, 9-56
resolution 9-20
resolution edit box 4-29, 4-32
Restart suffix after 9-10
resume a job on hold 3-17
Reverse Order 4-100, 4-101
Reverse standard print order 2-16, 4-69, 4-123
Reverse standard print print order 3-19
Revert to Standard Patterns 8-4
Revision Compare 4-9
  Batch Compare 4-106
  Batch Compare Finished 4-107
Revision HighLighting 4-99
Revision Highlighting
  Batch compare 4-102
  Specify 4-102, 4-103
right edge scanning 9-21
RK Color Model Specific 8-33, 8-37, 8-49
RK Color Model Specific Tab Window 8-49
rks 1-17
Roll Feed 8-23
Rolls 1-6 8-18
rotation (folding) 11-23
Rotation feature 8-16, 11-10

S

S macro 4-43
sample custom PFS file 12-4
sample PFS files Appendix D-42
  sample user interfaces Appendix D-44
  sample Excel interface Appendix D-45
  sample Windows interface Appendix D-44
Save 9-9
save a job ticket 4-16
Save as 4-91
Save Configuration 4-8
Save Job 4-8
Save Job As 4-8
Save memory when nesting 8-12
Save paper when nesting 8-12
Save Pen Set 4-8
save the job ticket 2-15
save the job to Falcon/DMS 4-18
Save Watermark 4-62
Save with new rev 4-103
Save with old rev 4-103
Saving Jobs from the Queue to a different location 3-20
Scale 4-13
scale pens 4-27
Scale RTL Raster Blocks 4-42
Scale View 4-10, 4-64
  media type 4-64
  mirroring 4-64
  quantity 4-64
  scale 4-64
  size 4-64
Scale View diagram 4-64
Scan 4-7
Scan and Replace a CAL or TIFF file 9-28
Scan and Replace Mode 9-11, 9-28
Scan Controls 9-2, 9-3, 9-5
  Configuration 9-5
  Mode 9-5
    Bilevel 9-6
    Bilevel (Adaptive Area) 9-5
    Bilevel (Manual) 9-5
    Error Diffusion Dither 9-6
    Ordered Dither 9-6
Scan directory 4-89, 9-3
Scan file format 9-8
scan images into a job ticket 9-26
Scan right 9-9
Scan to Disk 9-3
Scan to Print 9-3
Scan units 9-14
Scanned Document Descriptions 9-12
Scanner 1-17
Scanner ARU Data Fields 10-10
Scanner Interface 1-17, 9-1
  1-17
    setting up 9-17
Scanner Main 9-2
scanner settings 9-25
Scanner speed 9-8
Scanner type 9-14
scanning 9-26
  right edge 9-21
Scanning a Document to Replace a Saved Digital Document 9-27
Scanning from Twain Devices 4-125
Scanning Options 4-89
scanning speed 9-20
scan-to-print 9-27
Scorpion Interface Card 1-7
SCSI capability 9-13
SecondFold 11-35
Security Code to Expire Appendix B-10
security key 1-10
select AutoCAD in PlotWorks Appendix F-9
Select Fold Style 11-33
Select Folder 11-33
Select Queue Colors 3-13
Selected files only 4-123
selecting a Windows printer 8-76
selecting an RTL printer 8-65
Selecting the TWAIN scanner 4-91
Send 7-6
Send Additional Information from
  TEMPLATE.INF file 4-113
Send e-mail notification of errors 7-6
Send e-mail notification to remote submitter 8-14
Send flat output to finisher 8-16
send jobs to the printer 2-15
Send notification to local submitter 8-14
Send notification to remote submitter 8-14
Send original image files only 4-74
send print jobs
  send special instruction file 4-120
  TEMPLATE.INF file 4-120
Separator page 8-31
separator page
  enable 8-31
  include in ARU reports 8-32
Separator Pages 8-6
separator pages
  printing 8-30
Serial port 8-16, 11-9
set basic scanning parameters 9-17
set file Appendix G-14
SET Files Appendix G-2
Set of at least 8-31
set preferences 4-65
Set Printer Mode 8-4, 8-28
set Queue options 3-11
set resolution 4-29, 4-32
  manually 4-29, 4-32
  PDF files 4-29
  PostScript files 4-29
set up destination
  destination types 4-114
  local area network 4-115
  local Queue directory 4-115
set up file naming 9-17
Setting Macros and Other Options 11-23
setting up
  Job Processor 7-5
  Network Polling 6-6
  printer 8-10
  Scanner Interface 9-17
setting up an FTP destination 4-116
Setting up the Printer Interface to use your Folder 11-8
Setup menu 3-4
Sharpen Raster Blocks 4-46
Sheet Feed 8-23
Sheet Size Preferences 8-12
Short Drawing Support 11-1
Short Edge 4-43
Show all notices 4-109
Show on scanner startup 4-89, 4-93
simulate printing 8-44
Simulation Options 8-6
Simulation/Demo 8-6
site-level defaults Appendix D-4
Size Tolerance sheet 4-75
Size units 4-65
Skip 4-4
Skip a File 4-4
Skip Image 4-110
Smart Switch 1 1-11
Smart Switch Options 8-16
Socket Port Number 8-72, 8-74
Socket Printers 8-67
software components
  Job Editor 1-16
  Job Processor 1-16
  Job Queue 1-16
  Network Polling 1-16
  PlotWorks Client 1-17
  Printer Interface 1-16
  Print-to-Queue 1-17
  Scanner Interface 1-17
software flowchart 1-18
Sort by Column 4-9
sort the jobs in the Queue 3-9
Special Fold 11-28, 11-29
Specified Path 4-89
Specified Size 4-21, 4-22
Specified size 4-19
Specifying what data the ARU log collects 10-2
standard configurations 9-25
Start 7-2
Start number 4-82, 4-86
start processing 7-7
Start suffix 4-91
Start suffix at 9-10
start the Job Processor 2-8
Status Bar 4-10
Stop 7-2
stop processing 7-7
Stopping Polling 4-83, 4-87
Submit on Hold 6-9
Submitted.PFS 6-13
Subtractions Setup options 4-102
Suffix 4-81, 4-86, 4-90
support
online help 1-21
technical support 1-21
world wide web 1-22
supported file formats 1-5
Supported PlotWorks Devices 1-3
Synergix ·Synergix PRINT SYSTEM 510dp 8-51
Synergix Fold System 40 11-7
Synergix Print System 510dp 8-51
Synergix Print System 721p 8-56
system requirements
minimum 1-15
System Tray Icons 2-19

T

T macro 4-41
Tab/Reinforcement 11-33
Table of Contents 6-4
Tarantula Interface Card 1-9
target directory 6-6
delete 6-12
modify 6-11
TDS 400 8-73
TDS 600 8-73
TDS 800 8-73
Technical Support 1-21
technical support 1-21
TEMPLATE.INF 3-23
TEMPLATE.INF file 4-120
create 4-120
send 4-121
Templates 4-7
Templates... 4-62, 4-63
Text 9-6
Text and Photo 9-6
Text qualifier 10-17
The 1-9
The destination directory does not exist Appendix B-24
The file %s can not be overwritten because of insufficient file permissions or some other reason. Polling will be aborted Appendix B-25
The file yyy already exists in the destination directory. Would you like to overwrite the existing file? Appendix B-25
The following jobs could not be deleted because Appendix B-3
The following jobs could not be selected to print from the selected location because Appendix B-3
The following jobs could not be selected to print next because Appendix B-3
The following jobs could not have their destination changed because Appendix B-3
The following jobs were not aborted because Appendix B-3
The following jobs were not held because.. Appendix B-4
The following jobs were not resumed because.. Appendix B-4
The following jobs were not selected for reprint because.. Appendix B-4
The General Configuration tab window 9-11
The Next filename 4-91
The printer number could not be changed because... Appendix B-4
The priority on the following jobs were not changed because... Appendix B-4
The selected job cannot be printed immediately because... Appendix B-4
The selected jobs could not be dragged because... Appendix B-4
The Setup Menu 7-3
The specified FTP server could not be found or an error occurred. xxx (nnn) Appendix B-25
This job cannot be edited because... Appendix B-4
Threshold 9-6, 9-60
TIFF 8-49, 9-11
Time out (sec) 6-11
Title bar 9-3
Title Block 4-21
Title Block Location 11-19
Title Block Location Viewer 4-10
TitleBlock Appendix D-28
TitleBlockLocation 11-35, Appendix D-28
To add a polling directory 6-7
To edit the DEF file 10-2
Toolbar 4-9
toolbar buttons 3-2, 4-5
   Network Polling 6-2
Trailer 8-18
Trailing 8-17
Transparency 4-41
troubleshooting
   Job Queue Appendix B-1
   Network Polling Appendix B-5
   Printer Interface Appendix B-8
TWAIN 4-88
Twain 1-3, 4-8
Twain Options 4-11, 4-89
TWAIN Scanning Options 4-93
Twain Scanning Options 4-11, 4-88
Type Detected 8-23

U
U macro 4-45
ueue 1-17
Unable to allocate enough memory for this operation. Appendix B-4
Unable to register Queue as a drag/drop target Appendix B-4
Unchanged Setup 4-102
understanding PFS files Appendix D-1
Unix 12-20
UpperLeft 11-35
UpperRight 11-35
Use dial-up networking to connect to destination 4-113
Use drawings Page Size 4-42
Use drawings page size 4-31
Use original filename, adding a unique number if needed 4-82, 4-86
Use RTL Pallet for Monochrome 4-43
Use set memory 6-9
   3-19
user defined pattern Appendix G-14
User Information sheet 4-67
User Interface Units 8-5
User Specified 4-19
User Specified File Format 4-4
using a network printer 12-20
using finishing macros with the Printfold folders 11-25

V
V macro 4-42
Vector Imaging 8-33, 8-34
VIC 24 Driver Appendix C-1
VIC Files Appendix G-1
Vidar Flash Scanner Interface 9-74
Vidar Flash+ Scanner Interface 9-71
View 4-14
view a scanned image 9-31
View Image 4-10
View Log 6-15
View menu 3-3
View Name 4-14
view or edit the Fontmap.gs file Appendix B-9
Viewer path 9-11
Viewer Selection 9-11
Viewer Window 5-2
Viewing 4-106
viewing 9-26

W
W macro 4-41
Wang 9-32
Wang/Kodak Imaging Viewer 9-32
Warning
   A file of an unsupported file format was downloaded from the remote directory. It will not be added to the job ticket. Please check the remote directory to ensure that it is correct Appendix B-26
Watermark 4-14
Watermark Direction 4-50
Watermark property sheet 4-49
Watermark Text 4-51
watermarks
    create 4-49
what is Print-to-Queue 12-1
What title do you want for your Query 10-25
What’s New in PlotWorks version 5.3 1-1
When Printing is Complete 8-14
White point 9-8
White Seed 9-59
Width Detected 8-23
Windows and RTL printer options 8-18
Windows printers 8-69, 8-76
    paper sizes supported 8-77
Windows XP Viewer 5-9, 9-32
X
X macro 4-46
X offset 8-23, 9-13
Xerox 7336 Scanner Interface 9-33
    general configuration options 9-34
    set up a foot pedal 9-34
Xerox 7356 Scanner Interface 9-35
Xerox 7396
    modes 9-24
Xerox 7396 Scanner Interface 9-37
Xerox 7399 9-24
Xerox 7399 Scanner Interface 9-39
Xerox 8180 Interface 8-46, 8-50
    color or patterns in CALS and TIFF files 8-49
    color performance limitations 8-48
    color planes 8-48
    patterns used 8-48
Xerox 8180 Printer
dual color printing Appendix A-4
Xerox 8180 Scanner Interface 9-42
    options 9-44
Xerox 8830 Printer Interface 8-37
Xerox 8840D/Fuji Xerox 4024 options 8-53
Xerox 8845/Fuji Xerox 4036 options 8-54
    pen widths 8-55
    using a folder 8-55
Xerox 8855 options 8-56
Xerox Access Controller 8-67
Xerox Access Controller Driven Printers 8-71
Xerox MAX200 Interface
    patterns used 8-48
Xerox MAX200 Interface 8-46, 8-50
    color or patterns in CALS and TIFF files 8-49
    color performance limitations 8-48
    color planes 8-48
Xerox MAX200 Printer
dual color printing Appendix A-4
Xerox MAX200 Scanner Interface 9-42
    options 9-44
Xerox MAX200NP 8-50
Xerox MAX200NP Device Specific Options 8-50
XP Viewer 4-111
Y
Y macro 4-46
Y offset 8-23, 9-13
Yes, but only when loaded in the printer 8-22
You must specify a queue directory Appendix B-8
Z
Z macro 4-44, 4-45